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ABSTRACT 
 
The MACCS User’s Guide is intended to assist analysts in understanding the 
MACCS/WinMACCS model and to a lesser degree provide information regarding the code.  The 
historical reference to the consequence code has been MACCS or MACCS2, which was related 
to the version number. The purpose of this document is to update the User’s Guide to reflect the 
model as it is presented in MACCS Version 3.10.0.  This User’s Guide provides a brief 
description of the model history, explains to a user how to set up and execute a problem, and 
informs the user of the definition of various input parameters and any constraints placed on 
those parameters.    
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EXECUTIVE SUMMARY 
 
The purpose of this document is to provide a reference document for MACCS, which is used for 
calculating health and economic consequences from a release of radioactive materials into the 
atmosphere. The program has been widely distributed and used throughout the Department of 
Energy (DOE) and by the Nuclear Regulatory Commission (NRC) as well as other 
organizations, including international regulators and industry.  The historical reference to the 
consequence code has been MACCS or MACCS2. The number 2 has now been dropped in 
favor of a single version number, which is 3.10.0 at the time of this writing.  
 
In 2001, the NRC initiated an effort to create a Window’s based interface and framework for 
performing the consequence analysis. This manual describes the functions of both WinMACCS 
and MACCS together. For simplicity, the combined functions of MACCS and WinMACCS are 
often referred to as MACCS. However, WinMACCS and MACCS are separate codes and it is 
often useful to distinguish the functions of the two codes. This User’s Guide is based on version 
3.10.0 of both MACCS and WinMACCS.   
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1. INTRODUCTION  
 
The historical reference to the consequence code has been MACCS or MACCS2, which was 
related to the version number. In 2001, the NRC initiated an effort to create a Window’s based 
interface and framework for performing the consequence analysis. This manual describes the 
functions of both WinMACCS and MACCS together. For simplicity, the combined functions of 
MACCS and WinMACCS are often referred to as MACCS. However, WinMACCS and MACCS 
are separate codes and it is often useful to distinguish the functions of the two codes.  
 
MACCS is the NRC code used to estimate the offsite consequences of potential severe 
accidents at nuclear power plants (NPPs).  The code is used to perform probabilistic health and 
economic consequence assessment of hypothetical releases of radioactive material.  
Atmospheric dispersion and transport, wet and dry deposition, probabilistic treatment of 
meteorology, environmental transfer, countermeasure strategies, dosimetry, health effects, and 
economic impacts are addressed in the code.   
 
The lineage of development of accident consequence codes for the NRC is described as 
follows: 
 

CRAC was used in the landmark Reactor Safety Study (WASH-1400) to estimate 
consequences of a set of hypothetical accidents. WASH-1400 was published in 1975 but 
a CRAC users’ manual was never published.  
 
CRAC2 was published in 1983 (Ritchie et al., 1984) and was most notably used to 
support Technical Guidance for Siting Criteria Development (Aldrich et al., 1982) 
 
MACCS was published in 1990 (H-N Jow, et al., 1990) and was used to perform the 
consequence analyses for the landmark PRA study documented in NUREG-1150 (NRC, 
1989) 
 
MACCS2 was published in 1997 (Chanin and Young, 1997). The work to create 
MACCS2 was sponsored by the U.S. Department of Energy (DOE) and was focused on 
generalizing MACCS to be used for nonreactor applications. 
 
WinMACCS was first released to the public in March of 2008 as Version 3.4.0. Version 
3.10.0 is the sixth release version to be published. WinMACCS has been used for a 
large number of important studies, including the SOARCA study (NRC, 2012, N. Bixler et 
al., 2013, and Sandia National Laboratories, 2013), the SOARCA uncertainty study for 
Peach Bottom (Sandia National Laboratories, draft published in 2015), and 
Consequence Study of a Beyond-Design-Basis Earthquake Affecting the Spent Fuel 
Pool for a U.S. Mark I Boiling Water Reactor (Barto et al., draft published in 2013).  

 

1.1 MACCS History 
 
MACCS2.1.12 was released in April of 1997 as a batch process code.  In September 2001 
version 1.13 was released to allow execution under newer operating systems and to fix several 
bugs in the previous version.  Since 2001 a new version of MACCS has been released 
approximately every two years.  New versions offered enhancements as well as addressed 
bugs.  The current version of MACCS is 3.10.0. A detailed chronicle of changes made to 
MACCS is distributed as along with MACCS in a document titled, “History of MACCS.” 
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1.2 WinMACCS Overview 
 
In 2001, the NRC initiated an effort to create a Windows-based interface and framework for 
performing consequence analyses. WinMACCS is developed for Windows operating systems. 
This effort was intended to address the following needs: 
 

 Simplify and make the effort required to create or modify input files more intuitive; 

 Reduce the likelihood of user errors in performing consequence analyses;  

 Enable the user to simply and conveniently account for uncertainties in input data; and  

 Displace the original batch framework with a Windows-based framework. 
 
The result of this development effort was the WinMACCS code. WinMACCS is currently 
integrated with versions of MACCS, COMIDA2, and LHS (Latin Hypercube Sampling) to 
perform all of the required functionality. The original MACCS2 batch framework is preserved; 
MACCS can still be run in stand-alone fashion apart from the WinMACCS interface. However, 
there are significant advantages for migrating to the WinMACCS framework for running 
consequence calculations.  
 

1.3 MACCS Framework 
 

 Software used to Develop WinMACCS 1.3.1
 
Components used to develop the WinMACCS software are described in the Reference Guide 
provided in Chapter 4. 
 

 WinMACCS Components 1.3.2
 
The components of WinMACCS are shown in Figure 1-1. WinMACCS allows one or more 
calculations to be run on a computer.  The user can modify model input variables and model 
settings and save them in the project database.  The user can initiate a WinMACCS 
deterministic simulation or a set of simulations to evaluate uncertainty from input parameters 
represented by probability distributions to reflect degree of belief. To do the latter, WinMACCS 
uses a code called LHS (Latin Hypercube Sampling) to generate vectors of sampled input 
variables to create a set of equally probable realizations. LHS, can use either of two sampling 
algorithms: simple random sampling (SRS) or Latin Hypercube Sampling, which is a type of 
stratified sampling. WinMACCS can also run three other codes: COMIDA2 to evaluate 
parameters affecting the food ingestion pathway, PopMod to change the number of sectors in a 
site file, and CombineSource to combine source terms for multiple units and/or spent fuel pools. 
These codes act as preprocessors for MACCS.  
 
WinMACCS can run LHS to generate values of the uncertain variables and builds the MACCS 
input files for each simulation. It runs MACCS multiple times, once for each realization. Multiple 
simulations can also be created using the cyclical file option. In this case, MACCS input can be 
modified using a set of input files that effectively act as change cards. One application of this 
feature is to run successive MACCS simulations using multiple source terms from MELCOR 
simulations. The interface utility, MelMACCS, can be used to create the input files containing 
the source-term data. This feature is called cyclical because it can be combined with sampling 
of uncertain input data and the input files are cycled if there are more simulations than input 
files. The user may view, export, and aggregate results of MACCS simulations in various 
formats, such as text, Microsoft Excel, JPEG, BMP, XML, and HTML.  
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Figure 1-1  WinMACCS components 

 
PopMod is required with site files generated with versions of SecPop prior to 4.0 to support 
MACCS grids with more than 16 compass sectors. The work of PopMod is primarily 
interpolation and reformatting.  No new information is added to the site data file that is created.  
 
Data files managed by WinMACCS include a set of auxiliary files, such as a site file, a 
meteorological file, one or more COMIDA2 binary file(s), and one or more DCF file(s). Input files 
are created by WinMACCS using the model and input settings stored in an underlying database. 
This input files can include Atmosn.inp, Earlyn.inp, Chroncn.inp, Comidan.inp, and Lhs.inp input 
files. Here, n is 1 or more and denotes the simulation number. Multiple simulations are 
performed when evaluating uncertainty and/or using the cyclical file option discussed in this 
document. Output files are created by MACCS and its preprocessors (e.g., LHS and 
COMIDA2). A set of MACCS output files, Modeln.out and Modeln.bin, are normally created for 
each simulation. Other files may or may not be created, depending on settings chosen by the 
user. 
 
An Access database file is created from a database template file, Initialize2000.mdb, when a 
new project is created. The project database is modified using the Microsoft DAO 3.6 library. 
The database contains the following information: 
 

 Default input values and model settings, 

 Input values and model settings specified by user, 

 Input variable descriptions and limits, 

 Information to construct input forms,  

 Information to construct input files, 

 LHS results, and 

 MACCS results read from binary files. 
 

 WinMACCS Project File Structure 1.3.3
 
A project folder contains the following files and subfolders: 
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A database file (e.g., myProject\myProject.mxd). This file is an Access 2010 database 
file. In addition to its settings, this file contains the parameter values used to build the 
MACCS input files when a simulation is run. 
 
Three subdirectories as follows:  
 

 myProject\Data\ contains user specified data files, such as the site file, the 
meteorological file, and the dose conversion factor file.   

 myProject\Input\ contains input files created by WinMACCS each time the user 
requests a MACCS simulation. 

 myProject\Output\ contains output files from MACCS and other executables run by 
WinMACCS.   

To move the location of the project, the user can simply move (or drag and drop) the folder 
myProject\, including its files and subdirectories, to a new location.   
 

 Parameters Tab 1.3.4
 
The parameters are organized in a tree structure to facilitate access. The highest level of the 
tree structure is called a main category, the second level is called a category, the third level is 
called a subcategory, fourth level is called a form and under a form are one or more parameters. 
In some cases there is an additional level called a sub subcategory that falls directly below a 
subcategory. The example in Figure 1-2, shows the main categories: GENERAL, ATMOS, 
EARLY, CHRONC, DOSE COEFFICIENTS, and COMIDA2. GENERAL contains categories 
named Properties, File Specifications, and Output Options. More information under each of the 
categories can be viewed if the + is clicked to display more detail. The convention used in this 
document is that italicized words are names or labels that appear in the WinMACCS interface.  
 
Within the ATMOS main category, the Radionuclide category has been completed, as indicated 
by the solid orange diamond next to the category name. The orange color of the symbol 
indicates that there is at least one form in this category that is optional. 
 
Within the ATMOS main category, the Deposition category detail is shown. The X-ed red 
octagon indicates that there is missing or inconsistent information in this category. The Wet/Dry 
Depos Flags and Wet Deposition forms have been completed consistently, as indicated by the 
solid green octagons. The Dry Deposition form needs attention, as indicated by the X-ed red 
octagon next to the form name. This form contains two variables: NPSGRP and VDEPOS. If the 
form name or the variables are double-clicked, the corresponding parameter modification form 
is opened. 
 
It is important to note that the symbols do not indicate whether input values are correct or 
incorrect; they only indicate whether they are consistent and within acceptable bounds imposed 
by WinMACCS. The user is responsible for entering and performing adequate quality 
assurance/control to verify that correct (or at least intended) values of input parameters are 
entered in the interface.  
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Figure 1-2  Parameters tab under the Project window 
 
Each entry in the tree shown in Figure 1-2 has a related icon. This icon reflects the state of the 
object. The objects and icons are as follows: 
 

 Input associated with a main category is represented by a lightning bolt icon. 

GENERAL, ATMOS, EARLY, CHRONC, DOSE COEFFICIENTS and COMIDA2 are the 
major categories. The GENERAL category contains the links to the model settings (for 
example, the weather sampling method) and the links to the auxiliary files to be used in 
a simulation. There are a number of categories within each module. These categories 
contain forms that are used to specify input parameters. An example of a category is 
Plume Specifications. 
 

Icons next to category names define the form states as follows: 
 

 An X-ed red octagon or X-ed orange diamond indicates that the user needs to  

 complete or correct this form before running MACCS. 

   A solid green octagon indicates that the user has correctly completed this form and that 
the data defined on this form are needed to perform a calculation. 

   A solid orange diamond indicates that the user has completed this optional form. The 
data defined on all forms with an orange diamond are used to perform a calculation. 
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   An empty orange diamond indicates that the user has not completed this optional form.  

  A solid X-ed orange diamond indicates that this optional form needs attention before 
running MACCS.  This can be done by opening, clearing the form, and clicking OK or by 
correcting it, in which case the data on this form will be conveyed to the appropriate MACCS 
input file.  

 A solid gray octagon with a diagonal line indicates that the user has completed this form, 
but the data are not needed under the current model choices. 

 An empty gray octagon with a diagonal line indicates that the user has not completed 
this form, but it is not required and can be ignored. 

 A black circle indicates a parameter that is contained on a form. The parameter names 
are listed to facilitate navigation of WinMACCS and are given the same names as the MACCS 
input variables. Double-clicking on a parameter object causes the related form to open with the 
focus at the selected parameter value. 

 

Double-clicking on a form or on a variable name associated with a form causes that form to 
open for editing. 
 
The Properties form found under the GENERAL main category and under the Properties 
category allows the user to modify model choices to be used in a subsequent MACCS 
calculation(s). Data entry on this form can modify the status of the categories and forms as 
indicated by the icons listed above. The user should generally start a new project or modify an 
existing project by making appropriate model choices under the Properties form. This defines 
the status of the categories and forms shown under the Project Parameters tab.  
 

 Files Tab 1.3.5
 
There are three file categories on the Files tab: Data, Input, and Output. The Data file category 
contains several file-type variables. Beneath the file-type variables are links to the files currently 
used or defined in the project. Each of the file categories corresponds to folders stored in the 
project folder.  
 
The structure emulates the folder structure displayed when the project is viewed in Windows 
Explorer as shown in Figure 1-3 with differences noted below in the detailed description of each 
of the three file categories. 
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Figure 1-3  Data folder as seen from Windows Explorer 
 
 

 Data Files 1.3.5.1
 
This file category called Data contains data files specified by the user under the General/File 
Specifications category on the Parameters tab of the Project window. Double-clicking on a file 
link opens the selected file in Notepad for editing. This allows the user to modify the file and 
save it. The modified file is used when MACCS is run. Files in the Data folder, as shown in 
Figure 1-3, other than those in File Specifications, are not shown in under the Data files 
category.  
 

 
 

Figure 1-4  Project data folder 
 
Not all of the files shown in Figure 1-4, are necessarily used when MACCS is run. Which files 
are used depends on the models that have been selected on the Properties form. For example, 
if Early Consequences is not selected under the Scope tab on the Properties form, the DCF file 
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is not needed for the simulation. This is indicated by the icon displayed next to Dose Conversion 
Factor File under the File Specifications category.  
 
The file links displayed in Figure 1-4 can be modified by double-clicking on the form or variable 
name under the GENERAL/File Specifications category, as shown in Figure 1-5. 
 

 
 

Figure 1-5  File specifications 
 

Model settings that determine which data files are needed for a calculation are controlled with 
the Project Properties form shown in Figure 1-6. 
 
Map files that are displayed behind a spatial grid also need to be placed in the Data folder.   
These files need to be in Graphics Interchange Format (.gif).   The .gif files are created for the 
spatial grid entered by the user in WinMACCS by a stand-alone executable called MapGen 
(Section 1.3.2).  MapGen reads an interface file containing information about the spatial grid 
written by WinMACCS and creates a set of map files from this interface file. (Using this 
capability currently requires the user to have Microsoft MapPoint installed on their computer.) 
While the map files need to be saved in the Data folder, they are not shown in the Files tab in 
the Project form.  Some forms use these maps as background to help the user determined 
evacuation model settings.  These forms are present in each of the EARLY/Emergency Cohort 
categories (e.g., EARLY/Emergency Cohort One).   
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Figure 1-6  Project properties form 
 

 
 Input Files 1.3.5.2

 
This category contains input files as shown in Figure 1-7 that are normally created by MACCS 
before running a MACCS simulation. If the main menu option, Execute→Refresh Template 
Input Files before Running is not checked, the template files atmosTemplate.txt, 
earlyTemplate.txt, chroncTemplate.txt, and comidaTemplate.txt are not recreated from the 
settings within WinMACCS before running a simulation. This feature allows the user to edit 
these files and run a simulation using the edited files.  This feature was created to allow users to 
modify the template files manually during the implementation of new features not yet supported 
by WinMACCS.  It is unusual to uncheck this menu option, but it could be useful in exceptional 
situations when the WinMACCS template file does not satisfy the user’s needs.  When any 
project is opened, regardless of the previous state of this menu option, this option is checked.  
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Figure 1-7 Input files 
 
All files in Project\Input\ are shown in the Project window.  Selecting main menu option 
File→Refresh File View causes the hard drive to be queried and refreshes the set of files shown 
in the Project window.  
 
WARNING: The Input folder is not a good place to store any files that the user wants to 

keep! The Data (Project\Data\) and root directories (Project\) are safe places 
to store files because they are never deleted by MACCS. The user can also 
create additional directories for archiving files under the Project\ folder. 

 
The following example reflects a run with a scope of Atmospheric Dispersion, Early 
Consequences, Late Consequences, and COMIDA2. In this example, some variables are 
sampled, the template files are created and two simulations are requested.  
 

Table 1-1  Files created in the input folder by WinMACCS during execution. 

Name of file 
Conditions when file 

Is created 
Description 

atmosTemplate.txt  File atmosTemplate.txt is used to create input 
files Atmos1.inp and Atmos2.inp. This file is 
used by WinMACCS 

earlyTemplate.txt EARLY module is 
selected under the 
Scope tab in the 
Properties form. 

File earlyTemplate.txt is used to create input 
files Early1.inp and Early2.inp. This file is used 
by WinMACCS. 

chroncTemplate.txt CHRONC module is 
selected under the 
Scope tab in the 
Properties form. 

File chroncTemplate.txt file is used to create 
input files Chronc1.inp and Chronc2.inp. This 
file is used by WinMACCS.  
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Name of file 
Conditions when file 

Is created 
Description 

Atmos1.inp 
Early1.inp 
Chronc1.inp 
Atmos2.inp 
Early2.inp 
Chronc2.inp 

Input files are created 
consistently with the 
model scope. For 
example, when the 
user has only 
specified Atmospheric 
Dispersion and Early 
Consequences on the 
Scope tab in the 
Properties form, 
Atmos1.inp, 
Atmos2.inp, 
Early1.inp, and 
Early2.inp are created 
using 
atmosTemplate.txt 
and 
earlyTemplate.txt. 
Chroncn.inp is not 
created. This example 
is for Late 
Consequences 
selected so that the 
Chronc files are 
created. 

Files are created using the template files in 
conjunction with data from LHS.out relevant to 
each simulation. If any of the variables are 
uncertain, this information is encoded in the 
relevant template file. The actual values used 
in simulation n correspond to realization n in 
the LHS.out file. These files are used by 
MACCS.  

LHS.inp Created whenever 
uncertain variables 
are defined. 

This file contains input to LHS that indicates 
the number of observations, probability 
distributions, variable names, and correlations 
between sampled parameters. 

Sipra.ini Created whenever 
uncertain variables 
are defined. 

This file contains LHS settings and is copied 
from Program Files\WinMACCS folder into the 
\Project\Input\ folder. It is read by LHS.  

LHS.out 
LHS.msg 

Created whenever 
uncertain variables 
are defined. 

These files are created by LHS.  LHS.msg is a 
detailed output file describing the run. LHS.out 
is used to create the input files  by WinMACCS 
for MACCS. 

comidaTemplate.txt Created when the 
Late Consequences 
option is selected on 
the Scope tab in the 
Properties form and 
the Create COMIDA2 
File option is selected 
on the Food tab in the 
Properties form. 

This file is similar to the other template files. It 
is used with LHS.out to create the three input 
files required by COMIDA2, namely 
Comidan.inp, Comidan.par, and Comidan.var, 
where n is the simulation number. 
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Name of file 
Conditions when file 

Is created 
Description 

Comida1.inp 
Comida2.inp 

Created when the 
Late Consequences 
option is selected on 
the Scope tab in the 
Properties form 
and the Create 
COMIDA2 File option 
is selected on the 
Food tab in the 
Properties form. 

This is a pair of one of three input files required 
by COMIDA2. 

Comida1.var 
Comida2.var 

Created when the 
Late Consequences 
option is selected on 
the Scope tab in the 
Properties form 
and the Create 
COMIDA2 File option 
is selected on the 
Food tab in the 
Properties form. 

This is a pair of one of three input files required 
by COMDIA2. It contains radionuclide data. 

Comida1.par 
Comida2.par 

Created when the 
Late Consequences 
option is selected on 
the Scope tab in the 
Properties form 
and the Create 
COMIDA2 File option 
is selected on the 
Food tab in the 
Properties form. 

This is a pair of one of three input files required 
by COMDIA2. It contains food-pathway data. 

 
When the Execute→Refresh Template Input Files before Running from the main menu is 
checked (the default setting): 

 All of the files in the Project\Input folder are deleted when Run is clicked on the Run 
formRun_Form. 

When the Execute→Refresh Template Input Files before Running from the main menu is 
unchecked: 

 All of the files in the Project\Input folder are deleted except for the files 
atmosTemplate.txt, earlyTemplate.txt, chroncTemplate.txt, and comidaInpTemplate.txt 
when Run is clicked on the Run form.  

 The option allows the template files to be manually edited before running MACCS. While 
this option would not normally be selected by a user, it could be helpful if there were new 
models in MACCS that are not yet supported by WinMACCS. 

If the user has checked the box labeled Delete Atmos, Early, Chronc and COMIDA2 Input Files 
on the Advanced Execution Parameters form, the input files that aren’t used as templates are 
deleted when the calculation is finished.  In the example above, this means that Atmos1.inp, 
Atmos2.inp, Early1.inp, Early2.inp, Chronc1.inp, Chronc2.inp, LHS.inp, Comida1.inp, 
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Comida2.inp, Comida1.par, Comida2.par, Comida1.var and Comida2.var are deleted.  
Normally, this box is checked.  The user would have this box unchecked if the MACCS input 
files were needed for some other process.    
 

 Output Files 1.3.5.3
 
This category contains output files created by MACCS and COMIDA2. 
 
The entries under the file category Output are file names found in the user’s project folder 
Project\Output\ excluding the binary MACCS result files, which end with a .bin extension.  They 
are created when Run is selected. Select main menu option File→Refresh File View to query 
the hard drive and refresh the file list. 
 
The Output folder is a convenient place to store files because they are listed in the file view of 
the project as shown in Figure 1-8.   
 

 
 

Figure 1-8  Output files 
 
WARNING: Do not name any files in the output folder Modeln.out, Modeln.bin, 

Comidan.cnc, Comidan.dmp, or Comidan.lst. These files are deleted from 
the Ouput folder each time a simulation is run. Likewise, never put any files 
in the Project\Input\ folder. These are all deleted each time a simulation is 
run. 

 
Double-clicking on a file opens it in Notepad. The following example shows a simulation with a 
scope including Atmospheric Dispersion, Early Consequences, and Late Consequences. 
Comida2 is run to create the .bin files used for Late Consequences. In the example shown in 
Table 1-2, two simulations are requested.  
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Table 1-2  Output files created by MACCS and COMIDA2. 

Name of file Description 

Model1.out 
Model2.out  

These are the text output files created by 
MACCS corresponding to each of the LHS 
samples. 

Model1.bin 
Model2.bin 

These are the binary result files created by 
MACCS corresponding to each of the LHS 
samples. These files are not shown on the 
Project\Output\ screen.   

Comida1.lst 
Comida2.lst 
Comida1.cnc 
Comida2.cnc 
Comida1.dmp 
Comida2.dmp 

These are output created by COMIDA2 for 
each of the LHS samples. 

 
If the user has checked the box labeled Delete MACCS and COMIDA2 Output Files on the 
Advanced Execution Parameters form, the text output files are deleted after each simulation.  
Normally, this box is unchecked as shown in Figure 1-9.  The user would have this box checked 
if it was not necessary to view the output results.  Results that are written to the binary file would 
still be available in the form of plots, summary.out and custom available reporting options. This 
is important if there are many simulations and it is important to conserve space on the hard 
drive. 
 
Similarly, if the user has checked the box labeled Delete MACCS and COMIDA2 Binary Result 
Files the binary result files are deleted after the reports have been created.  See 4.5.2 for more 
information.  Normally, this box is unchecked as shown in Figure 1-9.  WinMACCS imports the 
binary results into the project file (the .mxd file) after the simulations are complete.  Having this 
box checked causes these files to be deleted after the data are imported into WinMACCS.  This 
may be important for conserving space on the hard drive.   
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Figure 1-9  Advanced Execution Parameters 
 

 Results Window 1.3.6
 
The Results window is found at the bottom of the application window.  The Results window 
communicates progress, e.g., during MACCS execution.  
 
Text shown in Figure 1-10 can be selected and copied to the Windows clipboard by using the 
copy and paste functions available when right clicking the mouse. Alternatively, the user can 
use the control-C option to copy text from this window.  Normally, this would not be necessary.  
However, it may be useful if an error occurs and it is necessary to save or share the messages 
with another analyst. 
 

 
 

Figure 1-10  Sample results window 
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1.4 Main Menu Options 
 
Figure 1-11 shows the main menu options listed at the top of the MACCS application. 
 

 
 

Figure 1-11  Main menu 
 
 

The main menu contains the following drop-down menus: 
 

 File allows projects to be managed and MACCS files to be imported, along with several 
other functions. 

 Edit manages some screens, enables distributions for uncertain input parameters to be 
correlated, enables editing of some parameters, and allows the user to open all windows 
containing a specified parameter.  

 Execute allows the user to run calculations and to control choices related to those 
calculations.  

 PostProcessing controls the post-processing options, both graphical and tabular. 

 Window manages screens within WinMACCS. 

 Help provides information on the version of WinMACCS that is installed on the user’s 
computer.  

 
Chapter 2 describes each of these menu items in more detail. 
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2. GETTING STARTED  
 

2.1 Overview of User Interface 
 
When a project is opened using the File→Open Project command or a new project is created 
using the File→New Project command, Project and Results screens are also opened, as 
illustrated in Figure 2-1. The Project window is used to modify parameter values and view 
related project files.  
 

 
 

Figure 2-1  Project and results windows 
 
The caption at the top of the window indicates the file name and location of the project. In the 
example shown in Figure 2-1, the file C:\WinMACCS Samples\Tutorials\sample 1 is displayed. 
 
The main menu options are File, Edit, Execute, PostProcessing, Window, and Help. 
The Project window contains two tabs, the Parameters tab and the Files tab.   
 

 The Parameters tab contains a list of forms that are used to select model options, modify 
input parameters, and create file links.  

 The Files tab contains links to active files in the project folder displayed at the top of the 
window.  

The Results window displays the progress of a user initiated action, such as importing a file or 
running a simulation.  
 
A legend automatically opens with a project, as shown in Figure 2-2.  The legend defines the 
meaning of the icons shown next to the form names and categories in the Parameters tab of the 
Project window. 
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Figure 2-2  Legend 
 
The information displayed under the Parameters tab is organized as follows: 
 

 The top display level is called a main category, which include GENERAL, ATMOS, 
EARLY, CHRONC, DOSE COEFFIENTS, and COMIDA2. The icon used for main 
categories looks like a lightning bolt and they can contain categories, subcategories, and 
forms, as defined below.  

 The next level of organization below a main category is a category. For example, 
Radionuclides is a category under ATMOS. Several types of icons are used to represent 
categories, depending on whether they are required, not required, optional, defined, 
undefined, or have an error state. The icons corresponding to each possibility are 
displayed in the Legend window shown in Figure 2-2. 

 The next level below a category is either a subcategory. For example, Emergency 
Cohort 2 is a subcategory under Additional Emergency Cohorts, which is a category 
under EARLY. 

 The next level of organization below a subcategory is a form. The icons for forms are 
identical to those for categories and subcategories. For example, Basic Parameters is a 
form under Additional Emergency Cohorts.  

 Each form contains one or more parameters. Parameters are denoted by black dots. 

In some cases, forms are directly under categories or even main categories because the 
intermediate levels are not required.  
 

2.2 Modifying a Parameter Value 
 
A parameter can be modified by opening the form containing the parameter.  This is illustrated 
in Figure 2-3 for the parameters associated with wet deposition. 
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Figure 2-3  Modifying a parameter on a form 
 
Parameter values are changed by replacing the value on the form and clicking the OK button.  
The Make Uncertain button allows a probability distribution to be assigned to an uncertain 
variable for sampling in an uncertainty analysis. Clicking OK saves all changes and closes the 
form; Clicking Cancel retains the previous values and closes the form.  Clicking the pencil 
eraser button on the top right clears the form of all values and comments.  
 
The user is not allowed to save values by clicking OK unless all values have been defined and 
are within the bounds specified on the form.  For example, the limits on CWASH1 in Figure 2-3 
are from 0.0 to 1.0, inclusive of the end points. Resetting a form to the default state is 
accomplished by closing the form, right clicking on the form name, and selecting Reset to 
Default.  
 

2.3 Specifying and Viewing Files 
 
MACCS may require auxiliary files depending on the selections made in Project Properties.  For 
example, if one of the file-sampling options was selected on the Weather tab of Project 
Properties, the user must provide a meteorological data file. 
 
Under the GENERAL/File Specifications category, icons displayed next to the names indicate 
which files are required. Figure 2-4 shows an example in which the Meteorological File and 
Dose Conversion Factor File are required. The dose conversion factor file has been defined 
previously, as is indicated by the solid green octagon, but the user has not yet defined a 
meteorological data file, as is indicated by the red, X-ed octagon. The undefined status for this 
file is addressed by opening this form, clicking the Browse button, and selecting the desired file. 
The selected file is copied to the project’s data folder, ProjectName/Data, where ProjectName is 
the name of the project.  This copy is used for subsequent MACCS calculations. 
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Figure 2-4  File specifications 
 
Selecting a site file works the same way as selecting a meteorological data file. The Site File 
form contains extra functionality to allow the creation of a more finely gridded site file from an 
existing, more coarsely gridded one. This function is described in a subsequent chapter.   
 
The Annual Differential DCF Files, Annual Differential COMIDA2 Files, and Cyclical File Set are 
organized to allow selection of a set of files. Copies of the files are used for a calculation, and 
these copies are placed in the ProjectName/Data folder. 
 
Once a file has been selected, it can be viewed and edited via the Files tab.  The Data, Input, 
and Output categories on the File tab correspond to files stored in the project folders named 
Data\, Input\, and Output\.  Any of these files can be viewed and edited in Notepad by double 
clicking on the file name.  The files in the Input\ and Output\ folders are automatically generated 
when a simulation is run.  
 

2.4 Filling out a Map Form 
 
Some forms in the interface display a polar grid.  These are used to specify evacuation 
directions if the network evacuation model is enabled or speed multipliers if the speed multiplier 
option is enabled on the Project Properties form, Evac/Rotation tab, or to specify what 
population group is designated to that grid element.   
 
Detailed instructions are provided in Chapter 4.  The following notes, however, can help the 
user get started with these forms: 
 

 Evacuation directions are initially set to be radially outward and the speed multiplier is 
set to one.  The evacuation direction in each grid element is shown as an arrow.  The 
speed multiplier is identified by an integer.  

 Speed multipliers are modified on the forms named Radial Evacuation Speed and 
Network Evacuation Speed, depending on which model is selected on the Properties 
form.  Evacuation directions are modified on the form named Network Evacuation 
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Direction.  There is one of these forms for each cohort. Both speeds and directions are 
shown on all of these forms, but only one of them can be changed from that form.  

 Speed multipliers are added by clicking on the button Modify Multipliers. 

 There are several ways to change evacuation directions on this screen. The simplest is 
to click on one of the grid elements, which causes the arrow to rotate clockwise to the 
next direction. Directions can also be changed on the Network Evacuation Direction form 
by selecting multiple radii and/or sectors, and applying a direction to the selected portion 
of the map.  The direction is selected by clicking on an entry in the table labeled 
Direction; the multiple radii and sectors are selected from the lists labeled Radius and 
Sector. Clicking the Assign button applies the direction to the selected area(s). Multiple 
radii and sectors can be selected by holding down either the shift or the control key for 
contiguous or noncontiguous selections, respectively.  Similar options are available on 
the Radial Evacuation Speed and Network Evacuation Speed forms. 

 The SaveMap button saves a copy of the evacuation map with the grid background as 
either a jpeg or Windows bit map file.  This allows maps to be easily imported into other 
applications and documents. 

 The sliders labeled Inner Ring Shown and Outer Ring Shown allow the user to zoom in 
and out and to eliminate detail at the center of the map. 

 In WinMACCS versions 3.9.0 and newer, the maps forms can be resized by grabbing 
the corner/edge of the map and dragging it to the desired size.  

2.5 Running a Simulation 
 
Select Execute→Run Models from the main menu.  
 
The MACCS modules to be used,  Atmospheric Dispersion, Early Consequences, and Late 
Consequences, can be selected or deselected from the Scope tab. The Create COMIDA2 File 
setting can be chosen from the Food tab. 
 
Clicking the Run Simulation button initiates a simulation. If there are any input inconsistencies 
detected by winMACCS, forms open automatically to allow values to be corrected.  However, 
not all input inconsistencies are caught at this stage.  Some input problems are detected when 
MACCS is run.  Errors generated at this step are described into the Results window. 
 
The simulation progress can be observed in the command-prompt window (Results Window) 
from which MACCS is initiated. The window is minimized by default, but can be opened by the 
user. 
 
When the simulation has completed, the command window closes and a message conveying 
successful completion is written to the Results window.  At this point, results can be viewed as 
follows: 
 

 Double-clicking on Output/Model1.out found under the Files tab of the Project window to 
open the results file in Notepad. 

 Select Post Processing/Graphical Result/Results Over All Weather Trials to view a 
CCDF over weather trials. 
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 If sampling was used (variables were set to be uncertain and multiple realizations were 
run), the option Post Processing/Create Custom Report can be used to combine results.  
The quantiles reported can be modified on the form GENERAL/Reporting Options. 

 If sampling was used, the option Post Processing/Graphical Result/Statistical Summary 
Results can be used to display the distributions of the results. 

2.6 Running MACCS from a command line 
 
A MACCS run can be generated by using command line parameters. The following parameters 
can be specified on the MACCS.exe command line in any order. 
 

-a  ATMOS input file and path  

-e  EARLY input file and path 

-c  CHRONC input file and path 

-m  meteorological data file and path 

-s  site file and path 

-o  output file and path.  The prefix portion of the output file name is also used to 
name the binary output file.  For example, if the output file is named model1.out, 
the binary file created by MACCS is named model1.bin.  

-i  file containing names of MACCS input files.  This is the path and name of a file 
containing the ATMOS, EARLY, CHRONC, meteorological, site and output file 
names and paths, one file name per line in that order.  If any of these files have 
been specified on the command line using the -a,   -e, -c, -m, -s, or -o parameter, 
this file is not used for any of the file names.  If this -i option is not used and the 
files are not specified on the command line, the file names are expected to be in 
a file named MACCS.tmp located in the same folder as MACCS.exe.  If a file is 
not needed for a calculation, the line must contain a dummy name or blank field 
defined by two consecutive double quotes. 

 The following example shows the contents of a sample MACCS.tmp file.  Only 
the Atmos model is to be executed.  The EARLY, CHRONC, and site files are not 
needed and file names do not need to be specified.  A meteorological data file, 
Metsur.inp, is to be used.  MACCS creates the output files Model1.out and 
Model1.bin.  

C:\WinMACCSSamp\inb\Input\Atmos1.inp 
"" 
"" 
C:\WinMACCSSamp\inb\Data\Metsur.inp 
"" 
C:\WinMACCSSamp\inb\Output\Model1.out 

 
-p  is a prefix used in naming the status files. If this isn’t specified, the status files are 

named MaxStat.log and FortErr.log by default.  If it is specified, the names of the 
two status files are prefixed with the string following this flag.  For example, 
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“MACCS.exe -p MyRun” would create status files MyRunMaxStat.log and 
MyRunFortErr.log.  These files are placed in the same folder as the output file 
specified with the -o parameter.  If the -i option was used to specify the file 
names (instead of the -a, -e, -c, -m, -s and -o parameters), the status files are 
placed in the same folder as the output file specified using the -i option.  If neither 
of these options were used, the status files are placed in the same folder as the 
MACCS executable file, MACCS.exe.  

 The status file, MaxStat.log, contains a single line with the string ‘OK’ if the 
MACCS execution was successful.  If the execution was not successful, this file 
contains a line with the string ‘NO’.  If MACCS detected an error and exited, the 
line containing the string ‘NO’ is followed by a MACCS generated error message. 

 The FORTRAN error file, FortErr.log, is created only if MACCS aborts 
abnormally.  It contains trace-back information and system level error messages.  
If this file exists before MACCS crashes, the error messages are appended to the 
end of the file rather than overwriting the previous contents. 

When at least one of the command line parameters, -a, -e, -c, -m, -s, or -o, is present, the 
MACCS.tmp file is not used to define the names and paths of the required files.  In this case all 
of the files used by MACCS must be specified on the command line.  
 
The following example shows a case in which all files are specified on the command line. 

C:\Program Files\WinMACCS> MACCS.exe  -a C:\inb\Input\Atmos1.inp -m 
C:\inb\Data\Metsur.inp -o C:\inb\Output\Model1.out 

 
The following example shows a case in which a file is used to specify the names of MACCS 
files.  The file specifying the names is Maccs.tmp.  Error files are named inbMaxStat.log and 
inbFortErr.log.  These files are placed in the folder C:\inb\. 
 C:\ Program Files\WinMACCS> MACCS.exe -i C:\inb\Maccs.tmp –p inb 
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3. USERS GUIDE 
 
All WinMACCS model choices and parameters are specified through the Parameters tab on the 
Project window. The main categories are GENERAL, ATMOS, EARLY, CHRONC, DOSE 
COEFFICIENTS, and COMIDA2.  
 

3.1 GENERAL Main Categories  
 
The GENERAL main category consists of Properties, File Specifications, and Reporting 
Options.   
 
The hierarchical structure in WinMACCS can be expanded or contracted by clicking on the + or 
– next to items on the parameters tab, respectively. For example, clicking on the + to the right of 
the GENERAL main category reveals three categories that belong to this main category. 
Clicking on the + to the left of the Properties category expands it, revealing the two forms that it 
contains. Finally, clicking on the + to the left of the Properties form reveals the set of parameters 
that it contains. 
 

 Properties 3.1.1
 
The Properties form is opened by double-clicking on General/Properties/Properties from the 
Parameters tab in the Project window, as illustrated in Figure 3-1.  
 

 
 

Figure 3-1  Accessing Properties form 
 
A window opens that shows the scope of the calculation and related model settings, as shown 
in Figure 3-2.  Depending on the selections made, input parameters may be or may not be 
required.  Details describing the available models are included in the User’s Guide portion of 
this document. 
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Figure 3-2  Project Properties Form 
 
The following describes how modifying the scope of the calculation affects the forms that are 
required. 
 

1. Creating a new project by selecting File→New from the main menu causes Project 

Properties to open after the new project is created with default settings.  Notice that 

Atmospheric Dispersion (corresponding to the ATMOS Main Category in the Parameters 

tab) is always selected and cannot be modified, as indicated by the light gray color of this 

item.  Early Consequences (corresponding to the EARLY Main Category) and Late 

Consequences (corresponding to the CHRONC Main Category) are not checked by 

default. 

2. Clicking on the plus sign next to the ATMOS, EARLY, and CHRONC main categories on 

the Parameters tab causes additional subcategories to become visible, as illustrated in 

Figure 3-3.   All of the categories under EARLY and CHRONC are empty grey circles with 

a single slash.  This means that the parameters on these forms are not defined but are 

not required in order to run a simulation given the model choices on the Properties form.  

3. Clicking the check box next to the Early Consequences label and clicking the button 

labeled Show Required Forms shows that some categories in the EARLY main category 

now require attention.  These categories have icons consisting of an X-ed red octagon.  If 

the OK button is clicked in Properties, the scope of the calculation changes to include 

early health effects. 

4. Repeating the process by adding Late Consequences to the scope causes an additional 

group of categories to require attention. 
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5. Each of the selected main categories (ATMOS, EARLY, CHRONC) contains a form 

called Property Form Parameters.  Next to each of these names is a solid green icon, 

indicating that this form requires no attention.  Opening these by double-clicking on the 

word Property Form Parameters under each of the main categories allows a user to see 

the variable values that are defined on the Project Properties form.    

 
 

Figure 3-3  Form icons 
 

 
Figure 3-4 shows the form for EARLY. The values on these forms correspond to model settings 
in Project Properties.  These values can be modified by changing settings in Project Properties 
(under the GENERAL  main category) but cannot be changed from the Property Form 
Parameters form, as indicated by the light gray backgrounds.   
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The settings on the other Project Properties tabs function in a similar way.   
 
When the Show Required Forms is clicked on the Project Properties form, WinMACCS modifies 
the icons next to each category to indicate the ones that would be required if the change is 
selected by clicking OK.   
 

 
 

Figure 3-4  Read-only variables on property form under the EARLY main category 
 
Scope Tab 
 
MACCS uses variables ENDAT1 and ENDAT2 to determine whether the simulation should run 
ATMOS; ATMOS and EARLY; or ATMOS, EARLY, and CHRONC.  The Scope tab in Figure 3-5 
determines the value of these variables.  ENDAT1 is set to False if the EARLY model is to be 
run.  ENDAT2 is set to False if the CHRONC model is to be run. The option to invoke the 
MACCS Cyclical File Set does not correspond to any MACCS parameters; this option is 
handled within the WinMACCS interface.  
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Figure 3-5  Scope Tab on the Project Properties Form 
 
The Atmospheric Dispersion (ATMOS) box is always checked.   
 
Checking the Early Consequences Module (EARLY) box means: 

 A dose conversion factor file needs to be assigned under the File Specifications 
category on the Parameters tab of the Project window.  

 Entries on other tabs, namely Site Data, Dose, Evac/Rotation, Wind Rose, and Early 
Effects determine which other EARLY input variables are required. 

 
Checking the Late Consequences module (CHRONC) means: 

 Early Consequences are automatically checked. The CHRONC module cannot be run 
without the EARLY module. 

 Entries on the Food tab determine which additional CHRONC input variables are 
required. 

 
Checking the MACCS Cyclical File Set means: 

 A cyclical file set needs to be assigned under the File Specifications category on the 
Parameters tab of the Project window. The function of this model choice is described in 
a subsequent section.  

 OK saves changes made under any tab and closes the form. Show Required Forms 
shows how changes affect the form states on the Parameters tab window and the tab 
states in Project Properties without saving the changes.  

 Cancel closes the form without saving any changes. 
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Dispersion Tab 
The contents of the Dispersion tab are shown in Figure 3-6. The user must either select power 
law functions or lookup tables to define the dispersion parameters.  
 
Selecting the Power Law Functions means: 

 Power law function parameters are required. They must be defined in the Dispersion 
Function form found in the ATMOS/Dispersion category in the Parameters tab.  

 WinMACCS sets NUM_DIST to be zero when building input images for MACCS. 
 
Selecting Lookup Tables means: 

 Lookup table parameters are required. These must be defined in the Dispersion Table 
form found in the ATMOS/Dispersion category in the Parameters tab.   

 WinMACCS sets NUM_DIST to be the value defined on the Dispersion Table form when 
building input images for MACCS. 
 
 

 
 

Figure 3-6 Dispersion tab on the Project Properties form 
 
Switch to Time-Based Dispersion Model at User-Specified Distance: 

 If checked, WinMACCS sets the variable DISPMD to the value LRTIME. Parameters on 
the Long-Range Time Based Parameters form found in the ATMOS/Dispersion category 
in the Parameters tab are required. Dispersion parameters are functions of time rather 
than distance beyond a user-specified distance. 

 If not checked, DISPMD is set to the value LRDIST.  The value LRDIST causes MACCS 
to use the original model in which dispersion parameters are functions of distance. 
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There are three choices for the plume meander model.  MACCS uses a variable, MNDMOD, to 
determine which plume meander model to use. The corresponding value of MNDMOD is shown 
parenthetically on the right of each entry. 
 
Selecting Original MACCS means: 

 The plume meander model is the original one in MACCS 1.12. This model accounts for 
the effect of the duration of release. 

 The ATMOS/Plume Specifications/Original Meander form is required. 
 
Selecting US NRC Regulatory Guide 1.145 means: 

 The Regulatory Guide 1.145 plume meander model is used. This model assumes one-
hour duration plume segments. It accounts for the effects of stability class and wind 
speed on plume meander. It should not be used when plume segment durations are 
substantially different than one hour, especially when they are less than one hour, 
because this violates the assumptions of the model.  

 Parameters on the form ATMOS/Plume Specifications/US NRC Reg. Guide 1.145 
Meander are required.  

 
Selecting None means:  

 There are no required parameters.   

 The plume meander model is turned off.   
 

Weather Tab 
The contents of the Weather tab are shown in Figure 3-7. 
 

 
 

Figure 3-7  Weather tab on the Project Properties form 
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MACCS uses a variable, METCOD, to specify which weather sampling option to use. The 
corresponding value of METCOD is shown on the right of each entry.   
 
Constant Weather means inputs on the following ATMOS/Weather category forms on the 
Parameters tab are required: 

 Constant or Boundary Conditions  

 Fixed Start Time Data 
 
User Supplies 120 Weather Points means that the following inputs found on the 
ATMOS/Weather category on the Parameters tab are required: 

 Constant or Boundary Conditions 

 Fixed Start Time Data 

 User-Supplied Weather 

 Boundary Limit  
 
The fixed start time is required for these options to determine the time the accident occurs 
during the growing season in connection with food ingestion modeling. These inputs are 
required even if food ingestion is not being treated, but can be set to dummy values. 
 
The other weather sampling options require specifying a meteorological data file. The 
meteorological data file supports 15-minute, 30-minute, and one-hour intervals. Only the 
traditional hourly weather data are supported with the User Supplies 120 Weather Points 
(METCOD=3) option. 
 
If Weather File Specified is selected, a meteorological data file is required and needs to be 
assigned under the File Specifications category. Also, a sampling method must be chosen.  The 
input data requirements for the weather sampling options are described in the subsequent 
paragraphs. 
 
Fixed Start Time means that the following ATMOS/Weather category forms under the 
Parameters tab inputs are required: 

 Constant or Boundary Conditions 

 Fixed Start Time Data 

 Boundary Limit 
 
Uniform Bin Sampling means the following ATMOS/Weather category forms under the 
Parameters tab are required: 

 Constant or Boundary Conditions 

 Samples per Bin 

 Seed 

 Boundary Limit 

 Rain Distances 

 Rain Intensities 
 
Nonuniform Bin Sampling means the following ATMOS/Weather category forms under the 
Parameters tab are required: 

 Constant or Boundary Conditions 

 Seed 

 Boundary Limit 

 Bins 

 Rain Distances 

 Rain Intensities 
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Stratified Random Sampling means the following ATMOS/Weather category forms under the 
Parameters tab are required: 

 Constant or Boundary Conditions 

 Samples per Day 

 Seed 

 Boundary Limit 
 
If the Weather File Specified is selected, an optional, mixing-height model can be chosen.  
MACCS uses a variable, MAXHGT, to determine which mixing height model to use. 
 
Adjust Mixing Height Based on Time of Day means: 

 WinMACCS sets the variable MAXHGT to the value DAY_AND_NIGHT.  

 Parameters in Site Location found on the ATMOS/Weather category are required.   

 Both daytime and nighttime values of the mixing heights in the meteorological data file 
are used.  

 If not checked, MAXHGT is set to the value DAY_ONLY.  This causes MACCS to use 
the model in MACCS 1.12, which uses only the maximum seasonal values that normally 
correspond to daytime values. 
 

Plume/Source Tab 
The contents of the Plume/Source tab are shown in Figure 3-8. 
  

 
 

Figure 3-8  Plume/Source Tab on the Project Properties form 
 
Choosing Power Model means:  

 The original MACCS model is used.  
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 Heat rate input for each plume segment must be specified in ATMOS/Release 
Description/Heat. 
 

Choosing Density and Flow Model means:  

 Mass flow rate and mass density are required for each plume segment. These are 
defined in ATMOS/Release Description/Density and Flow. 

 
Choosing Original MACCS 1.12 Briggs Model means: 

 WinMACCS sets the variable BRGSMD to the value ORIGINAL. The original Briggs 
model is used to simulate plume rise. The default and recommended model is the 
improved one. 

 If not checked, BRGSMD is set to the value IMPROVED. This causes MACCS to use 
the improved plume rise model. 

 
Choosing Multi Source Term means: 

 MACCS allows the user to use multiple source term definitions, possibly from different 
.ptf files, to define the overall source term for an accident.   

 The user specifies these files under File Specifications and needs to fill out additional 
forms in the ATMOS main category.   

 
Site Data Tab 
The contents of the Site Data tab are shown in Figure 3-9. This tab is required if Early 
Consequences are selected on the Scope tab. MACCS uses a variable, POPFLG, to define the 
source of the site data.  
 

 
 

Figure 3-9  Site Data tab on the Project Properties form 
 
Choosing Import from File means:  

 A site file is required and needs to be chosen under the File Specifications category 
under the Parameters tab. This file can be created by a preprocessor, e.g., SecPop, to 
generate a file containing census and economic data for the chosen site. A sample site 
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file, FicticiousSite.inp, is included in the WinMACCS installation.  WinMACCS allows the 
user to increase the angular resolution of a site file, and this feature has been integrated 
into the site file specification form.   

 WinMACCS sets the variable POPFLG to the value FILE. 
 
Choosing Uniform means:  

 Population density data are required and are specified in Population Data form found 
under the EARLY/Model Basis category. 

 MACCS sets the variable POPFLG to the value UNIFORM. 

 The SUMPOP option is unavailable under Results Weighting Factor. 
 
Results Weighting Factor determines the way multiple-cohort results are combined. 
Except when SUMPOP is selected, the weighting factor used for each of the cohorts is 
assigned by the variable WTFRAC found under the EARLY/Emergency Cohort N/Basic 
Parameters forms, where N is the cohort number. 
 

 If SUMPOP is selected, the site file must include a separate population distribution for 
each evacuation scenario. This option enables cohorts to be defined in a very general 
fashion.  

 If TIME is selected, the weighting factor under each Basic Parameters form refers to 
fraction of time.   

 If PEOPLE is selected, the weighting factor under each Basic Parameters form refers to 
fraction of people.  

 
MACCS uses a variable, WTNAME, to determine the cohort weighting method.  This is set to 
SUMPOP, TIME, or PEOPLE, depending on the choice on this form. 
 
If Import from File is chosen and the Results Weighting Factor is set to be equal to SUMPOP, 
the user must specify the source of the site file by choosing one of two options as follows. 
 
Choosing Predefined Site File means: 

 The user is required to link an existing site file to the project using the Site File form in 
the GENERAL/File Specifications category on the Parameters tab.  This site file should 
have a POPULATIONn section defined for each evacuation cohort or MACCS will fail. 
The n a number corresponding to the cohort number. 

 
Choosing Create from Existing Site File means: 

 The user is required to link an existing site file to the project using the Site File form in 
the GENERAL/File Specifications category on the Parameters tab.  The number of 
POPULATION sections in this file is not relevant.   In other words, a site file previously 
created with or without the SUMPOP option is acceptable.  Most commonly, the site file 
is created using SecPop. 

 Additional forms in the EARLY category Population by Cohort is required.   
 
After a site file is linked, the total population can be viewed on the Population from Site File form 
found in the EARLY/Model Basis category within the Parameters tab. 
 
Dose Tab 
Choices under the Dose tab must be made if the Early Consequences option is selected under 
the Scope tab. The contents of the Dose tab are shown in Figure 3-10. 
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MACCS supports Federal Guidance Reports (FGRs) 11 and 12 dose coefficient files created by 
a preprocessor program, FGRDCF, files created from Federal Guidance Report 13, and dose 
conversion files created by DOSFAC2. DOSFAC2 bases its dose conversion factors on 
DOE/EH-0070 (1988).  Changing the type of dose conversion factor file has the effect of 
changing the allowed organ types on a number of forms and the user is required to modify these 
forms.   
 

 
 

Figure 3-10  Dose tab on the Project Properties form 
 
Choosing Federal Guidance Report (FGR-11 and -12) Dose Conversion Factor File (FGRDCF) 
means: 

 Early injury and early fatality results are not available. These selections, Early Fatality 
Effects and Early Injury Effects, are grayed out on the Early Effects tab of the Project 
Properties form. 

 Data on the related forms, Early Fatality Parameters and Early Injury Parameters, are 
not used. 

 Outputs requested on the Early Fatality Radius form in the Early/Output Control category 
are not available. 

 The Annual Threshold and Piecewise Linear dose-response models are not available on 
the Dose tab. Only the Linear No Threshold dose-response model is available. 

 
Choosing File Created by DOSFAC2 means: 

 If the Late Consequences option is selected on the Scope tab, the Annual Threshold and 
Piecewise Linear dose-response models are available. 

 The form Organs of Risk DOSFAC2 is required.   
 
Choosing File Created from FGR-13 means: 

 If the Late Consequences option is selected on the Scope tab, the Annual Threshold and 
Piecewise Linear dose models are available. 
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 The form Organs of Risk FGR-13 is required.   
 
The user has three dose-response models to choose from.  MACCS uses a variable, DOSMOD, 
to specify which dose-response model is to be used. 
 
Choosing Linear No Threshold means:  

 The linear no-threshold dose-response model (the only option in earlier versions of 
MACCS) is used to calculate latent health effects.  (MACCS continues to support a 
linear-quadratic dose response model under this option, although it has fallen into 
disuse.)  

 DOSMOD is set to LNT 
 
Choosing Annual Threshold means: 

 The EARLY/Dose Model/Annual Threshold form is required. 

 The EARLY/Dose Model/Lifetime Threshold is optional. 

 DOSMOD is set to AT. 
 
Choosing Piecewise Linear means: 

 The EARLY/Dose Model/Piecewise Linear form is required.  

 DOSMOD is set to PL. 
 
Choosing either Annual Threshold or Piecewise Linear means: 

 If the Activate KI Model box is checked, the EARLY/Emergency Cohort N/KI Ingestion 
Threshold or Piecewise form must be filled out instead of the EARLY/Emergency Cohort 
N/KI Ingestion Linear No Threshold form. In this case, only the values 0 or 1 are valid for 
POPFRAC on the KI Ingestion form.  

 On the Food tab the options User supplies COMIDA2 file or No Food Model must be 
chosen. 

 Files must be specified under the GENERAL/File Specifications/Annual Differential DCF 
Files and, if the COMIDA2 food option is selected, GENERAL/File Specifications/Annual 
Differential COMIDA2 Files forms.   

 
MACCS uses a variable named KIMODL to determine whether the KI model is to be used.  If 
the check box Activate KI Model is checked, this variable is set to KI.  Otherwise, this variable is 
set to NOKI. 
 
Choosing Predefined DCF File means: 

 The user is required to link an existing DCF file to the project using the Dose Conversion 
Factor File in the GENERAL/File Specifications category on the Parameters tab. 

 If the user has chosen Predefined COMIDA2 File on the Food tab, the COMIDA2 file 
chosen must have been created using the same DCF file that is specified. 

 
Choosing Create DCF File means: 

 The user is required to link an existing DCF file to the project using the Dose Conversion 
Factor File in the GENERAL/File Specifications category on the Parameters tab.  This 
file will be used to extract the list of available radionuclides.  The default DCF values will 
be the values defined in this file. 

 The COMIDA2 Food Model is unavailable, even though it appears to be enabled in the 
WinMACCS interface. 

 After the DCF file is linked to the project, the user can select radionuclides and define 
both deterministic and uncertain DCF values using forms in the category DOSE 
COEFFICIENTS within the Parameters tab. 
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Evac/Rotation Tab 
Information under this tab is required when the Early Consequences module is selected.  The 
Evac/Rotation tab is broken up into three main areas: problem model, number of cohorts, and 
model activation, as shown in Figure 3-11.  First, the user must choose the type of evacuation to 
use. The choices are Radial, Network, and None. Choosing Radial causes evacuees to move 
radially outward from each grid element to the next.  Network evacuation models evacuation 
from a grid element to any of the four adjacent grid elements.  Finally, None specifies that no 
evacuation occurs.   
 
The next action is to specify whether the Speed Multiplier Model and/or Keyhole Evacuation 
Model is active.  Finally, the user specifies the number of cohorts represented in the problem.  
WinMACCS supports up to 20 cohorts. All scenarios correspond to EARLY change sets in the 
MACCS input files.  MACCS uses a variable, EVATYP, to determine the evacuation model for 
each cohort. The choices for the evacuation model are is automatically designated once you 
choose one of the three options, Radial, Network or None. The selection in the Problem Model 
box applies to all cohorts.   
 

 
 

Figure 3-11  Evac/Rotation Tab on the Project Properties form  
 
Choosing None under Problem Model means: 

 The only option for the evacuation type field for all evacuation cohorts is None. 

 The Activate Speed Multiplier Model check box cannot be activated on this form. 

 The Activate Keyhole Evacuation Model check box cannot be activated on this form. 
 
Choosing Radial means:  

 The options for the evacuation Type field for all evacuation cohorts are None and 
Circular. Keyhole is available if the Activate Keyhole Evacuation Model check box is 
checked. 
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 The options for the evacuation type for all evacuation cohorts must be entered.  The first 
Cohort must be assigned the type Circular or Keyhole to allow Circular or Keyhole to be 
assigned for subsequent cohorts. 

 
Choosing Network means:  

 The options for the evacuation Type field for all evacuation cohorts are None and 
Circular. Keyhole is available if the Activate Keyhole Evacuation Model check box is 
checked. 

 The options for the evacuation type for all evacuation cohorts must be entered.  The first 
Cohort must be assigned the type Circular or Keyhole to allow Circular or Keyhole to be 
assigned for subsequent cohorts. 

 The field Wind Shift and Rotation must be set to Wind Shift without Rotation. 
 
Choosing Activate Speed Multiplier Model Means:  

 If the Network evacuation option has been selected, the evacuation speed can be 
adjusted by grid element on the Network Evacuation Speed form.  

 If the Radial evacuation option has been selected, the evacuation speed can be adjusted 
by grid element on the Radial Evacuation Speed form. 

 
The user must choose the method for plume segment modeling. MACCS uses a variable, 
IPLUME, to specify the option that is used. The corresponding value of IPLUME is shown to the 
right of the drop-down box, as shown in Figure 3-11.  
 
Choosing No Wind Shift with Rotation means:  

 All subsequent plume segments travel in the same direction as the initial plume 
segment. 

 When weather bin sampling is selected, a set of results is constructed for each weather 
trial by considering that the wind might have blown toward each compass direction. This 
is equivalent to rotating the results for the weather trial around the compass, one 
compass sector at a time. This process creates an expanded set of results for each 
weather trial. The total number of results generated by this process is the number of 
compass sectors times the number of weather trials. Probabilities for each of the rotated 
results are calculated by using the wind rose for the corresponding weather bin or using 
a user-defined wind rose, depending on the wind rose option selected by the user (see 
below). 

 
Choosing Wind Shift with Rotation means:  

 Each plume segment moves in the direction that the wind is blowing at the time of its 
release. Thus, each plume segment is allowed to travel in its own direction. 

 When weather bin sampling is selected, each weather pattern is rotated around the 
compass, creating a set of results equal to the number of compass sectors times the 
number of weather trials. The probability of each result is calculated using the wind rose 
for the weather bin or the user defined values for the wind rose, depending on the wind 
rose option selected by the user (see below). The wind-rose probability is assigned 
based on the direction taken by the first plume segment.  

 
Wind Shift with Rotation is based on the assumption that specific weather patterns (i.e., time 
dependence of wind directions) can occur in all wind directions and that the likelihood only 
depends on the wind rose probability of the initial wind direction. For example, the conditional 
probability of the second plume segment traveling southeast given that the first segment 
traveled east is the same as same as the conditional probability of the second plume segment 
traveling northwest given that the first segment traveled west. This option has been used in past 
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analyses, such as NUREG-1150, where only a few plume segments were used to represent the 
source term. More recent analyses commonly use more than a few plume segments to 
represent the source term. However, the more plume segments that are used in an analysis, the 
less likely this assumption is to be valid. As a result, this option should be avoided when more 
than a few plume segments are used.  
 
Choosing Wind Shift without Rotation means:  

 Each plume segment moves in the direction that the wind is blowing at the time of its 
release. Thus, each plume segment is allowed to travel in its own direction. 

 Only the set of wind directions indicated in the meteorological file is used; no wind 
rotation is performed. Thus, only a single result is generated per weather trial.  

 
Wind Shift without Rotation produces the most realistic results and is recommended for most 
analyses when more than a single plume segment is used. The drawback is that more weather 
trials may be required to achieve adequate weather statistics than are required using Wind Shift 
with Rotation.  
 
When more than one cohort is specified, the user must enter the evacuation Type for each 
cohort by filling in the grid, as illustrated in Figure 3-12. 
 

 
 

Figure 3-12  Specifying cohort evacuation types 
 
Wind Rose Tab 
This Wind Rose tab in Figure 3-13 is required if the Early Consequences module is selected.   
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Figure 3-13  Wind Rose tab on the Project Properties form 
 
The corresponding value of the MACCS variable OVRRID is shown to the right of each entry.     
 
Choosing User Supplied means:  

 Wind rose probabilities are required. These are defined on the Wind Rose Probabilities 
form found on the EARLY/Model Basis in the Parameters tab.  

 User defined wind rose probabilities are used in place of values taken from the weather 
file. 

 
Choosing Default means:  

 Wind rose probabilities for each weather sampling bin constructed from the 
meteorological data file are used if one of the bin sampling options is selected.  

 Wind rose data are only used by MACCS when one of the Wind Rotation options and 
one of the weather binning options are selected.  
 

Early Effects Tab 
This Early Effects tab shown in Figure 3-14 is required if the Early Consequences module is 
selected.  
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Figure 3-14  Early effects on the Project Properties form 
 
This form allows the user to select the health effects to be calculated. If an FGRDCF dose 
conversion factor file is specified, early fatality and injury results are not available. 
 
Checking the box next to Early Fatality Effects means:  

 Early fatality parameters must be defined on the Early Fatality Parameters form.   

 The fatalities defined can be included in the output requests on the Health-Effect Cases 
form (type 1), Early Fatality Radius form (type 2), Average Individual Risk form (type 4), 
Centerline Risk form (type 7), and Population-Weighted Risk form (type 8).  Early fatality 
results are unavailable when this box is not checked.  

 The user must choose a dose conversion factor file type that supports early health 
effects.  

 
Checking the box next to Early Injury Effects means:  

 Early injury parameters must be defined on the Early Injury Parameters form.   

 The injuries defined can be included in the output requests on the Health-Effect Cases 
form (type 1), Average Individual Risk form (type 4), Centerline Risk form (type 7) and 
Population-Weighted Risk form (type 8).  Early injury results are unavailable when this 
box is not checked. 

 The user must choose a dose conversion factor file type that supports early health 
effects. 
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Checking the box next to Latent Cancer Effects from Early Exposure means:  

 Latent cancer parameters must be defined on the forms found under the Latent Cancer 
Parameters category, namely those on the Latent Cancer Parameters and Latent 
Cancer Thresholds forms. 

 The latent cancer results can be included in the output requests on the Health-Effect 
Cases form (type 1), Average Individual Risk form (type 4), Centerline Risk form (type 7) 
and Population-Weighted Risk form (type 8). Latent cancer results are unavailable when 
this box is not checked. 
 

Food Tab 
The Food tab in Figure 3-15 is required when Long-Term Consequences was selected on the 
Scope tab.  
 

 
 

Figure 3-15  Food tab on the Project Properties form 
 
MACCS uses a variable, FDPATH, to determine which food model to use.  
 
Checking the radio button next to No Food Model means:  

 FDPATH is set to OFF. 

 No food-chain doses are calculated. 

 Economic consequences are disabled.  
 
Checking the radio button next to MACCS Food Model means:  

 The original MACCS food-chain model is used.  

 The Annual Threshold and Piecewise Linear dose-response models are not available. 
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 FDPATH is set to OLD. 

 MACCS uses variable NTTRM to indicate the number of crop weathering terms used 
when the MACCS food model is used.  The value of NTTRM is chosen on this tab. 

 A set of forms under CHRONC/Food-Chain are required.  
 
Predefined COMIDA2 File: 

 The COMIDA2 food chain model is used.  

 The Annual Threshold and Piecewise Linear dose-response models are available on the 
Dose tab. If either of these models is chosen, a set of binary files created by the 
preprocessor COMIDA2 and the corresponding dose conversion factor files used to 
create those binary COMIDA2 files must be linked to the project. 

 If the Linear No Threshold (LNT) dose-response model is chosen on the Dose tab, a 
single COMIDA2 binary file must be linked to the project. The dose conversion factor file 
must be the same one used to create the COMIDA2 binary file. 

 FDPATH is set to NEW. 
 
Create COMIDA2 File: 

 The Annual Threshold and Piecewise Linear dose-response models are not available, 
even though they appear to be available in the WinMACCS interface.  

 One or more COMIDA2 binary files are created when a simulation is run, depending on 
whether the run is deterministic or uncertain.  Values are specified under the COMIDA2 
main category on the Parameters tab.  

 

 Problem Description Form 3.1.2
 
WinMACCS provides a number of options for documenting a project by adding comments and 
other description fields.  One of the options is to enter a general project description on the 
General/Properties/Problem Description form. 
 
Comments entered anywhere within WinMACCS are echoed in the MACCS input files. MACCS 
echoes the comments in the input files to the output file, so comments are traceable throughout 
the calculation process. 
 

 File Specifications Category 3.1.3
 
Model settings that determine the types of files required are chosen on the Project Properties 
form. The set of files are shown as required under the File Specifications category. In the 
example shown in Figure 3-16, the meteorological, site, dose conversion factor, and COMIDA2 
files are required, as indicated by the icons to the left of the forms.   
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Figure 3-16  Specifying files 
 
The following Table 3-1 describes the types of files that may be required, the conditions under 
which they are required, the tab within the Properties form that controls the requirement, and 
some sample files that are included with WinMACCS to illustrate the contents and format of the 
file.  The interface uses icons just to the left of the form names to indicate which auxiliary files 
are required, depending on the project properties settings selected by the user. 
 

Table 3-1  Auxiliary files used by WinMACCS. 

Name of form 
Related Project 
Properties tab  

Conditions when form(s) is 
(are) required 

Files from sample 
problems 

Meteorological 
File 

Weather Radio button next to Weather File 
Specified is selected.  

westernsite_04.inp 
metsurMxHt_60min.inp 

Site File Scope and Site 
Data 

EARLY Consequences is selected 
on Scope tab. Import from File is 
selected on Dose tab. 

FicticiousSite.inp 
 

Dose 
Conversion 
Factor File 

Scope and Dose EARLY Consequences is selected 
on Scope tab.  
Linear No Threshold is selected 
on the Dose tab. 

DosData20Organs.inp 
DOSD825.inp Fgr13dcf.inp 
Pu72.inp 

Annual 
Differential DCF 
Files 

Scope, Dose, 
and Food 

Late Consequences is selected 
on Scope tab.  
Annual Threshold or Piecewise 
Linear dose model is selected on 
Dose tab. 
Predefined DCF File is selected 
on Dose tab. 
Either the No Food Model or the 
Predefined COMIDA2 File is 
selected on the Food tab. 

dosdata20organs.inp 
dosdata20organs01.inp 
… 
dosdata20organs50.inp 
Fgr13dcf.inp 
Fgr13dcf01.inp 
… 
Fgr13dcf50.inp 
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Name of form 
Related Project 
Properties tab  

Conditions when form(s) is 
(are) required 

Files from sample 
problems 

COMIDA2 File Scope and Food Late Consequences is selected 
on Scope tab.  
Linear No Threshold is selected 
on the Dose tab. 
Predefined COMIDA2 File is 
selected on the Food tab.  
COMIDA2 file needs to have been 
created using the Dose 
Conversion Factor File specified. 

samp_a20organs.inp 
samp_d.bin 
Fgr13samp_a.bin 

Annual 
Differential 
COMIDA2 Files  

Scope, Dose, 
and Food 

Late Consequences is selected 
on Scope tab.  
Annual Threshold or Piecewise 
Linear dose model is selected on 
Dose tab. 
Predefined DCF File is selected 
on Dose tab. 
Predefined COMIDA2 File is 
selected on the Food tab. 

samp_a20organs.inp 
samp_a20organs01.inp 
… 
samp_a20organs50.inp 
fgr13samp_a.bin 
fgr13samp_a01.bin 
… 
fgr13samp_a50.bin 

Cyclical File Set Scope MACCS Cyclical File Set is 
selected.  

Case 2, 1MW.txt 
Case 3, 5MW.txt 
Case 4, 10MW.txt 
Case 5, 1MW, 
Entr.+Wake.txt 
Case 6, 5MW, 
Entr.+Wake.txt 
Case 7, 10MW, 
Entr.+Wake.txt 

Multi Source 
Term File Set 

Plume/Source Multi Source Term option is 
selected. 

 

 
Meteorological File Form 
A meteorological data file is required when the user selects Weather File Specified on the 
Weather tab.  WinMACCS allows the user to select any file, but a file should be selected that 
conforms to the format described in the appendix, Meteorological File Format.  The range of 
allowable wind directions in the meteorological file is determined by the value of the MACCS 
variable NUMCOR, the number of sectors in the spatial grid.   
 

Variable Name Definable Type Dimensions Allowed Values 

Meteorological 
File 

Yes Text File None Any file.  File is not 
validated by 
WinMACCS. 

 
Site File Form 
A site file is required when the user selects EARLY CONSEQUENCES on the Scope tab and 
selects the Import From File on the Site Data tab.  NUMCOR is the number of sectors in the 
spatial grid.  Site files created by older versions of SecPop or used in earlier versions of MACCS 
have 16 sectors in the spatial grid.  Changing the value of NUMCOR is accomplished by clicking 
the button labeled Create New. The user can browse to an existing site file and create a new 
site file with a modified value of NUMCOR. The latest version of SecPop supports up to 64 
sectors and should be used to create site files with more than 16 compass sectors.  
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The site file is a text file containing site specific information. This file is normally created using 
SecPop, but may be created by a different process as long as it has the required format.   See 
section 4.4.8 for more information. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUMCOR Click Create 
New… to 
change value 

Integer None 16, 32, 48, and 64 

Site File Yes Text File None Site data file.  It is 
typically created by 
SecPop. It is partially 
validated by 
WinMACCS.  

 
Dose Conversion Factor File Form 
A dose conversion factor (DCF) file is required when the user selects Early Consequences on 
the Scope tab and has selected Linear No Threshold on the Dose tab.  A DCF File is an ASCII 
file containing dose conversion factors.  DCF files are provided that were created using 
preprocessors DOSFAC2 and FGRDCF.  Files based on FGR-13 are also provided with the 
WinMACCS installation. 
 

Variable Name Definable Type Dimensions Allowed Values 

DCF File Yes Text File None The format is defined 
in an appendix. 

 
Annual Differential DCF Files Form 
A set of DCF files are required when the user selects Late Consequences on the Scope tab and 
has selected Annual Threshold or Piecewise Linear on the Dose tab.  Annual Differential DCF 
Files are a set of fifty-one DCF files provided with the WinMACCS installation.  These consist of 
a parent DCF file and a set of 50 annual DCF files, for which the 50-year dose commitment 
period is broken up into single years. Only the parent DCF file needs to be selected by the user; 
the set of annual files, with standardized nomenclature, are automatically included when the 
parent is selected. See section 4.4.5 for more information. 
 

Variable Name Definable Type Dimensions Allowed Values 

Annual 
Differential DCF 
File Set 

Yes Text Files 51 File sets are 
provided. 
WinMACCS does not 
validate the files.  

 
COMIDA2 File Form 
This is required when the user selects Late Consequences on the Scope tab, selects Linear No 
Threshold on the Dose tab, and selects User Supplies COMIDA2 File on the Food tab. The 
COMIDA2 File is a binary file created by the COMIDA2 preprocessor.  COMIDA2 requires a 
DCF file as part of its input.  This DCF file must be the same as the DCF file specified in the 
section above.   
 

Variable Name Definable Type Dimensions Allowed Values 

COMIDA2 File Yes Binary File None Any file.  It is not 
validated by 
WinMACCS. 
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Annual Differential COMIDA2 Files Form 
This is required if the user selects Late Consequences on the Scope tab, has selected Annual 
Threshold or Piecewise Linear on the Dose tab and has selected User Supplies COMIDA2 File 
on the Food tab.  Annual Differential COMIDA2 File Set is a set of fifty-one COMIDA2 binary 
files provided with the WinMACCS installation.   
 

Variable Name Definable Type Dimensions Allowed Values 

Annual 
Differential 
COMIDA2 File 
Set 

Yes Binary 
Files 

51 File set are 
provided. 
WinMACCS does 
not validate the files. 

 
Cyclical File Set Form 
A set of cyclical files is required if the user selects MACCS Cyclical File Set on the Scope tab.  
A MACCS Cyclical File Set is a set of files in MACCS input format.  
 

Variable Name Definable Type Dimensions Allowed Values 

MACCS Cyclical 
File Set 

Yes Text File >=1 MACCS input file 
format. Files are 
read by WinMACCS.  

 
Multi Source Term File Set Form 
Using this option requires selecting Multi Source Term option on the Properties form, and 
selecting the multi-source term files created using MelMACCS or some other method.  A 
software program, CombineSource, is integrated into WinMACCS and processes the set of 
multi-source term files specified and creates two output files. One output file, 
CombineSource.wmc, contains information that is directly imported into WinMACCS.   The other 
file, CombineSource.out, contains information that is read by MACCS.   
 

Variable Name Definable Type Dimensions Allowed Values 

Multi Source 
Term File Set 

Yes Text Files >=1 MelMACCS output 
file format 

 

 Output Options 3.1.4
 
Reporting Options Form 
Results are calculated by WinMACCS for each quantile level on this form. If variables have the 
Report option activated in the output request forms, results are automatically generated after 
model execution.  The reported values are interpolated from the binned CCDF tables in the 
MACCS binary file.  The quantile levels are also used when creating custom reports that 
combine results over simulations.  See section 4.6.2.3 for more information. 
 

Variable Name Definable Type Dimensions Allowed Values 

Probabilities Yes Real >= 1 0.0 to 1.0 

 
Output Units Form 
Each time MACCS runs, an output file and a binary file is created containing results.  The units 
used in this report and in the binary results can be modified for predetermined result types.   
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Variable Name Definable Type Dimensions Allowed Values 

Activity Units Yes Character None {Bq, Ci} 

Distance Units Yes Character None {km, mi} 

Area Units Yes Character None {ha, km**2, mi**2} 

Dose Units Yes Character None {rem, Sv} 

 
 

3.2 ATMOS Input and Model Description 
 

 Overview of ATMOS 3.2.1
 
ATMOS performs all of the calculations pertaining to atmospheric transport, dispersion, and 
deposition, as well as the radioactive decay that occurs prior to release and while the material is 
in the atmosphere.  (Following calculation of deposition or transport within the problem domain, 
radioactive decay and dose modeling are performed by the EARLY and CHRONC modules of 
MACCS.) The specification of the release characteristics designating a “source term” can 
consist of up to 500 plume segments.  ATMOS models the transport of these plume segments 
considering time-varying meteorological conditions.  Treatment of uncertain meteorological 
conditions, referred to as weather sampling, is supported using various sampling options.  If 
weather sampling is used, results are reported as statistical summaries and optionally as binned 
cumulative distributions.   This is done independently of uncertain variables designated in the 
WinMACCS interface. 
 
The radioactive materials released are modeled as being dispersed while being transported by 
the prevailing wind.  During transport, whether or not there is precipitation, deposition of 
particles onto the ground can be modeled. In addition to the air and ground concentrations, 
ATMOS determines plume arrival and departure times and plume dimensions.  
 
ATMOS results are used by the EARLY and CHRONC modules.  Therefore, at a minimum, a 
MACCS calculation must include the ATMOS module.  In other words, calculations of early or 
latent health effects of a radioactive release are dependent on dispersion and deposition results 
provided by ATMOS. 
 
MACCS allows multiple source terms to be specified in the ATMOS input using a method called 
change records.  Change records allow the user to specify new values for previously defined 
source-term variables.  When these are encountered, the code's calculations are rerun based 
on the new values for variables defined in the set of change records and new output is 
generated for each specified source term and emergency response scenario.  
 
WinMACCS does not support this feature of ATMOS, although a similar feature in EARLY that 
allows the specification of multiple emergency response cohorts is supported.  Results for 
multiple source term are treated by WinMACCS through multiple MACCS runs using the 
MACCS Cyclical File Set option found on the Scope tab. 
 
A relatively new feature of MACCS is to treat releases from multiple units and/or spent fuel 
pools that occur in a sequential or overlapping fashion. These releases can have different 
isotopic inventories, different accident initiation and reactor shutdown times, and different 
release fractions. MACCS calculates the combined effects of the multiple releases.  
 



3-26 

 Basic Parameters 3.2.2
 
Atmos Description Form 
Atmos Description contains one variable, which is a short description of the calculation. This 
description is printed in the output file. It is required input for all MACCS calculations. 
 

Variable Name Definable Type Dimensions Allowed Values 

ATNAM1 Yes Character None 1 to 80 characters 

 
A more detailed description of the calculation can be entered on the Problem Description form 
under the GENERAL/Properties category. 
 
Property Form Parameters Form 
Property Form Parameters verify how selections in the Properties form define some important 
variables that are required in the ATMOS input to MACCS.  The variables are read-only and 
cannot be changed from this form.   
 
ENDAT1 terminates the calculation after running ATMOS when set to True. Likewise, ENDAT2 
terminates the calculation after running EARLY when set to True. ATMOS, EARLY, and 
CHRONC are run in sequence when both flags are set to False. 
 
DISPMD is the crosswind dispersion model flag.  The value is set to LRTIME for the long-range, 
time-based option, in which case dispersion is calculated as a function of time.  The value is set 
to LRDIST for the long-range, distance-based option, in which dispersion is calculated as a 
function of downwind distance. The distance-based model is the original MACCS2 1.12 
dispersion model.  
 
MNDMOD defines the algorithm used to calculate plume meander.  If set to OLD, the plume 
meander factor is a function of release duration only.  If set to NEW, plume meander factor 
depends on wind speed and stability class, but not on the duration of release. This model is 
consistent with NUREG/CR-2260 and US NRC Regulatory Guide 1.145.  If MNDMOD is chosen 
to be NEW, the plume segments should be approximately one hour in duration.  OFF means no 
plume meander is treated.   
 
METCOD determines what meteorological data are used and how weather sampling is 
performed. When the value is set to one, two, or five, a meteorological data file is needed to 
supply the meteorological data. 
 

1. A value of one allows the user to choose a single starting point in the file, defined by a 

day and period of the day.  A single weather trial is performed using this time as a 

starting point.   

2. A value of two corresponds to weather-bin sampling from the meteorological data file.  

3. A value of three is used for user-supplied hourly data for 120 hours. 

4. A value of four is used for user-supplied, constant weather. 

5. A value of five corresponds to stratified, random sampling from the meteorological data 

file.     

MAXHGT determines whether only the daytime or both the daytime and nighttime mixing 
heights are to be used in the calculation. When DAY_AND_NIGHT is selected, the Site Location 
form is required. The required mixing heights are specified in the meteorological data file.  
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BRGSMD is the plume-rise model flag. IMPROVED is the recommended value. This 
recommendation is based on comparisons of several empirical models with results from the 
National Institute of Standards and Technology (NIST) ALOFT-FT code. ALOFT-FT solves the 
fundamental equations that govern the rise of hot gases into the atmosphere. ORIGINAL is the 
original MACCS 1.12 Briggs plume rise model.  See 3.2.8.1 for more details. 
 
MSMODL is the Multi Source Term model flag. When set to True, the Multi Source Term Files 
Set form is required, and MACCS will calculate the combined effects of the multiple releases 
defined in these files.  When set to False, the source term is input in the WinMACCS interface. 
 

Variable 
Name 

Definable Type Dimensions Allowed Values 
Tab where defined 
on Properties form 

ENDAT1 Read-Only Logical None True, False Scope tab  

ENDAT2 Read-Only Logical None True, False Scope tab  

DISPMD Read-Only Character None LRDIST, LRTIME Dispersion tab  

MNDMOD Read-Only Character None OLD, NEW, OFF Dispersion tab  

METCOD Read-Only Integer None 1 to 5 Weather tab  

MAXHGT Read-Only Character None DAY_ONLY, 
DAY_AND_NIGHT 

Weather tab  

BRGSMD Read-Only Character None ORIGINAL, 
IMPROVED 

Plume/Source tab  

MSMODL Read-Only Logical None True, False Plume/Source tab 

 
Spatial Grid Form 

The region potentially affected by a release is represented by polar coordinates, ),( r .  The 

radius, r, represents distance from the release point, which is always at r = 0.  The angle, θ, is 
the angle measured clockwise from north.  The user must specify a set of radial endpoints, i.e., 
the outer radii for the grid elements.  Up to 35 of these radii may be defined, extending out to a 
maximum distance of 9999 km.  The number of angular divisions, or compass sectors, used to 
define the spatial grid are allowed to be 16, 32, 48, or 64.  If the spatial grid is divided into 16 
sectors, each sector is 22.5˚ wide.  In all cases the sectors are equally spaced. The first sector 
is always centered on north.  
 
NUMCOR is the number of sectors in the spatial grid.  If a site file is used, it must be consistent 
with the number of sectors in the grid. 
 
NUMRAD is the number of radial spatial intervals. The value of this parameter is automatically 
determined in WinMACCS by the number of entries in vector SPAEND. The number of radial 
intervals and the radial locations must be consistent with the site file, if one is used. 
 
SPAEND defines the radial boundaries in the spatial grid.  If a site data file is being used, these 
values are optionally updated when the site file is selected.  This update ensures consistency 
between the site file and the MACCS input. The first radius must be at least 0.05 km. The 
minimum spacing between adjacent radii is 0.1 km. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUMCOR Yes Integer None 16, 32, 48, 64 

NUMRAD Linked Integer None 2 to 35 

SPAEND Yes Real NUMRAD 0.05 to 9999.0  
Spacing ≥ 0.1 km 
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 Radionuclides 3.2.3
 
This section defines the radionuclide classes and the radionuclides that are modeled.  The 
radioactive decay data (half-life and decay chains) are provided to MACCS by the file 
INDEXR.DAT, which is from the Radiation Shielding Information Center as part of the FGR-
DOSE/DLC-167 data package.  This file is part of the WinMACCS installation.   
 

 Radionuclide Descriptions 3.2.3.1
 
Radionuclide names are case sensitive.  Names of chemical elements follow the usual 
convention that the first letter is capitalized; second letters are lower case. The element names 
are followed by a hyphen and the atomic mass of the radionuclide to define the radionuclide 
name.   
 
Each decay chain is limited to a maximum of six generations.  Each decay chain is independent 
of the others.  The MACCS output file lists the chains that are being used in the calculations.   
 
Decay chains can be terminated in two ways. They are automatically terminated when the 
decay product is a stable isotope. In some cases, it is desirable to terminate a decay chain with 
a decay product that is not stable. This is commonly done when the decay product has a very 
long half-life or contributes very little to the overall dose. Terminating a decay chain in this way 
is done by adding the radionuclide to the pseudostable isotope list. 
 
For example, Cs-135 is formed by beta-decay of Xe-135. It decays to Ba-135 from low-energy 
beta decay with a half-life of 2.3x106 years. Because of the long half-life and low energy beta 
produced by its decay, it has little effect on doses and is often included as a decay-chain 
terminator in MACCS calculations by including it as a pseudo-stable isotope. 
 
In some older calculations, decay products were added implicitly by adding the dose conversion 
factors for the progeny to the parent and including the progeny in the list of pseudostable 
radionuclides. This simplification was done to reduce memory and CPU requirements. It works 
when the half-life for the progeny is much shorter than the one for the parent so that the 
progeny decays almost immediately once the parent decays. This practice somewhat disguises 
the set of radionuclides that are being treated in a problem and reduces flexibility. Since 
computer memory is at much less at a premium now than when MACCS was initially developed, 
this practice of implicitly including progeny in a calculation is now discouraged.  
 
If an input error occurs because an unstable decay product is omitted, MACCS exits with an 
error message that lists the isotope or isotopes that are missing. The missing decay products 
must either be added to the radionuclide list or to the pseudostable isotope list. A radionuclide 
cannot be included on both lists. When one or more decay chain branches exist, the decay 
products in all of the active branches must be included in one of the two lists. 
 

 Radionuclides Forms and Parameters 3.2.3.2
 
Chemical Names Form 
The Chemical Names form is required when Multi Source Term is not selected on the 
Plume/Source tab. Each radionuclide is assigned to a radionuclide class, which has an 
associated chemical name.  Traditionally, the term radionuclide class has been used in 
MELCOR applications to identify a set of chemically similar elements that are assumed to 
behave identically within the radionuclide module of MELCOR. For example, all noble gases are 
generally assigned to the Xe class. In MACCS, the dry deposition characteristics and release 
fractions are assigned by radionuclide group, where group is equivalent to class.  Thus, all 
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isotopes assigned to a radionuclide group are assumed to act similarly in terms of release 
fraction and deposition behavior. The user is required to assign a name for each radionuclide 
group, which is used as a label in the forms for RELFRC, DRYDEP, and WETDEP. The 
Chemical Names form is required for all WinMACCS calculations. 
 
MAXGRP is the number of radionuclide groups. The value is linked to the number of entries in 
the vector GRPNAM. 
 
GRPNAM is vector of character strings used to identify each of the radionuclide classes. This 
variable is used for labeling within WinMACCS and also appears as a comment in the ATMOS 
input file created by WinMACCS. 
 

Variable Name Definable Type Dimensions Allowed Values 

MAXGRP Linked Integer None 1 to 150 

GRPNAM Yes Character MAXGRP 1 to 15 characters 

 
Radionuclides Form 
The Radionuclides form is required when Multi Source Term is not selected on the 
Plume/Source tab.  
 
The radionuclides form specifies the number of radionuclides treated in the WinMACCS 
calculation, the names of the radionuclides, the core inventory of each of the radionuclides, and 
the radionuclide group to which each one is assigned. The names of the radionuclides must 
correspond to those in the dose conversion factor (DCF) (ICRP now uses the term dose 
coefficient in place of dose conversion factor) file associated with the WinMACCS project. This 
form is required for all WinMACCS calculations. 
 
Three types of DCF files are distributed with WinMACCS. The oldest of these was created by 
the program DOSFAC2. This file, named dosdata20organs.inp, contains 60 radionuclides. It 
includes DCFs for estimating acute and latent health effects. In addition to the 60 radionuclides, 
11 decay products are implicitly included in this DCF file. This is done by summing the DCFs for 
the parent and progeny. This simplification was done to reduce CPU time and is appropriate 
when the progeny’s half-life is very short compared with the parent’s half-life. All implicit decay 
products must be included on the pseudostable isotope list. 
 
The two other types of DCF files are based on FGR-11, -12, and -13. The DCFs for the external 
pathways are common to both and are from FGR-12. DCFs for the internal pathways are from 
FGR-11 in one case and from FGR-13 in the other case. Both of these files contain extensive 
lists of radionuclides (825); however, treatment of implicit progeny is different in the two files. 
The older file, based on FGR-11 and -12, includes a number of implicit progeny, e.g., Ba-137m 
is included with Cs-137. Thus, Ba-137m should not be treated directly using this file or it would 
be double counted. On the other hand, the newer DCF file based on FGR-12 and -13 does not 
include any implicit progeny, so both Cs-137 and Ba-137m must be explicitly included. This 
allows more flexibility in the treatment of decay products. For example, with the older DCF file, a 
calculation could include either Cs-137 or Ba-137m in the inventory. Including both would lead 
to double counting most of the Ba-137m dose. The newer DCF file allows either Cs-137, Ba-
137m, or both to be included in the inventory. The newer file also includes DCFs for estimating 
both acute and latent health effects; the older file only includes DCFs for latent health effects. 
 
NUMISO defines the number of radionuclides. It is linked to the number of entries in the 
NUCNAM vector. 
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NUCNAM is a vector of radionuclide names. Each radionuclide name must be in the decay-
chain definition file, INDEXR.DAT, as well as the DCF file used in the calculation.  
 
CORINV defines the inventory of each radionuclide in the facility at the time of reactor 
shutdown.  The unit, Bq, or Becquerel, is equivalent to disintegrations/second.  This inventory 
can be scaled by modifying variable CORSCA found on form ATMOS/Release 
Description/Inventory Scale Factor. 
 
IGROUP identifies the radionuclide group to which the radionuclide is assigned.  The 
radionuclides should be grouped according to their physical/chemical properties.  All members 
of a radionuclide group have the same deposition characteristics and release fractions. The 
assignment into radionuclide groups or classes is often taken from MELCOR, especially if the 
source term was calculated using MELCOR.  
 

Variable Name Definable Type Dimensions Allowed Values 

NUMISO Linked Integer None 1 to 150 

NUCNAM Yes Character NUMISO 3 to 8 characters 

CORINV Yes Real NUMISO 0 to 1×1025 Bq 

IGROUP Yes Integer NUMISO 1 to MAXGRP 

 
Pseudostable Radionuclides Form 
The Pseudostable Radionuclides form is available when Multi Source Term is not selected on 
the Plume/Source tab. The Pseudostable Radionuclides form is optional, although it is almost 
always used in practice. This form specifies the name and number of pseudostable 
radionuclides, as described above.  
 
NUMSTB is the number of pseudostable radionuclides. The value is determined by the number 
of entries in vector NAMSTB. 
 
NAMSTB contains a set of decay-chain terminators. Each radionuclide must also be present in 
the decay-chain definition file, INDEXR.DAT.  These entries and their decay products are 
excluded from dose calculations.  Radionuclide names cannot appear in both NUCNAM and 
NAMSTB. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUMSTB Linked Integer None 1 to 150 

NAMSTB Yes Character NUMSTB 3 to 8 characters 

 

 Deposition 3.2.4
 

 Deposition Model Description 3.2.4.1
 
The wet deposition model predicts how much material is deposited on the ground by rainfall.  
Wet deposition is treated as a function of both rain duration and rain intensity.  The fraction of 
aerosols that remains suspended after wet deposition is calculated from the following equation 
(Brink and Vogt, 1981): 
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Where  

1C
 = linear washout coefficient, corresponding to MACCS input variable, CWASH1  

rt  = duration or precipitation (s) 

rI
 = intensity of precipitation (mm/hr) 

0I
 = unit rain intensity, 1 mm/hr 

2C
 = exponential washout coefficient, corresponding to MACCS input variable, 

CWASH2 

Dry deposition is modeled using the source depletion method.  This method makes use of the 
simplifying assumption that deposition onto the ground does not significantly affect the air 
concentration near the ground. That is, removal by deposition is much slower than dispersion in 
the air. This assumption allows the plume to be treated as Gaussian when deposition occurs. 
This is generally an excellent assumption because turbulent advection is generally on the order 
of 0.5 m/s while deposition velocities are typically a few cm/s or less. 
 
The concentration of monodisperse aerosols at a location on the ground is the product of the 
integrated ground-level air concentration there times the deposition velocity.  In the general 
case, multiple aerosol sizes each with a different deposition velocity, the ground concentration is 
the sum over the set of aerosol sizes of the products of the time integrated air concentrations 
and the deposition velocities.  
 
The material in each radionuclide group can be distributed among several particle-size groups 
(up to 20), with each radionuclide group having a different distribution of activity among the 
particle-size groups.  The particle-size distribution of each radionuclide group is specified in the 
release description data.  Because each particle size can deposit at a different rate, both the 
size distribution and the relative amounts of radionuclide groups can vary with downwind 
distance. For example, consider a release containing noble gases, which do not deposit 
(deposition velocity is zero) and iodine, which does deposit. As a result, the ratio of noble gases 
to iodine increases with downwind distance because iodine deposits while the noble gases do 
not. Further, consider that the iodine is represented by two aerosol bins, each with its own 
deposition velocity. The fraction in the bin that deposits faster is depleted more rapidly than the 
other bin as the plume travels downwind. Thus, both the chemical composition and size 
distribution of the plume change with time and distance. 
 

 Deposition Forms and Parameters 3.2.4.2
 
Wet/Dry Depos Flags 
The Wet/Dry Depos Flags form is required.  DRYDEP is defined for each of the radionuclide 
groups.  This flag indicates whether the radionuclide group is subject to dry deposition. Setting 
the flag to False ensures that the deposition velocity is zero for this radionuclide class. 
WETDEP is also defined for each of the radionuclide groups.  This flag indicates whether the 
radionuclide class is subject to wet deposition. 
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Variable Name Definable Type Dimensions Allowed Values 

DRYDEP Yes Logical MAXGRP True, False 

WETDEP Yes Logical MAXGRP True, False 

 
The radionuclide group representing the noble gases, which do not form aerosols and are highly 
inert, is generally assigned deposition flags of False for both wet and dry deposition. Other 
radionuclide groups are generally assigned deposition flags of True for both wet and dry 
deposition.  
 
Wet Deposition 
CWASH1 is the linear coefficient in the washout function shown in Equation (1). 
 
CWASH2 is the exponential coefficient in the washout function shown in Equation (1). 
 

Variable Name Definable Type Dimensions Allowed Values 

CWASH1 Yes Real None 0.0 to 1.0 

CWASH2 Yes Real None 0.0 to 1.0 

 
Dry Deposition 
NPSGRP is the number of particle size groups, determined by the number of entries in vector 
VDEPOS. 
 
VDEPOS is the set of dry deposition velocities corresponding to the set of particle size groups. 
 

Variable Name Definable Type Dimensions Allowed Values 

NPSGRP Linked Integer None 1 to 20 

VDEPOS Yes Real NPSGRP 0.0 to 10.0 m/s 

 

 Dispersion 3.2.5
 

 Dispersion Model Description 3.2.5.1
 
The Gaussian plume model of atmospheric dispersion uses spatially dependent dispersion 

parameters, y and z.  These can be supplied in two different ways: as power-law functions or 
in the form of a lookup-table.  The choice of which of the two models to use is made using the 
Dispersion tab on the Properties form.  
 
Dispersion Function Parameters 

The MACCS power-law functions for y and z have the form: 
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Where 

yi  = lateral dispersion parameter for stability class, i, representing the standard 

deviation of a Gaussian distribution (m) 
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zi  = vertical dispersion parameter for stability class, i, representing the standard 

deviation of a Gaussian distribution (m) 

x     = downwind distance (m) 

ai,bi = linear and exponential coefficients in the power-law expressions for crosswind 

dispersion. Subscript, i, represents stability class. Units are m and 
dimensionless, respectively. 

ci,di  = linear and exponential coefficients in the power-law expressions for vertical 

dispersion. Subscript, i, represents stability class. Units are m and 
dimensionless, respectively. 

x
0    

 = unit of length, 1 m 

The user should ensure that the categorization scheme used to define the stability classes for 
the meteorology is consistent with the values of the dispersion coefficients.  
 
Lookup-Table Parameters 
The lookup-table option allows the user to define a lookup table in place of the power-law 

functions for y and z.  This code option uses an interpolation algorithm that avoids the 
numerical instabilities observed with cubic spline fits.  The calculational approach uses a 
Hermite cubic approach from Kahaner, Moler, and Nash (1989).  This lookup-table algorithm 
can be used to implement alternative dispersion parameterizations or to use fits to site-specific 
tracer data. 
 

This feature was implemented to allow the use of parameterizations other than simple power 
laws (e.g., the Briggs formulas).  Also, if tracer experiments are available for a site, it is possible 

to process such data into tables of horizontal and vertical standard deviations (y and z). A 
caution to the user is that the algorithms associated with the lookup tables do not allow for 
extrapolation, either to smaller values than the first entry or to larger values than the last entry in 
the table. If, for example, the initial value of one of the dispersion parameters is smaller than the 
first value in the table for a specific stability class, the initial value in the table is used. If a larger 
value of the dispersion parameter is needed than the final value in the table for a specific 
stability class, the dispersion parameter is held fixed until the stability class changes. 
 

Time-Based Dispersion  
A time-based dispersion model can be enabled, also from the Dispersion tab on the Properties 
form. 
 

Hanna (2002) recommends that plume dispersion beyond 30 km be based on time, not on 
distance. This model allows the user to implement Hanna’s recommendation. The basis for the 
recommended distance, 30 km, is that most measurements upon which dispersion tables are 
based have a limit of about 30 km. The time-based dispersion model is closer to the treatment 
used in some Gaussian puff codes. In the MACCS implementation, the user must select the 
downwind distance at which the code switches from distance-based dispersion to time-based 
dispersion. The user must also select a linear coefficient for the time-based dispersion model. 
Hanna recommends a value of 0.5 m/s. The virtual source concept is used to ensure that there 
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is no discontinuity in switching from distance-based to time-based dispersion. The following 
equation describes the new model:  
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          (Equation 3) 

 
Where  

y  = Value of crosswind dispersion (m) 

a = Linear coefficient for distance-based, crosswind dispersion (m) 

x = Downwind distance from the virtual source (m) 

b = Exponential parameter for distance-based, crosswind dispersion  

  (dimensionless) 

xc =  Distance from the source (m) at which dispersion model switches from  

  distance- to time-based (CYDIST in MACCS) 

ac = Linear coefficient for time-based, crosswind dispersion (m/s) (CYCOEF in  

  MACCS) 

t = Time since the plume was released from the virtual source (s) 

 

When the time-based dispersion model is enabled, time-based dispersion is implemented at 

distances greater than or equal to cx  in Equation (3). However, distance-based dispersion is 

always applied within the first ring, regardless of the value of CYDIST. Either a power-law 
function, as illustrated in Equation (3) or a lookup table can be used to define the dependence of 
dispersion on downwind distance at distances less than CYDIST. 
 

Gaussian Plume Equations 
MACCS models plume dispersion during downwind transport using Gaussian plume models. 
Thus, the horizontal and vertical extent of plume segments is expressed in terms of the 

horizontal ( y ) and vertical ( z ) standard deviations of the normal concentration distributions 

that characterize a Gaussian plume. The Gaussian equations implemented in MACCS are 
derived assuming that turbulent velocities are negligible compared to the mean wind speed 
[Ka84]. Accordingly, MACCS assumes that the initial length of plume segments is unaffected by 
dispersion during downwind transport (i.e., plume segment lengths are constant once release of 
that plume segment is complete). Furthermore, MACCS assumes that concentration profiles 
have a sharp leading and trailing edge, i.e., the profile is a step function. 
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During downwind transport, atmospheric turbulence causes plume segments to expand in all 
directions with the rate of expansion increasing when atmospheric turbulence increases. 
Vertical expansion of the plume is increased by surface roughness and constrained by the 
ground and by the temperature structure of the atmosphere (location of inversion layers). 
Crosswind spreading of the plume along the y-direction is unconstrained. The effective 
crosswind dimensions of a plume segment are increased by lateral meander of the plume about 
its centerline trajectory. Because turbulent velocities are almost always very small compared to 
the mean wind speed that transports the bulk plume, expansion in the wind direction can be 
neglected [Tu70]. 
 
Because they are simple and computationally efficient, Gaussian plume models are commonly 
used to model atmospheric dispersion in reactor accident risk assessments (see for example 
the PRA Procedures Guide [US83]). Gaussian plume models assume that the diffusion of gas 
molecules and aerosol particles in the plume during its downwind transport can be modeled as 
a random walk that generates a normal distribution for air concentration in all directions. 
Because wind speed and temperature vary significantly with height near the ground, vertical and 
horizontal plume distributions differ significantly and must be calculated separately. Since the 
distribution in the wind direction does not appear in the Gaussian plume equations implemented 
in MACCS, only the vertical and crosswind distributions are actually calculated. 
 
The size of a Gaussian plume in the vertical and crosswind directions is defined by the standard 
deviations (σy and σz) of the normal distributions of material concentrations in the vertical and 
crosswind directions. When not constrained by the ground or by inversion layers, the Gaussian 
plume equation has the following form [Tu70]: 
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       (Equation 4) 

 
Where 

 zyx ,,  =time-integrated air concentration (Bq∙s/m3) at the downwind location (x, 

y, z) 

Q  = released activity (Bq) 

y  = lateral dispersion parameter representing the standard deviation of a 

Gaussian distribution (m) 

z   = vertical dispersion parameter representing the standard deviation of a 

Gaussian distribution (m) 

h = stabilized height of the plume centerline (m) 

Once a plume has expanded sufficiently in the vertical dimension so that further vertical 
expansion is constrained by the ground and/or the capping inversion layer, Equation (4) is no 
longer applicable. To treat restricted growth in the vertical dimension, the ground and the 
inversion layer are treated as impenetrable, reflecting boundaries. Mathematically, reflection is 
accomplished by the addition of mirror image sources above the inversion layer and below the 
plane of the ground. This produces the following equation, which is used in MACCS to calculate 
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both the time-integrated, plume-centerline, air concentration,  (x, y = 0, z = h), and time-

integrated, ground-level, air concentration under the plume centerline,  (x, y = 0, z = 0), from the 

time a plume segment is released until the vertical distribution of the segment becomes uniform 
between the ground and capping inversion layer (becomes well mixed in the vertical dimension): 
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              (Equation 5) 
 
Where 

H = height (m) of the capping inversion layer, i.e., the height of the mixing 

layer 

At each spatial interval along the plume's trajectory, MACCS tests for the occurrence of a 
uniform concentration distribution in the vertical direction (well-mixed plume between the ground 
and the capping inversion layer). Once a uniform vertical distribution is attained, Equation (5) 
reduces to the following equation: 
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         (Equation 6) 

 

MACCS switches from Equation (5) to Equation (6) when 03.0/ zH  . This criterion 

approximately corresponds to the requirement that the results of the two equations agree within 

1%. Because Equation (6) is independent of z , this value is not calculated once the transition 

from Equation (5) to Equation (6) is made. 
 
Dispersion Values 
The rate at which materials disperse in the atmosphere depends strongly on atmospheric 
turbulence, which varies greatly with stability class. Therefore, the rate of expansion of a plume 
during downwind transport also varies with stability class. 
 
The growth of plume dimensions during downwind transport to short distances (1 km) has been 
experimentally determined [Ha59] over flat terrain covered by prairie grass (surface roughness 
length z0 = 3 cm) for short plumes (10 min release durations) released during stable, neutral, 

and unstable atmospheric conditions. Pasquill [Pa61] used this data to develop curves that 
depict the increase of plume dimensions (σy and σ z values) with downwind distance for each of 
the six Pasquill-Gifford Stability Classes A through F. Although measurements had only been 
made to 1 km, Pasquill extrapolated the curves to 100 km. These curves, as later modified by 
Gifford [Gi75 and Gi76], are presented in Figure 3-17. 
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Figure 3-17  Dependence of σy and σz on distance for the six Pasquill-Gifford stability 

classes, A through F 
 
Solid lines depict the range of the experimental data; dashed lines are extrapolations. Tadmor 
and Gur [Ta69] constructed power-law fits to the Pasquill-Gifford (P-G) curves. The coefficients 
are provided in Table 3-2.  
 

Table 3-2  Tadmor and Gur coefficients for σy and σz for equation (2). 

 

Stability Class Constant* 

P-G i ai bi ci di 

A 1 0.3658 0.9031 0.00025 2.125 

B 2 0.2751 0.9031 0.0019 1.6021 

C 3 0.2089 0.9031 0.2 0.8543 

D 4 0.1474 0.9031 0.3 0.6532 

E 5 0.1046 0.9031 0.4 0.6021 

F 6 0.0722 0.9031 0.2 0.6020 

*The values of these constants reflect correction of typographical errors identified by Dobbins 
[Do79]. 
 
As used in MACCS, the values of the dispersion parameters, σy and σz, in Equation (2) must 

change in a piecewise continuous fashion. Discontinuous changes in slope occur when stability 
class changes. Since stability class changes discretely, the source distance x in the dispersion 
parameter equation (Equation (2)) must be changed to some new value that causes dispersion 
parameter growth to be continuous. The new value of the source distance is called the “virtual 
source” distance and generally has a different value for σy and for σz. It is calculated as follows.  
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Let i be the stability class before the change in atmospheric conditions, j the stability class after 
the change, and xyi and xzi be the source distances under the old conditions (the downwind 
distances to the virtual source just before the stability class changes). Let xyj and xzj be the 

source distances under the new conditions (i.e., the new virtual source distances). To ensure 
continuity, σyi must be equal to σyj and σzi must be equal to σzj. Thus, 
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         (Equation 7) 

 
These equations can be solved explicitly for the virtual source locations to produce the following 
result: 
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         (Equation 8) 

 
This same approach can be used in conjunction with the lookup table option described above. 
This assumes that the inverse functional dependence for the lookup table can be evaluated, i.e., 
that given a dispersion value, a unique value of x can be determined. For the lookup table, the 

requirement of monotonically increasing values in the table ensures uniqueness. Performing the 
inverse function is done by interpolation in the same way as for the function itself. 
 
Although new “virtual source” distances for σy and σz are calculated every time stability class 
changes, these distances are used only to calculate growth of σy and σz. Plume locations are 
always expressed relative to the release point that is the center point of the polar-coordinate 
computational grid. 
 
For a given spatial element, the average values of σy and σz are used to calculate air and 
ground concentrations for the entire spatial element. The average values of σy and σz are the 

arithmetical means of the initial and final values of these two parameters as a plume segment 
traverses the spatial element. 
 
Scaling Factors 
MACCS allows the user to input a separate scaling factor for σy and σz. These scale factors can 

be used to account for phenomena that would tend to increase or decrease the plume 
dimensions. There are two such phenomena that are commonly included in plume modeling: 
plume broadening caused by meander (wind direction fluctuations) and increase in the vertical 
plume dimension caused by surface roughness. Separate options exist to account for plume 
meander, as described in a subsequent subsection, so the scale factor for σy is usually set to 
1.0. However, MACCS does not contain a separate model to account for surface roughness, so 
most commonly the vertical scale factor is set to a value other than unity. 
 
The Pasquill-Gifford curves depicted in Figure 3-17 are appropriate for transport over flat terrain 
covered by prairie grass (surface roughness length z0 = 3 cm). But plume transport is usually 

over areas characterized by surface roughness lengths greater than 3 cm. Figure 3-18 presents 
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some approximate surface roughness lengths for different surfaces based on the values in 
[Le69, Br84, Ra84]. 
 

 
 

Figure 3-18  Approximate surface roughness lengths (z0) for various surfaces 
 
Figure 3-18 suggests that a roughness length greater than 3 cm, at least 5 cm and possibly as 
much as 1000 cm, is more likely typical of populated areas. Surface roughness principally 

affects vertical dispersion and thus z values. The following formula [AMS77] can be used to 

correct Pasquill-Gifford values of GP,z  , which are appropriate for z0,P–G = 3 cm, for the effects 

of smoother or rougher surfaces: 
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Where the subscript P–G refers to the Pasquill-Gifford formulation for dispersion parameters 
and subscript r refers to the scaled dispersion accounting for the actual surface roughness, z0.  

 
 Dispersion Forms and Parameters 3.2.5.2

 
Dispersion Function Form 
The Dispersion Function form is required when the user selects Power Law Functions on the 
Dispersion tab. Values entered on this form correspond to the parameters used to calculate 
dispersion when using the six Pasquill–Gifford stability classes (classes A through F).  The user 
must supply six values for each variable defined on this form, one value for each stability class 
in the order A through F. 
 

CYSIGA is the linear coefficient of the expression for y.   

CYSIGB is the exponential coefficient of the expression for y. 
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CZSIGA is the linear coefficient of the expression for z. 

CZSIGB is the exponential coefficient of the expression for z. 

 

Variable Name Definable Type Dimensions Allowed Values 

CYSIGA Yes Real 6 1×10-6 to 10.0 m 

CYSIGB Yes Real 6 1×10-6 to 10.0  

CZSIGA Yes Real 6 1×10-6 10.0 m 

CZSIGB Yes Real 6 1×10-6 to 10.0  

 
Dispersion Table Form  
The Dispersion Table form is required if the user selects Lookup Tables on the Dispersion tab. 
NUM_DIST is the number of distances in the lookup table and its value is determined by the 
number of rows entered in the grid containing the dispersion table. DISTANCE is the set of 
downwind distances corresponding to sigma-y and sigma-z data. These values must be 
monotonically increasing. SIGMA_Y and SIGMA_Z variables need to be provided on this form 
for each stability class, A, B, C, D, E, and F.   Values must be monotonically increasing. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUM_DIST Linked Integer None 3 to 50 

DISTANCE Yes Real NUM_DIST 1.0 to 1×108 m 

SIGMA_Y_A Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Z_A Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Y_B Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Z_B Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Y_C Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Z_C Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Y_D Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Z_D Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Y_E Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Z_E Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Y_F Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Z_F Yes Real NUM_DIST 1×10-6 to 1×1020 m 

 
Scaling Factors 

Scaling factors are required.  MACCS allows linear scaling of y and z by means of the input 

parameters, YSCALE and ZSCALE. These scaling factors are used to multiply the values of y 

and z that have been defined for each of the six stability classes.  YSCALE is the linear scaling 

factor that is applied to the formula for y.  This modifies all of the calculated y values by a 
constant multiplicative factor for either the power-law or lookup-table options.  ZSCALE is the 

linear scaling factor that is applied to the formula for z.  It is commonly used to account for 

surface roughness.  This factor modifies all of the z values by a constant multiplicative factor 
for either the power-law or lookup-table options. The value is normally set to 1.0.  
 

Variable Name Definable Type Dimensions Allowed Values 

YSCALE Yes Real None 0.01 to 100.0 

ZSCALE Yes Real None 0.01 to 100.0 
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Long-Range Parameters 
The Long-Range Parameters form is required if the user selects the option, Switch to Time-
Based Dispersion Model at User-Specified Distance, on the Dispersion tab.  CYDIST is the 
distance for switching from distance-based to time-based crosswind dispersion model.  The 
distance-based dispersion model is always used within the first radial interval.  The default value 
for this parameter is 30,000 m.  CYCOEF is the linear coefficient for the time-based, crosswind 
dispersion model.  The default value for this parameter is 0.5 m/s.Both of these default values 
are based on recommendation by Hanna (2002).  
 

Variable Name Definable Type Dimensions Allowed Values 

CYDIST Yes Real None 0.0 to 1×107 m 

CYCOEF Yes Real None 1×10-6 to 2.0 m/s 

 

 Multi Source Term Option 3.2.6
 

Variable Name Definable Type Dimensions Allowed Values 

MAXGRP No Integer None 0.0 to 1×107 m 

GRPNAM No Character None 1×10-6 to 2.0 m/s 

 
 Multi Source Term Model Description 3.2.6.1

 
MelMACCS is the interface tool that allows MELCOR plot files to be post processed to create 
MACCS source term data that can be imported directly into WinMACCS using the Import 
MACCS Input File option discussed in Chapter 4. In the past, the process has only been able to 
address single-unit source terms. WinMACCS 3.10 now has the capability to merge a number of 
source terms to create a multi-unit source term. Furthermore, both MELCOR and MelMACCS 
have been modified to create multiple source terms from a single MELCOR plot file, provided 
this feature is activated in the MELCOR input. The new feature allows the user to create a 
source term file for each ring in the MELCOR analysis. This feature is especially designed for 
analyses of spent fuel pools, where each ring can represent a different age of spent fuel. This 
allows different ages of fuel to be assigned different isotopic inventories in performing the 
MACCS analysis. MelMACCS 2.0 and later allow the user to assign an inventory for a selected 
ring. One source term file is created for each ring processed by the user.  
 
Source term files can be merged to create a multi-unit source term, as described subsequently 
in this section. Details of how to use MelMACCS are provided in Appendix A.  Details of how to 
use WinMACCS to use the mult source term model is provided in 4.4.10 
 

 Multi Source Term Forms and Parameters 3.2.6.2
 
Chemical Names Form 
The values on this form were read from the multi-source term files and are not changeable. 
 

Variable Name Definable Type Dimensions Allowed Values 

MAXGRP No Integer None 1 to 150 

GRPNAM No Character MAXGRP 1 to 15 characters 

 
Radionuclides Form 
The values on this form were read from the multi-source term files and are not changeable. 
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Variable Name Definable Type Dimensions Allowed Values 

NUMISO No Integer None 1 to 150 

NUCNAM No Character NUMISO 3 to 8 characters 

IGROUP No Integer NUMISO 1 to MAXGRP 

 
Plume Segments Form 
The values on this form were read from the multi source term files and are not changeable. 
Each row in the grid identifies a plume segment that was defined on one of the multi source 
term files. 
 

Variable Name Definable Type Dimensions Allowed Values 

TOTREL No Integer None 2 to 500 

MS_LABELS No Character TOTREL 1 to 255 characters 

IGROUP No Integer NUMISO 1 to MAXGRP 

 
Time Offsets Form 
A time offset can be associated with each of the multi source term files.  This allows MACCS to 
adjust its calculation for the radioactive decay due to the time offsets. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUM_SOURCES No Integer None 2 to 500 

Source Time 
Offset 

Yes Real NUM_SOURCES 0 to 2.592×106 s 
(30 days) 

 
 

 Plume Specification 3.2.7
 

 Plume Meander Model Descriptions 3.2.7.1
 
WinMACCS allows for three choices for plume meander model on the Dispersion tab.  Namely, 
the original MACCS model, a model based on Reg Guide 1.145, and an option to turn off plume 
meander.    
 
Original MACCS Plume Meander Option 
The original MACCS model accounted for the effect of meander during transport of a plume 

segment by using a meander factor.  This factor, mf , serves to broaden the plumes in the 

cross-wind dimension.  It acts as a linear factor on y, which affects the calculation of /Q.  The 
expansion factor is defined as follows: 
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     (Equation 10) 

 
Where 

releaset
 = release duration for the plume segment (s) 

0t
 = release duration for the P–G data (s), which was 600 s 
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1t
 = breakpoint in release duration (s), usually chosen to be 3600 s (the 

default value 

F1 = exponent for time dependence below the breakpoint (dimensionless), 

usually chosen to be 0.2 (the default value)  

F2 = exponent for time dependence above the breakpoint (dimensionless), 

usually chosen to be 0.25 (the default value)  

The duration of each plume segment should be limited to 10 hr when using this meander model 
because the formula is not intended to be used above that value.  If a plume segment exceeds 
10 hr, a nonfatal warning is given in the output file and the expansion factor is calculated as 
though the plume duration were 10 hr.  
 
Plume Meander Model Based on US NRC Regulatory Guide 1.145 
MACCS now contains a plume meander model based on Regulatory Guide 1.145 and 
supporting document NUREG/CR-2260. The Regulatory Guide 1.145 plume meander model 
differs from the original model in MACCS in that it accounts for the effects of wind speed and 
stability class. On the other hand, the original model in MACCS accounts for the duration of the 
release; the new model is calibrated for 1-hour release durations. The plume meander model 
described below would lead to an over prediction of peak doses for release durations longer 
than 1 hour; it would under predict peak doses for release durations that are significantly shorter 
than 1 hour. Enforcement of this recommendation is left to the user; WinMACCS and MACCS 
do not restrict the duration of plume segments to be approximately 1 hour when this model is 
selected. The MACCS implementation of the Reg. Guide 1.145 plume meander model treats 
plume meander in a similar manner as an area source. The meander occurs in the first 800 m 
downwind, creating a broader plume at that distance. Beyond 800 m, the plume gradually 
approaches the size that it would have had if meander had not occurred, just like the effect of an 
area source.  
 
The plume meander model described in Regulatory Guide 1.145 is described as follows: 

 

 )(xf ymym            (Equation 11) 

 
Where 

)(xy  = lateral dispersion not accounting for plume meander (m) 

mf  = meander factor (dimensionless) 

ym  = lateral dispersion accounting for plume meander (m) 

x  = downwind distance measured from the source (m) 

Lateral dispersion, σy, can be defined in terms of a power-law equation or as a look-up table. 

The meander factor is defined as follows: 
 

 )(ufmfm                 (Equation 12) 

 
Where 
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m  = 1 for stability classes A through C 

  2 for stability class D 

  3 for stability class E 

  4 for stability class F 

f(u) = a function of wind speed and is defined in Equation (13) below 

u = wind speed (m/s) 
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   (Equation 13) 

 
The above equations are valid for distances within 800 m of the source. Beyond 800 m 
downwind, Equation (11) is modified as follows: 

 

 )()800()1( xf yymym          (Equation 14) 

 
The MACCS model is similar to the model described above except that it is more general and 
uses a different approach at distances greater than D (D = 800 m in Equation (14)). The 
equations used in MACCS are as follows: 
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  (Equation 15) 

 
D is the location beyond which the plume meander factor is no longer used. At this distance, the 

location of the virtual source is adjusted to ensure continuity in the value of ym . Just beyond 

MNDIST, the meander factor is set to unity and the effect of the plume meander is treated in just 
the same way as an area source, i.e., by using an appropriate value for the virtual source 
location. 
 
The MACCS plume meander model matches the Reg. Guide 1.145 model when [MNDFAC(i)] = 
[1, 1, 1, 2, 3, 4], WINSP1 = 2 m/s, WINSP2 = 6 m/s, and MNDIST = 800 m. These are the 
default values. 
 

 Plume Forms and Parameters 3.2.7.2
 
Original Meander Form 
The Original Meander form is required when the user selects Original MACCS 
(MNDMOD=OLD) in the Select Plume Meander Model group on the Dispersion tab.  TIMBAS is 
the release duration associated with the tests to determine dispersion coefficients.  BRKPNT is 
the time breakpoint in the formula used to calculate the plume meander expansion factor.  If the 
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release duration is less than or equal to this value, the first formula is used.  If the release 
duration exceeds this value, the third expression is used in Equation (10).  XPFAC1 is the 
exponential factor used to calculate the plume meander expansion factor for releases having 
durations that are less than or equal to BRKPNT.  XPFAC2 is the exponential factor used in 
calculating the plume meander expansion factor for releases having durations that are greater 
than BRKPNT. 
 

Variable Name Definable Type Dimensions Allowed Values 

TIMBAS Yes Real None 60.0 to 86400.0 s 

BRKPNT Yes Real None 60.0 to 86400.0 s 

XPFAC1 Yes Real None 0.01 to 1.0 

XPFAC2 Yes Real None 0.01 to 1.0 

 
US NRC Reg. Guide 1.145 Meander Form  
This is required if the user selects US NRC Regulatory Guide 1.145 (MNDMOD=NEW) in the 
Select Plume Meander Model group on the Dispersion tab.  
 
WINSP1 is the wind speed where the meander factor changes from a constant value to a 
linearly decreasing function of the wind speed.  Meander factor decreases linearly from the 
value specified by MNDFAC(n) to one at WINSP2.  The index n represents the atmospheric 
stability class. 
 
WINSP2 is the wind speed where the meander factor reaches one for all stability classes.  
Meander factor decreases linearly from the value specified by MNDFAC(n) at WINSP1 to one at 
WINSP2.  The index n represents the atmospheric stability class. 
 
MNDIST is the downwind distance where the effect of meander begins to diminish. MNDIST is a 
breakpoint in the formulae for calculating sigma-y. 
 
MNDFAC is the plume meander factor used to calculate sigma-y described in the NRC 
Regulatory Guide 1.145.  MNDFAC(1) corresponds to atmospheric stability class A, 
MNDFAC(2) to stability class B, ..., and MNDFAC(6) to stability class F. 
 

Variable Name Definable Type Dimensions Allowed Values 

WINSP1 Yes Real None 0.0 to 20.0 m/s 

WINSP2 Yes Real None 0.0 to 20.0 m/s 

MNDIST Yes Real None 0.0  to 10,000.0 m 

MNDFAC Yes Real 6 1.0 to 10.0 

 
Plume Rise Scale Factor 
SCLCRW is a linear scaling factor on the critical wind speed used to determine whether buoyant 
plumes are trapped in the turbulent wake of the facility building complex.  Parameter values less 
than unity make plume rise less likely to occur because plume liftoff occurs only when the 
ambient wind speed at the time of release is less than the calculated critical wind speed; values 
greater than unity make plume rise more likely to occur. 
 
SCLADP is the linear scaling factor on the plume rise formula used to determine the amount of 
plume rise that occurs when the atmosphere is unstable or neutrally stable (stability classes A 
through D). 
 
SCLEFP is the linear scaling factor on the plume rise formula used to determine the amount of 
plume rise that occurs when atmospheric conditions are stable (stability classes E and F). 
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Variable Name Definable Type Dimensions Allowed Values 

SCLCRW Yes Real None 0.001 to 1x106  

SCLADP Yes Real None 0.01  to 100.0 

SCLEFP Yes Real None 0.01 to 100.0 

 

 Release Description 3.2.8
 

 Release Model Description 3.2.8.1
 
Release Description 
ATMOS can handle multiple plume segments in order to treat a source term that has a time-
varying composition and release rate.  The plume segments that describe a release can be 
separated with a time gap, can directly follow each other, or can overlap.  Different release 
heights, heat contents, starting times, release durations, release fractions, and initial values for 

y and z can be assigned to each plume segment.  Only one initial particle-size distribution can 
be assigned to each chemical group. Thus, the effective, initial, particle-size distribution can 
vary from one plume segment to another only as a function of the relative release fractions of 
the radionuclide classes. However, the aerosol size distribution of a plume segment changes 
with time (i.e., downwind location as the plume segment travels through the grid) when there are 
multiple particle sizes with different deposition velocities.  
 
Initial Plume Dimensions 
Mixing of the plume into the wake of a building from which a release occurs generally 
determines the initial crosswind dimensions of the plume. For the purpose of initializing plume 
dimensions, the common assumption is that the plume centerline is at ground level and in the 
middle of the downwind face of the building.  
 
If plume concentrations at the sides and roofline of the building from which the release occurs 
are assumed to be 10% of plume centerline concentrations (building edges are 2.15 sigma from 
the plume centerline), initial values of the horizontal and vertical standard deviations of the 
Gaussian plume are given by 
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       (Equation 16) 

 
Where 

Wb  = Width of the building from which release occurs (m) 

Hb  = Height of the building from which release occurs (m) 

Choosing the height and, especially, the width of the building from which the release occurs is 
not always straightforward. In many cases, the reactor complex is comprised of a set of 
buildings, which may be connected or disconnected. The heights of the buildings in this complex 
may vary. Usually, the containment or reactor building is used to define the building height, but 
this may not be appropriate in all cases. Determining the width is more problematic because the 
complex is generally rectangular or irregular in shape. Thus, the apparent width depends on the 
direction of the wind. Fortunately, the effects of the initial size of the plume are quickly lost as 
the plume moves downwind of the plant. While the initial plume dimensions can have a 
significant effect on the maximum dose at the exclusion area boundary, they usually have little 
effect on the doses multiple kilometers from the plant. 
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Plume Rise Models 
There are three basic components of the plume rise models in MACCS: (1) liftoff of buoyant 
plumes from a building wake, (2) plume rise under unstable and neutral atmospheric conditions 
(stability classes A to D), and (3) plume rise under stable conditions (stability classes E and F). 
Each of these components is described in this section. 
 
When wind speeds are sufficiently high, a buoyant plume segment that is released into a 
building wake is unable to escape from the wake. In MACCS, escape of a buoyant plume 
segment from a building wake is governed by a liftoff criterion (Equation (17) below), which was 
originally proposed by Briggs [Br73] and validated by experiments performed at the Warren 
Spring Laboratory in Great Britain [Ha86]. The criterion states that plume rise occurs only when 
the wind speed upon release of the segment is less than a critical wind speed (uc) that is 
calculated using the following formula: 
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Where 

bH   = the height of the building from which the plume is escaping (m) 

F      = the buoyancy flux (m4/s3), which, under standard atmospheric conditions 
is 

    = 
Q61079.8 

 

Q  = the sensible heat release rate of the plume (W), i.e., the sensible heat content of 

the plume divided by its release duration. Sensible heat is measured relative to 
the ambient temperature. 

This equation indicates that there is little or no possibility of plume liftoff when the sensible heat 
release rate is less than 105 W for a typical, 50-m high, reactor or containment building. Even 
when the rate of release of sensible heat is 1 MW, the plume only lifts off when wind speed is 
less than approximately 1.2 m/s.  
 
Plume rise, when atmospheric conditions are neutral or unstable (stability classes A through D), 
is treated using the “two thirds” law for bent over plumes of Briggs [Ha82]: 
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Where 

h = height of the plume centerline (m) 

h  = plume rise (m) measured from the initial release height 

u  = wind speed (m/s) averaged between the initial height and the current location 

(x, h) 
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Buoyant plume rise is terminated when any of the following conditions occur: 
1. ∆h reaches a final rise height, as defined below, 
2. the height of the plume centerline reaches the mixing height (height of the capping 

inversion layer), or 
3. one hour has elapsed since release of the plume segment began. 

 

In the original MACCS plume rise model, the following equation recommended by Briggs [Br75] 
was used to determine the final rise height for stability classes A to D: 
 

 3/300 uFh           (Equation 19) 

 
In the currently recommended, improved MACCS plume rise model, a different formula is used, 
also based on the work of Briggs (Hanna, 1982): 
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In the original MACCS model, plume rise under stable atmospheric conditions (stability classes 

E and F) is calculated using the Briggs equation for the final rise  h  [Ha82]: 
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In the improved MACCS model, plume rise under stable atmospheric conditions (stability 
classes E and F) is calculated using a slightly modified version of the above equation: 
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In Equations (21) and (22), the stability parameter, S, is defined as follows: 
 

S = stability parameter (s-2) defined by the following equation 
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Where 

g = acceleration due to gravity (m/s2) 

aT  = ambient temperature (K) 
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z

Ta




 = ambient temperature lapse rate (K/m) 

pc  = heat capacity of air at constant pressure (J/kg/K) 

pc

g
 = dry adiabatic lapse rate (0.98 K/100 m) 

Regulatory Guide 1.23 [US72] specifies ranges for temperature lapse rates  zTa   for the six 

atmospheric stability classes A through F. The values of the stability parameter S used in 
MACCS were derived using midpoint values for these lapse-rate ranges. The lapse rate ranges 
specified for Stability Classes E and F are -0.5 K/100 m to 1.5 K/100 m and 1.5 K/100 m to 
4.0 K/100 m. Thus, Class E has a lapse rate range midpoint of 0.5 K/100 m and Class F a 
midpoint of 2.75 K/100 m. Substitution of these midpoint values and the International Civil 
Aviation Organization standard atmosphere [We72] value of 288.16 K (15°C) into Equation (13) 

results in values of 5.04  10-4 s-2 and 1.27  10-3 s-2 for the stability parameter S for Stability 
Classes E and F, respectively.  
 
Because near-surface wind speeds generally increase with altitude, Equations (21) and (22) 
both overestimate plume rise if surface wind speeds are used to calculate ∆h. Since this could 
underestimate radiation exposures, for purposes of calculating plume rise, wind speeds aloft are 
estimated from surface wind speeds using the following equation [Ha82]: 
 

 

p

rh

h
uu 










 0           (Equation 24) 

 
Where 

0u  = surface wind speed measured at the reference height, rh  (usually 10 m above 

ground level) 

p = exponential coefficient (dimensionless), which depends on stability class and 
surface roughness. Values are provided in Table 3-3 below. 

Table 3-3  Values of exponential coefficient, p, in equation (24) for six stability classes. 

Stability class A B C D E F 

Urban Surfaces 0.15 0.15 0.20 0.25 0.40 0.60 

Rural Surfaces 0.07 0.07 0.10 0.15 0.35 0.55 

 
For the purpose of calculating plume rise, the weather conditions that characterize the time 
period during which release of the plume segment begins are used to calculate the entire rise of 
the segment even when the rise extends into the next time period (e.g., a buoyant plume 
segment released at 1:30 PM would have its entire rise calculated using 1:00 PM weather). 
 
In MACCS, plume rise is calculated in three steps. First, the surface wind speed u0 and one of 

the Equations (19) through (22), as appropriate, are used to make a first-order estimate of the 



3-50 

final centerline height (h) of the plume segment after plume rise has taken place  hhh  0 , 

where h0 is the initial release height of the plume segment. Then the wind speed u at the height 
h is calculated using Equation (24). Finally, an average wind speed over this range is estimated 
by averaging u0, the reference wind speed, and u, the wind speed at the first-order estimate of 
the final height of the plume centerline. This average value of u is used in one of Equations (19) 

through (22) to make a second-order estimate of the amount of plume rise, h, which is used to 
evaluate the final plume centerline height of the plume segment, h.  
 
The individual numerical coefficients used by these models are fixed in the code with no 
provision for their convenient modification by the user. While it is not possible for the user to 
vary the individual coefficients used by the three components of the plume rise model, it is 
possible to modify their end results by specifying linear scaling factors, SCLCRW, SCLADP, and 
SCLEFP.  
 
Two optional sets of inputs are available in MACCS to determine plume buoyancy.  If the Power 
Model is selected on the Plume/Source tab, the plume buoyancy is calculated using the rate of 

release of sensible heat content in a plume ( Q  in the equations above). In some cases, it is 

simpler for the user to estimate the rate of mass release and the density of a plume segment 
rather than the rate of release of sensible heat. The second option, the Density and Flow Model 
allows these values to be specified in place of the rate of release of sensible heat.  The required 
values, plume density and mass flow rate, are related to the buoyancy flux, F, by the following 
formula: 
 







mg
F

a












 1          (Equation 25) 

 
Where 

g = acceleration due to gravity (9.8 m/s) 

  = mass density of the plume (kg/m3) 

a  = mass density of surrounding air at ambient conditions (1.178 kg/m3) 

m   = mass flow rate of the plume (kg/s) 

Equation (25) can be used to account for release of gases that are lighter than air, such as 
hydrogen and steam, as well as releases at elevated temperatures. Generally, the presence of 
aerosols can be neglected when plume density and flow rate are calculated. 
 

 Release Description 3.2.8.2
 
Release Info Form 
The Release Info form allows the user to describe the source term and other ATMOS input 
parameters through MACCS parameter ATNAM2.  This identifying information is printed in the 
output file. 
 
OALARM is used as a reference time that provides user flexibility should it be desirable to shift 
the entire response timeline.  It is important to note that response actions cannot occur before 
OALARM.  The user should consider this when establishing this parameter.  Traditionally it has 
been used to define the time at which the public is notified, which could either be aligned with 
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the declaration of site area emergency or general emergency. However, it’s use is very flexible 
and there is no requirement to align it with either of these emergency levels. The user should be 
aware that whatever time is assigned to OALARM has implications for other delays discussed 
subsequently.  
 

Variable Name Definable Type Dimensions Allowed Values 

ATNAM2 Yes Character None 1 to 80 characters 

OALARM Yes Real None 0. to 2,592,000 s 
(30 d) 

 
Plume of Maximum Risk Form 
The Plume of Maximum Risk form is required when Multi Source Term is not selected on the 
Plume/Source tab.  
 
MAXRIS specifies which plume segment is to be considered risk dominant.  The selection of 
this plume segment is usually based on its potential for causing early fatalities.  Release of the 
risk-dominant plume begins at the start time of the selected weather sequence. The upper limit 
on this parameter, NUMREL, is defined below. 
 

Variable Name Definable Type Dimensions Allowed Values 

MAXRIS Yes Integer None 1 to NUMREL 

 
Plume Parameters Form 
The Plume Parameters form is required when Multi Source Term is not selected on the 
Plume/Source tab. It contains four parameters that define the timing of plume segments and the 
initial release height.  
 
NUMREL defines the number of plume segments that are released. This value is determined by 
the number of rows in the grid containing values of PDELAY, PLHITE, REFTIM, and PLUDUR.  
 
PDELAY specifies the start time of each plume segment from the time of reactor scram, which 
is usually the time of accident initiation. Sequential, overlapping, and gaps between plume 
segments are allowed.  
 
PLHITE specifies the height above ground level at which each plume segment is released. 
 
REFTIM specifies the representative location for each plume segment (e.g., 0.0 = leading edge, 
0.5 = midpoint, 1.0 = trailing edge). This parameter allows the user to locate the contents of the 
plume in a bucket of material situated at some point along the plume segment.  Radioactive 
decay, dry deposition, and dispersion are all calculated as if the entire contents of the plume 
segment were located at this point.  The choice of this parameter has no impact on the wet 
deposition calculations since those are performed as if the entire contents of the plume are 
uniformly distributed along its length.  
 
PLUDUR specifies the duration of each plume segment.  
 

Variable Name Definable Type Dimensions Allowed Values 

NUMREL Linked Integer None 1 to 200 

PDELAY Yes Real NUMREL 0.0 to 2,592,000 s 
(30 d) 

PLHITE Yes Real NUMREL 1 to NUMREL 

REFTIM Yes Real NUMREL 0.0 to 1.0 
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Variable Name Definable Type Dimensions Allowed Values 

PLUDUR Yes Real NUMREL 60.0 to 86,400.0 s 
(1 min to 1 d) 

 
Particle Size Distribution Form 
The Particle Size Distribution form is required when Multi Source Term is not selected on the 
Plume/Source tab. It defines the aerosol-size distribution for each chemical class in the 
analysis.  
 
PSDIST defines the fraction of the released material allocated to each of the particle-size 
(deposition-velocity) groups. The initial particle-size distribution for a chemical group is the same 
for all plume segments.  The deposition velocity (VDEPOS) is shown as the column header.  
There are NSPGRP, the number of particle size groups, columns and MAXGRP, the number of 
chemical groups, rows. The fractions across a row (over the set of size groups) must sum to 
approximately 1.0. 
 

Variable Name Definable Type Dimensions Allowed Values 

PSDIST Yes Real MAXGRP by  
NSPGRP 

0.0 to 1.0 

 
Inventory Scale Factor Form 
The Inventory Scale Factor form is required when Multi Source Term is not selected on the 
Plume/Source tab. CORSCA, the only parameter on this form, is a linear scaling factor that can 
be used to adjust the inventory of all the radionuclides defined in the model. This factor is useful 
for modeling similar reactors with different power ratings.  
 
It is preferable to obtain new sets of inventory values when studying reactors with different 
power ratings, fuel burnup levels, or fuel management histories, but this is not always practical. 
When facility-specific inventories are not available, a representative inventory may be obtained 
by linear scaling of the inventory of a similar reactor having a different thermal power level.  The 
scale factor is usually chosen to be the ratio of the two reactors' thermal power levels. 
 
The parameter CORSCA can also be used to convert the facility inventory from one set of units 
to another during the input processing phase in order to avoid the tedium of manually converting 
a set of data from one set of units to another.  For example, to convert from curies to 
Becquerels, use a value of 3.7x1010 for CORSCA. However, a second way to accomplish this is 
by simply switching units using the Change Units button at the lower left corner of the form.  
 

Variable Name Definable Type Dimensions Allowed Values 

CORSCA Yes Real None 2.7×10-10 to 1×1016 

 

Daughter Ingrowth Flag Form 
The Daughter Ingrowth Flag form is required when Multi Source Term is not selected on the 
Plume/Source tab. APLFRC, the only parameter on this form, specifies how release fractions 
are applied to decay products. PARENT indicates that decay products formed after reactor 
shutdown are released in the same fraction as their parent; PROGENY indicates decay 
products formed after reactor shutdown are released according to their own chemical class. 
PARENT is preferred when using MELCOR data because MELCOR does not account for 
radioactive decay and ingrowth. 
 



3-53 

Variable Name Definable Type Dimensions Allowed Values 

APLFRC Yes Character None PARENT, 
PROGENY 

 
Release Fractions Form 
The Release Fractions form is required when Multi Source Term is not selected on the 
Plume/Source tab. RELFRC defines the release fraction for each of the plume segments and for 
each chemical group.  All radionuclides in a chemical group are released from the facility in the 
same fraction. Normally, the values of RELFRC summed over the set of plume segments 
should not exceed 1.0, but this requirement is not imposed by either WinMACCS or MACCS.  
 

Variable Name Definable Type Dimensions Allowed Values 

RELFRC Yes Real NUMREL by 
MAXGRP 

0.0 to 1.0 

 
Wake Effect Data Form 
The Wake Effect Data form is required when Multi Source Term is not selected on the 
Plume/Source tab. BUILDH defines the height of the facility building or building complex.  This 
value is used to evaluate whether a buoyant plume is entrained in the turbulent wake of the 
building based on Equation (17).   
 
SIGYINIT defines the initial value of sigma-y for each plume segment released. 
 
SIGZINIT defines the initial value of sigma-z for each plume segment released. 
 

Variable Name Definable Type Dimensions Allowed Values 

BUILDH Yes Real NUMREL 0.1 to 1000.0 m 

SIGYINIT Yes Real NUMREL 0.1 to 1000.0 m 

SIGZINIT Yes Real NUMREL 0.1 to 1000.0 m 

 
Heat Form 
The Heat form is required when the Power Model is selected on the Plume Rise tab and the 
Multi Source Term is not selected on the Plume/Source tab. The values are used to determine 
buoyant plume rise.  
 
PLHEAT specifies the rate of release of sensible heat in each plume segment. This quantity is 
traditionally calculated based on the difference between the plume and ambient temperatures, 
the heat capacity of air, and the flow rate of the plume.  This value is used to determine the 
amount of buoyant plume rise. 
 

Variable Name Definable Type Dimensions Allowed Values 

PLHEAT Yes Real NUMREL 0.0 to 1×1010 W 

 
Density and Flow Form 
The Density and Flow form is required if the Density and Flow Model is selected on the Plume 
Rise tab and the Multi Source Term is not selected on the Plume/Source tab. The values on this 
form are used to determine the amount of buoyant plume rise. This formulation is more general 
and sometimes more convenient than specifying rate of release of sensible heat.  
 
PLMFLA is the average mass flow rate for a plume segment. 
 
PLMDEN is the average gas density for a plume segment. 
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Variable Name Definable Type Dimensions Allowed Values 

PLMFLA Yes Real NUMREL 1×10-6 to 1×1032  kg/s 

PLMDEN Yes Real NUMREL 0.02 to 5.0 kg/m3 

 

 Weather 3.2.9
 

 Weather Model Description 3.2.9.1
 
There are five options available to the user for specifying the weather data that are used by 
ATMOS.  MACCS can run either a single weather sequence or multiple weather sequences, as 
described in the following paragraphs.  
 
When a single weather sequence is desired, there are three ways to specify the weather data.  
The user can (1) specify data for 120 hr, (2) specify a starting day and time period in the 
weather data file, or (3) specify constant weather conditions. 
 
For the specified starting day and time period option, MACCS weather data from the 
meteorological data file beginning at the specified day and time.  A file of weather data covering 
a period of 365 days (8760 hr) is required.  
 
The two methods of weather sampling are (1) a modified version of the weather bin sampling 
method used in CRAC2 (Ritchie et al., 1984) and (2) a stratified, random sampling approach.  
The weather bin sampling method sorts weather sequences into categories and assigns a 
probability for each category, depending on the number of data points that fit into that category. 
The categories (i.e., bins) are defined by wind speed and stability class or by the occurrence of 
rain (intensity and distance).  The rain bins depend on rain intensity as well as the downwind 
distance at which rain begins. The user is required to supply the parameters that define the rain 
bins as part of the ATMOS input file.  The definitions of the weather bins that depend on stability 
class and wind speed are fixed in the code and are defined in the output file.   
 
The stratified random sampling method allows the user to sample weather from each day of the 
year after division of each day into one, two, three or four equal time periods.  Each weather 
sequence selected is considered to have the same probability of occurrence, that is, P = 
1/(number of samples).  
 

 Mixing Height Option 3.2.9.2
 
Daytime and nighttime values for mixing height are specified for each of the four seasons in the 
meteorological data file.  An option is available in MACCS to account for night-to-day transitions 
in mixing height. This is activated by checking the box Adjust mixing height based on time of 
day on the Weather tab. This option only applies when a meteorological file is used (i.e. 
METCOD = 1, 2, or 5).  
 
If Adjust mixing height based on time of day is unchecked, only the daytime mixing heights are 
used.  The meteorological file contains 2 sets of 4 values for mixing height at the end of the file.  
The first set is the morning mixing height values for each of the four seasons.  The second set is 
afternoon mixing height values for each of the four seasons.  Only the second set of values is 
used when this option is chosen. That is, the mixing height only depends on the season for 
which the calculation is performed. 
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If Adjust mixing height based on time of day is selected, mixing height is adjusted depending on 
time of day.  This model uses both the morning and afternoon values.  If the start time is 
between sunset and sunrise, the morning value for the appropriate season is used until the first 
hour after sunrise.  At the first hour after sunrise and until the hour of sunset, the maximum 
mixing height is calculated by linearly interpolating between the morning value and the 
afternoon value for that season.  Once the first sunset in the simulation is reached, the 
afternoon mixing height is used until the end of the weather trial. If the start time of the 
simulation is between the first hour after sunrise and the hour of sunset, the mixing height is 
calculated by interpolating between the morning value and the afternoon value for that season. 
Again, once the first sunset of the simulation is reached, the mixing height is fixed at the 
afternoon value.  The mixing height is never allowed to decrease in the MACCS treatment 
because that would violate the second law of thermodynamics.  
 
Calculations based on time of day require the user to supply the latitude and longitude of the 
accident site.  This is done on the form labeled Site Location. 
 

 Weather Forms and Parameters 3.2.9.3
 
Constant or Boundary Conditions Form  
The Constant or Boundary Conditions form is required. This form allows the user to specify 
constant weather (METCOD = 4) or boundary weather conditions (METCOD = 1, 2, 3, or 5). 
Boundary weather is implemented when the radial interval greater than the value specified by 
LIMSPA is entered by a plume segment. Boundary weather allows the user to prescribe simple, 
constant weather conditions (in place of measured weather conditions taken from the 
meteorological data file) in the outer portion of the computational grid. This has traditionally 
been used to implement boundary rain, the purpose of which is to prevent the aerosols from 
escaping the grid. Using boundary rain tends to force a conservative result. A more realistic 
result can be obtained by setting LIMSPA = NUMRAD so that real weather data are used all the 
way to the edge of the grid.  
 
BNDMXH is the mixing layer height that is used for the constant weather conditions (METCOD 
= 4). Mixing height is determined from other sources for all other values of METCOD.  
 
IBDSTB is the stability class that is used for constant and boundary weather conditions.  The 
integers 1 through 6 represent Pasquill-Gifford stability classes A through F, respectively. 
 
BNDRAN is the rain rate that is used for the constant and boundary weather conditions. 
 
BNDWND is the wind speed that is used for constant and boundary weather conditions. 
 

Variable Name Definable Type Dimensions Allowed Values 

BNDMXH Yes Real None 100.0 to 10,000.0 m 

IBDSTB Yes Integer None 1 to 6 

BNDRAN Yes Real None 0 .0 to 99.0 mm/hr 

BNDWND Yes Real None 0.5 to 30.0 m/s 

 
Fixed Start Time Data Form 
The Fixed Start Time Data form is required when Constant Weather, User Supplies 120 
Weather Points, or Fixed Start Time is selected on the Weather tab. For the first two options, 
the start time is only used in conjunction with the COMIDA2 food-chain model. However, 
MACCS requires these input parameters even when the COMIDA2 food-chain model is not 
used.  
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ISTRDY is the day of the year when the weather sequence begins. 
 
ISTRHR is the starting time period of the weather trial. A 24-hour day is divided into 15-, 30-, or 
60-minute time periods in the meteorological file, depending on the value of PERIOD in the 
meteorological data file. These divisions correspond to 96 time periods per day, 48 time periods 
per day, and 24 time periods per day, respectively.  MACCS enforces the following ranges of 
ISTRHR: 
 

Allowed Range of ISTRHR Data Interval Third line of 
meteorological file 

1 to 24 60 minutes /PERIOD 60 (default) 

1 to 48 30 minutes /PERIOD 30 

1 to 96 15 minutes /PERIOD 15 

 
Additionally, the food pathway calculations of the CHRONC module depend on the day the 
accident occurs when the COMIDA2 food-chain model is used.  If the user has chosen the 
Fixed Start Time option, the values of ISTRDY and ISTRHR specify the starting day and time 
period in the weather file of the single weather trial that is performed. 
 

Variable Name Definable Type Dimensions Allowed Values 

ISTRDY Yes Integer None 1 to 365 

ISTRHR Yes Integer None 1 to 96 

 
User-Supplied Weather Form 
The User-Supplied Weather form is required when User Supplies 120 Weather Points is 
selected on the Weather tab.  There must be one data record for each hour of weather in the 
sequence.   
 
HRMXHT is the set of mixing layer heights that is used for a single weather trial. The user must 
supply 120 values, one per hour. 
 
IHRSTB defines the list of stability classes that are used for a single weather trial.  The integers 
1 through 6 represent the Pasquill-Gifford stability classes A through F, respectively.  The user 
must supply 120 values, one per hour. 
 
HRRAIN defines the list of rain rates that are used for a single weather trial. The user must 
supply 120 values, one per hour. 
 
HRWNDV defines the list of wind speeds that are used for a single weather trial. The user must 
supply 120 values, one per hour. 
 
IHRDIR defines the list of wind directions that are used for a single trial.  They are given as 
integers corresponding to each of the compass directions starting with north (1) and ending with 
the direction just to the west of north.  The user must supply 120 values, one per hour. 
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Variable Name Definable Type Dimensions Allowed Values 

HRMXHT Yes Real 120 100.0 to 10,000.0 m 

IHRSTB Yes Integer 120 1 to 6 

HRRAIN Yes Real 120 0.0 to 99.0 mm/hr 

HRWNDV Yes Real 120 0.5 to 30.0 m/s 

IHRDIR Yes Integer 120 1 to NUMCOR 

 
Site Location Form 
The Site Location form is required when Adjust mixing height based on time of day is selected 
on the Weather tab. The user must also specify the latitude and longitude of a site when map 
files need to be generated with MapGen, which allows maps to be displayed behind speed 
multiplier and network evacuation forms.  
 
The latitude and longitude of a site can be found on a site file generated by SecPop as a 
comment line; however, this information must be entered manually because WinMACCS does 
not read this comment line from a site file. 
 
LATITU_DEG, LATITU_MIN, and LATITU_SEC represent the degrees, minutes, and seconds 
of the latitude.  These values are used to calculate the time of sunrise and sunset. 
 
LATITU_DIREC indicates hemisphere, North or South. 
 
LONGIT_DEG, LONGIT_MIN, and LONGIT_SEC represent the degrees, minutes, and seconds 
of the longitude.   
 
LONGIT_DIREC indicates hemisphere, East or West. 
 

Variable Name Definable Type Dimensions Allowed Values 

LATITU_DEG Yes Real None 0.0 to 90.0˚ 

LATITU_MIN Yes Real None 0.0 to 60.0′ 

LATITU_SEC Yes Real None 0.0 to 60.0″ 

LATITU_DIREC Yes Character None N, S 

LONGIT_DEG Yes Real None 0.0 to 360.0˚ 

LONGIT_MIN Yes Real None 0.0 to 60.0′ 

LONGIT_SEC Yes Real None 0.0 to 60.0″  

LONGIT_DIREC Yes Character None E, W 

 
Samples per Bin Form 
Samples per Bin is required when Uniform Bin Sampling (METCOD=2) is selected on the 
Weather tab.  The bins are defined to represent rain conditions at different distance intervals 
downwind from the accident site together with 16 bins for initial conditions organized by stability 
class and wind speed.  The rain intensities and distance intervals that define the rain bins are 
chosen by the user.  These values are specified on forms Rain Distances and Rain Intensities. 
 
The total number of weather bins is determined by the number of rain intensities, NRINTN, and 

the number of rain distances, NRNINT, defined by NRNINT•(NRINTN+1)+16. The total number 

of bins can range from 28 to 40, depending on the number of rain distances and intensities 

supplied by the user. The 16 initial weather bins are fixed in MACCS according to the definitions 

given in   
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Table 3-4. 
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Table 3-4  Definition of the 16 standard weather bins in MACCS. 

Bin number Stability class Wind speed 

1 A/B 0 m/s < u   3 m/s 

2 A/B 3 m/s < u 

3 C/D 0 m/s < u   1 m/s 

4 C/D 1 m/s < u   2 m/s 

5 C/D 2 m/s < u   3 m/s 

6 C/D 3 m/s < u   5 m/s 

7 C/D 5 m/s < u   7 m/s 

8 C/D 7 m/s < u 

9 E 0 m/s < u   1 m/s 

10 E 1 m/s < u   2 m/s 

11 E 2 m/s < u   3 m/s 

12 E 3 m/s < u 

13 F 0 m/s < u   1 m/s 

14 F 1 m/s < u   2 m/s 

15 F 2 m/s < u   3 m/s 

16 F 3 m/s < u 

 
NSMPLS defines the number of weather sequences to be chosen from each of the individual 
bins.  The more samples that are taken, the better the statistical representation of the results.   
 

Range for NSMPLS 
(365 x number time periods per day) 

Weather Data 
Time Interval 

Third line of 
meteorological file 

1 to 8760  60 minutes /PERIOD 60 

1 to 17520 30 minutes /PERIOD 30 

1 to 35040 15 minutes /PERIOD 15 

 

Variable Name Definable Type Dimensions Allowed Values 

NSMPLS Yes Integer None 0 to 35040 

 
Samples per Day Form 
Samples per Day is required when Stratified Random Sampling (METCOD=5) is selected on the 
Weather tab.   
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NSMPLS defines the number of weather sequences to be chosen from each day of the year.  
MACCS enforces the following range: 
 

Range for NSMPLS  Data Interval Third line of 
meteorological file 

1 to 24 60 minutes /PERIOD 60 

1 to 48 30 minutes /PERIOD 30 

1 to 96 15 minutes /PERIOD 15 

 
Although not enforced by MACCS or WinMACCS, NSMPLS should be set to be a factor of 24 
when the meteorological data are hourly (i.e., 1, 2, 3, 4, 6, 8, or 24), a factor of 48 when there is 
one record of data for every 30 minutes, or a factor of 96 when there is one record of data for 
every 15 minutes. This is because the sampling algorithm begins by dividing each day up into 
NSPLS time intervals. One sample is selected from each time interval. For example, if NSPLS is 
4 and hourly weather data are specified, each day is divided into 4 6-hr intervals. MACCS 
selects a single random starting time from each of these 4 intervals. Because the duration of 
each of the intervals is the same, each of the trials is equally probable. Selecting an integer that 
is not a factor causes some of the time intervals to be longer than others and leads to a bias in 
the sampling algorithm.    
 

Variable Name Definable Type Dimensions Allowed Values 

NSMPLS Yes Integer None 1 to 96 

 
Seed Form 
Seed is required when Stratified Random Sampling (METCOD=5) is selected on the Weather 
tab.   
 
IRSEED defines the seed of the random number generator. Changes to this value cause 
different weather trials to be selected. 
 

Variable Name Definable Type Dimensions Allowed Values 

IRSEED Yes Integer None 0 to 255 

 
Boundary Limit Form 
Boundary Limit is required when anything but Constant Weather (METCOD=4) is selected on 
the Weather tab. 
 
LIMSPA is the limiting spatial interval for using recorded weather data.  Spatial intervals greater 
than with this value use the boundary weather conditions specified on form Constant or 
Boundary Conditions.  Boundary weather conditions are applied to all spatial intervals when a 
value of 0 is specified for this parameter. 
 

Variable Name Definable Type Dimensions Allowed Values 

LIMSPA Yes Integer None 0 to NUMRAD 

 
Bins Form 
The Bins form is required if Nonuniform Bin Sampling (METCOD=2, NSMPLS=0) is selected on 
the Weather tab.  Sampling a subset of all the weather bins allows the effects of weather type to 
be examined. This is accomplished by setting INWGHT to zero for one or more of the bins. 
Another option for examining the importance of various weather bins is to set the RISCAT flag 
to True, as described below in the section on EARLY. 
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NSBINS defines the number of bins from which weather sequences are to be chosen. Its value 
is determined by the number of rows in the grid containing values of INDXBN and INWGHT. 
However, the user should ensure that the number of bins is consistent with the value of 
NRNINT•(NRINTN+1)+16.  
 
INDXBN defines the list of bins from which weather sequences are to be selected when 
nonuniform bin sampling is chosen.  Indices are reported in the MACCS output under 

METEOROLOGICAL BIN SUMMARY.  MACCS requires that the range of values is 1  value  
NSBINS. The total number of bins depends on the rain distances and intensities supplied by the 
user, as described above. 
 
INWGHT defines the number of weather sequences to be selected from the each weather bin.  
If this number exceeds the number of sequences in the specified bin, the code selects all of the 
sequences in that bin.  In order to find the index number for a rain bin, refer to the output titled 
METEOROLOGICAL BIN SUMMARY.  MACCS requires that the sum of the values must be 
greater than or equal to one.  
 
MACCS enforces the following range: 

 

Range for INWGHT Data Interval Third line of 
meteorological file 

1 to 8760  60 minutes /PERIOD 60 (default) 

1 to 17520 30 minutes /PERIOD 30 

1 to 35040 15 minutes /PERIOD 15 

 

Variable Name Definable Type Dimensions Allowed Values 

NSBINS Linked Integer None 1 to 40 

INDXBN Yes Integer NSBINS 1 to 40 

INWGHT Yes Integer NSBINS 0 to 35040 

 
Rain Distances Form 
The Rain Distances form is required when either Uniform Bin Sampling (METCOD=2) or 
Nonuniform Bin Sampling (METCOD=2, NSMPLS=0 to 35040) is selected on the Weather tab.   
 
NRNINT defines the number of rain distance intervals used for weather binning. The value is 
determined by the number of entries in vector RNDSTS. 
 
RNDSTS defines the rain distance interval endpoints used for the weather binning.  MACCS 
requires that each of these distances lie within 10% of one of the spatial interval endpoint 
distances, SPAEND, and that the user supply unique values in ascending order. 
 
For example, if the user specifies 2, 4, 8, and 16 km, these values define the following four rain 
distance intervals: 

1. 0 km   distance of first rain occurrence   2 km 

2. 2 km <  distance of first rain occurrence   4 km 

3. 4 km <  distance of first rain occurrence   8 km 

4. 8 km <  distance of first rain occurrence   16 km. 
 
Rain that occurs beyond 16 km in this example is not categorized as being in a rain bin. These 

time intervals are categorized under the 16 bins defined in   
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Table 3-4. 
 

Variable Name Definable Type Dimensions Allowed Values 

NRNINT Linked Integer None 4 to 6 

RNDSTS Yes Real NRNINT 0.001 to 99.9 km 

 
Rain Intensities Form 
The Rain Intensities form is required when either Uniform Bin Sampling (METCOD=2) or 
Nonuniform Bin Sampling (METCOD=2, NSMPLS=0) is selected on the Weather tab.  The user 
must specify either two or three rain intensities that are used as breakpoints in the 
categorization of precipitation rate.  For example, if the user specifies two rain intensity 
breakpoints of 1 and 4 mm/hr, the following three rain intensity intervals, where x is the rain 
intensity, are used: 

1. 0 mm/hr < x   1 mm/hr 

2. 1 mm/hr < x   4 mm/hr, 
3. 4 mm/hr < x. 
 
NRINTN defines the number of rain intensity breakpoints to be used for weather binning.  
 
RNRATE defines the rain intensity breakpoints.  MACCS requires that unique values are 
supplied in ascending order. 
 

Variable Name Definable Type Dimensions Allowed Values 

NRINTN Linked Integer None 2 to 3 

RNRATE Yes Real NRINTN 0.001 to 100.0 mm/hr 

 

 Output Control 3.2.10
 
When requested by the user, the ATMOS module generates the complementary cumulative 

distribution function, CCDF, of ten atmospheric modeling parameters for user-specified 

distances and plume segments, as listed in   
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Table 3-5.   
 
Air and ground concentrations are reported for the radionuclide specified for the variable 
NUCOUT.  In addition to the results produced for the single specified radionuclide, the total 
radioactivity on the ground (from all radionuclides) is reported as well.  Within a single run of the 
code, there is no provision in MACCS for generating CCDFs of air and ground concentrations 
for multiple individual radionuclides.  When such output is needed, separate MACCS runs are 
required to produce results for each radionuclide.   
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Table 3-5  Results available from ATMOS in CCDF form. 

Selected Radionuclide Centerline Air Concentration (Bq∙s/m3) 

Selected Radionuclide Ground-Level Air Concentration (Bq∙s/m3) 

Selected Radionuclide Centerline Ground Concentration (Bq/m2) 

Total Centerline Ground Concentration (Bq/m2) 

Ground-Level /Q Dispersion Factor (s/m3) (Undepleted) 

Selected Radionuclide Adjusted Source Strength, Qa (Bq) 

Plume y, Crosswind Size (m) 

Plume z, Vertical Size (m) 

Plume Centerline Height (m) 

Plume Arrival Time at Centerpoint (s) 

 
In the Gaussian plume equations, Q is commonly used to represent the amount released.  
When material decays or is deposited on the ground during transport, the effective source 
strength for downwind distances is reduced.  This is treated in MACCS through the definition of 
an adjusted source strength, Qa, which is reduced by deposition and radioactive decay that 

occur over each spatial interval. Note that all of the concentration results shown in this table 

account for plume depletion; however, the value for /Q does not. This quantity simply 

represents reduction in concentration due to dispersion.  
 

 Output Forms and Parameters 3.2.10.1
 
Output Control Form 
The Output Control form is required.  The user has the option of printing tables of dispersion 
data for all of the trials that are performed.  This information includes air and ground 

concentrations, y and z values, arrival time, and time overhead for each plume segment at 
each spatial interval.  These data are written to the output file. 
 
The following variables can be written to the output file using the variable IDEBUG. 
 

Table 3-6  Additional ATMOS output information. 

NUCNAM name of the radionuclide for which results are being presented 

DISTANCE distance from the point of release to the center of the spatial interval (m) 

GL AIRCON centerline ground-level time-integrated air concentration from this plume 
segment averaged over the spatial interval (Bq∙s/m3) 

GRNCON centerline ground concentration after passage of this plume averaged 
over the spatial interval (Bq/m2) 

GL /Q centerline ground-level /Q, the ratio of time-integrated air concentration 

() to source strength (Q), averaged over the spatial interval (s/m3). 
Values reported do not account for plume depletion by deposition or 
radioactive decay. 

WETREM fraction of material remaining in the plume segment after wet deposition 
over the spatial interval (dimensionless) 

DRYREM fraction of material remaining in the plume segment after dry deposition 
over the spatial interval (dimensionless) 

REMINV adjusted source strength of the plume upon entering each spatial 
interval after adjustment for losses in the previous intervals due to 
radioactive decay and wet and dry deposition (Bq) 
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PLSIGY horizontal dispersion parameter, y, averaged over the spatial interval 
(m) 

WEATHER indices to the first and last hours of the weather sequence used for 
determining atmospheric conditions during transport across each spatial 
interval 

HTFCTR ratio of the centerline ground-level air concentration (z=0) to the plume 
centerline air concentration (z=H), (dimensionless) 

AVGHIT average height (H) of the plume as it traversed the spatial interval (m) 

TIMCEN time after reactor shutdown at which the leading edge of the plume 
arrived at the centerpoint of the spatial interval (s) 

TIMOVH duration for which the plume was overhead at the centerpoint of the 
spatial interval (s) 

 
IDEBUG specifies the quantity of debug output to be printed.  For normal runs, IDEBUG should 
be set to 0 and no debug output is printed.  If IDEBUG is set to 1 or 2, detailed results for 
atmospheric transport are generated for each weather trial and each plume segment.  If 
IDEBUG is set to a value of 3 or more, the meteorological data used for each weather trial are 
also printed.    
 
NUCOUT specifies which radionuclide is reported in the dispersion results.  Debug results are 
only reported if IDEBUG is greater than zero. The specified radionuclide name must be in the 
previously defined list of radionuclides. 
 

Variable Name Definable Type Dimensions Allowed Values 

IDEBUG Yes Integer None -1 to 8 

NUCOUT Yes Character None Must select a 
Radionuclide 
defined in vector 
NUCNAM. 

 
Spatial Intervals for Output Form 
The Spatial Intervals for Output form is optional. 
 
NUM0 specifies the number of results.  For each request, a set of ten results describing 
atmospheric transport and dispersion is reported. The value is determined by the number of 
rows in the grid containing values of vectors INDREL, INDRAD, and Report Options. 
 
INDREL specifies the index of the plume segment for which results are to be reported. 
 
INDRAD specifies the index of the radial grid element for which results are to be reported. The 
reported values are evaluated at the radial midpoint of the grid element by averaging the results 
at the grid boundaries. 
 
When Report Options are set to CCDF or CCDF & REPORT, the complementary cumulative 
distribution function data are reported in the MACCS output file. When set to REPORT or CCDF 
& REPORT, WinMACCS automatically generates a report over all realizations based on the 
quantile values specified on the Reporting Options form. 
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Variable Name Definable Type Dimensions Allowed Values 

NUM0 Linked Integer None 0 to 35 

INDREL Yes Integer None 1 to NUMREL 

INDRAD Yes Integer NUM0 1 to NUMRAD 

Report Options Yes Character NUM0 CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 

3.3 EARLY Input and Model Description 
 

 Overview of EARLY 3.3.1
 
The EARLY module models the time period immediately following a radioactive release.  This 
period is commonly referred to as the emergency phase.  It may extend up to 40 days after the 
arrival of the first plume segment at any downwind spatial interval.  The subsequent 
intermediate and long-term phases are treated by CHRONC.  
  
In the EARLY module the user may specify emergency response scenarios that include 
evacuation, sheltering, and dose-dependent relocation.  The EARLY module has the capability 
to combine results from one to twenty different emergency response cohorts. The number of 
cohorts is specified on the Evac/Rotation tab found on the GENERAL main category under 
Properties in WinMACCS.  
 
Results are output for each of the user-defined emergency response cohorts and for a weighted 
sum of the cohorts.  Cohorts may be combined by assigning time fractions (frequencies of 
occurrence), population fractions (fraction of the population engaging in the specified behavior) 
to each cohort, or by a simple summation of the results for each emergency response cohort 
(when a unique population distribution is defined for each cohort).  The weighting method is 
specified from the Project/Site Data tab. 
 
CCDFs calculated for emergency response cohorts combined based on time fractions are a 
function of the probability for each meteorological trial/wind direction multiplied by the time 
fraction applied to the emergency response cohort.  Emergency response cohorts combined 
using population fractions are a function of the consequence calculated for each meteorological 
trial/wind direction multiplied by the fraction of people assigned to the cohort.  The approach 
selected (fraction of people or fraction of time) affects the shape of the CCDF but does not 
affect the mean results. 
 
For results that are calculated by both EARLY and CHRONC, such as population dose and 
cancer cases, the consequence calculated by CHRONC is added to the value of the same 
consequence measure produced by EARLY in order to generate the overall combined results.  
Whenmore than one EARLY emergency response cohort is being run, these results are 
combined according to the weighting fractions supplied for each scenario variable WTFRAC.  
The weighted sum is combined with the CHRONC result to produce the overall result.  MACCS 
models the entire population behaving the same in the CHRONC module, so only one 
CHRONC cohort exists. Whenever results are combined by the code, the output file list the 
overall combined results as well as results for each of the individual cohorts. 
 

 Dose Calculation 3.3.2
 
The calculation of radiation doses from early exposure considers five pathways: (1) direct 
external exposure to radioactive material in the plume (cloudshine), (2) exposure from inhalation 
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of radionuclides in the cloud (cloud inhalation), (3) exposure to radioactive material deposited on 
the ground (groundshine), (4) inhalation of resuspended material (resuspension inhalation), and 
(5) skin dose from material deposited on the skin. 
 
Two kinds of doses are calculated: (1) acute doses used for calculating early fatalities and 
injuries and (2) lifetime committed dose used for calculating cancers resulting from the early 
exposure.  The accumulation of radiation doses from early exposure is strongly dependent on 
the assumed emergency response, that is, evacuation, sheltering, and relocation.  Cloudshine 
and cloud inhalation exposures are limited to the time of cloud passage.  Groundshine and 
resuspension inhalation doses for early exposure are limited to the duration of the emergency 
phase. 
 
In general, the dose equation for an early exposure pathway in a given spatial element is the 
product of the following quantities: radionuclide concentration, usage factor, duration of 
exposure, dose conversion factor, and shielding or protection factor.  The quantities used in the 
dose equations depend on the exposure pathway.  For example, for the cloud inhalation 
exposure pathway, these quantities are the ground-level air concentration within a spatial 
element, breathing rate, duration of inhalation, inhalation dose conversion factor, and inhalation 
protection factor. 
 
The dose conversion factors for all exposure pathways are provided in the dose conversion 
factor files distributed with WinMACCS.  However, the user can modify any of these factors by 
defining constant or uncertain values in WinMACCS.   
 
Dose conversion factors are supplied in one of the following three ways: 
 

 A single, predefined file.  In this case, the linear no threshold model has been selected 
on the Properties/Dose tab.  Files based on DOSFAC2, FGR-11 and -12, and FGR-13 
are distributed with WinMACCS.  The user selects this file from the WinMACCS 
GENERAL main category under File Specifications/Dose Conversion Factor File. 

 A set of 51 predefined files, a base file and a file for each of the 50 years of dose 
commitment.  In this case, the piecewise linear or annual threshold model has been 
selected.  Files based on DOSFAC2 and FGR-13 are distributed.  The user selects a 
base file, e.g., named FGR13DCF.INP, on the form found in the WinMACCS GENERAL 
main category under File Specifications/Annual Differential DCF Files. 

 A single file or 51 files created by WinMACCS based on user input values.  In this case, 
a predefined DCF file or files are used as the basis.  The source of the DCF file is set to 
Create DCF File on the Properties/Dose tab.  Values in the DCF file are modifiable for 
nuclides selected on the DOSE COEFFICIENTS/Reveal Nuclides form.  

A MACCS user has some flexibility in the selection of a dose conversion factor file (DCF).  Files 
based on (1) DOSFAC2, a pre-processer using data from DOE/EH-0070 and tissue weighting 
factors from ICRP-26 and -60; (2) files created using pre-processer utility FGRDCF based on 
Federal Guidance reports 11 and 12, and (3) files based on Federal Guidance Report 13 (FGR-
13). The DCF set based on FGR-13 is the most complete and up to date and is currently 
recommended for most consequence analyses. 
 
As a side note, the International Committee on Radiation Protection (ICRP) traditionally used 
the term dose conversion factors (DCFs) to refer to coefficients that convert activity levels for an 
exposure pathway to doses. The newer ICRP term is dose coefficients. In this document and in 
the WinMACCS interface, the two terms are used interchangeably.  
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The list of organs that can be used in a calculation depends on which DCF file is selected.  
WinMACCS forms show organ doses with an A- or an L- prefix.  Organ doses beginning with A- 
(e.g., A-SKIN) are used for acute exposure doses in the EARLY module; organ names 
beginning with L- (for example L-THYROID) are used for lifetime, 50-year committed doses in 
both the EARLY and CHRONC modules. Internal doses from inhalation for the acute organ 
doses are calculated over a much shorter commitment period than doses for the lifetime organ 
doses. Because of the shorter commitment period, acute doses are less than or equal to lifetime 
doses for the same organ.  
 
The DCF files do not use the A- or L- prefix for the organ names. They contain columns of data, 
some of which correspond to acute and some to lifetime doses. The dose conversion factor 
values, whether for acute or latent exposures, depend on the exposure pathway in the 
calculation.   
 
Though SKIN is listed as an organ in the FGRDCF dose conversion factor file, the numbers for 
SKIN in the DCF are not used in the acute exposure calculation corresponding to A-SKIN.  
Dose to the skin is calculated directly in MACCS based on beta energy depositing in the skin 
from radionuclides that have deposited onto the skin.  This is different than the long-term skin 
dose (L-SKIN), which is calculated using values from the FGRDCF file. To make this distinction 
clear, the lifetime organ dose is labeled L-SKIN(FGR). Lifetime skin doses are genrally 
unimportant in terms of estimating latent cancers and are not included in either of the other DCF 
files. 
 
Organ choices shown on MACCS forms depend on the choice of dose conversion factor file 
type selected on the Properties/Dose tab.  These choices are as shown in Table 3-7. Organs 
not included on this list, even though present in the DCF files, cannot currently be used in 
MACCS calculations. The list of organs that can be used is hardwired within the MACCS code.   
 

Table 3-7  Organ doses defined in MACCS for each type of DCF file. 

DCF based on FGR-13 
DCF generated by 

DOSFAC2 
DCF generated by FGRDCF 

A-SKIN A-SKIN L-GONADS 

A-RED MARR A-RED MARR L-BREAST 

A-LUNGS A-LUNGS L-LUNGS 

A-THYROID A-THYROIDH L-RED MARR 

A-STOMACH A-STOMACH L-BONE SUR 

A-LOWER LI A-LOWER LI L-THYROID 

L-ICRP60ED L-EDEWBODY L-REMAINDER 

L-RED MARR L-RED MARR L-EFFECTIVE 

L-BONE SUR L-BONE SUR L-SKIN(FGR) 

L-BREAST L-BREAST  

L-LUNGS L-LUNGS  

L-THYROID L-THYROID  

L-LOWER LI L-LOWER LI  

L-BLAD WAL L-BLAD WAL  

L-LIVER L-LIVER  

 L-THYROIDH  

 
When a COMIDA2-generated input file is used in a MACCS run, MACCS must use the same 
DCF file as the one used to generate the COMIDA2 file.  The first two header records of the 
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DCF files used by MACCS and COMIDA2 are read and compared to ensure that the two sets of 
calculations used the same DCF file.  This is important when predefined COMIDA2 files are 
used. 
 
The duration of exposure depends on the exposure pathway and the emergency response at a 
spatial element and is calculated based on user-supplied data.  The shielding factor is a 
dimensionless quantity used to reduce the radiation dose as a result of shielding protection 
provided by a given protective action for a given exposure pathway.  Shielding factors for the 
various exposure pathways (cloudshine, inhalation, groundshine, and skin dose) and for three 
different groups of people (evacuees, people doing normal activity, and people taking shelter) 
are specified by the user. 
 
The evacuation model incorporates two delay times that affect the timing of evacuation: one is a 
delay to shelter and the second is a delay to evacuate.  Different shielding factors and breathing 
rates can be used while people continue normal activity, take shelter, or evacuate.  
 
The EARLY calculation accumulates the radiation doses for an evacuating population by adding 
the doses they receive during normal activity, sheltering, and evacuation.  This is done until the 
evacuees reach a user-defined distance where they are assumed to avoid further exposure. 
 
Evacuees receive no additional emergency phase radiation doses after evacuation is complete.  
The CHRONC module allows the user to define dose projection criteria that determine whether 
evacuees return to their original locations during the intermediate and long-term phases.  
Additional radiation doses are calculated in the CHRONC module. 
 
Before a population takes shelter, the members of the population are assumed to be carrying 
out normal activities. Shielding factors (cloudshine, groundshine, inhalation, and skin) for normal 
activity apply to them during this period of time.  When the members take shelter, shielding 
factors for sheltering apply. After they begin to evacuate, shielding factors for evacuation apply. 
The user defines the durations of each of these activities; a null period is possible, e.g., no time 
period for sheltering.  
 
The plume transport model assigns the plume a finite length calculated by using the assumed 
release duration and wind speed(s) during the release.  The length of the plume segment is 
constant following the release (i.e., the front and back of the plume travel at the prevailing wind 
speed), and the concentration of radioactive material is assumed to be uniform over the length 
of the segment.  The radial position of evacuating persons, before or during evacuation, is 
compared with the positions of the front and back of the plume as a function of time to 
determine the period of exposure to airborne radionuclides.  
 
 

 Model Basis 3.3.3
 

 Basic Model Description 3.3.3.1
 
Grid Subdivisions 
The basic nodalization used in MACCS is defined above in the description of the spatial grid in 
the ATMOS section. In addition to this basic grid, a more refined grid, called the fine grid, is 
used in EARLY to calculate off-centerline doses. The fine grid is used both for calculation of 
acute and latent health effects.   
 
Each one of the compass sectors is further subdivided into a number of fine grid divisions. The 
number of fine grid divisions is specified by the user and is allowed to be 3, 5, or 7.  



3-70 

 
The off-centerline correction factor of a fine spatial element for the cloudshine pathway is 
calculated in a different manner than correction factor for the other exposure pathways of the 
emergency phase. For the cloudshine pathway, the off-centerline correction factor within a fine 
spatial element is the finite cloud correction factor discussed below. This finite cloud correction 
factor takes into account both the total distance to the plume centerline and the size of the 
plume. 
 
For cloud inhalation, groundshine, resuspension inhalation, and skin exposure pathways during 
the emergency phase, the Gaussian crosswind distribution is evaluated at the centerpoint of 
each fine grid. The outermost extent of the plume is the azimuthal location where the Gaussian 
distribution falls to one-tenth of its peak, i.e., the outermost fine grid that contains the point 
where the crosswind distance (measured around a circular arc) is (2.15 x σy) from the plume 
centerline. 
 
Weather Sampling and Wind Rose Probabilities  
One of the basic options in MACCS that affects weather sampling is chosen under the 
Evac/Rotation tab. This choice defines the MACCS parameter, IPLUME. These options carry 
two independent concepts for weather sampling: wind shift and rotation. 
 
Wind shift carries the idea of variations in wind direction. Wind shift only matters when a release 
is divided into multiple plume segments. The simplest Gaussian plume methods do not allow 
any variations in wind conditions. These methods treat the entire plume as following along a 
single direction. The MACCS implementation of the Gaussian plume model is more general. 
One of the generalizations is that plume segments are allowed to travel in different directions, 
depending on the directions indicated in the weather data that are being used. For example, 
suppose the wind blows toward the north in the first hour and to the east in the second hour. 
When two plume segments are modeled, each with release duration of one hour, the first plume 
segment travels north. The direction of the second plume segment depends on whether wind 
shift is included in the calculation or not. When it is, the second plume segment travels in the 
direction that the weather data indicate, to the east. When it is not, both plume segments must 
travel in the same direction, to the north. 
 
Rotation is a numerical convenience for squeezing more information out of a set of results 
without significantly increasing the amount of computer time required. Rotation uses wind-rose 
probabilities to expand a result for a single weather trial into a set of NUMCOR results, where 
NUMCOR is the number of compass directions treated in the calculation. For example, suppose 
MACCS performs a weather trial for which the initial wind direction is to the north. When rotation 
is not used, this is the only result that is computed. When rotation is used, NUMCOR results are 
constructed. These results are based on the probabilities that the wind might have blown in 
each of the compass directions, assuming that other weather conditions, e.g., stability class and 
wind speed, are the same. As a simple example, suppose the probability of the wind blowing in 
each compass direction is 1/N. For this case, MACCS constructs the consequences assuming 
that the initial wind direction were toward each of the compass sectors and assigns each result 
a probability of 1/N times the probability that the original weather trials would have had.  
 
The assumption that the conditional probability of a weather trial occurring in any compass 
direction is the same as the wind rose probability for that direction is perfectly reasonable when 
only a single plume segment is modeled. The larger the number of plume segments modeled in 
a calculation, the more dubious this assumption becomes. That is because the inherent 
assumption is that the entire pattern of wind shifts that define a weather trial can occur in any 
direction around the compass, and that the likelihood is only determined by the wind-rose 
probability of the initial wind direction for that weather trial. Thus, for extended releases modeled 
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with a number of plume segments, modeling plume transport without rotation is the preferred 
approach.   
 
There are three options allowed by MACCS, which are defined as follows: 
 

 No Wind Shift with Rotation. In this case, all plume segments follow the same direction 
as each other. However, for each weather trial, results are constructed as though the 
wind had blown in each compass direction. The relative probability of the wind blowing in 
each direction is taken from wind rose data. 

 Wind Shift with Rotation. In this case, all plume segments follow the direction indicated 
by the weather data. Generally, each plume segment can travel in a different direction 
than the other plume segments, depending on the weather data. Wind rose probabilities 
are used to construct N different results where the wind shift pattern is preserved for 
each of these results. For example, suppose that in the initial calculation, plume 
segment 1 travels toward compass sector 1 (north) and plume segment 2 travels toward 
compass sector 2. In the first rotation, plume segment 1 travels toward compass sector 2 
and plume segment 2 travels toward compass sector 3. This pattern continues for each 
of the rotations, until all compass sectors are considered.  

 Wind Shift without Rotation. In this case, wind shift is performed but not wind rotation. 
This is the only option that is allowed when the network evacuation model is selected. 
This is because the computational savings that can be achieved when evacuation 
patterns are the same in any direction around the compass disappear when they are not 
the same in any direction.  

MACCS supports six choices for selection of one or more weather trials. Three of these are 
single weather-trial options; the remaining three are support random sampling from a set of 
annual data. These weather sampling options are described in this section. Specifically, the 
interaction between wind rose data and sampling option is described. 
 

 Constant Weather. Conditions are specified on the Constant or Boundary Conditions 
form. However, the user is not allowed to specify wind direction. When wind rotation is 
not included, wind direction is always to the north. When wind rotation is included, wind 
directions are assumed to be distributed uniformly around the compass.  

 User Supplies 120 Weather Points. Weather conditions are specified on the User 
Supplied Weather form. This form allows the user to specify hourly wind directions, 
which define the wind directions when wind rotation is not used. When wind rotation is 
used, the wind rose is uniform around the compass. 

 Fixed Start Time. This option works exactly the same as the User Supplies 120 
Weather Points option except that the weather data are extracted from the weather file, 
beginning with the hour and time period specified under the Fixed Start Time Data form. 

 Uniform Bin Sampling. Weather data, including wind direction, are taken from the 
weather file. When wind rotation is performed, the default is that a separate wind rose is 
constructed within MACCS for each weather bin. Therefore, the wind rose varies from 
weather trial to weather trial, depending on which weather bin the trial is taken from. 
When OVRRID = True, the data on the Wind Rose Probabilities form are used for all 
weather trials. 
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 Nonuniform Bin Sampling. This option works exactly the same as Uniform Bin 
Sampling, except that the user defines the number of weather samples to be taken from 
each weather bin. 

 Stratified Random Sampling. No weather binning is performed for this option. Instead, 
a user-specified number of weather trials are selected randomly from each weather day. 
Because weather bins are not created, MACCS does not assemble wind rose data. 
Thus, each weather trial is handled similarly as in the User Supplies 120 Weather Points 
option. When wind rotation is not used, wind directions are taken directly from the 
weather file. When wind rotation is used, the wind rose is uniform around the compass. 

Relocation Model Description 
Relocation is a post-accident protective measure designed to limit radiation exposure and is 
implemented in MACCS following plume arrival. The model provides four alternatives for 
relocation, including hot-spot relocation, normal relocation, relocation during the intermediate 
phase, and relocation during the long-term phase.  During the emergency phase, relocation 
occurs at a user-specified time after plume arrival, conditional on a projected dose from 
cloudshine, groundshine, cloud inhalation, and resuspension inhalation that exceeds a user-
specified limit. 
 
MACCS includes the ability to simulate relocation of residents from elevated dose rate areas 
through the hotspot and normal relocation parameters. The user can specify a hotspot 
relocation criterion and a normal relocation criterion. For both relocation criteria, the user 
specifies a dose limit, the critical organ for the dose limit, and a relocation time. MACCS 
requires that the dose for hotspot relocation be greater than or equal to the dose for normal 
relocation and the delay time for hotspot relocation be less than or equal to the delay time for 
normal relocation. The concept is that the segment of the public that would receive larger doses 
would be relocated more urgently than those who would receive smaller doses. 
 
For evaluating the need for relocation during the emergency phase, the dose commitment 
received from the sum of the following dose pathways is considered: cloudshine, inhalation of 
the cloud during plume passage, groundshine, and resuspension inhalation. These doses are 
assessed beginning with the arrival of the first plume segment for the dose-projection period. 
They are based on lifetime doses. 
 
The relocating population is assumed to be in normal activity before relocation. The shielding 
factors for normal activity are used. Once they are relocated, no further dose is calculated for 
them in the EARLY module. Additional doses could be calculated in the CHRONC module. The 
criterion for determining whether or not they return to their original spatial element depends on 
dose projections for the intermediate and long-term phases evaluated in CHRONC. The dose 
projection criterion for the long-term phase is commonly referred to as the habitability criterion.  
 
Emergency Phase Resuspension 
The resuspension model in MACCS is as follows: 
 

RESHAFtRESCONGC /2         (Equation 26) 

 
Where 

C = Air concentration at ground level from resuspension (Bq/m3) 

G = Concentration on ground (Bq/m2) 

t = Time measured from the time of deposition (s) 
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RESCON is the initial value of the resuspension coefficient (m-1) and RESHAF is the 
resuspension coefficient half-life (s). 
 
Keyhole Model 
The standard MACCS evacuation model assumes that the evacuation region is a circular area.  
With keyhole evacuation, the evacuation area is a keyhole shaped area with a circular area 
surrounding the nuclear site and an odd number of sectors projecting out to a larger radius, as 
illustrated in Figure 3-19. The region is defined by the radius of the inner, circular area, the 
number of sectors to evacuate beyond the circular area, and the outer radius of the evacuation 
area.  
 
Initially, the keyhole is centered on the wind direction, as shown by the yellow and purple portion 
of the keyhole in Figure 3-19. The keyhole is expanded as the wind direction changes in 
subsequent hours, as illustrated by the green/orange portion of the keyhole.  
 

 
Figure 3-19  Illustration of a keyhole evacuation model 

 
An additional model concept is to allow the keyhole to be expanded in advance of an actual 
wind shift to account for weather forecasting. This parameter in WinMACCS is defined as 
KEYFORCST. The user must specify the number of hours of weather forecasting to use in the 
model. When the number of hours is four, for example, the model considers the wind directions 
that will occur over the next four hours and expands the size of the keyhole accordingly. 
 
When the check box titled Activate Keyhole Evacuation Model is checked, the forecast interval 
is required as shown in Figure 3-20.  The same forecast interval is used for all evacuation 
cohorts that use keyhole evacuation. This parameter allows the keyhole to be expanded in 
advance of actual wind shifts to account for foreknowledge of weather. The model assumes that 
weather forecasting is perfectly known for the number of hours specified by this parameter. 
When no advance knowledge of weather is to be assumed in the model, the user enters 0. 
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Figure 3-20  Form designating the number of hours of weather forecast data that are 
used to expand the keyhole 

 
 Basic Forms and Parameters 3.3.3.2

 
Early Description Form 
The Early Description form has one variable that contains a short description of the early model. 
This description is printed in the output file. This form is required when Early Consequences are 
selected on the Properties/Scope tab. 
 

Variable Name Definable Type Dimensions Allowed Values 

EANAM1 Yes Character None 1 to 80 characters 

 
Property Form Parameters Form 
The Property Form Parameters form shows how selections under the Properties form define 
some important variables that are required in the EARLY input to MACCS.  The variables on 
this form cannot be changed on this form; they are read only.  Details about these parameters 
are provided in the following paragraphs. 
 
POPFLG determines the source of population data.  The value is set to FILE when the 
population is provided by a file either generated by the preprocessor, SecPop, or in a format 
consistent with SecPop files.  POPFLG is set to UNIFORM when the population is to be treated 
as uniformly distributed. 
 
WTNAM determines the method used for combining results from different cohorts when 
generating overall sums.  The most commonly used values are PEOPLE or TIME.  In these 
cases, the weighting factor for each cohort is determined by the value of variable WTFRAC.  
Results from CHRONC are included as a single, separate cohort, and are simply added to the 
weighted results from EARLY. When WTNAM is set to SUMPOP, the population for each cohort 
is present in the site file under headings POPULATION1, POPULATION2, etc.  Such a site data 
file can be created by hand or using a relatively new feature of WinMACCS described below.  
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KIMODL determines whether consequence calculations consider potassium iodide (KI) 
ingestion.   The value is set to KI when the effect of KI is to be included or to NOKI when they 
are not to be included in a calculation.  When included, variables regarding the percentage of 
the population ingesting KI and its efficacy at reducing thyroid dose must be defined, as 
explained below.   
 
DOSMOD determines which model is used for calculating dose.  The choices are LNT (linear no 
threshold), AT (annual threshold), or PL (piecewise linear).  The simplest and traditional choice 
is the LNT model, for which only one dose conversion factor (DCF) file is required. That file 
contains internal dose coefficients for a 50-year commitment period.  Other choices require 
additional user input for threshold values and a set of 51 dose coefficient files. The additional 50 
files break down the dose-commitment period of 50 years into annual periods.  
 
EVATYP determines the evacuation model.  The choices are NONE, RADIAL, or NETWORK.  
When RADIAL or NETWORK is chosen, further user input to define evacuation behavior is 
required. RADIAL models evacuation as being radially outward within each sector. NETWORK 
allows evacuees to travel from one grid element to any of the four adjacent grid elements.  
 
OVRRID is a flag set to either True or False.  This flag allows the user to override the default 
values used for wind rose probabilities.  When either uniform or nonuniform weather bin 
sampling is selected, by default the wind rose probabilities are calculated from the weather file; 
when OVRRID is set to True, the default wind rose probabilities are replaced by user-specified 
values. When weather binning is not selected, equal probabilities (1/NUMCOR) are assumed for 
each compass direction regardless of the value of OVRRID.  Setting OVRRID to True is 
sometimes done when a meteorological file is not available for the actual site being studied but 
wind rose data are available for the site. This option allows local wind rose characteristics to 
replace those contained in a meteorological data file. It assumes that other weather 
characteristics of the site are similar to those in the file. Wind rose data are only used when 
rotation is chosen (IPLUME = 1 or 2).  
 
IPLUME defines two characteristics regarding plume transport.  When set to 1, no wind shift is 
modeled; when set to 2 or 3, wind shift is modeled.  No wind shift means that all plumes travel in 
the same direction; wind shift means that each plume segment can travel in its own direction.  
The second characteristic is rotation. When IPLUME is set to 1 or 2, rotation is used; when 
IPLUME is set to 3, no rotation is used in the model.   These two concepts, wind shift and 
rotation, are discussed in detail below.  
 
KEYAVAIL determines whether the keyhole evacuation model is an available choice for the 
cohort evacuation.  When KEYAVAIL is equal to KEY_NOT_AVAIL the choices for the cohort 
evacuation are circular or none.  When KEYAVAIL is equal to KEY_AVAIL the choices for the 
cohort evacuation are circular, none or keyhole.  
 

Variable 
Name 

Definable Type Dimensions Allowed 
Values 

Defined on 
Form 

POPFLG Read Only Character None FILE, 
UNIFORM 

Site Data tab 
on Properties  

WTNAME Read Only Character None PEOPLE, 
TIME, 
SUMPOP 

Site Data tab 
on Properties  

KIMODL Read Only Character None KI, NOKI Dose tab on 
Properties  
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Variable 
Name 

Definable Type Dimensions Allowed 
Values 

Defined on 
Form 

DOSMOD Read Only Character None LNT, AT, PL Dose tab on 
Properties  

EVATYP Read Only Character None RADIAL, 
NETWORK, 
NONE 

Evac/Rotation 
tab on 
Properties  

OVRRID Read Only Logical None True, False Wind Rose 
tab on 
Properties  

IPLUME Read Only Integer None 1 to 3 Evac/Rotation 
tab on 
Properties  

KEYAVAIL Read Only Character None KEY_AVAIL, 
KEY_NOT_A
VAIL 

Evac/Rotation 
tab on 
Properties 

 
 

 Basic Model Forms 3.3.3.3
 
Grid Subdivisions Form 
The Grid Subdivisions form is required. NUMFIN is the number of fine-grid subdivisions used by 
the model.  The fine grid is used to improve the resolution of doses in EARLY. This is especially 
important for non-linear dose responses such as early health effects. Each of the grid elements 
is subdivided into NUMFIN fine-grid elements in the azimuthal direction.  NUMFIN is only used 
in the calculations performed by EARLY. Values in CHRONC are averaged over the fine grid.  
 

Variable Name Definable Type Dimensions Allowed Values 

NUMFIN Yes Character None 3, 5, 7 

 
Wind Rose Probabilities Form 
The Wind Rose Probabilities form is required when the user selects User Supplied on the Wind 
Rose tab.   
 
WINROS contains the probabilities of the wind blowing from the site toward each of the 
compass sectors.  Values are listed clockwise on the wind rose starting from the value for north.  
When these values do not approximately sum to unity, the MACCS validation step fails when a 
simulation is run.   
 

Variable Name Definable Type Dimensions Allowed Values 

WINROS Yes Real NUMCOR 0.0 to1.0 

 
Uniform Site Data Form 
The Uniform Site Data form is required when the user selects Uniform on the Site Data tab of 
the Properties form.  This information is required when a site data file is not used. 
 
IBEGIN specifies the spatial interval beyond which the population begins.  Inside of this region 
there are no people, usually representing the exclusion area. 
 
POPDEN specifies the uniform population density of the region. 
 
FRACLD specified the average fraction of the region that is land.  



3-77 

 

Variable Name Definable Type Dimensions Allowed Values 

IBEGIN Yes Integer None 1 to NUMRAD  

POPDEN Yes Real None 0 to 1,000,000 
people/km2 

FRACLD Yes Real None 1×10-6 to 1.0 

 
Population from Site File Form 
The Population from Site File form is active when the user selects “Import from File” on the Site 
Data tab of the Properties Window.  The Population from Site File form contains a table with 
column labels of sector number and rows labeled with values of SPAEND (radial distance).  The 
table contains the total population in each grid element (not divided into cohorts).   
 
Organs of Risk DOSFAC2 Form 
The Organs of Risk DOSFAC2 form is required when the user selects File Created by 
DOSFAC2 on the Dose tab.  
 
ORGNAM is the organ name with the appropriate prefix of A- or L-, where the prefix A- (e.g., A-
LUNGS) indicates an acute dose and the prefix L- (e.g., L-LUNGS) indicates a lifetime (50-year 
commitment period) dose.   
 
ORGFLG specifies whether the associated organ is to be included in the calculations.  When 
the organ is not included in the calculations, health effects related to that organ cannot be 
calculated. 
 

Variable Name Definable Type Dimensions Allowed Values 

ORGNAM No Character 16 N/A  

ORGFLG Yes Logical 16 True, False 

 
Organs of Risk FGR-13 Form 
The Organs of Risk FGR-13 form is required when the user selects File Created from FGR13 on 
the Dose tab.  
 
ORGNAM and ORGFLG have the same meaning as in the Organs of Risk DOSFAC2 form. 
 

Variable Name Definable Type Dimensions Allowed Values 

ORGNAM No Character 15 NA  

ORGFLG Yes Logical 15 True, False 

 
Duration of Early Phase Form 
The Duration of Early Phase form is required. 
 
ENDEMP defines the duration of the emergency phase.  Doses at each spatial interval end after 
ENDEMP seconds from the arrival of the first plume segment at that location. Normally, 
ENDEMP is chosen to be large enough so that all plume segments exit the problem domain. 
The allowed range corresponds to 1 to 40 days.   
 

Variable Name Definable Type Dimensions Allowed Values 

ENDEMP Yes Real None 86,400 to 3,456,000 s 

 
Evacuee Return Time Form 
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The Evacuee Return Time is an optional form.  When this is not defined, MACCS assumes the 
value of TIMRTN is the same as the value specified for ENDEMP. 
 
TIMRTN is defines the elapsed time between the time of evacuation and return back to the 
home for an evacuee whose location on the grid is not affected by any contamination. In 
previous versions of MACCS, this value was assumed to be the duration of the emergency 
phase. TIMRTN allows the user to choose this time.  
 

Variable Name Definable Type Dimensions Allowed Values 

TIMRTN Yes Real None 0 to ENDEMP  

 
Normal Relocation Form 
The Normal Relocation is required. 
  
TIMNRM defines the normal relocation action time after plume arrival. Normal relocation applies 
to individuals residing outside of the evacuation zone and nonevacuees within the evacuation 
zone (everyone who does not evacuate).  Normal evacuation uses a dose projection criterion to 
determine the need to relocate. TIMNRM must be greater than or equal to TIMHOT and less 
than or equal to ENDEMP.  The value of TIMNRM can account for the fact that the initial priority 
is on evacuating the public within the EPZ, for time needed to evaluate releases and project 
doses to the public, and for time needed for the public to receive notification and begin to 
relocate. Relocation is modeled as being instantaneous, so TIMNRM may also account for 
some portion of a realistic relocation time.  
 
The normal relocation dose (DOSNRM), along with the critical organ and dose projection period, 
determines where relocation is required. When total projected dose commitment exceeds 
DOSNRM, people in an area are relocated at the normal relocation time TIMNRM.  DOSNRM 
cannot exceed DOSHOT. 
 
The dose used to evaluate normal relocation is the dose commitment projected for an individual 
who remains in place for the dose projection period (defined below) while engaging in normal 
activity.  The dose pathways used to calculate the projected dose commitment are cloudshine, 
groundshine, direct inhalation, and resuspension inhalation. Any individuals relocated due to 
normal relocation are removed from the problem for the duration of the emergency phase and 
receive no additional dose during this phase. 
 

Variable Name Definable Type Dimensions Allowed Values 

TIMNRM Yes Real None 0 to 3,456,000 s  
(40 d) 

DOSNRM Yes Real None 0 to 1×1010 Sv 

 
Hot Spot Relocation Form 
The Hot Spot Relocation form is required when EARLY is selected on the Scope tab. 
 
TIMHOT defines the hot-spot relocation action time after plume arrival.  Hot-spot relocation 
occurs for individuals residing outside the evacuation zone and those within the evacuation 
zone who do not evacuate.  Hot-spot relocation works similarly to normal relocation but is used 
to prioritize the population at higher risk. TIMHOT must be less than or equal to TIMNRM and 
less than or equal to ENDEMP. The same time elements described for defining TIMNRM also 
apply to TIMHOT.   
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The hotspot relocation dose (DOSHOT) is intended to trigger relocation beyond the evacuation 
area, although it also applies to non-evacuees who reside within the evacuation area.  Areas 
identified for hotspot relocation would usually take priority once evacuation is completed or well 
along and would occur before normal relocation.  When individuals are projected to exceed 
DOSHOT, those people are relocated at the hot-spot relocation time (TIMHOT).  
 
The dose used to evaluate hotspot relocation is the dose commitment projected for an individual 
who remains in place for the dose projection period while engaging in normal activity.  The dose 
pathways used to calculate the dose commitment are cloudshine, groundshine, direct inhalation, 
and resuspension inhalation. Any individuals relocated due to hot-spot relocation are removed 
from the problem for the duration of the emergency phase and receive no additional dose during 
this phase. 
 

Variable Name Definable Type Dimensions Allowed Values 

TIMHOT Yes Real None 0 to 3,456,000 s 
(40 d) 

DOSHOT Yes Real None 0 to 1×1010 Sv 

 
Dose Projection Form 
The Dose Projection form is an optional form.  When this is not defined MACCS assumes the 
value of DPPEMP is the same as the value specified for ENDEMP. 
 
DPPEMP is the dose-projection period for the emergency phase. It defines the dose projection 
period used for normal and hot-spot relocation. A full definition of the dose projection criteria for 
normal and hot-spot relocation includes the dose level (DOSNRM or DOSHOT, respectively), 
the target organ (CRIORG, defined below), the dose projection period (DPPEMP), the 
commitment period for the dose (standard value of 50 years for internal doses), and the set of 
dose pathways that are included, which are cloudshine, groundshine, direct inhalation from the 
plume, and inhalation of resuspended aerosols. The dose projection period begins with plume 
arrival and ends after the time interval specified by DPPEMP. Older versions of MACCS used 
ENDEMP for the dose projection period.  
 

Variable Name Definable Type Dimensions Allowed Values 

DPPEMP Yes Real None 0 to 1×1010 s 

 
 
Emergency Phase Resuspension Form 
The Emergency Phase Resuspension form is required. 
  
RESCON is the linear factor for the emergency phase resuspension concentration factor.   
 
RESHAF is the emergency phase resuspension concentration weathering half-life.  
 

Variable Name Definable Type Dimensions Allowed Values 

RESCON Yes Real None 0 to 1 per m 

RESHAF Yes Real None 1 to 1×1010 s 

 
Keyhole Forecast Form 
The Keyhole Forecast form is required when Activate Keyhole Evacuation Model is checked on 
the Evac/Rotation tab.  
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KEYFORCST defines the advance time for which wind shifts can be reliably forecast by weather 
forecasters, e.g., the National Weather Service. The model expands the number of sectors 
included in a keyhole evacuation, as illustrated in Figure 3-19, KEYFORCST hours before a 
wind shift occurs. This model is currently implemented as if the forecasting were infallible, i.e., it 
uses wind shifts from the recorded meteorological data and these are correct 100% of the time. 
Real weather forecasting is less than 100% reliable, but that is not accounted for in the current 
model. To compensate for the assumption on reliability of forecasting, this value should 
normally be chosen to be a relatively small number of hours.  
 

Variable Name Definable Type Dimensions Allowed Values 

KEYFORCST Yes Real None 0 to 432,000 s 
(5 d) 

 
Cohort Units Form 
The Cohort Units form is required, but it contains a set of default values and the user is not 
required to reset these values. 
 
The default units in MACCS are SI units. This form allows the user to change the units for a set 
of cohort variables for all of the cohorts. Units can be changed on this form for delays, phase 
durations, breathing rate, and evacuation speeds. To avoid confusion when entering input 
values, these units are required to be the same for all cohorts.  
 

Variable Name Allowed Units for 
variable 

DLTSHL (s), (min), (hr), 
(day), (yr) 

DURBEG (s), (min), (hr), 
(day), (yr) 

DLTEVA (s), (min), (hr), 
(day), (yr) 

BRRATE (m3/s), (l/s), (l/day), 
(m3/day), (m3/yr) 

DURMID (s), (min), (hr), 
(day), (yr) 

ESPEED (m/s), (cm/s), 
(km/hr), (mi/hr), 
(in/hr), (mm/hr) 

 
 

 Dose-Response Models 3.3.4
 

 Dose-Response Model Description 3.3.4.1
 
Three optional dose-response models are available to calculate latent-cancer injuries and 
fatalities. The three types of models are illustrated in Figure 3-21.  
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Figure 3-21  Three types of dose-response models for latent cancer health effects 
supported by MACCS 

 
The first uses the standard, linear, no-threshold, hypothesis (LNT). This was the only model 
available in earlier versions of MACCS. In the linear, no-threshold model, the relationship 
between dose and health effects is proportional, even for infinitesimal doses. Even the LNT 
model is not a simple linear function as one might expect. The LNT dose-response function is 
discontinuous and has a change in slope at a dose equal to a threshold dose, as shown in 
Figure 3-21. In the MACCS model, for the purpose of evaluating latent health effects, doses are 
divided by a dose and dose-rate effectiveness factor (DDREFA) for dose levels below the 
threshold but not for doses above the threshold.  
 
Figure 3-21 illustrates the simplified situation where all doses are delivered to an individual 
during the first year (internal doses from inhalation and ingestion have diminished to zero by the 
end of the first year). That means that equivalent organ doses are the same as effective dose. 
This assumption allows all three dose-response models to be compared on the same basis. 
Furthermore, the figure shows a typical dose response when radiation is assumed to be 
uniformly distributed over the body, although this assumption is not essential to the illustration. 
The figure shows typical values of 0.2 Sv for the threshold and a value of 2.0 for DDREFA. The 
solid curve in Figure 3-21 shows the individual risk of a cancer fatality using typical values for 
cancer induction and using the LNT dose-response model.  
 
Effective dose is the term used by ICRP when the weighted sum of equivalent organ doses is 
calculated using ICRP-60 tissue weighting factors. An equivalent organ dose accounts for 
biological damage using a radiation weighting factor, which is generally unity for beta and 
gamma radiation and 20 for alpha radiation. Effective dose is the same in concept as the older 
term of total effective dose equivalent (TEDE). Technically, TEDE is based on older tissue 
weighting factors from ICRP-26. (The latest tissue weighting factors from ICRP are in ICRP-103, 
but these are not currently used in the MACCS dose coefficient files.) 
 



3-82 

The second option for dose-response model is called the annual threshold (AT) model. In this 
model, the user can specify a set of thresholds, one for each year of the calculation. The 
thresholds are specified in terms of effective dose. When the predicted effective dose falls 
below an annual threshold, there are no contributions to any latent cancer health effects; when 
the predicted effective dose exceeds the annual threshold, contributions to health 
consequences are calculated in the same way as with the LNT model. This dose response is 
illustrated in Figure 3-21 for the case that the annual threshold is 0.05 Sv (5 rem).  
 
The third option for dose-response model is called the piecewise-linear (PL) model. In this 
model, the user can construct a series of line segments that define the functional dependence of 
health effects on dose. The line segments are required to form a continuous curve. The user 
defines a multiplicative factor that is applied to the LNT model as a function of annual dose. This 
model can be used to approximate a dose threshold, to create a sublinear dose-response 
model, or to create a supra-linear dose-response model. It cannot be used to construct a 
hormesis model because MACCS does not allow beneficial health effects from radiation 
exposure. Figure 3-21 illustrates a piecewise linear model that is sublinear below 0.1 Sv (10 
rem) and supra-linear between 0.1 Sv and 0.175 Sv (17.5 rem). Above this 0.175 Sv, the 
piecewise linear model is identical to the LNT model.  
 
For the general case where exposures occur over a number of years and internal dose 
pathways potentially deliver a dose over a 50-yr dose commitment period, the model is 
somewhat more complicated. For the two non-LNT models discussed above, annual doses are 
required for each year during the exposure and commitment periods. The models depend on 
the actual dose delivered to an individual during a one-year period, referred to as an annual 
dose. Annual doses account for external radiation received during the year and the first year of 
the commitment period for all internal radiation received during the year. They also account for 
the current year of the dose commitment for internal radiation received in all previous years. 
Once the annual doses are calculated for an individual, the latent cancer risk is the sum of the 
risks over the relevant set of years. In other words, the risk illustrated in Figure 3-21, which is for 
a single year, is summed over all the years for which doses are received by that individual.  
 
Even when radiation is not distributed uniformly over the body, the effective dose is still used to 
determine whether an annual threshold is exceeded. When the threshold is exceeded, 
equivalent organ doses are used to estimate the contributions to cancer risks for each type of 
cancer. Total cancer risks are summations of the cancer types considered in the consequence 
analysis. In Figure 3-21, nonuniform radiation would potentially increase or decrease the cancer 
risks proportionally, depending on the radiosensitivity of the organs receiving larger and smaller 
doses.  
 
The annual threshold model allows for an optional lifetime threshold, which is also based on 
effective dose. When the lifetime threshold is exceeded, the health effects are calculated to be 
identical to those for the LNT model. In that case, dose contributions to health effects are 
counted for all years, no matter how small the dose in a year.  
 

 Dose Model Forms and Parameters 3.3.4.2
 
Annual Threshold Form 
Annual Threshold is required when the user selects Late Consequences on the Scope tab and 
Annual Threshold on the Dose tab. 
 
DTHNUM is number of annual dose threshold values. This value is determined from the number 
of entries for DTHANN.  



3-83 

 
DTHANN is a vector containing the annual dose threshold for latent cancer models.  When 
calculated annual effective dose per person is below the specified threshold, all health 
consequences are zero for that year. The value specified for the last year is used for all 
subsequent years. When a single value is listed, it applies to every year in the exposure period. 
The first entry corresponds to year one, the second to year two, etc. 
 

Variable Name Definable Type Dimensions Allowed Values 

DTHNUM Linked Integer None 1 to 398 

DTHANN Yes Real DTHNUM 0 to 1×1030 Sv/yr 

 
Lifetime Threshold Form 
Lifetime Threshold is optional when the user selects Annual Threshold on the Dose tab. 
 
DTHLIF is the lifetime dose restriction.  When this dose is exceeded, all doses are used to 
estimate health effects the same as with the LNT model, regardless of annual threshold values.   
 

Variable Name Definable Type Dimensions Allowed Values 

DTHLIF Yes Real DTHNUM 0 to 1×1030 Sv 

 
Piecewise Linear Form 
The Piecewise Linear form is required when the user selects Late Consequences on the Scope 
tab and Piecewise Linear on the Dose tab. 
 
PWLNUM is the number of piecewise dose values entered by user. Its value is determined by 
the number of values of PWLDOS and PWLFAC entered by the user.  
 
PWLDOS is the effective dose associated with multiplier, PWLFAC.  Linear interpolation is used 
to calculate a multiplicative factor for an annual effective dose between those supplied by the 
user. Health consequences are calculated for each annual effective dose using the 
multiplicative factor calculated from this model as a multiplier on the LNT model. The health 
effects are summed for all of the annual dose contributions, accounting for the number of 
exposure years and the commitment period for each exposure year, as described above. 
PWLDOS must be specified in ascending order. 
 
PWLFAC is a multiplicative factor associated with PWLDOS.  The last value in vector PWLFAC 
must be one. Above the last dose specified on this form, the LNT model is used.  
 

Variable Name Definable Type Dimensions Allowed Values 

PWLNUM Linked Integer None 2 to 99 

PWLDOS Yes Real PWLNUM 1×10-10 to 1×1030  

Sieverts/year 

PWLFAC Yes Real PWLNUM 0 to 1×1030 

 

 Population by Cohort 3.3.5
 
The characteristics of each evacuation cohort are assigned in the Emergency Cohorts forms.  
The forms in this category allow assigning portions of the population to different evacuation 
cohorts for a given spatial grid element.  First, populations are defined on the Populations forms, 
where a population consists of a fraction of each of the cohorts.  Next, populations are assigned 
to spatial grid elements.  This has the result of defining the population portion of each 
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evacuation cohort that belongs to that grid element.  The total population per grid element is 
defined in the site data file.  See Section 4.4.7.2 for more guidance. 
 
Populations Form 
The Populations form is required when the user assigns SUMPOP to the Results Weighting 
Factor and selects Create from Existing Site File on the Site Data tab.  
 
N_POP_DIST is the number of population distributions entered by the user. 
 
POP_DIST defines the population distributions to be assigned to the evacuation grid.  One 
distribution is entered per row.  Each row should sum to one.  Each column is associated with 
an evacuation cohort.   
 

Variable Name Definable Type Dimensions Allowed Values 

N_POP_DIST Linked Integer None 1 to 90 

POP_DIST Yes Real N_POP_DIST 
by 
NUM_EVAC_
SCEN 

0 to 1.0 

 
Population Labels Form 
The Population Labels form is required when the user assigns SUMPOP to the Results 
Weighting Factor and selects Create from Existing Site File on the Site Data tab. 
 
DIST_SYMB is a single character that will be used to assigned a population to a grid element in 
the spatial grid form. 
 
DIST_LABEL is a descriptive label associated with the population. 
 

Variable Name Definable Type Dimensions Allowed Values 

DIST_SYMB Yes Character N_POP_DIST 1 character 

DIST_LABEL Yes Real N_POP_DIST 1 to 20 characters 

 
Populations Assigned Form 
The Populations Assigned form is required when the user assigns SUMPOP to the Results 
Weighting Factor and selects Create from Existing Site File on the Site Data tab. 
 
The spatial grid form allows the assignment of populations, identified by this symbol 
DIST_SYMB defined on the Population Labels form, to grid elements.  After this form is saved, 
each Population form for every defined cohort will be updated defining the population 
associated with each cohort by spatial grid element.  Before the MACCS simulation is run, a 
new site file is constructed based on each of the Population forms.  This site file is created to be 
compatible with the MACCS SUMPOP option and specifies a separate section defining the 
population for each cohort. 
    
POP_DIST is defined on the Populations form. 
 
DIST_SYMB associates the population distribution with a symbol. 
 
DIST_LABEL is a descriptive label associated with the population 
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COHORT_POP3D is an array defining the population assigned to each of the spatial grid 
elements.  
 
COHORT_POP is the population array associated with cohort one.  There are additional arrays 
associated with each of the cohorts.  
 

Variable 
Name 

Definable Type Dimensions Allowed Values 
Defined on 

Form 

POP_DIST No Real N_POP_DIST 
by 
NUM_EVAC_
SCEN 

0 to 1.0 Populations 

DIST_SYMB No Character N_POP_DIST 1 character Population Labels 

DIST_LABEL No Character N_POP_DIST 1 to 20 characters Population Labels 

COHORT_ 
POP3D 

Yes Character NUMRAD by 
NUMCOR 

1 character Populations 
Assigned 

COHORT_POP Yes Real NUMRAD by 
NUMCOR 

0 to 1×10
9
  Populations 

Assigned 

 

 Emergency Response Cohorts 3.3.6
 
WinMACCS supports up to twenty emergency cohorts.  The number of cohorts is defined on the 
Evac/Rotation tab.  A number of cohort forms are defined in the Emergency Cohort One 
category.  When there is more than one cohort, additional, identical, forms are defined in the 
Additional Emergency Cohorts category.  The form names and parameters are the same in the 
interface.  For example, a critical organ can be specified for each cohort on the Critical Organ 
form.  There is an entry for this form for each of the cohorts.  Each form must be filled out for the 
cohorts defined.  However, data entry can be simplified by selecting Edit/Auto Propagate Cohort 
Values on the main menu as described in Section 4.2.2. 
 

 Emergency Cohort Model Description 3.3.6.1
 
For the purposes of accounting for dose and health effects, the dose received by an evacuee is 
attributed to the location in which the evacuee originates. Evacuees travel from the center of 
one grid element to the center of another in discreet steps. The transit time for an evacuee to 
move from one grid element to another is determined by several input values. Dose calculations 
are performed as though the evacuee is located at the center of one grid element for a period of 
time then suddenly moves to the center of the next grid element along the path of evacuation. 
The top-hat approximation for concentration is used to calculate doses for evacuees, as shown 
in Figure 3-22. 
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Figure 3-22  Top-Hat approximation for plume concentration used for evacuees 
 
The starting point for all evacuees is the center of the element in which they begin. The transit 
time to arrive at the center of the next grid element depends on the choice of the parameter, 
TRAVELPOINT. When this parameter is equal to BOUNDARY, the evacuee is considered to be 
in the next grid element upon crossing the grid boundary; when equal to CENTERPOINT, the 
evacuee is considered to be in the next grid element upon arrival at the center of the destination 
grid element. The following formulae result for the case when TRAVELPOINT = BOUNDARY: 
 

 )2/()( 1, VrrT nnnt    when the evacuee moves radially and resides in the current 

grid element      (Equation 27) 
 

 VrrT nnnt /)( 1,   when the evacuee moves radially and does not reside in the 

current grid element     (Equation 28) 
 

 )2/()( 1, VNrrT nnnt     when the evacuee moves around the compass and 

resides in the current grid element   (Equation 29) 
 

 )/()( 1, VNrrT nnnt     when the evacuee moves around the compass and does 

not reside in the current grid element     (Equation 30) 
 
The following formulae result for the case when TRAVELPOINT = CENTERPOINT: 
 

 )2/()( 11, VrrT nnnt    when the evacuee moves radially outward  (Equation 31) 

 

 )2/()( 2, VrrT nnnt    when the evacuee moves radially inward  (Equation 32) 

 

 )/()( 1, VNrrT nnnt     when the evacuee moves around the compass (Equation 33) 

 
Where 
 Tt,n = transit time through the current grid element. For dose calculations, this value 

is used as the residence time at the center point of the element. The evacuee 
jumps instantaneously from the center point of one element to the next. 
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 rn = the outer radius of grid element n 
 
 V = the speed at which an evacuee moves through an element. This value is 

given by the equation ESPGRDESPEEDV   when no precipitation is 

occurring and by ESPGRDESPMULESPEEDV   when precipitation is 

occurring. ESPGRD corresponds to ESPGRD_RAD or ESPGRD_NET, 
depending on whether radial or network evacuation is selected, respectively. 
The values of  ESPEED and ESPMUL depend on the phase of the 
evacuation period, as described below. The value of ESPGRD depends on 
the grid element through which the evacuee travels. 

 N  = number of compass sectors in the grid, i.e., 16, 32, 48, or 64. 

 
The evacuee’s location as a function of time is compared with the location of the head and tail of 
the plume. For periods of time when the evacuee is located within the plume, the doses from 
direct exposure pathways are accumulated, i.e., cloudshine and direct inhalation of the plume. 
Doses from groundshine and inhalation of resuspended aerosols are always accounted for 
when the evacuee is at a location where the ground is contaminated. 
 

 Emergency Cohort Forms and Parameters 3.3.6.2
 
Basic Parameters 
Basic Parameters are required for each Emergency Scenario category.   
 
EVAKEY determines the algorithm used in evacuation.  CIRCULAR implies all sectors are 
subject to evacuation.  KEYHOOLE limits the number to NSECTR sectors.   NONE means that 
there is no evacuation. The evacuation type is defined under the Project Properties/Evac 
Rotation tab. 
 
EANAM2 is a unique name that identifies the cohort being studied. 
 
WTFRAC is a weight fraction to be applied to results from this emergency response cohort.  
This number is applied to either the fraction of people or the fraction of time, depending on 
whether the Results Weighting Factor is set to PEOPLE or TIME respectively on the Site Data 
tab.  Population weight fractions are applied to results from this emergency response scenario.  
The value is used when combining results for the overall weighted sum over all evacuation 
scenarios. The meaning is dependent on the value of the Results weighting factor defined as 
follows:  

 PEOPLE – WTFRAC represents the fraction of the population that belongs to this 
scenario. 

 TIME – WTFRAC represents the fraction of the time or probability that this scenario is 
applicable. With this option, the entire population follows each scenario a fraction of the 
time. 

 SUMPOP – in this case, the value of WTFRAC must be defined but isn’t used by 
MACCS. Weighting information is taken from population distributions read from the site 
data file.   

 
MACCS Requirement: The values of WTFRAC over all evacuation scenarios must add up to 1.0 
within a tolerance of 0.001. 
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Variable Name Definable Type Dimensions Allowed Values 

EVAKEY No Character None NONE, CIRCULAR, 
KEYHOLE 

EANAM2 Yes Character None 1 to 80 characters 

WTFRAC Yes Real None 0.0 to 1.0 

 
Phase Durations and Speeds 
This form is required for Emergency Cohort One and any subsequent cohorts when the 
evacuation type is circular or keyhole.  
 
The evacuation period is divided into three phases defined by DURBEG, DURMID, and the 
remainder of the emergency phase, as defined by ENDEMP-(DURBEG+DURMID).  The 
purpose for the evacuation phases is to allow the option of having the evacuation speed 
parameters vary over time. 
 
REFPNT defines the reference time point for actions in the evacuation and sheltering zone.  
The user may choose to have the reference time at ALARM (OALARM) or ARRIVAL which 
refers to the arrival time of the first plume.  When using a keyhole evacuation, ALARM is the 
only legal choice for this variable.  
 
TRAVELPOINT determines whether evacuees move from a spatial element when they cross 
the boundary between the two elements (BOUNDARY) or when they reach the center point of 
the destination element (CENTERPOINT). 
 
DURBEG is the duration of the initial phase of evacuation.  This phase starts when the cohort in 
the shelter and evacuation region begins to evacuate, which is defined by the minimum over all 
radial distances (i) of DLTSHL(i)+DLTEVA(i) after the time designated by REFPNT. The 
evacuation speed used during this phase is the initial value of ESPEED. Additionally, each 
cohort can be designated a DURBEG duration characteristic of that cohort.  
 
DURMID defines the duration of the middle phase of the three phases of evacuation.  The 
evacuation speed used during this phase is the middle value of ESPEED. The evacuation 
speed used during the final phase, which extends until evacuation is complete or until the end of 
the emergency phase, is the third value of ESPEED. Additionally, each cohort can be 
designated a DURMID duration characteristic of that cohort.  
 
The initial evacuation phase begins when the first individual begins to travel out of the region.  
The durations of the initial and middle phases of the evacuation are defined by input variables 
DURBEG and DURMID. The late phase of the evacuation extends as long as necessary for all 
individuals to complete their travel or until the end of the emergency phase. 
 
Vectors ESPEED and ESPMUL contain a set of values that correspond to each of the three 
evacuation phases. 
 
ESPEED is the travel speed of the evacuees.  Three values are required, one for each of the 
evacuation (travel) phases as follows: initial, middle and late.  MACCS requires that all three 
values be the same when TRAVELPOINT is set to BOUNDARY. 
 
ESPMUL is the multiplicative factor that affects ESPEED.  This factor is applied during times of 
precipitation.  Weather prior to release is assumed to be the same as at the beginning of 
release, which affects cases in which the evacuation begins before release. Precipitation data 
are from HRRAIN, BNDRAN, or the meteorological file, depending on the weather option.  The 
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value of evacuation speed in an element is calculated with the following formula where 
ESPGRD is the speed multiplier (supplied in another form): 
 
Evacuation Speed = ESPEED * ESPMUL * ESPGRD  when precipitation is occurring  
Evacuation Speed = ESPEED * ESPGRD    when no precipitation is occurring  
 
ESPEED is defined for each of the three sub-phases (initial, middle, and late) of the emergency 
phase, but are independent of grid elements. ESPGRD, a speed multiplier defined on the forms 
Radial Evacuation Speed or Network Evacuation Speed, is independent of the sub phase, but is 
defined for each grid element.  When ESPGRD is not defined because Activate Speed Multiplier 
Model has not been selected on the Project Properties/Evac Rotation tab, a value of one is 
assumed. 
 
Three values are required, one for each of the evacuation (travel) phases as follows: initial, 
middle, and late.  MACCS requires that all three values must be the same when TRAVELPOINT 
is equal to BOUNDARY. 
 

Variable Name Definable Type Dimensions Allowed Values 

REFPNT Yes Character None ALARM, 
ARRIVAL 

TRAVELPOINT Yes Character None BOUNDARY, 
CENTERPOINT 

DURBEG Yes Real None 0.0 to 86400.0 s 

DURMID Yes Real None 0.0 to 86400.0 s 

ESPEED Yes Real 3 1.0x10-6 to 1.0x106 
m/s  

ESPMUL Yes Real 3 0.0 to 1.0 

 
Critical Organ 
This form is required for Emergency Cohort One and any subsequent cohorts. 
 
CRIORG is the critical organ for relocation decisions during the emergency phase.  People 
remain in the grid element when the projected total committed dose to the critical organ is less 
than the values described relocation. 
 

Variable Name Definable Type Dimensions Allowed Values 

CRIORG Yes Character None Must select an 
Organ name. 
Choice will be 
depend on DCF file.    

 
KI Ingestion Linear No Threshold 
This form is required for Emergency Cohort One and any subsequent cohorts when the Linear 
No Threshold dose model and the Activate KI Model are selected on the Dose tab. 
 
The KI ingestion model treats the reduction of uptake of radioiodine by the thyroid gland. The 
ingested KI saturates the thyroid gland so that the effect of inhaling iodine from a plume is 
diminished. The KI ingestion model allows the user to specify a population fraction that ingests 
KI and an efficacy factor. The efficacy factor defines the fractional dose reduction to the thyroid 
gland from inhaled radioiodine. 
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POPFRAC is the fraction of the population that ingests KI.  A fractional portion of the population 
ingesting KI is allowed when the linear no threshold dose model is used. 
 
EFFACY is a factor used to reduce the dose to the thyroid from inhalation of radioactive iodine.  
The dose is reduced by a factor of (1 - EFFAC) ×  POPFRAC. 
 

Variable Name Definable Type Dimensions Allowed Values 

POPFRAC Yes Real None 0 to 1 

EFFACY Yes Real None 0 to 1 

 
KI Ingestion Threshold or Piecewise 
This form is required for Emergency Cohort One and any subsequent cohorts when the Annual 
Threshold or Piecewise Linear dose model and the Activate KI Model are selected on the Dose 
tab. 
 
POPFRAC is the fraction of the population that ingests KI.  When the piecewise linear or annual 
threshold dose model is used, either all of the population or none of the population ingest KI.   
 
EFFACY is a factor used to reduce the dose to the thyroid from inhalation of radioactive iodine.  
The dose is reduced by a factor of (1 - EFFAC) when the population ingests KI. 
 

Variable Name Definable Type Dimensions Allowed Values 

POPFRAC Yes Real None 0 or 1 

EFFACY Yes Real None 0 to 1 

 
Sheltering and Evacuation Boundary 
This form is required for Emergency Cohort One and any subsequent cohorts when the 
evacuation type is circular or keyhole. However, when the Radial Evacuation Speed, Network 
Evacuation Direction or the Network Evacuation Speed forms are used for any of the additional 
Emergency Scenario categories, this form must be completed first for that emergency scenario 
category.  
 
LASMOV indicates the outer boundary at which evacuees are assumed to disappear from the 
early health effects model and receive no further dose.  MACCS requires that the value be 
greater than or equal to NUMEVA. 
 
NUMEVA defines the outer boundary of the sheltering and evacuation region (also known as 
the emergency planning zone).  While LASMOV defines the outer boundary of the region that 
shelterees reside and evacuees traverse, NUMEVA defines the outer boundary of the sheltering 
and evacuation region, i.e., the emergency planning zone.  MACCS requires that NUMEVA be 
no larger than LASMOV.  For example, in a simple problem, the population within a 10 mile 
radius of the nuclear power plant is ordered to evacuate.  We can assume that there will be a 
percentage of the population outside the 10 mile radius who will elect to evacuate on their own 
free-will. This is referred to as a shadow evacuation.  Typically, a shadow evacuation is 
observed within a five miles radius of the declared evacuation zone.  Even though we wouldn’t 
assume population beyond 15 miles evacuates in this simple problem, we would want to model 
the population beyond that distance to quantify any dose they may receive.  For this simple 
example, we could model the population out to 50 miles from the plant.  So for this example, 
NUMEVA would equal 15 miles and LASMOV would be set at 50 miles.   
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Variable Name Definable Type Dimensions Allowed Values 

LASMOV Yes Integer None 1 to NUMRAD 

NUMEVA Yes Integer None 1 to NUMRAD 

 
Shielding and Exposure 
This form is required for Emergency Scenario One and is also required for each additional 
Emergency Scenario category. 
 
This section defines the shielding factors for exposure to cloudshine, groundshine, inhalation 
and deposition onto skin for three types of activities: normal activity, evacuation, and sheltering.  
A breathing rate is also specified for each type of activity.  When the evacuation type for 
scenario one is turned off, normal activity values are used. 
 
The CHRONC module requires input for the inhalation protection factor (CHRONC variable 
LPROTIN), the breathing rate (CHRONC variable LBRRATE) and the ground shine (CHRONC 
variable LGSHFAC).  A reasonable choice for these values would be the values used in EARLY 
for normal activity. 
 
Each variable in the section must be defined for each of the three sub-phases (evacuation, 
normal, and sheltering) of the emergency phase. 
 
CSFACT is the cloudshine shielding factor. This value is used as a multiplier on the value of 
cloudshine dose that would have been received when the person were standing outside. A 
value of 0 indicates complete shielding; a value of 1 indicates no shielding. 
 
PROTIN is the inhalation protection factor. This value is used as a multiplier on the value of 
inhalation dose that would have been received if the person were standing outside. A value of 0 
indicates complete protection from inhalation of radioactive materials; a value of 1 indicates no 
protection. 
 
BRRATE is the breathing rate. 
 
SKPFAC is the skin protection factor. This value is used as a multiplier on the value of skin dose 
that would have been received if the person were standing outside. A value of 0 indicates 
complete protection from aerosol deposition onto the skin; a value of 1 indicates no protection. 
 
GSHFAC is the groundshine shielding factors. This value is used as a multiplier on the value of 
groundshine dose that would have been received if the person were standing outside and the 
ground were a perfectly flat surface. A value of 0 indicates complete shielding from 
groundshine; a value of 1 indicates no protection. 
 

Variable Name Definable Type Dimensions Allowed Values 

CSFACT Yes Real 3 0.0 to 1.0 

PROTIN Yes Real 3 0.0 to 1.0 

BRRATE Yes Real 3 0.0 to 1.0 m3/s 

SKPFAC Yes Real 3 0.0 to 1.0 

GSHFAC Yes Real 3 0.0 to 1.0 

 
Response Delays 
This form is required for Emergency Scenario One and is also required for each additional 
Emergency Scenario category. 
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This form defines the delay from the time indicated by REFPNT until the beginning of sheltering 
and the delay from the beginning of sheltering until the beginning of evacuation. 
 
DLTSHL defines the delay from the time represented by REFPNT to the start of sheltering.  
Normal activity shielding factors are used during this delay.  Sheltering shielding factors are 
used following this delay. One number is supplied for each ring in the shelter/evacuate region. 
 
DLTEVA defines the delay from the beginning of the sheltering period to the beginning of 
evacuation. Sheltering is assumed during this delay. Evacuation shielding factors are used 
following this delay. One number is supplied for each ring in the shelter/evacuate region. 
 

Variable Name Definable Type Dimensions Allowed Values 

DLTSHL Yes Real NUMEVA 0 to 3.456 x 106 s or 
40 days 

DLTEVA Yes Real NUMEVA 0 to 3.456 x 106 s or 
40 days 

 
Radial Evacuation Speed 
This form is required for Emergency Scenario One when the Problem Model selected is Radial 
and Activate Speed Multiplier Model is selected on the Project Properties/Evac Rotation tab. 
This form is required for each additional Emergency Scenario category when evacuation type is 
circular or keyhole and Activate Speed Multiplier Model is selected. 
 
ESPGRD_RAD defines the speed multiplier for each grid element where evacuation is allowed.  
This includes all grid elements from the center to the outer boundary of the evacuation 
movement, LASMOV, after which evacuation is no longer considered.  A value of one indicates 
the speed is the same as the value of ESPEED. The ranks of these numbers are shown in the 
interface.  See Section 4.4.7 for more information. 
 

Variable Name Definable Type Dimensions Allowed Values 

ESPGRD_RAD Yes Real LASMOV 
by 

NUMCOR 

0.001 to 1000.0 

 
Network Evacuation Direction 
This form is required for Emergency Scenario One when the Problem Model selected is 
Network is selected on the Project Properties/Evac Rotation tab. This form is required for each 
additional Emergency Scenario category when evacuation type is circular or keyhole. 
 
ESPGRD_NET is a read-only variable on this form and is defined on the form Network 
Evacuation Speed. When this variable is undefined, a value of 1 is displayed for both the rank 
and the value of the speed multiplier.  
 
IDIREC defines the evacuation direction.  A value of one indicates an outward evacuation to the 
next grid element, two indicates clockwise evacuation, three indicates inward evacuation, and 
four indicates counter clockwise evacuation.  These numbers are input in the interface as 
arrows that can be clicked on to change the evacuation direction. 
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Figure 3-23  IDIREC Values in network evacuation grid 
 

Variable 
Name 

Definable Type Dimensions Allowed Values Defined on Form 

ESPGRD_NET No Real LASMOV 
by 

NUMCOR 

0.001 to 1000.0 Network 
Evacuation Speed 

IDIREC Yes Integer LASMOV 
by 

NUMCOR 

1 to 4 Network 
Evacuation 
Direction 

 
Network Evacuation Speed 
This form is required for Emergency Scenario One when the Problem Model selected is 
Network and Activate Speed Multiplier Model is selected on the Project Properties/Evac 
Rotation tab. This form is required for each additional Emergency Scenario category when the 
evacuation type is keyhole or circular and Activate Speed Multiplier Model is selected.  This set 
of variables is useful for adjusting speeds for bottlenecks in the road network or for areas of 
freely flowing traffic compared with the base speeds of the cohort in the three phases. 
 
ESPGRD_NET defines the speed multiplier for each grid element where evacuation is allowed.  
This includes all grid elements from the center to the outer boundary of the evacuation 
movement, LASMOV, after which evacuation is no longer considered.  A value of one indicates 
the speed is the same as the value of ESPEED. The ranks of these numbers are shown in the 
interface.  See Section 4.4.7 for more information. 
 
IDIREC is a read-only variable on this form as is defined on the form Network Evacuation 
Direction.  A value of one indicates an outward evacuation to the next grid element, two 
indicates clockwise evacuation, three indicates inward evacuation, and four indicates counter 
clockwise evacuation.  These numbers are shown in the interface as arrows that display the 
direction of evacuation.  
 
This data is indirectly input using the spatial grid as a background.   
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Variable Name Definable Type Dimensions Allowed Values Defined on Form 

ESPGRD_NET Yes Real LASMOV 
by 

NUMCOR 

0.001 to 1000.0 Network 
Evacuation 
Speed 

IDIREC No Integer LASMOV 
by 

NUMCOR 

1 to 4 Network 
Evacuation 
Direction 

 
Population 
The Population form is relevant for each emegergency cohort category when the user assigns 
SUMPOP to the Results Weighting Factor and selects Create from Existing Site File on the Site 
Data tab.  After the Populations Assigned form is completed, the Population form is updated.  
The values shown are the number of people assigned to each spatial grid element for the given 
cohort category. 
  
COHORT_POP defines the number of people assocated with each spatial grid element in the 
given cohort. 
 

Variable Name Definable Type Dimensions Allowed Values Defined on Form 

COHORT_POP No Real NUMRAD 
by 

NUMCOR 

0 to 1×109 Populations 
Assigned 

 
Keyhole Definition 
The Keyhole Definition form is required when the evacuation Type field is set to Keyhole. 
 
NSECTR defines the number of sectors to be considered in the keyhole evacuation.  This 
number should not exceed NUMCOR/2 – 1. 
 
KEYDIS is the radius of the circular portion of the keyhole.  The radius is the index into 
SPAEND.  The outer radius of the evacuation region is defined by NUMEVA.  Setting KEYDIS 
to zero eliminates the circular portion of the keyhole.  Setting KEYDIS to NUMEVA eliminates 
the key portion of the keyhole. 
 

Variable Name Definable Type Dimensions Allowed Values 

NSECTR Yes Real None 1, 3, 5, 7, …, 31 

KEYDIS Yes Integer None 0 to NUMEVA 

 
 

 Early Fatality and Injury Parameters 3.3.7
 

 Fatality Model Description 3.3.7.1
 
The individual risk of prompt fatality is modeled in MACCS using a two-parameter Weibull 
function, termed a hazard function (Evans, Moeller, and Cooper, 1985).  The hazard function is 
used to sum the cumulative risk from a number of potential types of damage as follows: 
 

 





i

iH

eRISK 1          (Equation 34) 

 
Where  
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EFFACA

DOSE
0.693=H

EFFACB

 

 
 DOSE  =  effective acute dose to the target organ (described later), 
 
 EFFACA  =  the alpha (LD50) parameter in the hazard function (Evans, Moeller, 

and  Cooper, 1985, p. II-8), and 
 
 EFFACB  =  the beta or exponential parameter in the hazard function that defines 

the steepness of the dose-response function. 
 
In addition to the two Weibull parameters, a dose threshold is incorporated into the early fatality 
model.  When the dose to any of the target organs is below the user-specified threshold (see 
EFFTHR below), the hazard function (H) for that organ is set to 0. 
 
When radioactive material is inhaled and retained in the respiratory system, an individual may 
continue to receive a radiation dose for long periods of time after the material was inhaled.  
Depending on particle size and chemical form, clearance mechanisms may remove the material 
from the body or transport it from the respiratory system to other organs of the body.  For this 
reason, reference to a radiation dose needs to include the time period of interest (commitment 
period).  The concept of lifetime dose commitment is widely used in radiation protection 
(Eckerman, Wolbarst, and Richardson 1989), but is not appropriate for estimating acute health 
effects.   
 
As applied in MACCS, lifetime dose refers to the dose received over the 50-year period 
following inhalation by a standard reference person who is 30 years old.  This lifetime dose is 
used to determine the need for mitigative actions and to calculate cancers and population dose. 
 
Implementation of the Evans, Moeller, and Cooper (1985) early health effects models requires a 
calculation method that takes account of dose protraction for radioactive material inhaled and 
retained in the respiratory system.  MACCS applies dose reduction factors to protracted doses 
that contribute to early health effects.  Dose reduction factors are derived from LD50 or D50 
values that apply to a sequential set of time periods of fixed length.  In addition, for the 
calculation of early fatalities and injuries in MACCS, a new measure of dose was defined in 
order to reduce the computational demands of the calculations.  Throughout this document it is 
referred to as effective acute dose. This dose is different than the effective dose defined by 
ICRP. 
 
The effective acute dose, De, is the dose which if it were delivered entirely in 1 day, would 
induce the same health effects as an actual dose delivered over many days.  Thus, 
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Where  
 De  = C ∙ Fe  
 Dt  = C ∙ Ft 
 C  = the amount of material inhaled from the plume,  
 Fe  = the effective acute dose conversion factor, 
 Ft  = the dose conversion factor for the actual dose, Dt, delivered in time period t.   

 t  = the LD50 or D50 for time period t. 
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 1  = the LD50 or D50 for time period of 1 day. 
 
Substitution yields the following result: 
 

 F Fe

tt
t














1  .         (Equation 36) 

 
Effective acute dose conversion factors are supplied only for the organs used for calculating the 
early health effects.  The acute dose commitment period from inhaled and internally deposited 
radionuclides is from 1 week to 1 year, depending on the organ.  The organs in the dose 
conversion factor file for which effective acute dose coefficients have not been assessed are 
assigned values of –1.0, which prevents their inadvertent use since any resulting doses would 
be negative.  
 

 Time Period after Initial Exposure (Days) 

 0–1 1–7 7–14 14–30 30–200 200–365 

 Effective Acute Dose Reduction Factors (1 /t) 
 RED MARR 1.0 0.5 0.5 0.25   

LUNGS 1.0 0.0625 0.0625 0.027 0.027 0.0109 

THYROID 1.0 0.2 0.2 0.2   

STOMACH 1.0 0.37     

LOWER LI 1.0 0.43     

SMALL IN 1.0 0.43     

 
 
A MACCS DCF preprocessor, DOSFAC2, allows the user to modify the acute dose reduction 
factors. The dose reduction factors that are contained in the dose file supplied with WinMACCS 

(i.e., 1/t) applied in the effective acute dose calculations are shown in the table above. 
 
For early fatalities (with supportive treatment) for bone marrow irradiation, Evans, Moellen, and 
Cooper (1985) show LD50 values of 4.5 Gy for the 0-  to 1-day time period, 9 Gy for the 1-  to 
14-day time period, and 18 Gy for the 14-  to 30-day time period.  Instead of calculating three 
different red marrow doses and applying the three different values of LD50 to calculate risk, a 
single red marrow dose is calculated using the effective acute dose conversion factor, as 
described above. The result is equivalent to the one that would have been obtained if committed 
doses over all three time periods had been obtained and Equation (35) had been used directly.  
 
So, according to the above table, effective acute red marrow dose is 100% of the first day's 
dose, 50% of the next 13 days' dose, and 25% of the subsequent 16 days' dose.  This acute 
dose is used in the risk equation with the LD50 for the 0- to 1-day time period to obtain the 
hazard to bone marrow. 
 
The dose protraction effect described here is used only for internal exposure from inhalation.  
Dose from the direct exposure pathways in EARLY (groundshine and cloudshine) are summed 
with no reduction factor even when the exposure lasted more than 1 day.  In other words, 
external doses are treated as though they had occurred in a single day. The current 
implementation of the early health effects models does not distinguish among cloudshine, 
groundshine, and the 0-  to 1-day inhalation dose commitment.  They are considered in this 
model to be equally effective in causing damage. Finally, the radiation weighting factor used for 
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acute alpha radiation is 10 instead of the conventional value of 20 used for lifetime dose 
conversion factors.  
 
The error introduced by attributing the entire direct exposure dose to the first day is small and is 
in the direction of overestimating the hazard function and resulting value of risk of an early 
fatality.  In most cases, emergency plans should ensure that no individuals are permitted to 
remain on contaminated ground for much longer than one day when dose levels are high 
enough to pose a risk of early health effects. 
 
Resuspension inhalation is another area where the importance of the pathway is overestimated 
somewhat.  The inhalation dose from resuspended material is treated identically to the 
inhalation dose from direct inhalation of the plume.  That is, it is treated as though all the 
resuspended material was inhaled during the first day of the exposure period.  
 
Information in this section is used only to control the calculation of individual risk.  Risks to be 
processed (e.g., total cases of early fatality, average individual risk of early fatality, and 
centerline risk vs. distance of early fatality) are described in later sections of this document.  In 
order for the code to produce early fatality results, the early fatality model must be activated.  
 

 Injury Model Description 3.3.7.2
 
The individual risk of each type of early injury is modeled in MACCS using an approach 
analogous to that used for early fatality risk (Evans, Moller and Cooper 1985).  The early injury 
risk model differs from the early fatality model in that, instead of summing the damage from 
more than one organ, only a single organ is evaluated.  The early injury risk function is as 
follows: 
 
 RISK = 1–e-H          (Equation 37) 
 
Where  

 H = 0.693
DOSE

EIFACA

EIFACB






  

 
 DOSE =  effective acute dose (described in 3.3.7.1 Fatality Model Description) 

to the target organ, 
 
 EIFACA  =  the alpha (D50) parameter in the hazard function (Evans, Moller and 

Cooper 1985, p. II-8), and 
 
 EIFACB  =  the beta or exponential parameter in the hazard function that defines 

the steepness of the dose-response function. 
 
In addition to the two Weibull parameters, a dose threshold is incorporated into the early injury 
model.  When the dose to any of the target organs is below the user-specified threshold (see 
EITHRE in the following discussion), the hazard function for this type of early injury is set to 0, 
which results in the risk being zero. 
 
In addition to the values described above, the user must specify the fraction of the population 
that is susceptible to the injury, EISUSC.  Information in this section is used only to control the 
calculation of individual risk.  Risks to be processed ( e.g., total cases of a given injury, average 
individual risk of a given injury, and centerline risk vs. distance of a given injury) are described in 
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later sections.  In order for the code to produce early injury results, the injuries must be 
activated. 
 

 Latent Cancer Model Description 3.3.7.3
 
The cancer risk model included in the first public release version of MACCS was based on a 
linear-quadratic risk model.  In response to recommendations presented in an NRC-sponsored 
reassessment of cancer risk models published in 1991 and referred to as LMF-132 
(Abrahamson et al. 1991), the cancer risk model was updated in MACCS version 1.5.11.1 
(Chanin et al. 1993) to include linear, not-threshold dose-response function.  The capability to 
exercise the linear-quadratic risk model was retained although it is not typically used at present 
for calculation of cancer induction risk. 
 
Linear-Quadratic Dose-Response Model 
The linear-quadratic dose-response model assumes that risk, R, increases linearly with 
increases in dose, D, at low doses and that risk increases quadratically with respect to dose at 
higher dose levels.  The linear-quadratic dose-response function is of the form (International 
Commission on Radiological Protection 1991): 
 
 D).(aDR(D)           (Equation 38) 

 
The implementation of the linear-quadratic dose-response model in MACCS 1.5 is based on the 
recommendations of NRC-sponsored work (Evans 1990) and is described as follows.  In the 
period modeled by EARLY, a quadratic dose-response relationship is used when dose to the 
target organ is less than a user-specified limit (MACCS ACTHRE input parameter). The dose-
response function used in this case has the form: 
 
 R(D) = DOSE • CFRISK • (DOSEFA + DOSE • DOSEFB) • ACSUSC  (Equation 39) 
 
Where 
 DOSE = 50-year lifetime dose commitment to the target organ, 
 CFRISK = lifetime risk factor for cancer injury, 

 DOSEFA = the linear factor, , of the dose dependence, 

 DOSEFB = the quadratic factor, , of the dose dependence, and 
 ACSUSC = fraction of the population susceptible to the latent cancer. 
 
When dose to the target organ is greater than the dose limit ACTHRE, the upper-bound linear 
dose-response relationship is used: 
 
 R(D) = DOSE • CFRISK • (DOSEFA + ACTHRE • DOSEFB) • ACSUSC  (Equation 40) 
 
The change from Equation (39) to (40) at the threshold value causes a discontinuity in the slope 
but not of the risk factor itself.  
 
During the long-term phase modeled by CHRONC, it is assumed that exposure of the 
population is limited to low levels by mitigative actions and therefore the quadratic term of the 

risk equation is ignored.  Cancer risk is calculated using only the linear term, R(D) = D, of the 
quadratic dose response function.  Cancer risk from all pathways (groundshine, resuspension 
inhalation, and ingestion) is modeled with the linear dose-response function given below: 
 

R(D)= DOSE • CFRISK • DOSEFA • ACSUSC     (Equation 41) 
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The meaning of DOSE and CFRISK depends on whether individual risk (groundshine and 
resuspension) or collective risk (also including ingestion and decontamination worker doses) is 
being calculated. 
 
The quadratic form of the dose-response relationship is deactivated by assigning a 0 to the 
MACCS ACTHRE input parameter. 
 
Dose and Dose-Rate Effectiveness Factor 
In response to recommendations presented in LMF-132, the MACCS cancer risk model was 
updated in MACCS version 1.5.11.1 to include a dose and dose-rate effectiveness factor in the 
dose-response function as follows: 
 

DDREF

D
R(D)      D < 0.2 Gy or 0.1 Gy per hour   (Equation 42) 

 

DR(D)       D > 0.2 Gy or 0.1 Gy per hour 

 
This function is shown as the LNT curve in Figure 3-21. DDREF is the dose and dose rate 
effectiveness factor.  The LMF-132 report states that the DDREF is to be applied "when the total 
dose is less than 0.2 Gray, and for higher doses when the dose rate is less than 0.1 Gray per 
hour."  This guidance for the application of the DDREF is identical to the recommendations 
provided in ICRP 60.  The DDREF is given a value of 2 in LMF-132 for central estimates of most 
cancer types.  In contrast, for central estimates of breast and thyroid cancers the DDREF is 
assigned a value of 1 in LMF-132.   
 
The user defines the lifetime dose commitment, input parameter DDTHRE, to which the DDREF 
is applied to cancer risk calculations for emergency phase exposures.  MACCS applies the 
DDREF to all of the dose calculations in the CHRONC module because exposures should 
always be less than 0.1 Gy per hour after the end of the emergency phase. 
 

 Injury and Fatality Forms and Parameters 3.3.7.4
 
Early Fatality Parameters Form 
The Early Fatality Parameters form is not needed when the dose conversion factor file FGRDCF 
is selected on the Project Properties/Dose tab or when Early Fatality Effects is not checked on 
the Project Properties/Early Effects tab. It is required when either of the other dose conversion 
factor file types is selected and Early Fatality Effects is checked.  
 
NUMEFA is the number of early fatality effects to be included in the total risk of early fatality. 
 
ORGNAM is an organ name.  The possible values depend on the DCF file chosen.  Possibilities 
are limited to supported acute organs (ones beginning with A-).   
 
EFFACA is the Alpha factor (LD50) in the hazard function for the target organ. 
 
EFFACB is the beta factor (shape parameter) in the hazard function for the target organ. 
 
EFFTHR is the threshold dose below which the risk of a fatality is zero. 
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Variable Name Definable Type Dimensions Allowed Values 

NUMEFA Linked Integer None 1 to 5 

ORGNAM Yes Character NUMEFA Acute Organ name 
from list in Table 3-7 

EFFACA Yes Real NUMEFA 1.0 to 100. Sv 

EFFACB Yes Real NUMEFA 1.0 to 100.0 

EFFTHR Yes Real NUMEFA 0.0 to 100.0 Sv 

 
Early Injury Parameters Form 
The Early Injury Parameters form is not needed when the dose conversion factor file FGRDCF 
is selected on the Project Properties/Dose tab or when Early Injury Effects is not checked on the 
Project Properties/Early Effects tab. It is required when either of the other dose conversion 
factor file types is selected and Early Injury Effects is checked. 
 
NUMEIN is the number of different types of early injuries that are to be calculated. 
 
EINAME is the name of each type of early injury.  This is a user defined label. 
 
ORGNAM is an organ name.  The possible values depend on the DCF file chosen.  Possibilities 
are limited to acute organs.   
 
EISUSC is the fraction of the population that is susceptible to early injury. 
 
EITHRE is the threshold dose below which risk of the injury is zero. 
 
EIFACA is the alpha factor (D50) in the hazard function for the injury. 
 
EIFACB is the beta (shape) factor in the hazard function for the injury. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUMEIN Linked Integer None 1 to 10 

EINAME Yes Character NUMEIN 1 to 16 characters 

ORGNAM Yes Character NUMEIN Acute Organ name 
from list in Table 3-7 

EISUSC Yes Real NUMEIN 0.0 to 1.0 

EITHRE Yes Real NUMEIN 0.0 to 1000.0 Sv 

EIFACA Yes Real NUMEIN 0.0 to 1000.0 Sv 

EIFACB Yes Real NUMEIN 0.0 to 100.0 

 
Latent Cancer Parameters Form 
The Latent Cancer Parameters form is required when Latent Cancer Effects is checked on the 
Project Properties/Early Effects tab. 
 
NUMACA is the number of different types of latent cancer effects that are to be calculated. 
 
ACNAME is the name of each type of latent cancer effect.  This is a user defined label. 
 
ORGNAM is the name of the target organ for each type of latent cancer effect.  The possible 
values offered depend on the DCF file.  Possibilities are limited to supported latent organs. 
 
ACSUSC is the fraction of the population that is susceptible to the latent cancer. 
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DOSFA defines the linear factor, alpha, of the dose dependence in the cancer risk model. 
 
DOSFB defines the quadratic factor, beta, of dose dependence in the cancer risk model. It is  
used in EARLY, but not in CHRONC. When the dose to the organ is below ACTHRE, DOSEFB 
defines the quadratic term of the cancer dose-response function. The user should assign a 
value of zero to deactivate the quadratic portion of the linear-quadratic risk model. 
 
CFRISK is the lifetime risk factor for cancer death. This parameter has units of risk/Sievert.   
 
CIRISK is the lifetime risk factor for cancer incidence (injury).  This parameter has units of 
risk/Sievert.   
 
DDREFA is the dose-dependent reduction factor.  When the lifetime dose commitment incurred 
during the EARLY exposure period is less than DDTHRE, the risk of cancer from irradiation of 
that organ is divided by DDREFA. Doses calculated in CHRONC are always divided by 
DDREFA. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUMACA Linked Integer None 1 to 10 

ACNAME Yes Character NUMACA 1 to 10 characters 

ORGNAM Yes Character NUMACA Lifetime Organ 
name from list in 
Table 3-7 

ACSUSC Yes Real NUMACA 0.0 to 1.0 

DOSEFA Yes Real NUMACA 0.0 to 2.0 

DOSEFB Yes Real NUMACA 0.0 to 2.0 

CFRISK Yes Real NUMACA 0.0 to 1.0 per Sv 

CIRISK Yes Real NUMACA 0.0 to 1.0 per Sv 

DDREFA Yes Real NUMACA 1.0 to 10.0 

 
Latent Cancer Thresholds Form 
The Latent Cancer Thresholds form is required when Latent Cancer Effects is checked on the 
Project Properties/Early Effects tab. 
 
ACTHRE is the lower dose limit for the linear dose-response relationship.  For doses less than 
ACTHRE, a quadratic relationship is used.  This parameter should be assigned a value of zero 
when the user wishes to deactivate the linear-quadratic risk model in favor of a linear 
relationship. This parameter might better be described as a breakpoint in the dose-response 
curve and its use is distinct from the model for a threshold in the dose-response function 
described in Section ?. 
 
DDTHRE is the threshold dose for applying the dose-dependent reduction factor DDREFA.  
When the lifetime dose commitment incurred during the EARLY exposure period is less than 
DDTHRE, the risk of cancer from irradiation of that organ is reduced by a factor of DDREFA. 
 

Variable Name Definable Type Dimensions Allowed Values 

ACTHRE Yes Real None 0.0 to 10.0 Sv 

DDTHRE Yes Real None 0.0 to 1.0 Sv 
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 Output Control 3.3.8
 

 Output Control Forms and Parameters 3.3.8.1
 
Debug Options Form 
IPRINT specifies the quantity of debug output that is desired.  The higher the value, the more 
output is printed. Normal runs should use a value of zero.   
 
Normally, centerline doses can be selected when IPLUME = 1 from the Centerline Dose form 
under EARLY/Output Control. An alternative method for evaluating centerline doses from 
EARLY is to set the output control variable, IPRINT, to a value greater than zero.  When this is 
done, a listing of dose vs. distance for all the organs is included in the output.  Since this is 
written for each weather trial, this option is normally used for single weather trial runs. 
 
For various values of IPRINT, the output file contains some intermediate results. These are 
described below.  
 
IPRINT ≥1: This option produces skin dose conversion factors, centerline doses for all 

organs (when IPLUME=1), Gaussian histogram and cloudshine correction 
factors, return code values (RETCOD). 

IPRINT ≥2: This option produces final groundshine dose rate for each organ, each plume 
segment. 

IPRINT ≥4: This option produces total acute dose for organs 2 and 3, early fatality, early 
injury, and cancer risk values for each spatial element. 

IPRINT ≥8: This option produces acute dose to organs 2 and 3 after completion of subroutine 
RELZON, acute dose to organs 2 and 3 after completion of subroutine ESTAT. 

When RISCAT is set to True and weather bin sampling is selected, the relative contribution of 
each of the weather-category bins to the mean consequence value is included in the MACCS 
output. 
 

Variable Name Definable Type Dimensions Allowed Values 

IPRINT Yes Integer None 0 to 10 

RISCAT Yes Logical None True, False 

 
Health-Effect Cases Form 
The Health Effect Cases form is optional. Cancer results requested from this form are 
automatically produced by CHRONC so that the results can be combined in the output.  In the 
results calculated by CHRONC, the cancer values include the following dose pathways: (1) 
groundshine to the residents, (2) inhalation of resuspended aerosols by the residents, (3) 
consumption of food and water produced in the region (not necessarily by the residents), and 
(4) groundshine exposure of workers required to decontaminate the region.  
 
NUM1 specifies the number of results. The value is determined by the number of rows in the 
grid containing values of vectors NAME, I1DIS1, I2DIS1, and Report Options. 
 
NAME indicates the type of result desired.  Choices for this are presented by WinMACCS, and 
depend on the values of variable EINAME, which represents the types of early injuries, and 
ACNAME, which represents the types of latent cancers. Totals for early fatalities and cancer 
fatalities are always available.  
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I1DIS1 defines the inner spatial interval of the region of interest. The distance corresponds to 
the inner boundary of this ring.  
 
I2DIS1 defines the outer spatial interval of the region of interest.  The distance corresponds to 
the outer boundary of this ring. MACCS requires that the value must be greater than or equal to 
I1DIS1. 
 
Report Options determine whether CCDF data are written to the MACCS output file and 
whether they are to be included in the WinMACCS summary report. WinMACCS reports can 
also be generated on demand and independently of the choice of Report Options. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUM1 Linked Integer None 0 to 40 

NAME Yes Character NUM1 ERL FAT/TOTAL, 
ERL INJ/[EINAME], 
CAN FAT/[ACNAME], 
CAN FAT/TOTAL, 
CAN INJ/[ACNAME], 
CAN INJ/TOTAL 

I1DIS1 Yes Integer NUM1 1 to NUMRAD 

I2DIS1 Yes Integer NUM1 1 to NUMRAD 

Report Options Yes Character NUM1 CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Early-Fatality Radius Form 
The Early-Fatality Radius form is optional.  This result type is unavailable when Federal 
Guidance Report FGRDCF is selected on Dose tab of the Properties form or when Early Fatality 
Effects is not selected under the Early Effects tab of the Properties.  
 
NUM2 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors RISTHR and Report Options. 
 
RISTHR defines the risk threshold used for calculating the fatality radius (reported in 
kilometers). It estimates the maximum distance at which a specified level of early fatality risk is 
exceeded.  The user can obtain information about the size of the region in which early fatalities 
are predicted to occur by setting this variable to zero.  
 
Report Options determine whether additional CCDF data are written to the MACCS output file, 
and whether the data are to be included in the WinMACCS summary report. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUM2 Linked Integer None 0 to 10 

RISTHR Yes Real NUM2 0.0 to 1.0 

Report Options Yes Character NUM2 CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Population Exceeding Threshold Form 
The Population Exceeding Threshold form is optional. 
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This output type provides an estimate of the number of people who receive acute or lifetime 
doses exceeding a user-definable level.  This consequence measure is for doses calculated in 
the EARLY module.  There is no analogous capability for doses estimated in CHRONC or for 
combined doses estimated in EARLY and CHRONC. 
 
NUM3 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors NAME, DOSTH3 and Report Options. 
 
NAME defines the name of the organ to which the dose threshold applies.  
 
DOSTH3 defines the dose threshold that is used for counting the population. 
 
Report Options determine whether CCDF data are written to the MACCS output file and 
whether they are to be included in the WinMACCS summary report. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUM3 Linked Integer None 0 to 10 

NAME Yes Real NUM3 Organ name from list in 
Table 3-7 

DOSTH3 Yes Real NUM3 0.0 to 1000.0 Sievert 

Report Options Yes Character NUM3 CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Average Individual Risk Form 
The Average Individual Risk form is optional.  Average individual risk is obtained by taking the 
sum of the risk values in all sectors at a given distance and dividing it by the number of sectors. 
The result is based on a phantom person residing in each grid element and does not depend on 
site data.  
 
Cancer results are automatically produced by CHRONC so that the results can be combined in 
the MACCS output.  When this result is produced by CHRONC, it is only a measure of the risk 
from the dose pathways of groundshine and inhalation or resuspended aerosols.  The risk 
presented in this result does not include doses from ingestion of food and water by the region's 
population or doses to workers required to decontaminate the region. 
 
NUM4 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors I1DIS4, NAME, and Report Options. 
 
I1DIS4 specifies outer spatial boundary.  For example, when I1DIS4 is two, the associated 
average risk is calculated from the center of the grid to the outer radius of SPAEND(2).  
 
NAME indicates the type of result desired.  Choices for this are presented by WinMACCS, and 
depend on the values of variable EINAME, which represents the types of early injuries, and 
ACNAME, which represents the types of latent cancers. Totals for early fatalities and cancer 
fatalities are always available.  
 
Report Options determine whether CCDF data are written to the MACCS output file and 
whether they are to be included in the summary report. 
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Variable Name Definable Type Dimensions Allowed Values 

NUM4 Linked Integer None 0 to 20 

I1DIS4 Yes Integer NUM4 1 to NUMRAD 

NAME Yes Real NUM4 ERL FAT/TOTAL, 
ERL INJ/[EINAME], 
CAN FAT/[ACNAME], 
CAN FAT/TOTAL, 
CAN INJ/[ACNAME] 

Report Options Yes Character NUM4 CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Population Dose Form  
The Population Dose form is optional. This form requests population dose to a given organ to be 
calculated.  The user must supply the name of the target organ as well as the inner and outer 
spatial intervals of the region of interest.  When only the EARLY module is run, this result 
reflects only the pathways considered by EARLY.  When both EARLY and CHRONC are run, 
the population dose from all pathways is included in the calculation.  The CHRONC pathways 
include (1) groundshine dose to the population, (2) inhalation of resuspended aerosols by the 
population, (3) food and water ingestion doses resulting from deposition within the region (not 
necessarily ingested by the population within the region), and (3) doses to workers 
decontaminating the region.   
 
NUM5 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors NAME, I1DIS5, I2DIS5, and Report Options. 
 
NAME is the name of the target organ for the dose calculation.  The possible values offered 
depend on the DCF file chosen and include only lifetime doses. 
 
I1DIS5 defines the inner spatial interval of the region of interest. The distance is the inner radius 
of the specified ring.  
 
I2DIS5 defines the outer spatial interval of the region of interest.  The distance is the outer 
radius of the specified ring. MACCS requires that its value must be greater than or equal to 
I1DIS5. 
 
Report Options determine whether CCDF data are written to the MACCS output file and 
whether they are to be included in the summary report. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUM5 Linked Integer None 0 to 10 

NAME Yes Character NUM5 Organ name from list in 
Table 3-7. 

I1DIS5 Yes Integer NUM5 1 to NUMRAD 

I2DIS5 Yes Integer NUM5 1 to NUMRAD 

Report Options Yes Character NUM5 CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Centerline Dose Form 
The Centerline Dose form is optional.  This form is available when No Wind Shift with Rotation 
(IPLUME=1) is selected on the Evac/Rotation tab on the Properties form. In this case, MACCS 
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saves the centerline dose between a range of distances for a set of dose pathways and for 
acute and lifetime doses. 
 
The following pathways/dose types are supported: 
 
Pathway Description Calculation 
CLD cloudshine dose EARLY 
GRD groundshine dose EARLY 

CHRONC 
INH ACU dose from inhalation of the passing plume EARLY 
INH LIF dose from inhalation of the passing plume EARLY 
TOT ACU total dose from all direct exposure pathways EARLY 

CHRONC 
TOT LIF total dose from all direct exposure pathways EARLY 

CHRONC 
RES LIF dose from inhalation of resuspended material after plume 

passage 
EARLY 
CHRONC 

RES ACU dose from inhalation of resuspended material after plume 
passage 

EARLY 
CHRONC 

 
Depending on the exposure pathways and dose types requested, the results are calculated by 
EARLY and/or CHRONC.  When both EARLY and CHRONC are being run, CHRONC 
automatically produces all of the results for the pathways it includes.  When pathways 'GRD', 
'RES LIF', or 'TOT LIF' are chosen, those results are automatically produced by CHRONC. The 
other pathway values are only produced by EARLY. 
 
An alternative method to request centerline doses from EARLY is to set the output control 
variable, IPRINT, to a value greater than 0.  When this is done, a listing of dose vs. distance for 
all organs are included in the output.  
 
NUM6 specifies the number of results. Its value is determined by the number of rows in the grid 
containing vectors ORGNAM, PATHNM, I1DIS6, I2DIS6, and Report Options. 
 
ORGNAM is the name of the target organ for the dose calculation.  The possible values offered 
depend on the DCF file chosen.   
 
PATHNM indicates the pathway/dose type to be used for the calculation.  The pathway name is 
ignored when ‘A-SKIN’ is specified as the target organ because direct dry deposition is the only 
exposure pathway considered for skin. 
 
I1DIS6 defines the inner spatial interval of the region of interest. The distance is the inner 
boundary of the specified ring.  
 
I2DIS6 defines the outer spatial interval of the region of interest.  The distance is the outer 
boundary of the specified ring. MACCS requires that the value must be greater than or equal to 
I1DIS6. 
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Variable Name Definable Type Dimensions Allowed Values 

NUM6 Linked Integer None 0 to 10 

ORGNAM Yes Character NUM6 Organ name from list in 
Table 3-7 

PATHNM Yes Character NUM6 CLD, GRD, INH ACU, 
INH LIF, TOT ACU, TOT 
LIF, RES LIF, RES ACU 

I1DIS6 Yes Integer NUM6 1 to NUMRAD 

I2DIS6 Yes Integer NUM6 1 to NUMRAD 

Report Options Yes Character NUM6 CCDF, NONE, REPORT, 
CCDF & REPORT 

 
Centerline Risk Form 
The Centerline Risk form is optional.  This form is available when No Wind Shift and Rotation is 
set to No Wind Shift with Rotation (IPLUME=1) is selected on the Evac/Rotation tab on the 
Properties form. 
 
Centerline risk is calculated for phantom individuals located directly under the path of the plume 
who are exposed to the Gaussian peak of the air and ground concentrations.  The centerline 
risk at each distance in the region is treated as a separate result and MACCS generates a 
distribution of the consequence measure for each of the spatial intervals within the specified 
range. 
 
Cancer results are automatically produced by CHRONC. The CHRONC values represent risk 
from groundshine and inhalation of resuspended aerosols.  This risk does not include doses 
from ingestion of food and water or doses to workers decontaminating the area. 
 
NUM7 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors NAME, I1DIS7, I2DIS7, and Report Options. 
 
NAME indicates the type of health effect requested.  Choices are presented by WinMACCS, 
and depend on the values of variable EINAME, the types of early injuries, and ACNAME, the 
types of latent cancers.  
 
I1DIS7 defines the inner spatial interval of the region of interest. The distance is the inner 
boundary of this ring.  
 
I2DIS7 defines the outer spatial interval of the region of interest.  MACCS requires that the 
value must be greater than or equal to I1DIS7. The distance is the outer boundary of this ring.  
 
Report Options determine whether CCDF data are written to the output file, and whether the 
data are to be included in the report generated after simulations are completed. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUM7 Linked Integer None 0 to 10 

NAME Yes Character NUM7 ERL FAT/TOTAL, 
ERL INJ/[EINAME], 
CAN FAT/[ACNAME], 
CAN FAT/TOTAL, 
CAN INJ/[ACNAME], 
CAN INJ/TOTAL 

I1DIS7 Yes Integer NUM7 1 to NUMRAD 
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Variable Name Definable Type Dimensions Allowed Values 

I2DIS7 Yes Integer NUM7 1 to NUMRAD 

Report Options Yes Character NUM7 CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Population Weighted Risk Form 
The Population Weighted Risk form is optional.  Population-weighted health effect risk is 
obtained by calculating the number of cases of a health effect within a region and dividing by the 
total population of that region.  It takes account of the population distribution and the wind rose.  
 
Cancer results are automatically produced by CHRONC.  CHRONC risks include the exposure 
pathways of groundshine and inhalation of resuspended aerosols. 
 
The population-weighted risk in CHRONC is calculated by estimating the number of cancer 
cases and dividing that value by the population of the region.  The risk presented in this result 
does not include the societal pathways of (1) ingestion of contaminated food and water or (2) 
doses to workers decontaminating the area. 
 
NUM8 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors NAME, I1DIS8, I2DIS8, and Report Options. 
 
NAME indicates the type of health effect desired.  Choices depend on the values of variable 
EINAME, the types of early injuries, and ACNAME, the types of latent cancers.  
 
I1DIS8 defines the inner radius of the region of interest. The radius is the inner boundary of this 
ring.  
 
I2DIS8 defines the outer boundary of the region of interest.  The radius is the outer boundary of 
this ring. MACCS requires that the value must be greater than or equal to I1DIS8. 
 
Report Options determine whether CCDF data are written to the output file and whether they 
are to be included in the MACCS report generated after simulations are completed. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUM8 Linked Integer None 0 to 20 

NAME Yes Character NUM8 ERL FAT/TOTAL, 
ERL INJ/[EINAME], 
CAN FAT/[ACNAME], 
CAN FAT/TOTAL, 
CAN INJ/[ACNAME], 
CAN INJ/TOTAL 

I1DIS8 Yes Integer NUM8 1 to NUMRAD 

I2DIS8 Yes Integer NUM8 1 to NUMRAD 

Report Options Yes Character NUM8 CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Peak Dose Form 
The Peak Dose form is optional.  Results are based on the dose at each distance for a range of 
distances, analogous to centerline dose results.  Reporting of centerline doses is not an option 
when wind shift is considered because a centerline does not exist. Peak dose is more general 
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than centerline dose because it calculates the maximum dose around the compass for any 
option for plume transport. The implementation of this result differs from centerline dose in two 
ways: (1) there is no capability for reporting a breakdown of individual doses by pathway and (2) 
peak doses represent an average dose over the width of a fine grid and are not point values like 
centerline dose.  
 
This result is produced for each emergency response cohort.  The dose depends on the 
definition of that cohort in terms of evacuation and relocation.  When the CHRONC module is 
exercised, this result is automatically produced by CHRONC as well.  However, the peak dose 
is calculated on the fine grid level in EARLY but only on the course grid level in CHRONC. 
 
The overall results represent the combination of doses calculated by EARLY and CHRONC.  
However, the overall results may be misleading because peak doses for the various cohorts 
may occur at different angular locations.  Summation of these values may be meaningless when 
multiple plume segments travel in different directions (i.e., when NUMREL is greater than 1 and 
IPLUME is equal to 2 or 3).   
 
NUMA specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors NAME, I1DISA, I2DISA, and Report Options. 
 
NAME is the name of the target organ for the dose calculation.  The possible values offered 
depend on the choice of DCF file.   
 
I1DISA defines the inner radius of the region of interest. The radius is the inner boundary of this 
ring.  
 
I2DISA defines the outer radius of the region of interest.  The radius is the outer boundary of 
this ring. MACCS requires that the value must be greater than or equal to I1DISA. 
 
Report Options determine whether CCDF data are written to the output file and whether they 
are to be included in the summary report. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUMA Linked Integer None 0 to 10 

NAME Yes Character NUMA Organ name from list in 
Table 3-7 

I1DISA Yes Integer NUMA 1 to NUMRAD 

I2DISA Yes Integer NUMA 1 to NUMRAD 

Report Options Yes Character NUMA CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Peak Dose Polar Form 
The Peak Dose Polar form is optional.  In this output type, the peak dose is calculated for a 

user-specified (r,) location.  Individual doses at locations other than directly under the plume(s) 
are reported with this option. There is no capability for reporting individual doses by dose 
pathway. 
 
When CHRONC is used, these results are generated by CHRONC as well as by EARLY.  The 

total dose is estimated for a representative individual assumed at a particular (r,) location on 
the spatial grid.  The dose depends on the definition of that cohort in terms of evacuation and 
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relocation. Exposures resulting from the ingestion of contaminated food and water are not 
included in the dose.   
  
The location for which this result is to be calculated is specified as a radial index (which can 
range from 1 to NUMRAD) and an angular index (which can range from 1 to 64).  Following the 
convention used throughout MACCS, an angular index of 1 represents a compass sector 
centered to the north of the release point. Numbering of compass sectors increases in the 
clockwise direction from the north. 
 
NUMB specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors NAME, IRAD_B, IANG_B, and Report Options. 
 
NAME is the name of the target organ for the dose calculation.  The possible values depend on 
the DCF file chosen.   
 
IRAD_B defines the radial interval of the grid element for which this result is to be calculated.  
 
IANG_B defines the angular index of the grid element for which this result is to be calculated. 
 
Report Options determine whether CCDF data are written to the MACCS output file and 
whether they are to be included in the summary report. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUMB Linked Integer None 0 to 32 

NAME Yes Character NUMB Organ name from list in 
Table 3-7 

IRAD_B Yes Integer NUMB 1 to NUMRAD 

IANG_B Yes Integer NUMB 1 to NUMCOR 

Report Options Yes Character NUMB CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Land Area Exceeding Dose Form 
The Land Area Exceeding Dose form is optional. The land area that exceeds a user-specified 
dose level to an organ is reported. Optionally, dose values for all grid elements for the selected 
organ are displayed.  
 
NUMC specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors ORGNAM, ELEVDOSE, and PRINT_FLAG_C. 
 
ORGNAM is the name of the target organ for the dose calculation.  The possible values offered 
depend on the DCF file chosen.  
 
ELEVDOSE is the threshold value for calculating land contamination areas. Land area that is 
contaminated above the threshold value is reported in the output.  
 
PRINT_FLAG_C set to True means that the output includes results dose levels to the specified 
organ for each grid element.  Otherwise, these results are suppressed.  
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Variable Name Definable Type Dimensions Allowed Values 

NUMC Linked Integer None 0 to 40 

ORGNAM Yes Character NUMC Organ name from list in 
Table 3-7 

ELEVDOSE Yes Real NUMC 0.0 to 1×1012 Sv 

PRINT_FLAG_C Yes Logical NUMC True, False 

 
Land Area Exceeding Concentration Form 
The Land Area Exceeding Concentration form is optional. This output type provides the land 
area that exceeds a user-specified ground concentration for a specified radionuclide. Optionally, 
the user can also request ground concentrations and time-integrated, ground-level, air 
concentrations for every grid element. 
 
NUMD specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors I1DISD, NUCLIDE, ELEVCONC, and PRINT_FLAG_D. 
 
I1DISD is the outer spatial interval bounding the region of interest. The radius corresponds to 
the outer radius of the specified ring. The contaminated area in the calculation is from a radius 
of zero to the outer spatial interval.  
 
NUCLIDE is the radionuclide of interest.  The value must be an element of vector NUCNAM. 
 
ELEVCONC is the threshold value for calculating the land contamination area. The land area 
that is contaminated above this threshold value is reported in the output. 
 
PRINT_FLAG_D set to True means that the output includes ground and ground-level air 
concentrations for each grid element.  Otherwise, this output is suppressed. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUMD Linked Integer None 0 to 40 

I1DISD Yes Integer NUMD 1 to NUMRAD 

NUCLIDE Yes Character NUMD Must select a 
radionuclide from 
NUCNAM 

ELEVCONC Yes Real NUMD 0.0 to 1×1012 Bq/m2 

PRINT_FLAG_D Yes Logical NUMD True, False 

 
Population Movement Form 
The model reports the fraction of each cohort and of the total population that has left the circular 
boundary corresponding to the I1DISE radial distance. The output reports the result at the time 
interval specified by TIMDIVE, but only when the fraction has changed since the previous time 
interval. For the case that the network evacuation model is used and some portion of the 
population exits the boundary then later returns into the circular region defined by the boundary, 
only the first crossing of the boundary is treated by the model. 
 
NUME specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors I1DISE, TIMDIVE, and Report Options. 
 
I1DISE specifies the radial index for which results are to be reported.  The region considered is 
within the outer boundary of the specified radial grid element.  The fraction of the population 
within this boundary crossing the boundary as a function of time is reported in the output. 
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TIMDIVE is the time interval for reporting. 
 
Report Options determine whether CCDF data are written to the output file and whether they 
are to be included in the MACCS report generated after simulations are completed. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUME Linked Integer None 0 to 35 

I1DISE Yes Integer NUME 1 to LASMOV 

TIMDIVE Yes Integer NUME 60 to 86400 s 

Report Options Yes Character NUME CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 

3.4 CHRONC Input and Model description 
 

 Overview of CHRONC 3.4.1
 
The CHRONC module simulates the events that occur following the emergency phase time 
period modeled by EARLY.  Various long-term protective actions can be taken during this period 
to limit radiation doses to acceptable levels.  
 
CHRONC calculates the individual health effects that result from both external and internal dose 
pathways.  CHRONC also calculates the economic costs of the long-term protective actions as 
well as the cost of the emergency response actions that were modeled in the EARLY module. 
 
Three long-term exposure pathways are modeled to predict the long-term radiation exposures 
from accidental radiological releases: groundshine, resuspension inhalation, and ingestion of 
contaminated and drinking water.  The models used in predicting the doses from these four 
pathways are described individually in the following sections.  The dose from each of the 
long-term pathways is evaluated for each spatial element surrounding the accident site.  For the 
intermediate phase, only the groundshine and resuspension inhalation exposure pathways are 
treated. The implicit assumption is that contaminated food and water would not be ingested 
during the intermediate phase.  
 
MACCS incorporates two optional food ingestion models as follows: 

 the food ingestion model from the original MACCS code, as used in NUREG-1150 

 the COMIDA2 food ingestion model.  
 
The MACCS food ingestion model is based on the principle that the long-term dose produced by 
any radionuclide to an organ via the food-ingestion pathway is the product of the ground 
concentration of the radionuclide, the integrated transfer factor for the radionuclide to human 
intake for the pathway, and the ingestion dose conversion factor.   
 
There are a number of limitations in the MACCS food-ingestion model.  A main drawback is that 
the integrated transfer factors for food pathway radionuclides not included in the MACCS 
sample problems must be derived externally.  Calculation of the transfer factors is difficult and 
error prone.  A second limitation of the MACCS food-ingestion model is that it is not capable of 
distinguishing the effects of contamination at different times during the growing season. This 
difference is substantial depending on whether deposition occurs directly onto standing crops or 
not.  
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By contrast, the COMIDA2 ingestion model is based on a preprocessor that can be exercised by 
the user, with consideration of site-specific data, when such data are available. Alternatively, the 
user can use a COMIDA2 file distributed with the code that provides typical values for the U.S. 
The COMIDA2 model considers a set of times during the growing season, so variations in food 
contamination over the growing season are automatically treated.   
 
The radiation dose for the exposure pathways of the intermediate and long-term phases is 
calculated for each of the coarse spatial elements using the initial ground concentration under 
the plume centerline calculated by the ATMOS module.  Similar to the early exposure pathways, 
MACCS uses centerline and off-centerline concentrations to estimate the initial ground 
concentration for any spatial element.  By contrast with EARLY, which estimates deposition at 
the fine grid level, CHRONC only resolves deposition at the course grid level. For each dose 
pathway, the Gaussian distribution is averaged over the width of a compass sector to estimate a 
ground concentration for each grid element.   
 
CHRONC incorporates calculations for two distinct periods of time, the intermediate phase and 
the long-term phase. These phases are described in the following subsections.  
 

 Intermediate Phase 3.4.1.1
 
The intermediate phase begins immediately after the emergency phase. The user can define 
the duration of the intermediate phase to be zero (i.e., no intermediate phase) or up to one year.  
 
The only response considered during the intermediate phase is continued relocation for areas 
that are too heavily contaminated for the population to return. The criterion for relocation during 
the intermediated phase is based on a user-defined dose projection and dose level. The dose 
projection is defined in terms of an exposure period and a target organ. The user also specifies 
the maximum acceptable dose level. When the intermediate-phase dose criterion is satisfied, 
the residential population of a grid element is assumed to be present and subject to radiation 
exposure from groundshine and resuspension inhalation for the entire intermediate phase.  
When the criterion is exceeded, the population is assumed to be relocated to uncontaminated 
areas for the entire intermediate phase, with a corresponding per-capita economic cost defined 
by the user through the input variable POPCST.  
 

 Long-Term Phase 3.4.1.2
 
The long-term phase follows the intermediate phase, or directly follows the emergency phase 
when the duration of the intermediate phase is set to zero. A set of protective actions are 
implemented during the long-term phase, which are decontamination, interdiction, and 
condemnation of land that exceeds the habitability level set by the user.  
 
Decisions on mitigative actions during the long-term phase are based on two sets of 
independent criteria as follows: 

 Decisions are made relating to whether land at a specific location and time is suitable for 
human habitation. This criterion is often called the habitability criterion.  

 Decisions are made relating to whether land at a specific location and time is suitable for 
agricultural production. This criterion is often called the farmability criterion.  

 
 Division Between Farm and Population 3.4.1.3

 
The long-term phase incorporates a fundamental distinction between the consequences 
associated with agricultural uses of land (denoted FARM-DEPENDENT in the code output), and 
habitation of land by humans (denoted POP.-DEPENDENT in the code output). 
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 Habitability Decision Making 3.4.1.4

 
Habitability decision making determines whether land is immediately habitable, land is habitable 
after decontamination, land is habitable after a combination of decontamination and interdiction, 
or land is condemned.  
 
The first step in the decision making regarding habitability is to determine whether, in the 
absence of any mitigative actions, the land in a grid element is suitable for habitation during the 
long-term exposure period.  This is done by comparing the projected, lifetime, individual dose to 
the target organ (input variable CRTOCR) for the long-term dose projection period (input 
variable TMPACT) against the user-specified dose for long-term exposure (input variable 
DSCRLT).  When the projected individual dose does not exceed DSCRLT, the land is 
considered immediately habitable, and no further tests regarding habitability are made. 
Residents are assumed to return to the grid element and no further costs are tallied.  
 
When the land is not immediately habitable, a progressive series of actions are evaluated, 
beginning with decontamination for the various user-defined decontamination levels.  The 
influence of decontamination is twofold:  

 Doses are reduced by a dose reduction factor (DRF, input variable DSRFCT), which is a 
scaling factor by which the doses are reduced.  

 Doses are also reduced by weathering and radioactive decay during the 
decontamination period. 

 
The influence of these two factors is considered to be independent.  That is, when the user 
specifies a DRF of 3, and a decontamination period of 1 year, the doses to habitants at the 
conclusion of decontamination are generally less than one-third of the doses before 
decontamination because decontamination, weathering, and radioactive decay all work to 
reduce subsequent doses.   
 
The first level (smallest DRF) of decontamination is considered first. When this DRF plus 
weathering and decay is enough to meet the habitability criterion immediately after 
decontamination, this level of decontamination is performed and the population is assumed to 
return. When the first level of decontamination is not sufficient, higher levels of decontamination 
are considered. MACCS allows up to three levels.  
 
When the highest level of decontamination is insufficient to restore habitability, MACCS 
evaluates whether performing this level of decontamination plus additional interdiction would 
restore habitability. MACCS allows up to 30 years of interdiction when it performs this 
calculation.  
 
MACCS declares land to be condemned under two conditions: 

 Habitability cannot be restored after decontaminating at the highest level plus additional 
interdiction. 

 The total cost to restore habitability is greater than the cost to condemn the land.  
 
Under either of these conditions, the land is condemned immediately at the beginning of the 
long-term phase; the model assumes that decontamination is not performed. The code 
calculates the corresponding long-term food and population doses to be zero for the 
condemned land and assesses an economic cost for condemnation of the property. 
 
The effect of weathering and decay over the interdiction period is calculated with an 
interpolation technique that uses precalculated doses for predefined interdiction periods of 1, 5, 
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and 30 years.  These three predefined interdiction periods all begin at the conclusion of the 
maximum-level decontamination effort, which is a user-specified duration that can extend up to 
1 year. The time required for decontamination is considered to be part of the period of 
interdiction, so the total interdiction period can potentially extend to 31 years.  
 
For the two separate land uses, farm and population, mitigative actions are chosen to yield the 
lowest-cost approach to satisfying the applicable criteria.  For farms, the criteria define 
acceptable levels of foodstuff contamination; for populations, the criteria define acceptable 
levels of radiation exposures to individuals.  The maximum duration of temporary farmland 
interdiction is 8 years; as previously discussed, the corresponding maximum duration for 
populated areas is 30 years.  It is likely that neither of these limiting cases would be applied in 
practice because the cost of decontamination and interdiction would normally exceed the cost of 
condemnation before these time limits are reached.   
 

 Primacy of Habitability over Farmability Decisions 3.4.1.5
 
For both food-chain model options, farm production is allowed to occur only when the 
environmental contamination levels are sufficiently low enough to allow habitation. The implicit 
assumption is that people cannot work on land that is not habitable. When farmland is not 
habitable, it is treated exactly the same as described in the previous subsection on habitability 
decision making.  
 

 Farmability Decision Making 3.4.1.6
 
As described in the previous subsection, the decision on whether farmland can be used for 
agriculture is based first on evaluations of its suitability for human habitation. When farmland is 
immediately habitable or is restored to being habitable, it is next evaluated for farmability, which 
means that contamination levels of the agricultural products are low enough to be consumed. 
The criterion for farmability is specified through a set of maximum allowable food doses, which 
are input parameters DOSEMILK, DOSEOTHR, and DOSELONG. These parameters are 
discussed below.  
 
Most often the farmability criterion is stricter than the habitability criterion, so it is not unusual 
that farmland is habitable but not farmable. Decontamination is only implemented in MACCS to 
restore habitability, not farmability. Land that is initially habitable but not farmable is either 
interdicted without decontamination or condemned. 
 

 Basic Parameters 3.4.2
 

 Basic Forms and Parameters 3.4.2.1
 
Chronc Description Form 
The Chronc Description form contains one variable, which is a short description of the CHRONC 
model used in the calculation. This form is required.  
 

Variable Name Definable Type Dimensions Allowed Values 

CHNAME Yes Character None 1 to 80 characters 

 
Property Form Parameters Form 
This form allows the user to observe how the choices made on the Properties form define some 
important variables that are required in the CHRONC input.  The variables on this form are 
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read-only and cannot be changed from this form.  Details about the affect these parameters 
have on the model are provided in the subsections below. 
 
FDPATH determines the food-chain model used.  When this variable is set to OLD the food-
chain model developed for MACCS is used.  NEW means the COMIDA2 food-chain model is 
used. When this variable is set to OFF, no food-chain model is used. 
 
NTTRM is the number of terms used in the growing crop retention model.  This is only relevant 
when FDPATH is set to OLD. 
 

Variable 
Name 

Definable Type Dimensions Allowed 
Values 

Defined on 
Form 

FDPATH Read Only Character None NEW, 
OFF, 
OLD 

Food tab on 
Properties form 

NTTRM Read Only Integer None 1 to 3 Number of Crop 
Weathering 
Terms found on 
Food tab of the 
Properties form 

 

 Shielding and Exposure 3.4.3
 

 Shielding and Exposure Model Description 3.4.3.1
 
Shielding and exposure factors are specified separately for EARLY and CHRONC, but serve the 
same purpose. These factors account for long-term behavior of the public and for the shielding 
offered by structures in which people dwell, work, and spend time.  
 
Older versions of MACCS assumed that the long-term shielding and exposure factors in the 
intermediate and long-term phases are identical to those for normal activity during the 
emergency phase. This is still a reasonable assumption that is commonly used. However, there 
are some reasons why the factors could be different for these phases. The basic difference is in 
potential equilibration between the exterior and interior of buildings. The usual assumption in 
estimating these factors for the emergency phase is that the exterior is contaminated but the 
interior is clean. This may be a reasonable assumption for the short term, but may be less 
reasonable for the long term. Even for the short term, air exchange between the interior and 
exterior of a house or other building can cause some level of contamination to the interior. 
Filtered air exchange between the atmosphere and a control room is generally included when 
assessing doses to control-room workers for design-basis accidents. Similarly, ventilation 
systems in a home or other building would gradually introduce contaminants into the interior, 
which in turn would affect the shielding and exposure factors. After a long time, it is reasonable 
that the interior and exterior of a building would equilibrate. In other words, the contamination 
level of the interior of a building would be lower but proportional to the contamination level of the 
exterior of the building. By allowing a distinction between short-term and long-term shielding and 
exposure factors, MACCS can be used to evaluate possible time dependencies of these factors.  
 

 Shielding and Exposure Forms and Parameters 3.4.3.2
 
Shielding and Exposure Form 
The Shielding and Exposure form is required. 
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LPROTIN is the inhalation protection factor. A value of 0 indicates complete protection from 
inhalation of radioactive materials; a value of 1 indicates no protection and corresponds to a 
person standing outdoors with no protection from the surrounding atmosphere.   
 
LBRRATE is the breathing rate. There is a range of breathing rates that can be assigned, which 
is based on level of activity and other factors. This value should reflect a long-term average that 
is consistent with the exposure period used for the long-term phase.  
 
LGSHFAC is the groundshine shielding factor. This value is used as a multiplier on the value of 
groundshine dose that would have been received if the person were standing outside and the 
ground were a perfectly flat surface. A value of 0 indicates complete shielding from 
groundshine; a value of 1 indicates no protection. A typical surface roughness of the ground 
affords some shielding, which is typically taken to be 0.7.  
 

Variable Name Definable Type Dimensions Allowed Values 

LPROTIN Yes Real None 0.0 to 1.0 

LBRRATE Yes Real None 0.0 to 1.0 m3/s 

LGSHFAC Yes Real None 0.0 to 1.0 

 

 Dose Projection Model Description 3.4.4
 
Dose projection is used to determine the need for relocation during the intermediate phase and 
to determine habitability during the long-term phase. Dose projection is defined by an exposure 
period and a target or critical organ for the dose. It is used to estimate a dose that would occur if 
no protective action were taken. A criterion is defined to protect the population by ensuring that 
a dose projection is small enough; otherwise a protective action is taken to eliminate or reduce 
the projected dose.  
 
The dose criterion for habitability is discussed in a subsequent subsection. The dose criterion 
for relocation during the intermediate phase is based on a dose projection period, 
DPP_INTERPHAS, and a target organ, CRTOCR. The criterion is that the projected dose is less 
than a user input dose defined by parameter DSCRTI. These parameters are discussed in this 
and subsequent subsections. 
 
Dose Projection Form 
The Dose Projection form is optional. It contains a single parameter that defines the exposure 
period for dose projection used in the relocation criterion for the intermediate.   
 
DPP_INTERPHAS is the dose projection period for relocation during the intermediate phase. 
 

Variable Name Definable Type Dimensions Allowed Values 

DPP_INTERPHAS Yes Real None 0.0 to 1×1010 s 

 

 Evacuation/Relocation Cost Model Description 3.4.5
 
The evacuation and relocation costs describe the expected compensation for people who are 
subject take these protective actions.  Evacuation only occurs during the emergency phase.  It 
is triggered by an emergency declaration at a nuclear plant or facility, e.g., declaration of a 
general emergency.  
 
Relocation of individuals can occur during the emergency or intermediate phases. It can also 
occur during the long-term phase, but is commonly referred to as interdiction in that case.  
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In the presentation of economic cost results, the costs associated with the emergency phase 
(i.e., for evacuation and short-term relocation) are reported separately from the costs associated 
with the intermediate phase (i.e., for relocation) and the long-term phase (i.e., decontamination, 
interdiction, condemnation, loss of use, and permanent relocation costs).  
 

 Emergency Response Cost Forms and Parameters 3.4.5.1
 
Compensation Costs Form 
The Compensation Costs form is required. 
 
EVACST defines the daily cost of compensation for evacuees and short-term relocatees who 
are removed from their homes during the emergency phase.  MACCS does not impose any 
specific set of costs for this parameter; it is entirely up to the user to determine which costs 
should be included. The value usually includes food, housing, and transportation costs.  It can 
optionally include lost income when this cost is not included in other cost inputs.  
 
RELCST defines the daily cost of compensation for individuals relocated from their homes 
during the intermediate phase of CHRONC.  MACCS does not impose any specific set of costs 
for this parameter; it is entirely up to the user to determine which costs should be included. This 
value usually includes food, housing, and transportation costs.  It can optionally include lost 
income and lost personal property when these are not included in other input parameters.  
 

Variable Name Definable Type Dimensions Allowed Values 

EVACST Yes Real None 0 to 1000 $/person-da 

RELCST Yes Real None 0 to 1000 $/person-da 

POPCST Yes Real None 1×10-6 to 1×106 $/person 

 

 Long-Term Protective Action Model Description 3.4.6
 
The long-term protective action parameters define the intermediate and long-term action time 
periods as well as the maximum doses that people are allowed to receive during these periods.  
The maximum allowable doses defined here are used to determine the need for relocation, 
decontamination, interdiction, and condemnation. 
 

 Long-Term Protective Action Forms and Parameters 3.4.6.1
 
Long-Term Exposure Period Form 
The Long-Term Exposure Period form is required. 
DUR_INTPHAS is the duration of the intermediate-phase period.  This period follows the 
emergency phase period, which is defined by EARLY variable ENDEMP. In the MACCS model, 
each phase is distinct and contiguous.  The EPA definition allows for some overlap between the 
emergency and intermediate phases and of the intermediate and long-term phases (EPA, 
2013).  While this distinction should be recognized, it has little or no effect on the consequence 
results estimated by MACCS.  
 
TMPACT is the long-term dose projection period corresponding to the long-term dose limit, 
DSCRLT.  The dose projection is estimated at the beginning of the long-term phase for the 
target organ specified by CRTOCR to determine whether land is immediately habitable. The 
combination of these three parameters established the criterion commonly referred to as the 
habitability criterion. When habitability is not met at the beginning of the long-term phase, a set 
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of actions are evaluated to determine whether habitability can be restored at a later time, as 
described in section 3.4.1.  
 
EXPTIM is the long-term exposure period. It begins when people return to their property.  For 
example, when the code estimates that 5 years of interdiction are needed at a specific location 
to satisfy the habitability criterion and EXPTIM is 30 years, doses to the resident population is 
calculated for an exposure period that begins at the beginning of year 6 and ends at the end of 
year 35 of the long-term phase. 
 
The accrual of doses from food and water ingestion is not affected by the user-specified value of 
EXPTIM.  This accrual is not strictly associated with the population from which the contaminated 
food and water originate.  The ingestion of contaminated food and water is estimated as a 
societal dose to an unspecified population. However, the ingestion dose is accounted for in the 
grid element from which the food and water originated in the output.  
 

Variable Name Definable Type Dimensions Allowed Values 

DUR_INTPHAS Yes Real None 0 to 3.1536×107 s 

TMPACT Yes Real None 0 to 1.0×1010  s 

EXPTIM Yes Real None 0 to 1.0×1010  s 

 
Long-Term Dose Criterion Form 
The Long-Term Dose Criterion form is required. 
 
DSCRTI is the maximum allowable dose commitment to the long-term critical organ (CRTOCR) 
over the intermediate-phase dose projection period (DPP_INTERPHAS). The exposure 
pathways considered in the dose projection are groundshine and resuspension inhalation.  
When the intermediate-phase dose criterion (DSCRTI) is exceeded within a grid element, the 
population there is relocated for the entire intermediate phase.  
 
DSCRLT is the maximum allowable dose commitment to the long-term critical organ (CRTOCR) 
during the long-term dose-projection period (TMPACT). These three parameters establish the 
habitability criterion. The exposure pathways considered in the dose projection are groundshine 
and resuspension inhalation.  When the long-term-phase dose criterion (DSCRLT) is exceeded 
within a grid element, the population there is relocated until the habitability criterion can be met. 
When it is not possible to reduce doses to this level in a cost-effective manner, the property is 
condemned and the resident population is permanently relocated. When this occurs, no doses 
are accrued during the long-term phase.  
 
CRTOCR defines the critical organ that is used for both the intermediate and long-term phases.   
 

Variable Name Definable Type Dimensions Allowed Values 

DSCRTI Yes Real None 0 to 1×105 Sv 

DSCRLT Yes Real None 1×10-20 to 1×105 Sv 

CRTOCR Yes Character None Organ names from 
Table 3-7 

 

 Decontamination Plan 3.4.7
 
The decontamination plan data block defines the decontamination actions that may be taken 
during the long-term period to reduce doses to acceptable levels.  Each decontamination level 
represents an alternative strategy that would reduce the projected long-term groundshine and 
resuspension doses by a factor called the dose reduction factor. 
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 Decontamination Plan Model Description 3.4.7.1

 
The objective of decontamination is to reduce projected doses below the long-term dose 
criterion in a cost-effective manner.  When the maximum decontamination level is insufficient to 
restore an area to immediate habitability, a period of temporary interdiction following the 
maximum decontamination level is considered in order to allow for dose reduction through 
radioactive decay and weathering.  When the property cannot be made habitable within 30 
years or when the cost of reclaiming the habitability of the property exceeds the cost of 
condemning it, the property is condemned and permanently withdrawn from use. 
 
Decontamination cost is divided into two categories and these two types of cost are calculated 
separately.  Farm-dependent decontamination cost represents the cost of farmland 
decontamination in a grid element.  Farm-dependent decontamination cost is a function of the 
area of the grid element devoted to agriculture.  Population-dependent decontamination 
represents the cost of non-farmland decontamination.  Population-dependent decontamination 
cost is a function of the population residing in the grid element.  The strategy of decontamination 
within a grid element is largely independent of the type of area being decontaminated, with the 
exception that farmland can be decontaminated to restore habitability but not to restore 
farmability, as explained above. 
 
For a given decontamination level, the same decontamination time and effectiveness apply to 
both farmland and non-farmland, but the two costs are unique and are assigned independently 
for each type of decontamination.  Owing to the requirement that the recovery of property must 
be cost-effective, it is possible, in a given element, that decontamination of non-farmland is 
performed and it is restored to use, but farmland is instead condemned. 
 
Decontamination of a grid element serves to reduce the dose level in that element by the dose 
reduction factor associated with the decontamination effort being applied.  Everything else being 
equal, a decontamination factor of 10 causes the integrated dose over any exposure period to 
be reduced by a factor of 10.  Dose reduction factors are presented in Table 3-8. 
 

Table 3-8  Decontamination factors. 

Dose Reduction 

Factor 

Percent of Dose 

Reduction 

2 50% 

3 66.7% 

5 80% 

10 90% 

15 93.3% 

20 95% 

50 98% 

100 99% 

 
During the decontamination period, which is assumed to begin at the start of the long term 
phase, the population has been relocated from areas that are decontaminated. 
 
While engaged in cleanup efforts, decontamination workers are assumed to wear respiratory 
protection devices.  Therefore, they accumulate only groundshine doses.  These doses 
contribute to the aggregate dose tabulated in the MACCS output. 
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Decontamination reduces direct exposure doses (both groundshine and resuspension) caused 
by contamination of land and buildings.  Many decontamination processes reduce groundshine 
and resuspension doses by washing surface contamination down into the ground.  These 
processes do not eliminate contamination from the area, but they do reduce doses to the 
population by adding shielding. Since these processes may not move contamination out of the 
root zone, the WASH-1400-based economic cost model of MACCS assumes that farmland 
decontamination reduces direct exposure doses to farmers without reducing uptake of 
radioactivity by root systems.  Thus, decontamination of farmland does not reduce the ingestion 
doses produced by consumption of crops that are contaminated by root uptake. This is why 
decontamination is not considered for restoring farmability.  
 

 Decontamination Plan Forms and Parameters 3.4.7.2
 
Number of Plan Levels Form 
The Number of Plan Levels form is required. 
 
LVLDEC is the number of decontamination levels that can be used.  Each decontamination level 
represents an alternative strategy to reduce the projected long-term groundshine and 
resuspension inhalation doses. 
 

Variable Name Definable Type Dimensions Allowed Values 

LVLDEC Yes Integer None 1 to 3 

 
Plan Definition Form 
The Plan Definition form is required. 
 
DLBCST is the labor cost of a decontamination worker. 
 
TIMDEC defines the time required for completion of each level of decontamination.  
Decontamination begins at the end of the intermediate phase (TMIPND).  The values must be 
monotonically increasing. 
 
DSRFCT defines the effectiveness of the various decontamination levels in reducing dose.  A 
dose reduction factor of 3 means that the resulting population dose at that location is reduced to 
one-third of what it would have been without decontamination.  The values must be 
monotonically increasing. 
 
TFWKF defines the fraction of the decontamination period (TIMDEC) that a farmland 
decontamination worker spends in the contaminated area for each level of decontamination.  
 
TFWKNF defines the fraction of the decontamination period (TIMDEC) that a non-farmland 
decontamination worker spends in the contaminated area during the decontamination period for 
each level of decontamination.   
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Variable Name Definable Type Dimensions Allowed Values 

DLBCST Yes Real None 1.0 to 1×106  
$/person-yr 

TIMDEC Yes Real LVLDEC 1×10-6 to 3.15×107 s (1 
yr) 

DSRFCT Yes Real LVLDEC 1.01 to 100.0 

TFWKF Yes Real LVLDEC 0.0 to 1.0 

TFWKNF Yes Real LVLDEC 0.0 to 1.0 

 
Farmland Costs Form 
The Farmland Costs form is required. 
 
CDFRM defines the farmland decontamination costs for each level of decontamination.  Values 
must be monotonically increasing.  
 
FRFDL defines the fraction of the farmland decontamination cost that is due to labor for each 
level of decontamination.   
 

Variable Name Definable Type Dimensions Allowed Values 

CDFRM Yes Real LVLDEC 1.0 to 1×105 $/ha 

FRFDL Yes Real LVLDEC 0.0 to 1.0 

 
NonFarmland Costs Form 
The Non-farmland Costs form is required. 
 
CDNFRM defines the non-farmland decontamination costs of each level of decontamination.  
Values must be monotonically increasing. 
 
FRNFDL defines the fraction of the non-farmland decontamination cost that is due to labor of 
each level of decontamination.   
 

Variable Name Definable Type Dimensions Allowed Values 

CDNFRM Yes Real LVLDEC 1.0 to 1×105 

$/person 

FRNFDL Yes Real LVLDEC 0.0 to 1.0 

 

 Interdiction Costs 3.4.8
 
The interdiction plan cost data block defines the parameters needed to calculate the cost of 
interdiction.  The data supplied here are combined with data in the site data file and the regional 
characteristics data in the course of the calculations. 
 

 Interdiction Cost Model Description 3.4.8.1
 
The model used in MACCS for assessing the cost of interdiction is based on the model 
described in WASH-1400, Appendix 6.  It is currently used to calculate the economic cost of 
loss of use during both decontamination and temporary interdiction periods 
 

 Interdiction Cost Forms and Parameters 3.4.8.2
 
Interdiction Costs Form 
The Interdiction Costs form is required. 
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DPRATE defines the depreciation rate that applies to property improvements during a period of 
interdiction.  This depreciation rate is intended to account for the loss of value of buildings and 
other structures resulting from a lack of habitation and maintenance. 
 
DSRATE defines the expected rate of return from land, buildings, equipment, etc.   
 
POPCST defines the per-capita, one-time relocation cost for temporary or permanent relocation 
of population and businesses in a region rendered uninhabitable during the long-term phase.  
This cost is assessed when any of the following actions are required: decontamination alone, 
decontamination followed by interdiction, or condemnation.  This value can account for personal 
and corporate income losses for a transitional period and/or moving expenses. 
 

Variable Name Definable Type Dimensions Allowed Values 

DPRATE Yes Real None 0.0 to 1.0 per yr 

DSRATE Yes Real None 0.0 to 1.0 per yr 

 

 Weathering 3.4.9
 

 Weathering Model Description 3.4.9.1
 
The groundshine weathering relationship from Gale, Miller, and Fisher (1964) is described as 
follows:   
 

 GW(t)  = GWCOEF(1)  exp[ln(2)  t/TGWHLF(1)] +     (Equation 43) 

   GWCOEF(2)  exp[ln(2)  t/TGWHLF(2)] 

Where  

 GW(t) represents the groundshine weathering at time t, given the weathering 
coefficients, GWCOEF, and the weathering half-lives, TGWHLF.   

The resuspension weathering relationship is defined as: 

 RW(t)  = RWCOEF(1)  exp[ln(2)  t/TRWHLF(1)] +     (Equation 44) 

   RWCOEF(2)  exp[ln(2)  t/TRWHLF(2)]  

   RWCOEF(3)  exp[ln(2)  t/TRWHLF(3)]  

Where  

RW(t) represents the resuspension weathering at time t, given the weathering 
coefficients, RWCOEF, and the weathering half-lives, TRWHLF. 

The values are defined under the Weathering category in the WinMACCS interface. 

 Weathering Forms and Parameters 3.4.9.2
 
Groundshine Weathering Terms Form 
The Groundshine Weathering Terms form is required. 
 



3-124 

NGWTRM defines the number of terms in the groundshine weathering relationship.  
 

Variable Name Definable Type Dimensions Allowed Values 

NGWTRM   Yes Integer None 1 to 2 

 
Groundshine Weathering Coefficient Form 
The Groundshine Weathering Coefficient form is required. 
 
GWCOEF is the set of coefficients in the groundshine weathering equation. 
 
TGWHLF is the set of half-lives in the groundshine weathering equation. 
 
 

Variable Name Definable Type Dimensions Allowed Values 

GWCOEF Yes Real NGWTRM   1×10-20 to 1.0 

TGWHLF Yes Real NGWTRM   1×10-6 to 1×1012 s 

 
Resuspension Weathering Terms Form 
The Resuspension Weathering Terms form is required. 
 
NRWTRM defines the number of terms in the resuspension weathering relationship.  
 

Variable Name Definable Type Dimensions Allowed Values 

NRWTRM Yes Integer None 1 to 3 

 
Resuspension Weathering Coefficient Form 
Resuspension Weathering Coefficient is required. 
 
RWCOEF is the set of resuspension weathering coefficients. 
 
TRWHLF is the set of resuspension weathering half-lives. 
 

Variable Name Definable Type Dimensions Allowed Values 

RWCOEF Yes Real NRWTRM 1×10-20 to 1.0 /m 

TGWHLF Yes Real NRWTRM 1×10-6 to 1×1012 s 

 

 Regional Characteristics 3.4.10
 
The regional characteristics data block defines the aggregate economic and agricultural 
characteristics of the area surrounding the accident site. 
 

 Regional Characteristics Model Description 3.4.10.1
 
When mitigative actions are needed to restore habitability or farmability, the regional 
characteristic values are used to evaluate the cost-effectiveness of those actions.  For instance, 
when the average property values supplied here indicate that decontaminating a piece of land 
costs more than condemning it, the land is condemned. 
 
In order to implement the rotation strategy when the user has chosen the option of No Windshift 
with Rotation (IPLUME=1) or Windshift with Rotation (IPLUME=2), the result of the 
cost-effectiveness test must the same in any direction. Thus, instead of using actual property 
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values from the site file, uniform values defined in the following section are used to make the 
decision on whether it is cost effective to decontaminate. 
 

 Regional Characteristic Forms and Parameters 3.4.10.2
 
Farmland Wealth Form 
The Farmland Wealth form is required. 
 
VALWF defines the average value of farm wealth in the region.  This value should include both 
publicly and privately owned grazing lands, farmland, farm buildings, and nonrecoverable farm 
machinery, as well as any publicly owned infrastructure serving the farm industry in the region. 
A corresponding value (VFRM) is calculated for each economic region by SecPop. The SecPop 
value is not averaged over the entire region, so it is able to represent variations in farmland 
wealth within a computation grid. When a site file is used in a calculation, the actual losses are 
estimated from the site file values (VFRM) rather than the input value (VALWF).  
 
FRFIM defines the fraction of farm wealth in the region due to improvements.  This value 
includes farm buildings and nonrecoverable machinery, as well as any infrastructure such as 
silos and irrigation, which are devoted exclusively to the support of farming. 
 

Variable Name Definable Type Dimensions Allowed Values 

VALWF Yes Real None 1×10-6 to 1×106 
$/ha 

FRFIM Yes Real None 0.0 to 1.0 

 
Non-farmland Wealth Form 
The Non-farmland Wealth form is required. 
 
VALWNF defines the value of the nonfarm wealth in the region.  Nonfarm wealth includes all 
public and private property not associated with farming that would be unusable when the region 
was rendered either temporarily or permanently uninhabitable.  This value should include the 
cost of land, buildings, infrastructure, and the cost of any nonrecoverable equipment or 
machinery. A corresponding value (VNFRM) is calculated for each economic region by SecPop. 
The SecPop value is not averaged over the entire region, so it is able to represent variations in 
non-farmland wealth within a computation grid. When a site file is used in a calculation, the 
actual losses are estimated from the site file values (VNFRM) rather than the input value 
(VALWNF).   
 
FRNFIM defines the fraction of nonfarm wealth in the region due to improvements.  This value 
includes buildings and infrastructure such as roads and utilities, as well as any nonrecoverable 
equipment or machinery.  
 

Variable Name Definable Type Dimensions Allowed Values 

VALWNF Yes Real None 1×10-6 to 1×106 
$/person 

FRNFIM Yes Real None 0.0 to 1.0 

 
Land Usage Form 
Land Usage is required when Uniform is selected on the Site Data tab on the Properties form. 
When Import from File is selected on the Site Data tab, the values needed in the calculation are 
taken from the site data file. 
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FRCFRM defines the average fraction of land in the region devoted to farm production.  The 
land area devoted to agriculture is calculated as follows: 
 
 agricultural area = total area • FRACLD • FRCFRM    (Equation 46) 
 
FRMPRD defines the value of the average annual farm production (gross sales) in the region. 
 
DPFRCT defines the fraction of annual farm production (gross sales) in the region resulting from 
dairy production. 
 

Variable Name Definable Type Dimensions Allowed Values 

FRCFRM Yes Real None 1×10-6 to 1.0 

FRMPRD Yes Real None 0 to 1×105 $/ha 

DPFRCT Yes Real None 0.0 to 1.0 

 

 Food Chain 3.4.11
 
The user has a choice of using one of two food-chain models, or specifying that food-chain 
doses are not treated.  These choices are made on the Food tab of the Properties form. When 
the user selects No Food Model on the Food tab, user input is not required in this section; 
otherwise input is required. When the MACCS Food Model is chosen on the Food tab, all input 
to the food-chain model is contained in this section. When the COMIDA2 food-chain model is 
used, MACCS uses a binary data file written by the preprocessing program, COMIDA2, which 
contains the results of the COMIDA2 food-chain modeling calculations. 
 
When User Supplies COMIDA2 File is specified, the user must specify the COMIDA2 binary file 
to be used.  The name of the files is specified on the COMIDA2 File form found under the 
GENERAL/File Specifications category.  Additionally, the same DCF file used to create the user 
supplied COMIDA2 file must be specified as the DCF file specified in the GENERAL/File 
Specifications/Dose Conversion Factor File form. 
 
When Create COMIDA2 File is specified, the user must complete the forms found in the main 
model category titled COMIDA2.  In this case, when the model is executed, the COMIDA2 pre-
processor is run first.  This pre-processor uses the dose conversion factor file (DCF file) 
specified and creates a binary file to be used by MACCS.  One purpose for using this option is 
that uncertainty in food-chain parameters can be included in MACCS calculations. 
 
When one of the dose threshold models is used, either Annual Threshold or Piecewise Linear, 
creating the COMIDA2 binary file is not supported. Also, the MACCS food-chain model is not 
compatible with these choices.  WinMACCS enforces these requirements.  
 

 Food-Chain Model Descriptions 3.4.11.1
 
Modeling of Agricultural Countermeasures 
LASTACUM, a COMIDA2 input parameter, specifies the duration of the ingestion dose period.  
MACCS calculates the accumulated societal dose starting with the year that the land satisfies 
the human consumption criteria DOSEMILK and DOSEOTHR, with the exposure period ending 
in the LASTACUM year after the accident.  The allowable range for the LASTACUM variable is 
from 1 to 50 years.  The value of the LASTACUM variable is defined in the COMIDA2 user input 
file.  It is communicated to MACCS as part of the header information on the .BIN file written by 
COMIDA2.   
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Consistent with the MACCS interdiction model, the maximum farmland interdiction period 
considered is 8 years.  Land that cannot be returned to production after 8 years is condemned.  
MACCS condemns land that cannot be returned to production within LASTACUM years when 
the COMIDA2 model is used and the LASTACUM input variable is assigned a value less than 9. 
 
To preserve the functionality of the MACCS food-chain model, agricultural countermeasures are 
always subordinate to the code's evaluation of habitability.  That is, when land is uninhabitable 
because projected groundshine and resuspension doses exceed the long-term dose criterion 
DSCRLT, agricultural production at that location is not allowed.   
 
Furthermore, when the resident population is never allowed to return, either because of a failure 
to meet the dose criterion, or because the costs to restore habitability exceed the value of the 
property, farmland is also assumed to be condemned, irrespective of the projected doses from 
food ingestion.  When the farmland is condemned, none of the additional tests described below 
are performed.  The costs associated with the condemnation of the farmland are based on the 
value of the property, input variable VALWF. 
 
When the habitability dose criterion specified by the user is met, the following tests are 
performed by the code to determine the level of interdiction of agricultural production.  The 
second year following the accident, year 2, is the first year for which the long-term ingestion 
dose criterion (DOSELONG) is evaluated.  Milk and crop disposal during the year of the 
accident are triggered when the habitability criterion (DSCRLT) is exceeded in the year of the 
accident.  When DSCRLT does not lead to the triggering of milk and nonmilk crop disposal, the 
individual criteria for the first year's milk (DOSEMILK) and the first year's nonmilk crops 
(DOSEOTHR) are examined separately to find whether either is exceeded.  The disposal of milk 
and/or nonmilk crops is triggered when the projected ingestion dose for these two categories 
exceeds the DOSEMILK and/or DOSEOTHR criteria.  The first-year dose criteria are evaluated 
using the consumption rates specified by the COMIDA2 input variable CONSUM_RATES.  
 
Milk and crop disposal costs are calculated only for the year of the accident.  Beginning in the 
second year after the accident, acceptability of food production is evaluated by comparing the 
projected individual dose with DOSELONG.   
 
When the projected individual dose for the second year does not exceed the dose criterion 
DOSELONG, agricultural production for that year and all subsequent years is allowed.  Implicit 
in the model is the assumption that the food doses resulting from successive years of 
production do not increase with time.  Also, just as with the MACCS food-chain model, the long-
term interdiction of farmland applies to all crop categories; there is no provision for long-term 
interdiction of a subset of the crops.  
 
When the projected individual dose from the second year of agricultural production exceeds the 
dose criterion, the projected doses for up to eight successive annual periods are each examined 
in order to determine whether production can be resumed within the first 9 years after the 
accident.   
 
When the projected doses in each of years 2 through 9 exceed DOSELONG, no further tests 
are performed and the farmland is condemned.  When farmland is condemned, the associated 
cost is the market value of the farmland, VALWF, with dollar values reported on the output 
listing as FARM DEPENDENT CONDEMNATION COST.  
 
When the projected doses for one of the years examined satisfy the long-term dose criterion, 
agricultural production is assumed to resume in that year.  In that case, societal ingestion doses 
are assessed for the period ending with the LASTACUM year. 



3-128 

   
For example, when DOSELONG is satisfied in year 3, and LASTACUM has a value of 10, 
societal doses are accrued for the period denoted as years 3–10, an exposure period with a 
duration of 8 years.  Since agricultural production was not allowed in the first and second years, 
economic costs for 2 years of interdiction are assessed for farmland.  The model calculates the 
cost of temporary interdiction as the loss of return on investment of the land and improvements 
(see variables VALWF and FRFIM) and accounts for depreciation on the improvements (see 
input variables DSRATE and DPRATE). 
 
First-Year Crop Disposal Cost 
The economic cost of milk and/or nonmilk crop disposal during year 1 is modeled as the 
economic costs assessed for the loss of sales.  The two crop disposal cost calculations, 
however, consistent with CRAC2, are treated differently, as follows.  
 
When the disposal of the first year's milk production is triggered because the dose criterion 
DOSEMILK is exceeded, milk disposal costs are assessed as 0.25 of annual milk sales (see 
variables FRMPRD and DPFRCT).  The rationale for the reduction in milk disposal costs by the 
application of the 0.25 adjustment factor was based on the assumption that cows would be 
taken off pasture and fed uncontaminated feed, allowing dairy production to resume after one-
quarter of a year.  In order to maintain consistency with the MACCS food-chain model, the 
application of the fixed 0.25 adjustment factor on milk disposal costs has also been 
implemented for the COMIDA2 food-chain model. 
 
It is noted that the model implemented in MACCS for crop disposal costs, and the 0.25 factor for 
lost dairy sales, is not based on WASH-1400 because WASH-1400 did not account for crop 
disposal costs.  CRAC2, in contrast to WASH-1400, did implement separate milk and nonmilk 
crop disposal costs, providing the technical basis for the MACCS model to assess such costs.  
CRAC2, however, in assessing the costs of milk and nonmilk crop disposal, assessed a milk 
disposal cost based on the full year's dairy sales, and not the 0.25 of dairy sales used in the 
MACCS cost model.   
 
The technical basis for the 0.25 adjustment factor for milk disposal is not mentioned in the 
MACCS Model Description, but it was based on the assumption that dairy cows spend only a 
fraction of the year on pasture and obtain most of their food from stored feed.   
 
Water Ingestion Model 
When radioactive material is deposited on the ground, it is expected that some fraction of this 
material makes its way into drinking water consumed by humans (Helton, Muller, and Bayer, 
1985).  MACCS models this uptake into drinking water as two separate paths: (1) deposition of 
material directly onto freshwater bodies and (2) deposition of material onto land with subsequent 
wash off into freshwater bodies. 
 
The water ingestion model assumes that the area surrounding the site is divided into two 
categories: water and land.  The radioactive material deposited on a spatial element is initially 
apportioned between water and land according to the fraction of the region covered by land.  
For coastal sites, where both fresh water and ocean water need to be treated, it is 
recommended that the user create a site data file with more than one watershed.  A site data file 
can define up to four watersheds.  One or more of those watersheds (e.g., ocean) can be 
defined to have a 0 uptake fraction. 
 
The parameters described below are used to define the behavior of the single watershed that is 
used when a uniform population density has been specified. The user specifies which 
radionuclides are to be included with the water ingestion pathway.  
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Of the activity deposited directly onto water or transferred from land to water, the fraction 
represented by WINGF determines how much of that deposited activity is eventually consumed 
by humans.  Once the activity is transferred to the water body, there is no adjustment to account 
for radioactive decay.  
 
Of the activity that is initially deposited on land, some fraction makes its way through runoff into 
the freshwater supply over a relatively short time period after deposition.  This fraction is 
specified by the value of WSHRTI. The remainder of the material deposited on land is assumed 
to be washed off to the freshwater supply at a constant fractional rate over the time from t=0 to 
t=infinity.  The rate at which this subsequent wash off occurs is specified by the value of the rate 
constant WSHRTA. 
 
The model uses the values of the two variables, WSHRTI and WSHRTA, and evaluates the 
integral of the wash off fraction in a way that takes account of radioactive decay of the material 
deposited on land surfaces.  The model is described by Helton, Muller, and Bayer (1985).  The 
evaluation of this integral produces a numerical value, F, that represents the fraction of activity 
falling on land that is eventually transferred to surface water bodies that supply drinking water. 
 
With the value of F, the uptake fraction of activity deposited on land can be calculated, which is 
WINGF• F.  The input variable WINGF is the ratio of the total amount of a radionuclide 
consumed via the drinking-water pathway (i.e., by the entire population of the region 
surrounding the facility) and the amount entering potable surface-water bodies.  Ideally, a value 
for WINGF should be derived from a model for radionuclide transport through the surface-water 
system of the surrounding region. 
 
The models used to determine WINGF can vary in complexity from the very simple (e.g., a 
single uniformly mixed cell) to the very complex (e.g., three-dimensional fluid transport with 
temporal and spatial variability).  The value of WINGF supplied with the sample problems was 
derived in a very simple manner. 
 
MACCS Food Model 
Ingestion Transfer Factors 
When this model is selected, MACCS performs food and water ingestion calculations in the 
same manner as the original MACCS code used in NUREG-1150.   
 
When radioactive material is deposited on land, some fraction of this material may make its way 
through the food chain and ultimately be consumed by man in the form of contaminated food or 
drinking water.  The ingestion pathway is modeled in MACCS as a series of transfer processes 
that the material must undergo between the time of deposition and the consumption of the 
contaminated food products by humans; these processes decrease the amount of material 
passed on to the next step in the food chain. 
 
To calculate the population dose resulting from the accumulated contamination of an area, it is 
necessary to know the efficiency of the entire food chain taken as a whole in transferring 
material from the ground to man.  MACCS calculates the overall efficiency of the two ingestion 
pathways (food and water) by multiplication of all of the individual transfer factors which are 
described below, yielding an overall weighted sum representing the effectiveness of the 
pathway in transferring material from the ground to human consumption. 
 
Removal of Radioactivity from Plant Surfaces by Weathering 
When an accident occurs during the growing season, part of the radioactive material deposited 
on farmland is retained on plant surfaces and the remainder falls on the ground.  Between the 
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time of deposition and the time of harvest, radioactive material can be lost from plant surfaces 
due to weathering, radioactive decay, translocation to interior portions of the plant, and the 
harvesting process. 
 
The fraction of radioactive material that is removed from the air due to dry and wet deposition 
that ends up in edible portions of the harvested plant is referred to as the growing crop retention 
factor.  Specifically, this factor is defined to be the ratio between the amount of a radionuclide 
present in the crop at harvest and the total amount of material initially deposited onto the land 
used for producing that crop. 
 
For all crops except pasture, harvesting occurs at the end of the growing season.  The 
harvesting of pasture differs from other crops in that it is a continuous process.  In MACCS it is 
assumed that grazing takes exactly one growing season to harvest the year's entire production 
of the pasture crop. The numerical integration used in the pasture dose calculations is therefore 
different from that used for the other crop categories.  The type of integration performed by the 
code is determined by the name given to the crop categories.  Crop names beginning with 
PASTURE are treated differently from the rest. 
 
For crops where the edible portion of the plant is exposed to the environment, weathering 
losses over the period from deposition to harvesting decreases the amount of radionuclides 
retained as a function of time.  That is, the longer the time between deposition and harvesting, 
the lower the resultant dose. 
 
Crops such as grains and legumes, which have the edible portions internal to the plant, may 
show the opposite behavior, with material being absorbed into the plant over time.  Since this is 
a slow process and data on translocation rates are hard to obtain, the user should try to define 
an average retention factor appropriate for deposition onto crops that is independent of time 
during the growing season, and not use the weathering model for these types of crops.  The 
situation is further complicated by the fact that available data suggest that total retention for 
grains is greatest when the deposition occurs near the middle of the growing season rather than 
at the end of it. 
 
Both types of crops are modeled with a weathering equation that can have up to three 
exponential terms, each with a different weathering rate.  For the types of crops not subject to 
weathering losses (that is, grains and legumes), a very long half-life can be specified for the 
weathering rate as a way of replacing the weathering function with a constant transfer fraction. 
In MACCS the removal of radioactivity from plant surfaces by weathering is treated as a sum of 
terms that have the following form: 
 

 CTCOEF • exp (–• t), 
 
Where CTCOEF represents the fraction of material deposited on a cultivated field that is 

removed by weathering with a decay rate of  = 0.693 / CTHALF. 
 
CTCOEF equals the product of two quantities: the interception fraction and the availability 
fraction.  The interception fraction is the fraction of material deposited onto a field that is 
intercepted by crop surfaces and the availability fraction is the fraction of material deposited 
onto crop surfaces that is weathered away with the half-life CTHALF. 
 
When CTCOEF includes the effects of weathering, as suggested above, the exponential part of 
the weathering decay expression associated with this empirical value for CTCOEF is reduced to 
unity by setting CTHALF to the maximum allowable value, 3.15x1013 s (106 yr). Because 
translocation from the plant surface to interior portions influences the retention of radioactivity 
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for grains, legumes, and root crops, the weathering model can be modified provide a transfer 
factor that is nearly constant in time. 
 
Since long-term uptake is treated separately from the growing-season portion of the model, this 
may cause the long-term uptake dose from grains and legumes to be double counted in the first 
growing season.  However, since root uptake in a single season is typically small relative to the 
contamination resulting from direct deposition, the potential impact of such a double counting is 
unlikely to be significant. 
 
The number of terms in the weathering equation is defined in on the Food tab.  Up to three 
terms are supported. 
 
Protective Action 
In the unlikely event of an accident at a nuclear facility, an assessment of the accident's impact 
on agricultural production in the surrounding region can be performed with MACCS.  Based on a 
projected dose to an individual consuming locally produced food products, the local authorities 
determine whether local agricultural products are safe to eat.  When the food product is judged 
to be unsafe, two kinds of actions can be taken: disposal of current-year crops and long-term 
restriction of agricultural production in subsequent growing seasons. 
 
The MACCS food-chain model divides agricultural activities into four components representing 
two sets of binary pairs: 

 MILK DIRECT-DEPOSITION 

 CROP DIRECT-DEPOSITION 

 MILK ROOT-UPTAKE 

 CROP ROOT-UPTAKE 
 
This terminology is defined as follows.  MILK refers to fresh milk and dairy products, such as 
cheese and butter.  CROP refers to all other foodstuffs.  DIRECT-DEPOSITION refers to doses 
that result when an accident occurs during the growing season and the doses are incurred in 
the single annual period following the accident.  When an accident occurs outside of the 
growing season, the code does not evaluate the need for disposal of crops, and the 
corresponding doses from DIRECT-DEPOSITION are reported as zero.  By contrast, ROOT-
UPTAKE refers to food doses that result regardless of whether the accident occurs during the 
growing season, and these are calculated over an infinite time period.  For accidents that occur 
during the growing season, first-year doses are from both direct-deposition and root-uptake in 
the MACCS food-chain model. 
 
The stringency (degree of protection) for both types of mitigative actions is specified by the user 
through input parameters.  All of these parameters are specified in terms of allowable ground 
concentration and are referred to as "action guides." 
 

 Food Chain Forms and Parameters 3.4.11.2
 
Maximum Food Ingestion Dose Form 
The Maximum Food Ingestion Dose form is required when the COMIDA2 Food Model is 
selected on the Food tab.  When it is not acceptable to produce milk or crops, production is 
interdicted for up to LASTACUM–1 or 8 years, whichever is smaller, until farmability is restored.  
When the allowed years of interdiction are insufficient to restore farmability, farmland is 
condemned. 
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DOSEMILK, DOSEOTHR, and DOSELONG are vectors of size two. The first entry corresponds 
to a limit on effective dose, the second corresponds to a limit on thyroid dose. These 
parameters define the allowable individual food doses that determine farmability.  
 
DOSEMILK is the maximum allowable food ingestion dose from milk products during the year of 
the accident.  For dairy to be allowed in the first year after an accident, individual milk doses 
must be below this limit. In addition, second-year individual doses from milk products plus crops 
must not exceed DOSELONG. DOSEMILK is intended to fulfill a purpose similar to that served 
by the variable PSCMILK of the MACCS food-chain model. 
 
DOSEOTHR is the maximum allowable food ingestion dose from non-milk crops during the year 
of the accident.  For crops to be produced in the first year after an accident, individual doses 
from consumption of crops must be below this limit. In addition, second-year doses from milk 
plus crops must not exceed DOSELONG. This variable is intended to fulfill a purpose similar to 
that served by the variable PSCOTHR of the MACCS food-chain model. 
 
DOSELONG is the maximum allowable "long-term" annual dose to an individual from ingestion 
of the combination of milk and non-milk crops. These parameter values are used for determining 
whether agricultural production is suitable for consumption in years subsequent to the year of 
the accident. 
 
To use the COMIDA2 food-chain model in MACCS, the user must at a minimum select the 
lifetime (L-) organ flags to be true for two organs, effective and thyroid, for the EARLY variable 
ORGFLG. 
 

Variable Name Definable Type Dimensions Allowed Values 

DOSEMILK Yes Real 2 0.0 to 1×1010 Sv 

DOSEOTHR Yes Real 2 0.0 to 1×1010 Sv 

DOSELONG Yes Real 2 0.0 to 1×1010 Sv 

 
Radionuclides Form 
The Radionuclides form is required when MACCS Food Model is selected on the Food tab. This 
model does not account for the food ingestion doses from decay products of the food pathway 
radionuclides defined in NAMIPI. For this reason, the MACCS food-chain model should only be 
used with DCF files created by DOSFAC because they include doses from short-lived decay 
products with their parents.  
 
NFIISO defines the number of radionuclides for the food-ingestion pathway. 
 
NAMIPI defines the set of radionuclides used in the food-pathway model.  This list must include 
all of the radionuclides that are specified for the drinking water pathway, and they must appear 
in the same order as in NAMWPI. 
 

Variable Name Definable Type Dimensions Allowed Values 

NFIISO Linked Integer None 1 to 10 

NAMIPI Yes Character NFIISO Radionuclides defined 
in ATMOS variable 
NUCNAM 

 
Crop Ingestion Form 
The Crop Ingestion form is required when the MACCS Food Model is selected on the Food tab. 
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NFICRP defines the number of crop categories that are used by the food-pathway model. 
 
NAMCRP defines the name of a crop category used in the food-pathway model. MACCS 
distinguishes between two types of crops: those harvested at the end of the growing season, 
and those harvested continuously over the entire growing season.  The first seven letters of the 
crop names supplied here are used to distinguish between these two types of crops.  When a 
crop's name begins with 'PASTURE', it is harvested continuously; when it doesn't, it is 
harvested at the end of the growing season. 
 
FRCTCH specifies the fraction of the edible portion of the harvested crop that is consumed by 
humans.  The user must supply NFICRP values for this variable in column 2 of the data block. 
 
FRCTCM specifies the fraction of the edible portion of the harvested crop that is consumed by 
milk-producing animals. 
 
FRCTCB specifies the fraction of the edible portion of the harvested crop that is consumed by 
meat-producing animals. 
 

Variable Name Definable Type Dimensions Allowed Values 

NFICRP Linked Integer None 1 to 10 

NAMCRP Yes Character NFICRP 6 to 20 characters 

FRCTCH Yes Real NFICRP 0.0 to 1.0 

FRCTCM Yes Real NFICRP 0.0 to 1.0 

FRCTCB Yes Real NFICRP 0.0 to 1.0 

 
Meat/Milk Ingestion Form 
The Meat/Milk Ingestion form is required when the MACCS Food Model is selected on the Food 
tab. 
 
DCYPMH is the transfer factor describing the processing losses and radioactive decay that 
occur between the production and the consumption of milk products. Specifically, it is the ratio 
of the amount of a radionuclide in milk products at the time of consumption to the amount in the 
milk at the time of its production (milking).  The values are multiplied by the values of TFMLK to 
define the efficiency of the milk-to-man food pathway.   
 
DCYPBH is the transfer factor describing the processing losses and radioactive decay that 
occur between the production and the consumption of meat products. It is the ratio of the 
amount of a radionuclide in meat products at the time of consumption to the amount of that 
radionuclide in the meat at the time of its production (slaughter). The values given here are 
multiplied by the values given for TFBF in order to define the efficiency of the meat-to-man 
pathway 
 
TFMLK is the transfer factor describing how much of a radionuclide ingested by milk-producing 
animals ends up in milk products at the time of their production (milking). It is the ratio of the 
amount of a radionuclide in fresh milk to the amount of the radionuclide consumed by 
milk-producing animals.  It accounts for biological transport within the animal as well as 
radioactive decay.  The values are multiplied by the values of DCYPMH to define the efficiency 
of the milk-to-man food pathway.   
 
TFBF is the transfer factor describing how much of the material ingested by meat-producing 
animals ends up in meat products at the time of their production. It is the ratio of the amount of a 
radionuclide in edible meat at the time of slaughter to the amount of the radionuclide that was 
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consumed by the meat-producing animals.  It takes account of biological transport within the 
animals as well as radioactive decay. The values are multiplied by the values of DCYPBH to 
define the efficiency of the meat-to-man food pathway. 
 

Variable Name Definable Type Dimensions Allowed Values 

DCYPMH Yes Real NFIISO 0.0 to 1.0 

DCYPBH Yes Real NFIISO 0.0 to 1.0 

TFMLK Yes Real NFIISO 0.0 to 1.0 

TFBF Yes Real NFIISO 0.0 to 1.0 

 
Soil to Edible Crops Form 
The Soil to Edible Crops form is required when MACCS Food Model is selected on the Food 
tab. 
 
TCROOT defines the transfer factor for long-term transfer of radionuclides from soil to edible 
crops.  This is the ratio of the amount of a radionuclide taken up from soil into edible portions of 
a crop to the amount that was deposited onto the soil. The long-term transfer of radionuclides 
from soil to plants occurs principally by uptake (sorption) by plant root systems.  Transfer to 
plant surfaces by rain splash and by deposition of materials resuspended from surface soil can 
also contribute to this pathway.   
 
The values of TCROOT supplied in the data block should be calculated by integrating the 
overall uptake rate over the period from t=0 to infinity.  In other words, TCROOT incorporates 
the total uptake over all time after the initial deposition.  Since radionuclides are removed from 
the soil compartment not only by root uptake but also by radioactive decay, percolation, and 
irreversible chemical binding, all of these processes should be incorporated into the derivation 
of TCROOT.  
 
The annual rate at which the material is made unavailable by these processes is specified by 
the input variable QROOT.   
 

Variable Name Definable Type Dimensions Allowed Values 

TCROOT Yes Real NFIISO 
by 

NFICRP 

0.0 to 1.0 

 
Crop Radioactive Decay Loss Form 
The Crop Radioactive Decay Loss form is required when MACCS Food Model is selected on 
the Food tab. 
 
DCYPCH is the ratio of the amount of a radionuclide present in a crop at the time of 
consumption and the time of harvest, accounting for losses due to radioactive decay.  The 
values are used to calculate ingestion doses arising from both direct deposition onto growing 
crops and the long-term uptake processes of subsequent growing seasons. It is only applied to 
crops that are directly consumed by humans (e.g., grains, vegetables, and legumes).  Values 
supplied for crops not consumed by humans have no impact on the calculations.  The values 
are multiplied by the corresponding values of FPLSCH, which characterizes processing losses, 
to obtain the overall transfer factor for this part of the food chain.  Values of DCYPCH must be 
specified for each crop category for all radionuclides treated by the food pathway model (i.e., for 
all possible radionuclide/crop combinations). 
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Variable Name Definable Type Dimensions Allowed Values 

DCYPCH Yes Real NFIISO 
by 

NFICRP 

0.0 to 1.0 

 
Meat/Milk Radioactive Decay Loss Form 
The Meat/Milk Radioactive Decay Loss form is required when MACCS Food Model is selected 
on the Food tab. 
 
DCYPCM is the ratio of the amount of a radionuclide in the crop at the time of its consumption 
to the amount at the time of harvest.  The data supplied here are used in calculating ingestion 
dose arising from both direct deposition onto growing crops and the long-term uptake processes 
of subsequent growing seasons. It is applied only to crops that are directly consumed by 
milk-producing animals (e.g., pasture and forage).  Any values supplied for crops not consumed 
by milk-producing animals have no impact on the calculations.  
 
For pasture crops, harvest and consumption are simultaneous and so DCYPCM should be set 
to 1.0 for the pasture crop categories.  Values of DCYPCM must be specified for each crop 
category for all radionuclides treated by the food pathway model (i.e., for all possible 
radionuclide-crop combinations). 
 

Variable Name Definable Type Dimensions Allowed Values 

DCYPCM Yes Real NFIISO 
by 

NFICRP 

0.0 to 1.0 

 
Crop Radioactive Retention Form 
The Crop Radioactive Retention form is required when the MACCS Food Model is selected on 
the Food tab.  
 
FPLSCH is the ratio of the amount of a radionuclide in the crop after it has been processed for 
human consumption to the amount before processing.  The retention factor reflects the fraction 
of radioactive material in the edible portion of the plant that is retained after washing, peeling, or 
cooking.  The values apply only to crops that are directly consumed by humans.  Values 
specified for crops such as pasture have no impact on calculations. 
 
Values of FPLSCH must be specified for each crop category for all radionuclides treated by the 
food pathway model (i.e., for all possible radionuclide-crop combinations). The values are 
multiplied with the corresponding values of DCYPCH in order to obtain the overall transfer factor 
for this part of the food chain. 
 

Variable Name Definable Type Dimensions Allowed Values 

FPLSCH Yes Real NFIISO 
by 

NFICRP 

0.0 to 1.0 

 
Meat/Milk Radioactive Retention Form 
The Meat/Milk Radioactive Retention form is required when MACCS Food Model is selected on 
the Food tab. 
 
DCYPCB is the ratio of the amount of a radionuclide in the crop at the time of its consumption to 
the amount of that radionuclide in the crop at the time of harvest.  This factor is only applied to 
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crops that are directly consumed by meat producing animals (e.g. pasture and forage).  Values 
supplied for crops not consumed by meat-producing animals have no impact on the 
calculations. 
 
Values of DCYPCB must be specified for each crop category for all radionuclides treated by the 
food pathway model (i.e., for all possible radionuclide-crop combinations).   
 

Variable Name Definable Type Dimensions Allowed Values 

DCYPCB Yes Real NFIISO 
by 

NFICRP 

0.0 to 1.0 

 
Term One CTCOEF for Weathering Form 
The Term One CTCOEF for Weathering form is required when MACCS Food Model is selected 
on the Food tab.  
 
CTCOEF corresponds to the constant multiplier of the first term in the weathering equation as 
described in Subsection 3.4.11.1.  This variable defines the product of the interception fraction 
and the availability fraction for each term in the weathering model for crops with exposed edible 
portions.  For plants with edible portions internal to the plant, this defines the combined transfer 
fraction for interception, weathering, and translocation to seeds averaged over an entire growing 
season. Values of CTCOEF must be specified for each crop category and for all radionuclides 
treated by the food pathway model.   
 

Variable Name Definable Type Dimensions Allowed Values 

CTCOEF Yes Real NFIISO 
by 

NFICRP 

0.0 to 1.0 

 
Term One CTHALF for Weathering Form 
The Term One CTHALF for Weathering form is required when MACCS Food Model is selected 
on the Food tab.   
 
CTHALF corresponds to the half-life value of the first term in the weathering equation, as 
described in Subsection 3.4.11.1.  The values supplied for CTHALF must be properly paired 
with the corresponding values of CTCOEF defined in the previous form. Values of CTHALF 
must be specified for each crop category for all radionuclides treated by the food pathway 
model. 
 

Variable Name Definable Type Dimensions Allowed Values 

CTHALF Yes Real NFIISO 
by 

NFICRP 

1.0 to 3.15×1013 s 

 

 
Term Two CTCOEF for Weathering Form 
The Term Two CTCOEF for Weathering form is required when MACCS Food Model is selected 
on the Food tab and the Number of Crop Weathering Terms is set to Two Terms or Three 
Terms.   
 
CTCOEF corresponds to the constant multiplier of the second term in the weathering equation 
as described in Subsection 3.4.11.1.  It defines the product of the interception fraction and the 
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availability fraction for each term in the weathering model for crops with exposed edible 
portions.  For plants with edible portions internal to the plant, it defines the combined transfer 
fraction for interception, weathering, and translocation to seeds averaged over an entire growing 
season. Values of CTCOEF must be specified for each crop category and for all radionuclides 
treated by the food pathway model.   
 

Variable Name Definable Type Dimensions Allowed Values 

CTCOEF Yes Real NFIISO 
by 

NFICRP 

0.0 to 1.0 

 
Term Two CTHALF for Weathering Form 
The Term Two CTHALF for Weathering form is required when MACCS Food Model is selected 
on the Food tab and the Number of Crop Weathering Terms is set to Two Terms or Three 
Terms.  
 
CTHALF corresponds to the half-life value of the second term in the weathering equation as 
described in Subsection 3.4.11.1. Values must be specified for each crop category for all 
radionuclides treated by the food pathway model. 
 

Variable Name Definable Type Dimensions Allowed Values 

CTHALF Yes Real NFIISO 
by 

NFICRP 

1.0 to 3.15×1013 s 

 

 
Term Three CTCOEF for Weathering Form 
The Term Three CTCOEF for Weathering form is required when MACCS Food Model is 
selected on the Food tab and the Number of Crop Weathering Terms is set to Three Terms. In 
this case, variable NTTRM is set to three. 
 
CTCOEF corresponds to the constant multiplier of the third term in the weathering equation as 
described in the section titled Removal of Radioactivity from Plant Surfaces by Weathering.  
This variable defines the product of the interception fraction and the availability fraction for each 
term in the weathering model for crops with exposed edible portions.  For plants with edible 
portions internal to the plant, this defines the combined transfer fraction for interception, 
weathering, and translocation to seeds averaged over an entire growing season. 
 
Values of CTCOEF must be specified for each crop category and for all radionuclides treated by 
the food pathway model.   
 

Variable Name Definable Type Dimensions Allowed Values 

CTCOEF Yes Real NFIISO by 
NFICRP 

0.0 to 1.0 

 
Term Three CTHALF for Weather Form 
The Term Three CTHALF for Weathering form is required when MACCS Food Model is 
selected on the Food tab and the Number of Crop Weathering Terms is set to Three Terms.  In 
this case, variable NTTRM is set to three. 
 
CTHALF corresponds to the half-life value of the third term in the weathering equation as 
described in the section titled Removal of Radioactivity from Plant Surfaces by Weathering.  .  
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The values supplied for CTHALF must be properly paired with the corresponding values of 
CTCOEF defined in the previous form. 
 
Values of CTHALF must be specified for each crop category for all radionuclides treated by the 
food pathway model. 
 

Variable Name Definable Type Dimensions Allowed Values 

CTHALF Yes Real NFIISO 
by 

NFICRP 

1.0 to 3.15×1013 s 

 
Crop Share and Growing Season Form 
The Crop Share and Growing Season form is required when the MACCS Food Model is 
selected on the Food tab and the Site Data Specification is set to Uniform on the Site Data tab. 
Values are taken from the site file when Import from File is chosen on the Site Data tab.  
 
TSGBEG defines the start of the growing season for the named crop category in terms of Julian 
day (January 1 is day 1). 
 
TGSEND defines the end of the growing season for the named crop category in terms of Julian 
day. 
 
FRCTFL defines the fraction of cultivated farmland that is used to grow the named crop 
category. 
 

Variable Name Definable Type Dimensions Allowed Values 

TGSBEG Yes Real NFICRP 1.0 to 365.0 Jullian day  

TGSEND Yes Real NFICRP 1.0 to 365.0 Jullian day 

FRCTFL Yes Real NFICRP 0.0 to 1.0 

 
Protective Action Form  
The Protective Action form is required when MACCS Food Model is selected on the Food tab. 
 
For an accident that occurs during the growing season, there are two types of actions that can 
occur:  disposal of milk and its products and disposal of crops other than milk (nonmilk crops).  
All agricultural production is divided between these two categories.  The action levels used for 
determining when these two actions are necessary are the input variables PSCMLK and 
PSCOTH, which are defined below. 
 
When contamination levels are too high, agricultural production is restricted for one or more 
years after an accident.  A single set of values for allowable ground concentration (variable 
GCMAXR) is used to make this determination.  During the long-term interdiction period, either 
all crops (both milk and nonmilk) can be produced or no crops can be produced. 
 
For accidents that occur outside of the growing season, MACCS, in all cases, evaluates only the 
long-term action level (GCMAXR).  The growing season action levels, PSCMLK and PSCOTH, 
are not evaluated since crop disposal can only occur during the growing season. For accidents 
that occur during the growing season, however, both types of criteria (growing season and 
long-term) may be evaluated by the code.  It is up to the user to determine whether these two 
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types of evaluation are performed either independently of each other (uncoupled) or in such a 
way that the exceedance of one type of criteria automatically forces the exceedance of the other 
criteria (coupled).  The choice of these two options is defined by the user-specified input 
parameter, COUPLD. 
 
When the two types of criteria are chosen to be evaluated independently, there are no 
interactions between the growing season pathway and the long-term pathway.  The resulting 
doses and economic costs from these two components of the food model are calculated in a 
completely independent manner. 
 
When the user chooses the option of a coupled evaluation, the following rules define the 
interactions between two types of actions.  Whenever the long-term criteria (GCMAXR) are 
exceeded, the disposal of any growing crops (both milk and nonmilk) is automatically triggered.  
Alternatively, whenever both milk and nonmilk crop disposal are called for as a result of 
exceeding both the PSCMLK and PSCOTH criteria, the code automatically imposes at least 1 
year of long-term farmland interdiction. 
 
COUPLD defines whether the growing season and the long term action levels are evaluated in a 
coupled manner (True) or in a totally independent manner (False). 
 
PSCMLK defines the growing season protective action level (i.e., maximum permissible surface 
concentration), for milk and milk products for the named radionuclide. 
 
PSCOTH defines the growing season protective action level, maximum permissible surface 
concentration, for non-milk crops and their products for the named radionuclide. 
 
The long-term uptake fractions for root uptake and soil ingestion by animals have been 
previously defined by variable TCROOT.  These uptake fractions are integrated over all time, 
that is, from t=0 to t=infinity.  MACCS allows the user to define a model for the temporary 
interdiction of the long-term uptake pathway when certain ground contamination levels are 
exceeded at the time of the accident.  When this model is activated, and temporary interdiction 
of long-term uptake is needed, the period of temporary interdiction is the shortest number of 
whole years that allows the long-term criteria to be met.  The longest allowed period of 
long-term interdiction is 8 years.  When 8 years of weathering and radioactive decay are 
insufficient, the farmland is condemned and permanently removed from production. 
 
GXMAXR defines the protective action level (i.e., maximum permissible surface concentration) 
for long-term crop production for the named radionuclide.  This is the criteria to be met for each 
ingestion radionuclide. 
 
QROOT defines the rate constant for the decrease in availability over the temporary interdiction 
period.  This value accounts for radioactive decay, irreversible chemical binding to the soil, 
percolation downward into the soil and uptake into plants or ingestion by animals. 
 
The value assigned to QROOT is used to determine how effective temporary interdiction of the 
long-term agricultural pathway is for reducing ingestion doses.  For example, when the depletion 
rate is 0.5 per year (i.e., 50%/annum), a year of temporary interdiction causes the integrated 
dose to be EXP(–0.5) of what it would be if there were no interdiction. 
 
The MACCS food model input variables PSCMILK, PSCOTH, and GCMAXR are specified in 
terms of maximum allowable ground concentrations for each food radionuclide.  The model 
sums the ratios of the actual to the maximum concentrations for the set of radionuclides. When 
this value is greater than 1.0, interdiction is imposed.  
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Variable Name Definable Type Dimensions Allowed Values 

COUPLD Yes Logical None True, False 

PSCMLK Yes Real NFIISO 1×10-6 to 1×1020  Bq/m2 

PSCOTH Yes Real NFIISO 1×10-6 to 1×1020  Bq/m2 

GXMAXR Yes Real NFIISO 1×10-6 to 1×1035  Bq/m2 

QROOT Yes Real NFIISO 0.0 to 1×1035  per year 

 
Water Ingestion Radionuclides Form 
The Water Ingestion Radionuclides form is required when either MACCS Food Model or 
COMIDA2 Food Model is selected on the Food tab. 
 
When Import from File is selected on the Site Data tab, the entries on this form must agree with 
the water ingestion radionuclides specified in the site data file. 
 
NUMWPI defines the number of water ingestion radionuclides. Its value is determined by the 
number of rows in the grid containing values of NAMWPI. 
 
NAMWPI defines the name of a radionuclide used in the drinking water pathway.  The user 
must supply these nuclides in the same order that they were previously specified.  Nuclide 
choices are from variable NAMIPI when the MACCS food-chain model is used.  The choices 
must be consistent with radionuclides specified for COMIDA2 when that food-chain model is 
used. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUMWPI Linked Integer None 1 to 10 

NAMWPI  Yes Character NUMWPI Must select a 
radionuclide defined 
in NAMIPI 

 
Water Washoff Fraction Form 
The Water Washoff Fraction form is required when either the MACCS Food Model or COMIDA2 
Food Model is selected on the Food tab. 
 
When the Site Data Specification is set to Import from File on the Site Data tab, the entries on 
this form are not used.  Instead, the corresponding values specified in the site data file are used. 
 
For the purpose of calculating water ingestion doses, there is no provision for modeling the 
buildup of any radioactive daughter products that result from decay.  There is no provision for 
accounting for the water ingestion dose resulting from radioactive daughter products of the 
water pathway radionuclides defined in NAMWPI. 
 
WSHFRI defines the initial washoff fraction for the specified radionuclide.  This is the fraction of 
material deposited on land that is easily washed off into the watershed drainage system 
immediately following the deposition of that radionuclide. 
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WSHRTA defines the annual washoff rate for the specified radionuclide.  This is the rate at 
which material deposited on land is washed off into the watershed drainage system following 
the initial deposition. 
 

Variable Name Definable Type Dimensions Allowed Values 

WSHFRI Yes Real NUMWPI 0.0 to 1.0 

WSHRTA Yes Real NUMWPI 0.0 to 1.0 per year 

 
Water Ingestion Factor Form 
The Water Ingestion Factor form is required when the  MACCS Food Model or COMIDA2 Food 
Model is selected on the Food tab and the Site Data Specification is set to Uniform on the Site 
Data tab.   
 
WINGF defines the water ingestion factor for the radionuclide. This factor specifies the fraction 
of the radioactivity washed into the drainage system of the watershed that is ultimately 
consumed by humans. 
 

Variable Name Definable Type Dimensions Allowed Values 

WINGF Yes Real NUMWPI 0.0 to 1.0 

 

 Output Control 3.4.12
 

 Output Control Forms and Parameters 3.4.12.1
 
Debug Flag Form 
The Debug Flag form is required. This flag allows the user to print a detailed listing of values for 
intermediate variables used in CHRONC calculations.  The output for this option is written to the 
output file.  Most of the variables output are CHRONC internal FORTRAN variables.  Thus, this 
output may be more useful to MACCS developers than to a user. 
 
KSWTCH is used to print intermediate results on the output listing.  This variable should be set 
to 0 for normal calculations.  Because a nonzero value generates a large amount of output, it is 
preferable to use this option for single weather trial runs. 
 

Variable Name Definable Type Dimensions Allowed Values 

KSWTCH Yes Integer None 0 or 1 

 
Population Dose Results Form 
The Population Dose Results form is optional. 
 
The CHRONC module calculates long-term population dose broken down by pathway for a list 
of organs defined in the EARLY input file.  The option to examine this breakdown of long-term 
population doses for organs selected from the set of available organs is described in this 
section.  This result type has no counterpart in the EARLY module.  The EARLY module can 
produce just one consequence measure for population dose, which is total population dose for a 
specific organ. 
 
No long-term population dose results for an organ are produced on the output listing unless the 
user requests it.  Each request for the breakdown of the long-term population dose to an organ 
produces the block of either 12 or 15 dose results (depending on which food model is being 
used) identified below.  All of the dose results are reported in person-Sv although the units are 
listed simply as Sieverts (Sv) in the output file.  The following dose results are reported: 
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 TOTAL LONG-TERM PATHWAYS DOSE—total long-term population dose from 
groundshine and resuspension, from the consumption of contaminated food, from the 
ingestion of contaminated surface water, and from decontamination work. 

 LONG-TERM DIRECT EXPOSURE PATHWAYS—total long-term population dose to 
resident population from groundshine and resuspension. 

 TOTAL INGESTION PATHWAYS DOSE—total long-term population dose from the 
consumption of contaminated dairy products, contaminated nondairy products, and 
contaminated water. 

 LONG-TERM GROUNDSHINE DOSE—total long-term population dose received by 
resident population from groundshine. 

 LONG-TERM RESUSPENSION DOSE—total long-term population dose received by 
resident population from resuspension. 

 POP.-DEPENDENT DECONTAMINATION DOSE—total long-term population dose 
received from groundshine by workers performing "population dependent" (nonfarm) 
decontamination (decontamination workers receive no inhalation dose). 

 FARM-DEPENDENT DECONTAMINATION DOSE—total long-term population dose 
received from groundshine by workers performing "farm dependent" (farmland) 
decontamination (decontamination workers receive no inhalation dose). 

 WATER INGESTION DOSE—total long-term population dose from ingestion of 
contaminated surface water. 

 
When the MACCS food-chain model is used, the following food pathway results are reported: 

 MILK GROWING SEASON DOSE—total long-term population dose resulting from 
consumption of milk and dairy products contaminated as a result of deposition onto 
crops during the growing season. 

 CROP GROWING SEASON DOSE—total long-term population dose resulting from 
consumption of nonmilk food products contaminated as a result of deposition onto crops 
during the growing season. 

 MILK LONG-TERM DOSE—total long-term population dose resulting from consumption 
of milk and dairy products contaminated by long-term uptake in the period following the 
accident. 

 CROP LONG-TERM DOSE—total long-term population dose resulting from 
consumption of nondairy crops and their products contaminated by long-term uptake in 
the period following the accident. 

 
When the COMIDA2 food-chain model is used, the following food pathway results are reported: 

 INGESTION OF GRAINS—total long-term population dose resulting from consumption 
of grains by humans. 

 INGESTION OF LEAF VEG—total long-term population dose resulting from 
consumption of leafy vegetables by humans. 

 INGESTION OF ROOT CROPS—total long-term population dose resulting from 
consumption of root crops by humans. 

 INGESTION OF FRUITS—total long-term population dose resulting from consumption of 
fruits by humans. 

 INGESTION OF LEGUMES—total long-term population dose resulting from 
consumption of legumes by humans. 

 INGESTION OF BEEF—total long-term population dose resulting from consumption of 
beef by humans. 

 INGESTION OF MILK—total long-term population dose resulting from consumption of 
milk by humans. 

 INGESTION OF POULTRY—total long-term population dose resulting from consumption 
of poultry by humans. 
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 INGESTION OF OTHER MEAT CROPS—total long-term population dose resulting from 
consumption of other meat crops by humans. 

 
The region of interest, as specified earlier, is used to determine the size of the potentially 
contaminated area being evaluated.  In the context of this consequence measure, the 
population dose within a region is the population dose that occurs as a result of activity 
deposited within the region.  For groundshine and resuspension inhalation, the dose is received 
by the resident population, but for ingestion and doses to decontamination workers, the dose 
could be received by individuals who reside elsewhere.  
 
NXUM9 specifies the number of results. Its value is determined by the number of rows in the 
grid containing vectors ORGNAM, IX1DS9, IX2DS9, and Report Options. 
 
ORGNAM defines the name of the organ for which the long-term dose breakdown is to be 
reported. The possible values depend on the DCF file chosen.   
 
IX1DS9 defines the inner spatial interval of the region of interest. The location is the inner radius 
of the specified ring.  
 
IX2DS9 defines the outer spatial interval of the region of interest.  The location is the outer 
radius of the specified ring. MACCS requires that the value must be greater than or equal to 
IX2DS9. 
 
Report Options determine whether CCDF data are written to the MACCS output file and 
whether the data are to be included in the summary report. 
  

Variable Name Definable Type Dimensions Allowed Values 

NXUM9 Linked Integer None 0 to 10 

ORGNAM Yes Character NXUM9 Must select a Long 
Term Organ name 
specified in EARLY 

IX1DS9 Yes Integer NXUM9 1 to NUMRAD 

IX2DS9 Yes Integer NXUM9 1 to NUMRAD 

Report Options Yes Character NXUM9 CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Economic Cost Results Form 
The Economic Cost Results form is optional. The CHRONC module calculates the economic 
costs of all the long-term protective actions as well as the cost of the emergency response 
actions that were modeled by EARLY.   
 
No economic costs are printed unless the user specifically requests them.  When Flag10 is set 
to true, each request for economic results produces the block of 13 economic results described 
below.  All of the economic cost measures are reported in dollars.  

 TOTAL ECONOMIC COSTS—the sum of population- and farm-dependent costs. 

 POP.-DEPENDENT COSTS—the sum of population-dependent decontamination, 
interdiction, and condemnation costs. 

 FARM-DEPENDENT COSTS—the sum of farm-dependent decontamination, 
interdiction, and condemnation costs as well as milk and crop disposal costs. 

 POP.-DEPENDENT DECONTAMINATION COST—nonfarm property (i.e., property 
associated with resident population) decontamination cost. 



3-144 

 FARM-DEPENDENT DECONTAMINATION COST—farm property decontamination 
cost. 

 POP.-DEPENDENT INTERDICTION COST—depreciation and deterioration of nonfarm 
property during the period it cannot be used during both decontamination and 
interdiction plus the cost of population removal (see POPCST in Section 7.6). 

 FARM-DEPENDENT INTERDICTION COST—depreciation and deterioration of farm 
property during the period it cannot be used during both decontamination and 
interdiction. 

 POP.-DEPENDENT CONDEMNATION COST—compensation paid for permanent loss 
of nonfarm property plus the cost of population removal. 

 FARM-DEPENDENT CONDEMNATION COST—compensation paid for permanent loss 
of farm property because it could not be returned to production within 8 years of the 
accident. 

 EMERGENCY PHASE COSTS—per-diem costs to compensate people for being away 
from home due to evacuation and relocation during the emergency phase.  When more 
than one emergency response scenario is being evaluated by the EARLY module, the 
presentation of evacuation and relocation cost is calculated on the basis of the scenario 
that was defined last in sequence on the EARLY input file. 

 INTERMEDIATE PHASE COSTS—per-diem costs to compensate people for being 
away from home due to relocation for the duration of the intermediate phase when 
DSCRTI is exceeded. 

 MILK DISPOSAL COSTS—compensation for lost milk sales during a quarter of a year 
when the first year's crops require disposal.  This cost is incurred when the accident 
occurs during the growing season and any of the following conditions are found: the 
growing-season milk action guide is exceeded, or any decontamination actions are 
required, or (for MACCS food model only) when COUPLD=.TRUE. and any long-term 
interdiction is required. 

 CROP DISPOSAL COSTS—compensation for lost nonmilk crop sales during a full year.  
This cost is incurred when the accident occurs during the growing season and any of the 
following conditions are found: the growing-season nonmilk action guide is exceeded, or 
any decontamination actions are required, or (for MACCS food model only) when 
COUPLD=.TRUE. and any long-term interdiction is required. 

 
NXUM10 specifies the number of results. Its value is determined by the number of rows in the 
grid containing values of vectors I1DS10, I2DS10 and Report Options. 
 
I1DS10 defines the inner spatial interval of the region of interest. The location is the inner radius 
of the specified ring. 
 
I2DS10 defines the outer spatial interval of the region of interest.  The location is the outer 
radius of the specified ring. MACCS requires that the value must be greater than or equal to 
I2DS10.  
 
FLAG10 equal to true extends the output to include an expanded breakdown of costs. 
 
Report Options determine whether CCDF data are written to the MACCS output file, and 
whether the data are to be included in the WinMACCS summary report. 
 

Variable Name Definable Type Dimensions Allowed Values 

NXUM10 Linked Integer None 0 to 10 

I1DS10 Yes Integer NXUM10 1 to NUMRAD 

I2DS10 Yes Integer NXUM10 1 to NUMRAD 
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Variable Name Definable Type Dimensions Allowed Values 

FLAG10 Yes Logical NXUM10 True, False 

Report Options Yes Character NXUM10 CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Action Distance Results Form 
The Action Distance Results form is required when the MACCS Food Model or COMIDA2 Food 
Model is selected on the Food tab. 
 
The long-term protective actions that result from the calculations of the CHRONC module 
depend on the data supplied by the user.  Associated with the long-term actions of 
decontamination, interdiction, and crop disposal are the maximum distances to which these 
actions are implemented.   
 
The option to print these long-term action distances is controlled by a flag specified by the user.  
When FLAG11 is set to true, MACCS produces the eight maximum action distance results that 
are described below.  Each result is identified by the result name used on the output file along 
with a description of the result.   

 FARM-DEPENDENT DECONTAMINATION DIST.—maximum distance at which 
farmland decontamination is required. 

 POP.-DEPENDENT DECONTAMINATION DIST.—maximum distance at which non-
farmland decontamination is required. 

 FARM-DEPENDENT INTERDICTION DIST.—maximum distance at which farmland 
decontamination or interdiction is required. 

 POP.-DEPENDENT INTERDICTION DIST.—maximum distance at which non-farmland 
decontamination or interdiction is required. 

 FARM-DEPENDENT CONDEMNATION DIST.—maximum distance at which farmland 
condemnation is required. 

 POP.-DEPENDENT CONDEMNATION DIST.—maximum distance at which non-
farmland condemnation is required. 

 MILK DISPOSAL DIST.—maximum distance at which the loss of 3 months of milk and 
dairy products sales is required. 

 CROP DISPOSAL DIST.—maximum distance at which the loss of 1 year of nonmilk crop 
sales is required. 

 
FLAG11 set to true indicates that the output file includes maximum action distance at which 
decontamination or interdiction is required for various categories or data. 
 
Report Options determine whether CCDF data are written to the MACCS output file, and 
whether the data are to be included in the WinMACCS report generated after simulations are 
completed. 
 

Variable Name Definable Type Dimensions Allowed Values 

FLAG11 Yes Logical 1 True, False 

Report Options Yes Character 1 CCDF, NONE, 
REPORT, CCDF & 
REPORT 
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Impacted Area/Population Results Form 
The Impacted Area/Population Results form is optional when MACCS Food Model or COMIDA2 
Food Model is selected on the Food tab. Associated with the long-term actions of 
decontamination, interdiction, condemnation, and crop disposal are the farm areas and 
populations that are affected by these actions.  The option to print these impacted 
area/population results are controlled by the user. 
 
Each request for impacted farm-area/population results produces the block of eight results 
described below.   

 FARM DECONTAMINATION (HECTARES)—area within which farmland 
decontamination was required. 

 POP. DECONTAMINATION (INDIVIDUALS)—population of areas that required 
decontamination of nonfarm property. 

 FARM INTERDICTION (HECTARES)—farmland area which required either 
decontamination or interdiction. 

 POP. INTERDICTION (INDIVIDUALS)—population of areas that required either 
decontamination or interdiction of nonfarm property. 

 FARM CONDEMNATION (HECTARES)—area within which farmland condemnation was 
required. 

 POP. CONDEMNATION (INDIVIDUALS)—population of areas that required 
condemnation of nonfarm property. 

 MILK DISPOSAL AREA (HECTARES)—affected area requiring the loss of milk and 
dairy products sales for 3 months. 

 CROP DISPOSAL AREA (HECTARES)—affected area requiring the loss of nonmilk 
crop sales for a year. 

 
NUM12 specifies the number of results. Its value is determined by the number of rows in the 
grid containing values of vectors I1DS12, I2DS12, and Report Options. 
 
I1DS12 defines the inner spatial interval of the region of interest. The location is the inner radius 
of the specified ring. 
 
I2DS12 defines the outer spatial interval of the region of interest.  The location is the outer 
radius of the specified ring. MACCS requires that the value must be greater than or equal to 
I1DS12. 
 
Report Options determine whether CCDF data are written to the MACCS output file, and 
whether the data are to be included in the summary report. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUM12 Linked Integer None 0 to 10 

I1DS12 Yes Integer NUM12 1 to NUMRAD 

I2DS12 Yes Integer NUM12 1 to NUMRAD 

Report Options Yes Character NUM12 CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Individual Food Ingestion Dose Form 
The Individual Food Ingestion Dose form is optional when the COMIDA2 Food Model is selected 
on the Food tab. 
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MACCS reports statistics on the maximum food ingestion dose calculated for each of the wind 
directions within a user-specified spatial interval for effective dose or thyroid dose.  No other 
organs are available for this result.   
 
The maximum dose is the dose calculated using the food consumption rates specified in the 
COMIDA2 input file for a representative individual.  The projected doses in years 1 through 9 
are examined in turn, and the maximum value found is used in generating this result. 
 
NUM13 specifies the number of results. Its value is determined by the number of rows in the 
grid containing values of vectors I1DS12, I2DS12, and Report Options. 
 
IRAD13 defines the spatial interval of the region of interest. The location is the outer radius of 
the specified ring. 
 
ORGN13 defines the organ to be used for each requested result. 
 
Report Options determine whether CCDF data are written to the MACCS output file, and 
whether the data are to be included in the summary report. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUM13 Linked Integer None 0 to 20 

IRAD13 Yes Integer NUM13 1 to NUMRAD 

ORGN13 Yes Character NUM13 EFFECTIVE, THYROID 

Report Options Yes Character NUM13 CCDF, NONE, 
REPORT, CCDF & 
REPORT 

 
Impacted Population Results Form 
The Impacted Population Results form is optional. 
 
The results from this output type convey information about evacuees, relocatees, and impacted 
individuals for each phase. The output includes the following results: 

 EVACUEES NOT AFFECTED BY PLUME—the number of evacuees whose property is 
not contaminated and can return during or immediately after the emergency phase 

 EVACUEES AFFECTED BY PLUME—the number of evacuees whose property is affect 
is contaminated and may not be able to return immediately after the emergency phase 

 NORMAL EMERGENCY PHASE RELOCATION—the number of relocatees who are 
affected by normal relocation during the emergency phase 

 HOTSPOT EMERGENCY PHASE RELOCATION—the number of relocatees who are 
affected by hotspot relocation during the emergency phase 

 INTERMEDIATE PHASE RELOCATION—the number of relocatees during the 
intermediate phase 

 LEVEL 1 DECONTAMINATION RELOCATION—the number of people whose property 
requires the first level of decontamination during the long-term phase 

 LEVEL 2 DECONTAMINATION RELOCATION—the number of people whose property 
requires the second level of decontamination during the long-term phase 

 LEVEL 3 DECONTAMINATION RELOCATION—the number of people whose property 
requires the third level of decontamination during the long-term phase, but can return 
immediately after the decontamination is completed 

 DECONTAMINATION+INTERDICTION RELOC—the number of people whose property 
requires the highest level of decontamination (depending on the number of levels 
specified in the input) plus additional interdiction following the decontamination  
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 CONDEMNATION RELOCATION—the number of people whose property is condemned 
 
NUM14 specifies the number of results. Its value is determined by the number of rows in the 
grid containing values of vectors I1DS14, I2DS14, and Report Options. 
 
I1DS14 defines the inner spatial interval of the region of interest. The location is the inner radius 
of the specified ring. 
 
I2DS14 defines the outer spatial interval of the region of interest.  The location is the outer 
radius of the specified ring. MACCS requires that the value must be greater than or equal to 
I1DS14. 
 
Report Options determine whether CCDF data are written to the MACCS output file, and 
whether the data are to be included in the summary report. 
 

Variable Name Definable Type Dimensions Allowed Values 

NUM14 Linked Integer None 0 to 10 

I1DS14 Yes Integer NUM14 1 to NUMRAD 

I2DS12 Yes Integer NUM14 1 to NUMRAD 

Report Options Yes Character NUM14 CCDF, NONE, 
REPORT, CCDF & 
REPORT 
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4. WINMACCS REFERENCE GUIDE 
 

4.1 Software Components 
 
The MACCS suite is a set of interconnected software components.  A description of the main 
software components follows. 
 

 WinMACCS 4.1.1
 
The WinMACCS user interface was created using Microsoft Visual Basic Pro 6.0 (Service Pack 
5) and Microsoft Access 2010. WinMACCS is the graphical user interface used to modify input 
variables and model settings. WinMACCS creates input files, initiates the MACCS model and 
post processes MACCS results. 
 
The following initialization files are used by WinMACCS: 

 WinMACCS.ini contains initial settings.  This file resides in the same folder as 
WinMACCS.exe.  It is self-documenting, and can be edited in an ASCII editor such as 
Notepad.  

 Initialize2000.mdb is a Microsoft database used to create a project file. 
 

 MACCS 4.1.2
 
The MACCS executable file was created using Intel Visual FORTRAN version 11.1. MACCS is 
the modeling engine and can be initiated from WinMACCS or independently from a command 
prompt window.   
 
The following input files may be required, depending on modeling choices. These files are either 
created in MACCS or supplied by the user when MACCS is initiated via a command prompt 
window: 

 ATMOS input file containing parameters pertaining to atmospheric transport, dispersion, 
deposition, and source term; 

 EARLY input file containing parameters pertaining to the emergency phase, which is up 
to forty days from the beginning of release; and  

 CHRONC input file containing parameters pertaining to the intermediate and long-term 
phases. 

 
Additional files used by MACCS are as follows: 

 Indexr.dat is an ASCII file containing decay-chain information. This file is included as 
part of the installation. 

 MACCS2.ini. is an initialization file that contains two flags.  When FileTempMem is set to 
true temporary files are used instead of dynamic memory. The default value for 
FileTempMem is false.  When BinFileFlag is set to true, all dose values for all grid 
elements per cohort per weather trial per source term is printed to a file.  The default 
value of BinFileFlag is false. 

 MACCS.tmp is a text file containing the paths and names for the MACCS input files.  
The name of this file can be modified with a command line parameter. 

 The meteorological file is an optional file that describes the weather conditions for one 
year. 

 The site file is an optional file that describes the population, land use, and economic 
parameters. 
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 The dose conversion factor (DCF) file is an optional file used to calculate doses to a set 
of organs from radionuclide exposures corresponding to a set of exposure pathways. 

 The COMIDA2 binary file, created by COMIDA2.exe, is an optional file used to define 
food-chain dose conversion factors. 

 
A number of output files are created by MACCS; model1.out, model2.out, etc., where the 
number corresponds to the realization or calculation number. When the calculation is 
deterministic and the cyclical file option is not used, only model1.out is created.  

 Modeln.out is a text file containing output from MACCS. 

 Modeln.bin is a binary file containing output from MACCS. This file can be viewed as text 
using the File→Export Binary Results as Text option in the WinMACCS main menu or 
can be used to create plots from within the WinMACCS interface. 

 FortErr.log is created when MACCS terminates abnormally.  

 MaxStat.log contains the character string “OK” when MACCS terminates normally, “NO” 
when MACCS terminates abnormally or when MACCS does not complete the 
simulation. This file contains an error message when termination is due to an error 
detected by MACCS. 

 

 Latin Hypercube Sampling (LHS) 4.1.3
 
The executable file, Lhs.exe, generates values of uncertain variables using Latin Hypercube 
Sampling (LHS). This program is initiated from WinMACCS. The code, published by Sandia 
National Laboratories, is used to perform sampling from user-defined probability distributions 
that represent uncertain input parameters. LHS also allows uncertain distributions to be 
correlated.  
 
The following required input files are transparent to the user when running LHS from within 
WinMACCS: 

 Lhs.inp is generated by WinMACCS. This file contains the probability distribution types 
and values and the number of samples to generate. 

 Sipra.inp contains software settings used by LHS. 
 
The following output files are generated when using LHS: 

 Lhs.out contains sampled values created by the LHS execution.  This file is read by 
WinMACCS and it is used to create MACCS, COMIDA2 input files, and uncertain dose 
conversion factors, using the sampled values. 

 Lhs.err iscreated when an error is detected during LHS execution. 

 Lhs.msg contains details of LHS execution. 
 

 COMIDA2 4.1.4
 
The executable file, Comida2.exe, is a semi-dynamic food chain model that estimates annual 
concentrations in various food sources (dose-to-source ratios) given a set of radionuclides and 
transfer coefficients for each crop type considered.   
 
The input files are generated by WinMACCS. Uncertainty is supported in this input. The 
following input files are required: 

 Comida2.inp, a parameter input file. 

 Comida2.var, a parameter input file. 

 Comida2.par, a parameter input file.  

 A dose conversion factor (DCF) file. 
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The following output files are generated by COMIDA2: 

 Comida2.bin, a binary file that is used as input to MACCS.  

 Comida2.dmp, a detailed output file. 

 Comida2.lst, a detailed output file. 

 Comida2.cnc, a detailed output file. 
 

 PopMod 4.1.5
 
PopMod was written to allow MACCS to support more than sixteen compass directions by 
reformatting a site data file created by SecPop.   This function is no longer needed if the user 
can create site files supporting the number of compass directions required for their simulation. 
 
PopMod reads a site file created by SecPop and creates a new population file containing more 
compass sectors.  The work of PopMod is primarily interpolation and reformatting.  No new 
information is added to the new site data file. 
 
PopMod requires for input a site data file and the required number of angular sectors needed in 
the new file.  The number of final sectors must be greater than the original site data file. 
PopMod generates a modified site data file.  
 
Even though PopMod is still part of WinMACCS, it is not needed when SecPop 4.0 or later is 
used to create the site file.  SecPop 4.0 uses Census 2010 data and supports up to 64 compass 
sectors. 
 

 CombineSource 4.1.6
 
The executable file, CombineSource.exe, is integrated into WinMACCS to support the multiple 
source term model.  Input files required are result files referred to as source term files from 
MelMACCS, a separate software component used to extract source term data from MELCOR (a 
reactor modeling product) results.   
 

 Project Files 4.1.7
 
Data files managed by WinMACCS include a set of auxiliary files, such as the site file, the 
meteorological file, the COMIDA2 binary file(s), cyclical file(s), source term file(s) and the DCF 
file(s). 
 
Input files are created by WinMACCS using the model and input settings. This set can include 
Atmosn.inp, Earlyn.inp, Chroncn.inp, Comidan.inp, and Lhs.inp input files. 
 
Output files are created by MACCS and its preprocessors (e.g., LHS and COMIDA2). One or 
more sets of MACCS output files, Modeln.out and Modeln.bin, are normally created. Other files 
may or may not be created, depending on settings. 
 
A project database, eg., project.mxd, is created from an Access 2010 database file, 
Initialize2000.mdb, by WinMACCS when a new project is created.  The project database 
contains the following information: 

 Input values specified by user, 

 Default input values, 

 Variable descriptions and limits, 

 Information to construct input forms,  

 Information to construct input files, 
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 LHS results, and 

 MACCS results read from binary files 
 

4.2 Main Menu Items 
 
The main menu contains six drop down menus that allow the user to control WinMACCS 
projects and perform a number of useful functions. These are described in the following 
subsections for each of the menu items.  
 

 File Menu 4.2.1
 
The File menu shown in Figure 4-1 allows the user to do the following: 

 Manage MACCS projects via the New Project, Open Project, Save Project, SaveAs 
Project, and Close Project commands.  

 Refresh the view of the project files using Refresh File View. 

 Import custom report definitions from another WinMACCS using utility Import Custom 
Report Definitions. 

 View a MACCS binary output file in a text format using utility Export Binary Results as 
Text. 

 
These commands are explained in more detail below. 
 

 
 

Figure 4-1  File menu 
 
File→New Project  
The command File→New Project is used to create a new WinMACCS project, as shown in 
Figure 4-2.  The user is required to type a name for the project in the Project Name text box. 
This name is used as a folder name and as the prefix of the .mxd  project file. The user is limited 
to enter only names that are legal names for windows folders and files. Optionally, the user can 
change the drive and parent folder for this new folder. 
 
By default, the project location is on the drive where MACCS is installed. If the program was 
installed on the C:\ drive, the default project folder is C:\WinMACCS Projects\. 
 
The user should click OK to close this window and complete the operation of creating a new 
project or click Cancel to close this window without creating a new project. 
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Figure 4-2  New project form 
 
File→Open Project 
The command File→Open Project opens an existing WinMACCS project. The user opens a 
project by selecting the .mxd file in the project root folder. When the project file was not created 
with the same WinMACCS version, a box similar to one shown in Figure 4-3 is displayed.  
 

 
 

Figure 4-3  Database inconsistency 
 
The database is upgraded to the current version of WinMACCS by clicking Yes. The original 
.mxd file is not modified unless the user selects File→Save. The user can also retain the old 
project version by selecting File→SaveAs Project to store the upgraded version under a 
different name.  
 
File→Save Project 
The command File→Save Project saves the changes made to the project variables and 
settings. 
 
File→SaveAs Project 
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The command File→SaveAs Project creates a new WinMACCS project as shown in Figure 4-2 
based on the current project settings.  The folder structure and all files are copied to the new 
project. 
 
File→Close Project 
The command File→Close Project closes the current project. The current project must be 
closed before opening another project. The interface supports only one project at a time. 
However, multiple instances of WinMACCS can exist at the same time provided each instance 
corresponds to a different project folder. 
 
File→Refresh File View 
The command File→Refresh File View refreshes the data displayed on the project Files tab.  
This causes WinMACCS to update the files shown in the Input and Output entries on the project 
Files tab to be consistent with the files saved on the computer in the project Input/ and Output/ 
folders. This is done automatically when simulations are run.  However, when a file is copied or 
deleted manually from the computer, the file view is inconsistent unless this command is 
selected. 
 
File→Import MACCS Input File 
This command File→Refresh File View prompts the user to select a MACCS input file such as 
an Atmos, Early or Chronc input file, e.g., Atmos1.inp. The file contents are read and data 
values are imported into WinMACCS variables in the currently opened project.  If some of the 
WinMACCS variables were previously defined, the values read from the file are substituted in 
place of the old values. 
 
The MACCS input file does not need to be complete. The MACCS input lines are read and the 
values overlaid onto the existing project. When a vector or array is present in the MACCS input 
file, all values associated with that vector or array are cleared before the new data are assigned 
to the project. Only the data relevant to the model settings shown in the Project Properties form 
are imported into the project.  
 
The model settings may also be modified while importing a MACCS input file. For example, the 
MACCS input file modifies the weather sampling method when a METCOD card is included in 
the file. When the model settings are modified, data relevant to those modified settings are 
imported.  Data not relevant to model settings are not imported. 
 
File→Import Custom Report Definitions 
The command File→Import Custom Report Definitions is used to import custom report 
definitions created in another WinMACCS projects into the current project.  The WinMACCS 
project file is selected as shown in Figure 4-4.  The new report definitions are accessible after 
the simulations have completed in the Manage Reports form described in sections 4.6.2.3 and 
4.6.2.5.  A new report definition is valid only when the results requested in the Output Control 
form that created that result is identical between the two projects.   
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Figure 4-4  Import report definitions 
 
File→Export Binary Results as Text 
The command File→Export Binary Results as Text allows the user to open a MACCS binary 
output file in text format. These files are found in the Project\Output\ folder, one for each 
simulation, as shown in Figure 4-5.  The binary output files are the same files that are used by 
the WinMACCS postprocessor to display MACCS results graphically. 
  

 
 

Figure 4-5  Export binary file as text 
 
File→Exit 
The command File→Exit closes the WinMACCS application.  If the project has changed since 
the last time it was saved, a message box is displayed as shown in Figure 4-6. 
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Figure 4-6  Message box to save project 
 

 Edit Menu 4.2.2
 
The Edit menu shown in Figure 4-7 allows the user to do the following: 

 Show and hide the legend by checking or unchecking Show Legend.  The legend shows 
the meaning of the icons associated with forms in the Project window. 

 Modify data grids on parameter modification forms using commands from the submenu 
Grid. 

 Correlate uncertain variables from the submenu Correlate Uncertain Variables. 

 Modify form variables by selecting the form name and making a selection from the 
submenu   Modify Form Variables.  

 Open parameter modification forms by choosing the variable name using the command 
Find Parameter Window. 

 Open the Project Properties window to modify basic modeling choices. 
 

These commands are explained in more detail below. 

 

 
 

Figure 4-7  Edit menu 
 
Edit→Show Legend 
When the Edit→Show Legend checked command is checked, a window appears showing a 
legend, as shown in Figure 4-8.  When the box is unchecked, the legend is hidden. 
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Figure 4-8  Legend 
 
Edit→Auto Propagate Cohort Values 
When the Edit→Auto Propagate Cohort Values command is checked, the values are 
propagated from one cohort form to other forms after the OK button is clicked on the parameter 
modification form.  The propagation is applied to cohorts greater than the cohort saved.  This 
option is set to off by default. 
 
When this option is enabled and the values are saved on a cohort form, the same values are 
saved on other undefined cohort forms that have the same named variables for cohort numbers 
greater than the cohort number of the saved form.  For example, when the variable CRIORG is 
updated on the Critical Organ form for cohort 3 and there are a total of 6 cohorts, CRIORG for 
cohorts 4, 5 and 6 is assigned the same value provided this variable is undefined for these 
cohorts. 
 
When propagating values to other cohorts, when a form is encountered that is defined, the 
propagation stops and no more cohorts will receive the new value. 
 
Stated in a more rigorous way, when form A (for example, Network Evacuation Speed) for 
cohort m is completed, propagation will start at form A for cohort m+1, m+2..., until a variable is 
found to be defined on form A for cohort n, n>m.  At that point, the propagation ceases.  No 
previously defined values are overwritten when using this option.  
Edit→Propagate Cohort Values on Upgrade 
The Edit→Propagate Cohort Values on Upgrade checked command was implemented to 
support backward compatibility with projects 3.6 and earlier. When this is checked, values are 
copied to undefined cohort forms when opening a project that was created earlier than the 
current WinMACCS version.  By default this is checked (enabled).  However, when this is 
unchecked and the project saved, the unchecked state will also be saved. 
 
In earlier versions, the MACCS paradigm of change cards for cohort parameters was used 
within the user interface.  Parameters for cohort one were required, but the corresponding value 
used for subsequent cohorts were assumed to be equal to the value used for the previous 
cohort unless explicitly changed.   
 
All cohort forms are now required.  This means that the values to define a cohort do not have 
default values but must be defined.   
 
This option allows seamless opening of older projects in this version of WinMACCS. 
 
Edit→Grid 
The submenu Edit→Grid offers commands are available to manipulate grids in parameter 
modficiation forms.  Some of the parameter modification forms contain a grid.  Figure 4-9 shows 
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a grid found on the ATMOS/Release Description/Release Fractions form.  The options available 
in the Edit→Grid submenu are enabled when the current parameter modification form contains 
a grid.  
 
There are two types of grids within the parameter modification forms, vector and array grids. A 
grid showing an array represents a single variable containing both rows and columns.  For 
example variable RELFRC is an array displayed in a grid, as shown in Figure 4-9. A grid 
containing vectors may display multiple variables on a single grid, one variable for each column. 
When a grid displays multiple vectors, each vector on the grid must have the same number of 
rows as shown in Figure 4-10. 
 

 
 

Figure 4-9  Grid showing an array of release fractions for each plume segment 
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Figure 4-10  Grid showing multiple vectors NUCNAM, CORINV, and IGROUP 
 
The array operations, Edit→Grid→Insert Columns and Edit→Grid→Delete Columns, are 
enabled when the grid contains an array but are disabled when it contains one or more vectors. 
When a parameter form contains either an array or vectors with a variable number of rows, the 
operations Edit→Grid→Insert Rows and Edit→Grid→Delete Row Hint are enabled. These 
functions are not enabled when the grid requires a fixed number of rows (e.g., vector variables 
CYSIGA, CYSIGB, CZSIGA and CZSIGB all require exactly six rows).  
 
Edit→Grid→Insert Rows 
The Edit→Grid→Insert Rows command is used to insert rows in a grid. A row on the grid must 
be selected before this operation can be completed. A row is selected by clicking on the small 
box between the row label and the data in the desired column. The row is highlighted as shown 
below in Figure 4-11.   
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Figure 4-11  Grid showing a selected row 
 
After the Insert Rows option is selected, the Insert Row form opens as shown in Figure 4-12.  
By clicking on the radio button Before, the new rows may be inserted before the current 
selected row. By clicking on the radio button After, the new rows may be inserted after the 
current selected row.  The number of rows to insert is entered.  Complete the form by clicking 
OK to insert the rows. 
 

 
 

Figure 4-12  Insert Row form 
 
The menu option to insert rows is not available when the number of rows on a form is fixed 
(e.g., the ATMOS/Dispersion/Dispersion Function form). 
 
Edit→Grid→Delete Row Hint 
The command Edit→Grid→Delete Row Hint, when selected, opens a message box as shown in 
Figure 4-13.  This is an aid to give the novice user instructions on how to delete a row in the 
grid. 
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Figure 4-13  How to delete a grid row 
 
Edit→Grid→Insert Columns  
The command Edit→Grid→Insert Columns is used to insert columns in an array. A column of 
the array must first be selected by clicking the column header as shown in Figure 4-14.   
 

 
 

Figure 4-14  Grid showing a selected column 
 
After the Insert Column option is selected, the Insert Column form opens as shown in Figure 
4-15.  By clicking on the radio button Before, the new columns may be inserted before the 
current selected column. By clicking on the radio button After, the new column may be inserted 
after the current selected column.  The number of column to insert is entered.  Complete the 
form by clicking OK to insert the column. 
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Figure 4-15  Insert Column form 
 
The menu option to insert columns is not available when each column on a form represents a 
vector (e.g., the ATMOS/Dispersion/Dispersion Table form). 
 
Edit→Grid→Delete Columns 
The command Edit→Grid→Delete Column is used to delete the currently selected array 
column. 
 
Edit→Grid→Copy to Clipboard 
The command Edit→Grid→Copy to Clipboard is used to copy a portion of the grid data to the 
Windows clipboard.  
 
Data can be copied to the Windows clipboard as follows: 
1. A portion of the grid can be selected in WinMACCS by left clicking and holding button, 

dragging over the desired area, and then releasing the mouse button. 
 
2. The selected data can be copied to the clipboard by typing the keyboard short-cut for 

copying (Ctrl+F), selecting Edit→Grid→Copy to Clipboard, or right clicking and selecting 
Copy from the popup menu.  
 

Other methods described in section 4.4.1.1 are available for selecting portions of the grid to the 
clipboard.  
 
The data can be easily pasted into another application, such as Microsoft Excel, with the 
keyboard shortcut (Ctrl+V). Note that the shortcut for copying from the grid is different than the 
standard Windows shortcut because these are distinct operations. 
 
Edit→Grid→Paste from Clipboard 
The command Edit→Grid→Paste from Clipboard is used to transfer a portion of the grid data 
from the Windows clipboard into a grid in a parameter modification form.  
 
Before this can be done, clicking on a cell in the grid will define the position where the data will 
be pasted. Typing the keyboard short-cut for pasting (Ctrl+G), select Edit→Grid→Paste from 
Clipboard, or right clicking and selecting Paste will complete the paste operation. Note that the 
shortcut for pasting onto the grid is different than the standard Windows shortcut because these 
are distinct operations. 
 
These operations work well for transferring data from a Microsoft Excel spreadsheet into the 
grid. When data are not being transferred from Excel, it is helpful to know WinMACCS expects a 
TAB character to separate cells and a new line (i.e., the Enter key) to separate rows.  
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Edit→ Correlate Uncertain Variables 
The submenu Edit→ Correlate Uncertain Variables offers commands to correlate uncertain 
variables.  Two options are offered, either to allow LHS to enforce rank correlations or to define 
a perfect rank order of variable values after LHS has run.   Section Error! Reference source 
not found. can be referenced for more information. 
 
Edit→ Correlate Uncertain Variables→ Linear Coefficients 
The command Edit→ Correlate Uncertain Variables→ Linear Coefficients opens the Correlate 
Uncertain Variables form as shown in Figure 4-40. This option, only relevant when LHS is being 
used to sample a set of uncertain variables, allows the user to correlate uncertain variables. The 
correlation coefficient specifies the degree to which two uncertain variables are correlated.  
Section 4.4.3.1 can be referenced for more information. 
 
Edit→ Correlate Uncertain Variables→ Enforce Rank Order 
The command Edit→ Correlate Uncertain Variables→ Enforce Rank Order opens the Enforce 
Rank Order of Uncertain Variables form as shown in Figure 4-41.   
 
After LHS has run and imposed correlations specified by the user, WinMACCS can reorder 
some of the variables to be consistent with the rank order of other variables.  Section 4.4.3.2 
can be referenced for more information. 
 
Edit→Modify Form Variables 
The submenu Edit→Modify Form Variables as shown in Figure 4-16 contains commands that 
can be used to define form variables without opening the forms.  These menu items allow 
resetting forms to default values and applying the value of a cohort form, that is a form in the 
category Emergency Cohort One or Additional Emergency Cohorts to other forms in the 
Additional Emergency Cohorts category. 
 

 
 

Figure 4-16  Submenu Modify Form Variables 
 
Edit→Modify Form Variables→Reset Form Variables to Default 
The command Edit→Modify Form Variables→Reset Form Variables to Default is used to 
conveniently replace all the data on a form with default values as shown in Figure 4-17.  
 
Most forms in WinMACCS are undefined by default; in a few cases, there are specific values 
that are standard for a model.  Thus, in most cases, selecting this menu option has the same 
effect of clearing the form.  
 
The following operations will result a form to its default values: 

 When the form is open, click anywhere on the form.  This identifies it as the form of 
interest.  Select the menu option, Reset Form Variables to Default. The values are set to 
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the WinMACCS default values. This is a convenient way to clear the data from a form.  
In some cases this resets variables to default values rather than clearing the values on 
the form. This may produce a different outcome than that of the erase button found on 
the parameter modification form. The Erase button clears all values from the form, but 
does not replace variables with their default values when default values exist. 

 When the form is not open, an equivalent method for resetting form variables to their 
default is to click on the form name in the Parameters tab of the Project window.   Select 
the menu option, Reset Form Variables to Default. Variables defined on the selected 
form are reset to their default values.   

 To reset variables to their defaults, right click on the form name in the Parameters Tab, 
right click the mouse, and select Reset to Default from the popup menu. 

 
Resetting form variables to default values does not affect read-only variables on the form.  
Read-only variables have gray backgrounds when viewed on parameter modification forms.  
They are defined on a different form. 
 
This is the only way to remove data from required forms. Opening a required form, deleting the 
data, clicking the OK button is not allowed. 
 

 
 

Figure 4-17  Reset form variables to default 
 
Edit→Modify Form Variables→Copy Cohort Variables 
The command Edit→Modify Form Variables→Copy Cohort Variables is used to copy form data 
from one of the cohort forms to other cohort forms.  To use this function, a form must first be 
selected from the Parameters tab.  A form opens similar to the one shown in Figure 4-43.  
Section 4.4.4 can be referenced for more information. 
 
Edit→Find Parameter Window 
The command Edit→Find Parameter Window opens the Open Parameter Form as shown in 
Figure 4-18 to assist in locating input variables within the user interface.   
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Figure 4-18 Open parameter form 

 
The list of variables can be navigated by using: 

 Pressing the up and down arrow keys on the keyboard. 

 Typing a letter to position the list to parameters starting with that letter. For example, 
typing the letter m positions the list to the parameters starting with the letter M. 
Subsequent typing of that same letter moves the list position to the next variable starting 
with that letter. 

 Moving the scroll bar on the form. 
 
Multiple variables can be selected in the list by: 

 Clicking more than one of the variable names on the list. 

 By navigating through the list using the arrow keys, entries can be selected by pressing 
the space bar on the keyboard when the variable name is highlighted. Focus is indicated 
by a dotted rectangle boxing the variable name. 

 
The windows associated with the selected variables can be opened by: 

 Selecting OK. 

 Pressing the Enter key on the keyboard. 
 
In some cases, more than one form contains the same variable name. Sometimes the variables 
are separate entities, for example ORGNAM has a different usage on the Early Fatality Effects 
form and Off Centerline Dose form. All of the forms that contain the selected variable are 
opened. 
 
Edit→Project Properties 
The command Edit→Project Properties opens the Properties form.  This form is used to modify 
the basic model choices.  By selecting models using the Properties form, other variable values 
relevant to model selection that are used by MACCS are initialized.  Sections 3.1.1 and 4.3 
contains more information. 
 

 Execute Menu 4.2.3
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The Execute menu as shown in Figure 4-19 allows the user to do the following: 

 Allow complete control over the MACCS input files with respect to validation and 
creation before the MACCS simulations. 

 Switch from Latin hypercube sampling to simple random sampling for creating a set of 
Monte Carlo realizations to estimate the effects of parameter uncertainty. Latin 
hypercube sampling is checked by default. 

 Control when the binary result files are imported into WinMACCS and reports are 
created.  This is checked when WinMACCS is started. 

 Open the Run Models form to initiate a MACCS simulation. 
 

 
 

Figure 4-19  Execute menu 
 
Execute→Validate Data before Running  
The checked command Execute→Validate Data before Running has the following meaning: 

 All data are tested for consistency before a simulation when checked. 

 When unchecked, consistency testing is skipped. This may be desired if a minor 
modification was made and the user doesn't want to wait for the consistency check to be 
performed before executing MACCS.   

 
Execute→Refresh Template Input files before Running 
The checked command Execute→Refresh Template Input files before Running has the 
following meaning: 

 When checked, the template files are deleted and recreated based on the variable 
values and settings stored in WinMACCS when Run Simulation is clicked.  

 When unchecked, the template files are not recreated. This option is used to allow direct 
editing of the MACCS input files. In this case, the user can directly modify the file 
atmosTemplate.txt, earlyTemplate.txt, chroncTemplate.txt, and comidaTemplate.txt. The 
template files are than used by MACCS to create the actual MACCS input files.  Links to 
these files can be found in the Files tab in the project window.   

 
Changing variables in a template file does not modify variables in the database. The files used 
with MACCS, atmos1.inp, early1.inp, etc., are always recreated using the template files. 
 
Execute→Simple Random Sampling 
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The checked command Execute→Simple Random Sampling has the following meaning: 

 When checked, uncertain input parameter sampling uses a Monte Carlo method. 

 When unchecked, a stratified sampling method known as Latin Hypercube Sampling 
(LHS) is used. 

 
WinMACCS allows input parameter values to be made uncertain and enables sampling of the 
uncertain variables. Section 4.4.1.3 can be referenced for more information about uncertain 
variables. 
 
Execute→Auto Create Reports 
The checked command Execute→Auto Create Reports has the following meaning: 

 When checked and reports have been requested, the binary files are imported into the 
project database and the requested report is created without additional action by the 
user following completion of an execution. 

 When not checked, reports are not created after execution.  The user has the option to 
create reports by selecting PostProcessing→Create Custom Report from the main 
menu. Reporting probabilities can also be modified after execution through the 
General→Reporting Options form.  

 
Execute→Run Models…  
The command Execute→Run Models… opens the form used to initiate simulations.  This is 
used after the model data are defined to initiate a simulation.  Section 4.5.1 can be referenced 
for more information. 
 

 The PostProcessing Menu 4.2.4
 
The PostProcessing menus as shown in Figure 4-20  and Figure 4-21 allow the user to do the 
following: 

 Open various graphics windows using the Scalar Results, Statistical Summary Results, 
and Results over all Weather Trials options. 

 Modify plot lables, save plots in various file formats, and select, unselect and delete 
series.  

 Create custom reports using the Create Custom Report command for user defined 
probabilities. 

 Create the summary report. 
 
Post processing results are available after the simulations have completed.  If the MACCS 
binary result files have not been imported into WinMACCS, requesting a plot or report will cause 
all binary files to be imported. 
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Figure 4-20  Postprocessing/Graphical Results menu 
 

 
 

Figure 4-21  Postprocessing/Report Results menu 
 
PostProcessing→Graphical Results→Scalar Results  
The command PostProcessing→Graphical Results→Scalar Results is used to view plume 
releases by radionuclides as a CCDF as shown in Figure 4-22. Section 4.6.3.1 can be 
referenced for more information. 
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Figure 4-22  Plot of scalar results 
 
PostProcessing→Graphical Results→Statistical Summary Results 
The command PostProcessing→Graphical Results→Statistical Summary Results opens a 
graphics window to view statistical data MACCS has calculated for a set of realizations. The 
probability shown in the plot corresponds to the set of samples, cyclical files, or a combination of 
both. The implicit assumption is that the variations are equally probable. Section 4.6.3.2 can be 
referenced for more information. 
PostProcessing→Graphical Results→Results over all Weather Trials 
The command PostProcessing→Graphical Results→Results over all Weather Trials opens a 
graphical window to view the complementary cumulative distribution function reported on each 
individual simulation. The result is a series shown for each weather trial. The distribution shown 
corresponds to uncertainty in the weather for a hypothetical accident. Section 4.6.3.2 can be 
referenced for more information. 
 
PostProcessing→Graphical Results→Edit Plots→Modify Titles 
The command PostProcessing→Graphical Results→Edit Plots→Modify Titles is used to change 
the plot title and the axis labels. A description of all functions available for graphics forms is 
available in Section 4.6.3.4 
. 
PostProcessing→Graphical Results→Edit Plots →Select Next Series 
The command PostProcessing→Graphical Results→Edit Plots →Select Next Series is used to 
select the next series drawn on the plot.  This performs the same function as the Select button 
on the graphics screen.  A description of all functions available for graphics forms is available in 
Section 4.6.3.4. 
 
PostProcessing→Graphical Results→Edit Plots →UnSelect 
The command PostProcessing→Graphical Results→Edit Plots →UnSelect is used to remove 
the selection of the current selected series drawn on the plot.  It is possible to put the form in 
this same state by clicking the Select button repeatedly, though this is a tedious way to unselect 
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when there are many series drawn on the plot.  A description of all functions available for 
graphics forms is available in Section 4.6.3.4. 
 
PostProcessing→Graphical Results→Edit Plots →Delete Selected Series 
The command PostProcessing→Graphical Results→Edit Plots →Delete Selected Series is 
used to remove the selected series from the plot.  This can also be accomplished by clicking the 
Delete button on the graphics form.  A description of all functions available for graphics forms is 
available in Section 4.6.3.4. 
 
PostProcessing→Graphical Results→Edit Plots → Export Plot 
The command PostProcessing→Graphical Results→Edit Plots → Export Plot is used to save 
the plot that the user has specified.  A variety of formats, such as Excel (*.xls), Windows bitmap 
(*.bmp), Text (*.txt), JPEG (*.jpg), XML (*.xml), and HTML (*.html) are available. Two of these 
capture an image of the plot (.bmp and .jpg); the others capture the data that are plotted.  
 
PostProcessing→ Report Results→Manage Custom Reports 
The command PostProcessing→ Report Results→Manage Custom Reports is used to open the 
Manage Reports form.  Sections 4.6.2.3 can be referenced for more information. 
 
PostProcessing→ Report Results→Create Summary Report 
The command PostProcessing→ Report Results→Create Summary Reports is used to create a 
custom report based on probabilities entered by the user on the General→Output 
Options→Reporting Options form and the selected output requests.  Output requests are made 
on forms in the categories Atmos→Output Control, Early→Output Control, and Chronc→Output 
Control.  Output will be available only for form entries where Report Options is set to REPORT 
or CCDF & REPORT.  Section 4.6.2.2 can be referenced for more information. 
 

 The Window Menu 4.2.5
 
The Window menu as shown in Figure 4-23 allows the user to do the following: 

 Cascade the parameter modification forms and the plot form windows by selecting the 
Cascade function. 

 Change the focus to another window by selecting that window from the list shown under 
the Cascade function. 

 

 
 

Figure 4-23  Window menu 
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 The Help Menu 4.2.6
 
Selecting About on the Help menu, as shown in Figure 4-24 displays the version of WinMACCS 
being used. 

 

 
 

Figure 4-24  Help menu 
 

4.3 Selecting Models on the Properties Form 
 
The Properties form can be opened by selecting Edit→Project Properties from the main menu 
or by double-clicking on General/Properties/Properties from the Parameters tab in the Project 
window. 
 
Basic model selections are made from the Properties form.  By selecting models using the 
Properties form, other variable values relevant to model selection that are used by MACCS are 
initialized (e.g., METCOD). The variables affected by the Properties form can be viewed, but not 
modified, by opening the forms ATMOS/Property Form Parameters, EARLY/Property Form 
Parameter and CHRONC/Property Form Parameters.   
 
The Properties form is automatically opened when a new project is created. Each tab of the 
Properties form has default selections.  The user should ensure that the scope and intent of 
their problem is met through the designations on the Properties form.    
 
The decisions the user makes at this point determine which parameter forms are required. For 
example, when the Late Consequences module is not selected on the Properties/Scope tab, 
variables in the CHRONC category are not required. Consequently, all CHRONC variables in 
the Project window Parameters tab have gray icons associated with them. Additionally, all tabs 
related to the Late Consequences module in the Properties form also have gray icons 
associated with them. 
 
Each tab on the Properties form has at least one basic model associated with it. There is an 
icon next to the tab name. The meanings of the icons are as follows: 
 

 A solid green octagon means that a selection on this tab is required but has already 
been defined either by the user or by default.  When any modifications are made to this form, 
the user must click OK to save them. 
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 A solid gray octagon with a diagonal line means that the user has completed this tab, but 
the information is not used in a MACCS calculation given the basic modeling options the user 
has chosen.   

 

   An X-ed red octagon indicates that the model setting on this tab are not compatible with 
model settings on another tab. 

  
Depending on the models selected, some of the radio buttons are disabled in the Project 
Properties form.  For example, when Constant Weather is selected on the Weather tab, the 
group File Sampling Method is visible with the previous choices still showing on the form as 
shown in Figure 4-25.  However these controls are not available for editing because they are not 
relevant to the current model choices.  
 

 
 

Figure 4-25  Disabled controls on Project Properties form 
 
Clicking OK saves the changes. 
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Clicking Cancel or closing the window ignores the changes. 
 
The Show Required Forms button shows which forms in the Project window are required when 
the models selected in the Properties form were saved.  This does not save the current 
selection, but is a visual tool to help the user understand what input would be required when the 
selected options were saved. 
 
In Figure 4-26, Radial was selected and Show Required Forms was clicked. When this was 
done, the Radial Evacuation Speed form link on the left changed from a gray octagon to an X-
ed red octagon. This indicates that additional information is required for the Radial Evacuation 
Speed form and some form(s) in the Additional Emergency Cohorts category when OK is 
clicked and this problem model option is saved.   
 

  

 
 

Figure 4-26 Relating model selection to forms 
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4.4 Modifying Parameters 
 
A parameter modification form can be opened in one of two ways: 

 By double-clicking on the variable name or the form containing the variable found on the 
Parameters tab in the Project window. 

 By selecting the parameter name in the Open Parameter Form and click OK.  The Open 
Parameter Form can be opened as shown in Figure 4-18 or by selecting Edit→Find 
Parameter Window… from the main menu.  See section 4.2.2 for more information. 

 

 General Parameter Modification Forms 4.4.1
There are general parameter modification forms that have the same components, and custom 
parameter modification forms, such as the forms to manage evacuation directions, evacuation 
speeds, and reports.  This section describes the general parameter modification forms. 
 
The following are the main components of a parameter modification form as shown in Figure 
4-27: 

 Enter Comments: Optional comments are entered in this field.  The expected usage is to 
enter comments related to the justification or derivation of parameter values. 

  Eraser Button: Clicking clears the values entered. 

 Data entry area: This is the place where data values are entered. 

 Description area: Describes the data type, limits and units of the variable that has focus 
on the form.  Below this detail is a brief description of this variable. 

 Change Units: This button is used to change parameter units.  See section 4.4.2 for a 
further discussion. 

 Make Uncertain: This button is used to associate a probability distribution with a 
variable.  Most real-valued variables can be specified as uncertain. To change the value 
of a variable to uncertain, the user can either double-click on the text box or cell, or click 
Make Uncertain. This function is also used to change a variable from uncertain back to a 
constant.   

 Clicking OK or Cancel closes the form. OK accepts the modifications; Cancel ignores 
them. 

 
All of the data on the form must be entered before the user can save any of the data on the 
form. When a box is left blank, and OK is clicked, an error message pops up. This serves as a 
reminder to complete the form before clicking OK to save the data. 
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Figure 4-27 Parameter modification form 
 

 Modifying a Data Grid 4.4.1.1
 
Arrays and vectors are displayed in data grids.  Data grids support the following operations: 

 A row is selected by clicking on the small box between the row number and the data. 

 A column is selected by clicking on the column heading. 

 A row is deleted by pressing the Delete key on the keyboard after selecting the row.   

 A change to a row can be undone by pressing the Esc key on the keyboard. As long as 
the pencil icon is shown on the left margin of a row, it is possible to click in a cell on that 
row and press the ESC key to undo changes.   

 Clipboard functionality is provided. To use the copy feature in the grid, select the desired 
data from the grid with a mouse down, drag, mouse up motion. Figure 4-28 illustrates a 
selected area in the grid. To copy the data in this selected area to the Windows 
clipboard, select the Edit→Grid→Copy to Clipboard function from the main menu. 
Similarly, the Edit→Grid→Paste from Clipboard function can be used to replace a 
selected area in the grid with data on the Windows clipboard. This function can be used 
to transfer data from an Excel spreadsheet into WinMACCS. 

 It is possible to select rows in a non-contiguous fashion by holding the control-key down 
while clicking on rows for selection.  When pasting, it is possible to also select non-
contiguous rows for pasting.  In other words, not only can non-contiguous rows be 
selected for copying, but the effected rows for the past operation can also be selected. 

 Columns can be selected, however these must be contiguous.  When pasting, the area 
defining the paste is required to be contiguous. 

 It is possible to select and paste a rectangular area by pressing the left mouse button 
down and dragging over the desired grid data. 

 Copy and paste functions are supported with the keyboard shortcuts Cntl-F and Cntl-G 
respectively. 
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Figure 4-28  Selecting grid data for copy and paste 
 
When modifying a grid on a parameter form, it may be necessary to insert rows or columns.  A 
row may be inserted by using the menu item Edit→Grid→Insert Rows.  A column may be 
inserted by using the menu item Edit→Grid→Insert Columns. 
  

 Supported Data Types 4.4.1.2
 
The following data dimensions are supported: 

 Scalar data: These are single values that are associated with variables. A scalar has 
various types, as listed below.   

 Vector data: These are singly subscripted variables. Multiple vectors can be displayed 
on the same grid; however, each of these vectors must have the same number of rows.   

 Array data: These are multiply subscripted variables (i.e., arrays). A single array can be 
displayed on a grid.   

 
The following types are supported: 

 Integer: A number with no decimal point. An integer can be positive, negative, or zero. 

 Real: A number that has a decimal point.  

 Logical: Represented by a pull down menu. Value is either True or False. 

 Characters: A character string. Size requirements are shown in blue letters below the 
data entry area. 

 Drop-Down Menu: Possible values are displayed as a pull down menu. Only a portion of 
the name needs to be typed. For example, on the ATMOS/Output Control/Spatial 
Intervals for Output form, typing a c for CCDF or an n for NONE and advancing to 
another field completes the data entry for the CCDF field. 

 File: The name of a file is specified by clicking the browse button on the parameter 
modification form. The selected file is copied to the project\data\ folder.  

 Linked Variables: The values of some variables are array sizes calculated by MACCS. 
For example, NUM_DIST is the size of the vectors DISTANCE, SIGMA_Y_A, etc. This 
variable cannot be directly modified. When a linked variable has focus, a description is 
displayed in the description area of the form. The value of the variable is updated as the 
number of grid rows increases or decreases. Linked variables are of type Integer, but 
can only take on positive values.  Variable MAXGRP shown in Figure 4-29 is an 
example of a linked variable. 
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Figure 4-29  Example of a linked variable, MAXGRP 
 

Note: A gray background in an input area indicates that the variable is read-only 
and cannot be changed in that form. 

 
Examples of the data type and bounds that could be found in the description area are as 
follows: 

 Real [.01, 100.]: A number between 0.01 and 100, inclusive, must be entered in the text 
field.  This is displayed in Figure 4-30.  
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Figure 4-30  Real data type 
 

 Integer [1, NUMREL], (NUMREL=10): An integer value from 1 to 10 must be entered in 
the text field. When the value of NUMREL, the number of plume segments, is modified 
and saved on another form, the bounds are changed to reflect the new value of 
NUMREL as shown in Figure 4-31. 

 

 
 

Figure 4-31  Variable upper bound is a variable 
 

 1 to 16 Characters: A character string that is at least one character and not more than 16 
characters must be entered in the field as shown in Figure 4-32. 

 Row Bounds: [1, 10]: The grid must have at least one row and not more than 10 rows as 
shown in Figure 4-32. 
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Figure 4-32  Character length limits 
 

 Nrows = 6: The grid must have exactly 6 rows. This is shown in Figure 4-33. 
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Figure 4-33  Grid with fixed number of rows 
 

 Making a Parameter Value Uncertain 4.4.1.3
 
WinMACCS allows input parameter values to be made uncertain and enables sampling of the 
uncertain variables. The sampling can be done using either a Monte Carlo method or a stratified 
method known as Latin Hypercube Sampling (LHS). The sampling method can be changed 
from the default of LHS to simple sampling by selecting the main menu entry Execute→Simple 
Random Sampling. 
 
The sampling allows the effect of an uncertain input value to be explored. Uncertain variables 
must be assigned a distribution function from which samples are selected. The distribution 
function usually represents degree of belief over a range of values that are considered credible 
for that parameter.  
 
A parameter value can be made to be uncertain by first opening the window associated with that 
parameter. This can be done by double-clicking on the variable name in the Parameters tab in 
the Project window or by using Edit→Find Parameter Window to locate the form.  
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The user can double-click on the parameter value or click on the parameter value and click on 
the Make Uncertain button.  An example uncertain variable form is shown in Figure 4-34. 
 
A form opens with the parameter name in the form title (or caption). 
 
Use this form to: 

 Change parameters from constants to uncertain values described by probability 
distributions. 

 Change parameters from distributions to constants. 

 Change the probability distribution associated with the variable. 
 

Notice that the variable name is shown in the form caption. When an array or vector element is 
associated with a distribution, the index is also part of the name shown in the title bar. In Figure 
4-34, BUILDH(3) in the caption portion of the form indicates that the third value of vector 
BUILDH is being considered for modification. 
 
WinMACCS supports a wide range of distribution types, and each distribution type can accept a 
wide range of values for its parameters. It is possible to specify values for the distribution 
parameters that lead to invalid distributions, causing the LHS sampling to fail. The distribution 
parameter values entered should represent a reasonable distribution for the parameter. 
Furthermore, it is possible to define distributions that lead to values out of range of the 
parameter (e.g., a negative value for a MACCS parameter that must be greater than zero).  
 

 
 

Figure 4-34  Assigning a probability distribution to a parameter 
 
The value of an uncertain parameter can be modified as follows: 
 

1. The user first must select the distribution from the Distribution pull down list. The 
parameter can be changed from a distribution to a constant (deterministic) value by 
setting the distribution to CONSTANT.   
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2. The user enters the values that define the distribution in the text boxes or tables. The 
type of distribution determines the amount and type of information needed to define the 
value.  The values that define the distribution either consist of a list of (x, y) pairs (known 
as tabulated data), or a list of parameters (such as the mean and standard deviation of 
the normal distribution).  An example is shown in Figure 4-35. 

 
1. A representative sample of the current distribution entered can be viewed by clicking 

Apply Distribution.  LHS starts, and one hundred samples are returned and displayed.  
The data can be viewed as a CDF, CCDF, or a Scatter plot.  The mean of the 
distribution is shown in each view.  The sampled values used when running the model 
may differ from those shown on this graph because the input to LHS with respect to the 
number of samples and the seed used may not be the same.   

 

 
 

Figure 4-35 Tabulated uncertain parameters 
 
3. A row of tabulated data can be deleted by selecting the row by clicking on the left margin 

of the row and pressing the Delete key on the keyboard.   
 
4. By pressing the ESC key on the keyboard, typing can be undone. As long as the pencil 

icon is shown on the left margin of a row, it is possible to click in a cell on that row and 
press the ESC key to undo changes.   

 
5. A row of data can be inserted by selecting an existing row and clicking the row insert  

button ( ).  
 
6. By using the left or right arrow key on the keyboard, focus can be moved to an adjacent 

cell.  The Enter key also advances the curser to the next cell. 
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7. When satisfied with the distribution specified the OK button can be clicked as shown in 

Figure 4-34 or Figure 4-35.  This closes the window and saves any changes made to the 
parameter value.  The value of the parameter in the parameter modification form is set to 
the character string "Uncertain" and has a different colored background than constant 
values on the form as shown in Figure 4-36. 

 
 

Figure 4-36  Uncertain variable in a parameter modification form 
 
2. Changes can be discarded by selecting Cancel. 

Another way to view the parameter values after running MACCS is to open the file LHS.inp by 
clicking the Files tab within the project, opening the Input category and double-clicking on the 
file name LHS.inp. The sampled values used in the MACCS simulation can be viewed by 
double-clicking on the file name LHS.out. 
 

 Changing Units 4.4.2
 
Within WinMACCS, it is possible to specify unit changes.  There are three different types of unit 
changes, namely input units on a parameter modification form, input units used on forms 
defining the cohort parameters, and output units for MACCS reporting.   
 
Unit changes are integrated into other WinMACCS functions as follows: 

 The function that imports MACCS input files into the user interface (menu selection 
File/Import MACCS Input File) converts values to user specified units on each form. 

 The reset to default function (right click on form name and select Reset to Default) 
respects units chosen by the user, and converts default values to units specified. 

 Uncertain variable distributions must be changed by the user to be in the units specified 
on the form.  In other words, when the units are changed on a form with an uncertain 
variable, the distribution is not automatically modified to be in the new units; the user is 
responsible to convert the distribution to the new units. 

 Parameter bounds reflect the units selected on the parameter modification form. 

 Map forms (evacuation direction, speed multiplier, and cohort population) show values 
and units labels (km, mi, etc.) in specified units. 

 
 Modify the Input Units for Non-Cohort Variables 4.4.2.1

 
The user is also allowed to change input units for many of the input forms by using the Change 
Units button on the parameter modification forms. Each dimensioned parameter in WinMACCS 
is assigned to a unit family. The user can change input units and also convert existing values to 
the new input units that belong to the family assigned. 
 
Most parameter definition forms now include a Change Units button that allows unit changes, as 
shown in Figure 4-37.  When there are no parameters on the form with units that can be 
changed, this button is grayed out.  The Change Units button is always grayed out on the cohort 
specific forms since those units are changed on the Cohort Units form. 
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Figure 4-37  Changing units on a parameter form 
 
When building the MACCS input files, input parameter values are modified to be consistent with 
MACCS input parameter units, which are consistent with the default units shown in Table 4-1. 
Thus, MACCS input files retain their default units and input unit conversion is handled by 
WinMACCS. 
 

 Modify the Input Units for Cohort Variables 4.4.2.2
 
To avoid confusion, units are not allowed to be different between the sets of cohorts.  To 
enforce this requirement, there is one form used to specify units for all parameters associated 
with cohort definitions.  This form is opened by clicking on the EARLY/Model Basis/Cohort Units 
entry as shown in Figure 4-38. 
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Figure 4-38  Assigning units for cohort parameters 
 

 Modify the Output Units for MACCS reporting 4.4.2.3
 
A form, shown in Figure 4-39, allows the user to request results be reported in optional units, 
shown in Table 4-1, in both the text and binary output files created by MACCS.   
 

Table 4-1  Default and optional units for MACCS reporting. 

Unit Family Default Unit Optional Units 

Activity Bq Ci 

Distance km mi 

Area ha km2, mi2 

Dose Sv rem 
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Figure 4-39  Specifying MACCS reporting units 
 

 Correlate Uncertain Parameters 4.4.3
 
In many cases, sets of uncertain input variables are correlated. 
 
WinMACCS allows two methods for correlating uncertain input variables. The first uses rank 
correlation coefficients; the second method performs a direct rank reordering of one variable 
and is described in section 4.4.3.2. 
 
To correlate variables that have been chosen to be uncertain, select Edit→Correlate Uncertain 
Variables→Linear Coefficients from the main menu. This opens the Correlate Uncertain 
Variables form, which lists each rank correlation that is currently defined and allows new 
correlations to be defined.  
 

 Correlation Using LHS 4.4.3.1
 
After LHS has run and imposed correlations specified by the user, WinMACCS can reorder 
some of the variables to be consistent with the rank order of other variables.  This is a desirable 
feature when there is a need to impose a perfect correlation of 1 or -1 between two sets of 
variables. LHS does not support this feature. 
 
The command Edit→ Correlate Uncertain Variables→ Linear Coefficients opens the Correlate 
Uncertain Variables form as shown in Figure 4-40. 
 
Adding correlations in the table's insertion row (indicated by "*" at the beginning of the row) can 
be done by doing the following: 
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6. By clicking in the grid element in the Parameter One column, an uncertain parameter can 

be selected. 

7. By clicking in the grid element in the Parameter Two column, the uncertain parameter to 

correlate with Parameter One can be selected. 

8. The rank correlation coefficient between the two selected parameters in the column 

labeled Correlation Coefficient is done by typing a value in the third column.   

 
Variables can be positively or negatively correlated by specifying a correlation coefficient within 
the range (-1.0, +1.0), where the value -1.0 and 1.0 is not allowed. 
 
The correlations apply to the ranks of the parameter values rather than to the values 
themselves. Correlation coefficients must be greater than -1 and less than 1. These limits are 
enforced by WinMACCS. 
 
When any two parameters are uncorrelated, they have an implied correlation coefficient of zero, 
which is the default. Implied correlation coefficients are not listed in the table. Correlations can 
be removed (i.e., set to zero) by selecting the grid row and pressing the delete key on the 
keyboard. 
 
By using the arrow keys on the keyboard, focus moves from cell to cell in the grid.  
 
Clicking OK preserves changes.  Clicking Cancel discards changes.  
 
WinMACCS creates a report titled SampleRank.out in the project Input/ folder that summarizes 
the correlations and the order and values of the uncertain variables used in the MACCS 
simulations. 
 

 
 

Figure 4-40  Correlate uncertain variables 
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There are some restrictions on the correlations that WinMACCS allows.  For example, it doesn’t 
make sense to rank correlate two variables, say A and B, with a coefficient, and impose a rank 
order of B with respect to the order of A.  WinMACCS does not allow the same pair of variables 
to be rank correlated (as described in section 4.4.3.2) and also to be reordered. 
 
It is possible to specify combinations of rank correlations that are not mutually consistent.  Such 
inconsistencies are generally in the form of circular correlations. For example, two parameters 
"A" and "B" can be assigned a correlation coefficient of 0.99, parameters "B" and "C" can also 
be given a correlation coefficient of 0.99, but parameters "A" and "C" can be assigned a 
correlation of -0.99.  Each correlation is valid by itself, but the three are logically incompatible. 
The parameter sampling may fail when circular correlations are inconsistently defined. 
 
It is not possible to perfectly correlate two variables using this option.  In this case, use the 
command Edit→ Correlate Uncertain Variables→ Enforce Rank Order. 
 

 Enforcing Rank Order 4.4.3.2
 
Selecting Edit→ Correlate Uncertain Variables→ Enforce Rank Order from the main menu 
allows ranking of variables that have been chosen to be uncertain. This opens the Enforce Rank 
Order of Uncertain Variables form as shown in Figure 4-41, which lists each rank correlation 
that is currently defined and allows new correlations to be defined.   
 
Rank orders are specified as follows: 
 
1. The uncertain varialbes are defined by opening the relevant parameter modification 

forms and associating the variables to be ranked with probability distributions by clicking 
on the Make Uncertain button, closing the forms, and saving the values. 

 
2. The Enforce Rank Order of Uncertain Variables form is opened by selecting 

Edit→Correlate Uncertain Variables→Enforce Rank Order. 
 
3. In the column labeled Reorder Basis the user selects the first uncertain variable.  The 

order of this variable is not changed from the order of values returned from LHS. 
 
4. In the column labeled Reorder Parameter, the user selects the uncertain variable whose 

order is to be changed. 
 
5. In the column labeled Rank Order the user selects either Inverse Order to order the 

variable in the opposite order as the basis parameter, Reorder Basis, or Same Order to 
order the variable in the same relative order as the basis parameter.   

 
6. As many entries as needed may be added to the table. 
 
7. Clicking OK preserves changes. Clicking Cancel discards changes. 
 
Rows can be deleted by selecting the grid row and pressing the delete key on the keyboard.  
The arrow keys are used to move from cell to cell in the table.  
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Figure 4-41  Enforce rank order form 
 
In the example shown in Figure 4-42, a perfect positive correlation is imposed between ATMOS 
variables BUILDH(1) and SIGZINIT(1), and a perfect negative correlation is imposed between 
COMIDA2 variables DAIRY_RATE(1) and DAIRY_RATE(3).       
 

 
 

Figure 4-42  Enforce rank order example 
 
This ordering request causes the values of DAIRY_RATE(3) and SIGZINIT(1) to be changed 
from the order returned by LHS.  After execution, LHS.out can be opened by double clicking the 
entry LHS.out found on the Files Tab in the Input category. Sample values from LHS.out  are 
shown in Table 4-2. 
 

Table 4-2  Sampling example. 

Trial BUILDH(1) DAIRY_RATE(1) SIGZINIT(1) DAIRY_RATE(3) 

1 249.675 5.81245 295.12 9.16814 

2 123.061 10.1165 281.956 10.3411 
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3 180.287 15.7363 338.324 12.1482 

4 214.842 21.8037 267.811 13.5931 

5 188.622 19.2878 312.628 5.65193 

 
The actual order used in the sequence of MACCS simulations is in the file SampleRank.out, 
found in the project Input folder.  In this example, the ranked order is shown in Table 4-3. 
 

Table 4-3  Sampling ranked. 

Sample Value Rank Value Rank Value Rank Value Rank 

Trial BUILDH(1) DAIRY_RATE(1)  SIGZINIT(1)  DAIRY_RATE(3) 

1 249.675 5 5.81245 1 338.324 5 13.5931 5 

2 123.061 1 10.1165 2 267.811 1 12.1482 4 

3 180.287 2 15.7363 3 281.956 2 10.3411 3 

4 214.842 4 21.8037 5 312.628 4 5.65193 1 

5 188.622 3 19.2878 4 295.12 3 9.16814 2 

 
This table tells us which values are used in each MACCS simulation.  For example, for trial 
number 3 (corresponding to the output file Model3.out), BUILDH(1) is set to 180.287 and 
SIGZINIT(1) is set to 281.956. 
 
Notice that values of BUILDH(1) and DAIRY_RATE(1) are preserved from the order listed in the 
LHS output.  However, values for SIGZINIT(1) and DAIRY_RATE(3) have been reordered so 
that the rank order for SIGZINIT(1) is the same as that of BUILDH(1), and the rank order of 
DAIRY_RATE(3) is the opposite of that for DAIRY_RATE(1). 
 
WinMACCS creates a report titled SampleRank.out in the project Input/ folder that summarizes 
the correlations and the order and values of the uncertain variables used in the MACCS 
simulations. 
 
With the introduction of spatial grid forms containing complex evacuation directions and speed 
multipliers, came a need to replicate the values to other cohorts. Cohort forms are forms that 
are in the EARLY/Emergency Cohort One and EARLY/Additional Emergency Cohorts 
categories. Copying form data from one cohort form to another cohort form can be 
accomplished by right clicking on the form within a cohort category and selecting the popup 
menu item Copy Cohort Variables or by using the main menu function Edit→Modify Form 
Variables→Copy Cohort Variables.  See section 0 for more information.   
 

 Copy Values between Cohorts 4.4.4
 
With the introduction of spatial grid forms containing complex evacuation directions and speed 
multipliers, came a need to replicate the values to other cohorts. Cohort forms are forms that 
are in the EARLY/Emergency Cohort One and EARLY/Additional Emergency Cohorts 
categories. Copying form data from one cohort form to another cohort form can be 
accomplished by right clicking on the form within a cohort category and selecting the popup 
menu item Copy Cohort Variables or by using the main menu function Edit→Modify Form 
Variables→Copy Cohort Variables.  A dialog box opens as shown in Figure 4-43. 
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Figure 4-43  Copy values from one cohort form to other cohort forms 
 
In the following example, the user wants to copy all of the values in the Network Evacuation 
Direction from cohort two to cohort five and cohort six.   
 
3. The user first closes forms Emergency Cohort Two/Network Evacuation Direction, 

Emergency Cohort Two/Network Evacuation Direction and Emergency Cohort 
Two/Network Evacuation Direction.   

 
4. The user clicks on the form name Network Evacuation Direction under the category 

Emergency Cohort Two, highlighting the form name as shown in Figure 4-44. 
 
 

 
 

Figure 4-44  Select network evacuation direction form 
 
5. The user right clicks on Network Evacuation Direction and selects the pop up menu item 

Copy Cohort Variables.  Alternatively, Edit→Modify Form Variables→Copy Cohort 
Variables can be selected from the main menu as shown in Figure 4-43.  Checking the 
boxes labeled Cohort 5 and Cohort 6 and clicking OK replicates the data for this form 
into the cohort 5 and cohort 6 forms. 
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Figure 4-45  Copy form values between evacuation cohorts 
 
6. When an empty form is selected as the form to copy from (or base form), no data are 

replaced on the forms selected for application. 
 
7. When the base form is open and this option is used, the saved values of the variables 

are used in the copy.  In other words, when the base form is opened and values are 
changed, when selecting Edit->Modify Form Variables->Copy Cohort Variables the 
values that are copied are the values saved the last time the form’s OK button was 
clicked, not the new values just entered. 

 
Comments on forms are not copied or propagated. 
 

 Annual Dose Conversion Factor and Annual COMIDA2 Files 4.4.5
 
When the Annual Threshold or Piecewise Linear dose models are chosen on the Dose tab of 
the Project Properties form, a set of fifty-one dose conversion factor (DCF) files are needed by 
MACCS.   Additionally, when either of these dose models is chosen and the COMIDA2 Food 
Model is chosen on the Food tab, a set of fifty-one COMIDA2 files are needed by MACCS, each 
COMIDA2 file having been created with its associated DOSFAC2 file. 
 
WinMACCS is distributed with files sets to be used with the annual threshold or piecewise linear 
dose models.  The first set is based on DOE/EH-0070 (1988); the second is based on EPA 
(2002) Federal Guidance Report No.13. 
 
The base DCF file is one that contains the conversion factors for a fifty year commitment period. 
The base COMIDA2 file is created using the base DCF file.   
 
The annual, differential DCF files contain the dose conversion factors for each year of the 50-
year commitment period. These file names are sequenced to enable the identification of the 
year number. For example, FGR13DCF03.inp corresponds to the dose conversion factors used 
to calculate the dose in year three for an exposure that occurred in year one. The annual 
COMIDA2 files are created using the corresponding annual DCF files. 
 
The following example shows how an annual differential DCF and COMIDA2 file set can be 
specified:  
 
1. Opening the GENERAL/File Specifications/Annual Differential DCF Files form allows the 

specification of the DCF files as shown in Figure 4-46. 
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2. Opening the folder where the DCF are files are located updates the column labeled Click 

Base DCF File.  This is done by selecting the correct hard drive in the Select Drive pull 
down menu and locating the folder on the form.   When WinMACCS is installed, a copy 
of the DCF and COMIDA2 files are put in the Program Files\WinMACCS folder.   

 
3. Selecting the base DCF file in the box directly under the title Click Base DCF File results 

in the fields Base DCF File and Expected Auxiliary Files to be populated.   In the 
example shown in Figure 4-46, the name of the base file is FGR13DCF.inp.  The base 
file name is copied in the box labeled Base DCF File.  Other file names are generated 
given this base file following the algorithm of appending the year number to the file 
name.  WinMACCS expects these additional files to be present in the current folder. 

 
4. OK can be clicked to save the changes.  WinMACCS copies the base DCF file and the 

fifty auxiliary files to the project\Data folder. Click Cancel to close this form without 
saving any changes. 

 
5. Open the GENERAL/File Specifications/Annual Differential COMIDA2 Files form and 

repeat this process to define the COMIDA2 file set when needed 
 

 
 

Figure 4-46  Threshold DCF files 
 

 Sequential MACCS Files 4.4.6
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MACCS input can be changed using successive input files.  A single MACCS simulation is run 
for each of the files specified.   
 
The sequential, or cyclical, files must be formatted consistently as MACCS input files. However, 
the ATMOS, EARLY, CHRONC, and COMIDA2 input for a single simulation can be combined 
into a single file.  
 
The parameter values specified in each of the cyclical files are used for a simulation.  When a 
required parameter is not specified, the value of that parameter in the WinMACCS project is 
used. 
 
Before executing a set of cyclical files, a complete problem description must be defined. 
Parameter values in the cyclical files override the parameters defined in WinMACCS. Thus, the 
cyclical files do not need to contain a complete problem description, but only the set of 
parameters to be modified. 
 
An example of a cyclical file with a source term definition is a MelMACCS output file. 
 

 Specifying Cyclical MACCS Files 4.4.6.1
 
MACCS cyclical input files can be specified as follows: 
 

1. The MACCS Cyclical File Set model can be selected by opening the Properties 
form, checking the box MACCS Cyclical File Set on the Scope tab, and clicking 
OK. 

 
2. The GENERAL/File Specifications/Cyclical File Set form is opened, similar to the form 

shown in Figure 4-47. 
 
3. The location of the MACCS cyclical files should be located by selecting the correct drive 

and folder. 
 
4. Double-clicking on the MACCS cyclical file names will add them to the list on the right 

side of the window. 
 
5. Clicking OK will save the file selection. The files are copied to the project Data\ folder. 

Clicking Cancel closes the window without copying any files. 
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Figure 4-47  Choose input files for cyclical execution 
 
A file can be removed from the cyclical set by selecting the file in the list on the right side of the 

form, as shown in Figure 4-47, and pressing the Delete key on the keyboard. 

 
The order of processing the files by WinMACCS can be changed by selecting the file in the list 
of cyclical files and using the up and down arrow to change the order the selected file is listed.  
When MACCS executes, the files are used in the order they appear on this form. 
 
An interface tool named MELMACCS can be used to create MACCS-formatted files that contain 
source term information extracted from a MELCOR plot file. These files can be specified as 
cyclical files. In this way, a set of source terms for a plant can be run sequentially.  
 

 Cyclical Execution with Uncertain Parameters 4.4.6.2
 
It is possible to perform calculations with a cyclical file set and to sample uncertain variables 
using LHS simultaneously. When this is done, the number of simulations should be set to a 
multiple of the number of cyclical files.  The values from the cyclical files will be reused when the 
number of simulations is greater than the number of cyclical files. 
 
For example, when six simulations are requested, but there are three cyclical files, simulation 
one and four will use the values from the first file, two and five the values from the second file 
and three and six the values from the last file.  LHS will generate six sampled value sets and 
insert these values into the MACCS input files as expected. 



4-48 

 

 Spatial Grid Forms 4.4.7
 
Spatial grid forms are applicable in the following situations: 

 Evacuation directions are required when network evacuation is enabled.   

 When the speed multiplier option has been activated on the Properties form, speed 
multipliers per grid element (i.e., for each direction and spatial distance) can be specified 
for either the radial or network evacuation models, depending on which option is 
selected. 

 When population by cohort is specified, populations per grid element can be specified.  
This option is activated on the Properties form on the Site Data tab. 

 
All spatial grid forms contain the following functions 

 A copy of a map with the directions and speed multipliers as is shown in the spatial grid 
form can be created by clicking on the Save Map button as shown in Figure 4-57. 

 The map shown behind the polar grid can be hidden by checking the Hide Map check 
box. 

 Comments can be entered at the top of the form. 

 The inner ring and outer ring controls allow zooming in and out. 

 Multiple radii and sectors can be selected using the Windows shift-select and control-
select functions.  The selected grid elements can be assigned a common value. 

 
 Evacuation and Speed Multiplier Model 4.4.7.1

 
Radial and network evacuation and speed multiplier model parameters are defined using spatial 
grid forms.   
 
These models can be enabled as follows: 
 
1. By selecting Edit→Project Properties from the main menu, the Project Properties form 

can be opened. 
 
2. Clicking on the Evac/Rotation tab as shown in Figure 4-48 allows the user to select 

Radial or Network for the problem model. 
 
3. The evacuation type needs to be defined for each of the cohorts. 
 
4. When speeds vary within the evacuation grid elements for either the network or the 

radial evacuation models, check the box Activate Speed Multiplier Model.    
 
5. Clicking OK saves the settings, clicking Cancel cancels the settings. 
 
When the Network evacuation is selected, the Network Evacuation Direction form is required for 
cohort one.  When the Activate Speed Multiplier Model is checked, either the Radial Evacuation 
Speed or the Network Evacuation Speed form is required for cohort one.   
 



4-49 

 
 

Figure 4-48  Activate speed multiplier model 
 
The variables SPAEND, as shown in Figure 4-49, and LASMOV, as shown in Figure 4-50, must 
be defined before the Network Evacuation Direction forms, Radial Evacuation Speed or the 
Network Evacuation Speed forms can be successfully opened.  These two variables are needed 
to define the evacuation grid.  As a side effect, NUMEVA must also be defined because it is on 
the same form as LASMOV. 
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Figure 4-49  ATMOS radial grid, SPAEND 
 
 

 
 

Figure 4-50  Evacuation boundary, LASMOV 
 
The Network Evacuation Direction form and the Evacuation Speed form are similar.  The 
navigation of the forms is the same; however, the navigation of the forms with respect to 
specifying the direction or speed variables is different.   
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 Population by Cohort  4.4.7.2
 
Populations are assigned to grid elements using a spatial grid form, EARLY/Population by 
Cohort/Populations Assigned. 
 
To enable the specification of the population fraction by cohort, the Results Weighting Factor is 
set to SUMPOP in the Project Properties form as shown in Figure 4-51. This form is opened by 
selecting Edit/Project Properties from the main menu.   
 
Site data files that are not used with the SUMPOP option contain one array of population data, 
specifying the population for each grid element.  When using SUMPOP, there is an array of 
population data for each cohort.  The populations used per cohort are defined in forms found in 
the Project Parameters tab category EARLY/Population by Cohort. The SecPOP software is 
used to create the site data file, defining the populations to be consistent with Census data and 
the spatial grid. 
 

 
 

Figure 4-51  SUMPOP option on Project Properties form 
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An existing site file is specified to use as a basis for the new site file that supports the SUMPOP 
option.  This site file can be one that has multiple cohorts defined (e.g., already supports 
SUMPOP), or it can be a site file with a single cohort defined. 
 
A variable, Population, is defined when the site file is defined on the General/File 
Specifications/Site File form.  This variable will contain the population array corresponding to the 
grid population in the existing site file.  When the site file specified has multiple population 
arrays, variable Population is the array containing the sum of the population over all evacuation 
cohorts on the site file. 
 
Though this variable is defined on the Site File form, the EARLY/Model Basis/Population from 
Site File form must be opened to view this array as shown in Figure 4-52. It is not possible to 
change any values of the variable Population on this form.  To change the Population values, a 
new site file must be specified on the Site File form. This variable will be defined whenever the 
site file is updated. 
 
 

 
 

Figure 4-52  Population from Site File form 
 
To support assigning portions of the population to different evacuation cohorts for a given 
spatial grid element, population distribution was introduced into the model.  A population 
distribution is associated with a spatial grid element, and defines the portion of each evacuation 
cohort that belongs to that grid element.  For example, when there were two cohorts defined, a 
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population distribution of (.6, .4) assigned to a spatial grid element would mean that 60% of the 
population exhibits cohort one evacuation behavior, and 40% belong to cohort two.   
 
Opening the form EARLY/Population by Cohort/Distributions allows the user to define the 
various population distributions.  There can be up to ninety distributions defined.  The example 
shown in Figure 4-53 shows four cohorts that are differentiated by the delay to evacuate.  To aid 
in envisioning this problem, consider cohort one to be associated with the general population 
behavior, cohort two the behavior of special needs people, cohort three the behavior of children 
in schools, and cohort four does not evacuate. 
 

 
 

Figure 4-53  Population distributions over cohorts 
 
To aid the user in assigning populations to spatial areas, the EARLY/Population by Cohort 

/Population Labels form as shown in Figure 4-54 allows a symbol and a label to be assigned to 

each of the population distributions.  In this example, it is projected that Population 2 will be 

assigned to a spatial area that contains a school.  The analyst has determined that 99.9% of the 

population in this area are in cohort 3, and .1% are in cohort 4.  Notice that the fractional cohort 

sums for each of the populations defined add to one. 
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Figure 4-54  Population distribution labels 
 
Lastly, a population distribution must be assigned to each spatial element.  Open the form 

EARLY/Population by Cohort/Populations Assigned to assign distributions to grid elements. 

 
 Creating Road Maps 4.4.7.3

 
Radial distances vary from zero to the upper bound of SPAEND.  Grid elements are numbered 
with 1 for north, 5 for east, etc., when the grid is divided into sixteen equal angles.  Each value 
of SPAEND is represented as a concentric circle. 
 
When a new project is created, the Network Evacuation Direction forms and the Evacuation 
Speed forms do not show a road map behind the polar grid.  Evacuation directions are initially 
set to be radially outward, as shown in Figure 4-55, and the speed multiplier is set to one. 
 
The number or letter drawn at the center of each of the grid elements indicates the associated 
speed multiplier rank.  This is different than the value of the speed multiplier.  If, for example, 
the speed multipliers are either .5 or 1.5, there are two possibilities for the multiplier rank, 
namely 1 corresponding to a speed multiplier of .5 and 2 corresponding to a speed multiplier of 
1.5. 
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Figure 4-55  Initial state of evacuation grid 
 
Road maps can be easily created to display behind the grid by using MapGen, a custom 
application that uses Microsoft MapPoint, by clicking the Create Map File button in any of the 
spatial grid forms in WinMACCS.  When this is done, a file named MapSummary.txt is created 
and placed in the project Input\ folder. 
 
The file, MapSummary.txt is subsequently read by MapGen to create the road maps. MapGen is 
implemented as a separate application because of licensing issues. No license outside of the 
NRC licensing requirements is required for MACCS.  However, the map interface program, 
MapGen, requires that the Microsoft Map Point 2006 libraries be installed.  Thus, to enable the 
use of maps in the MACCS, Microsoft Map Point 2006 must be purchased and installed.  
 
WARNING:  When the Spatial Grid is modified, a consistent set of road maps must be 

regenerated. 
 
Background map files can be created as follows: 
 
1. Opening the form ATMOS/Weather/Site Location by double-clicking on this entry in the 

Parameters tab of the Project window allows the user to enter the latitude and longitude 
of the site.  This form is shown in Figure 4-56.  This form may not be flagged as a 
required data entry form for the MACCS models selected (i.e., the icon may have a slash 
through it), but to generate a set of road maps, it is necessary to enter the latitude and 
longitude of the site. 
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Figure 4-56  Enter latitude and longitude 
 
2. In any form that shows the polar evacuation grid, selecting Create Map File as shown 

Figure 4-57 causes a file titled MapSummary.txt to be created and placed into the 
WinMACCS project Input folder.  

 

 
 

Figure 4-57  Create map file 
 
Within the Files Tab in the Project window, this file can be optionally viewed by double-clicking 
on the entry Input/MapSummary.txt.   
 
A sample map interface file is as follows: 
 

* File created using WinMaccs Version 3.10.0 SVN:2560 7/15/2015 4:52:15 PM 
* Latitude and Longitude as a decimal 
/LAT           40.17194  
/LON          -88.83417  
* File Name to create, Distance in km from lat,long to edge of square map 
/DAT          Map_0.16.gif   0.1704918  



4-57 

/DAT          Map_0.52.gif   0.5540984  
/DAT          Map_1.21.gif   1.289344  
/DAT          Map_1.61.gif   1.715574  
/DAT          Map_2.13.gif   2.269672  
/DAT          Map_3.22.gif   3.431148  
/DAT          Map_4.02.gif   4.283607  
/DAT          Map_4.83.gif   5.146721  
/DAT          Map_5.63.gif   5.99918  
/DAT          Map_8.05.gif   8.577869  
/DAT          Map_11.27.gif  12.00902  
/DAT          Map_16.09.gif  17.14508  
/DAT          Map_20.92.gif  22.2918  
/DAT          Map_25.75.gif  27.43852  
/DAT          Map_32.19.gif  34.30082 

 
Notice each line of the file that starts with the character string “/DAT”.  Each /DAT lines directs 
MapGen to create a gif file.   
 
Example: 

/DAT          Map_0.16.gif   0.1704918  
  
Two parameters are shown per input line. The first is the name of the image file that is created 
by MapGen, e.g., Map_0.16.gif.  The second parameter is the distance in km from the center of 
the map to the edge of the map as displayed in the WinMACCS interface.  This input line 
corresponds to the spatial grid element 0.16 km.   
 
WinMACCS creates a line in the file for each value of SPAEND, the spatial grid distance.  The 
value of SPAEND is built into the name of the GIF file.  This ensures that an incorrect map is not 
shown behind the evacuation grid when the spatial grid entries are modified (SPAEND is 
changed in WinMACCS).   
 
The second number is a measure in km from the center of the map to the outer edge calculated 
in WinMACCS to allow the map to fit to the edge of the form.   
 
This process assumes that all maps are square. 
 
1. MapGen can be started from the MapGen group found on the Windows Start Menu. 
 
2. From the main MapGen menu as shown in Figure 4-58, selecting File→Generate Gif 

from File allows the user to select the file MapSummary.txt file created in the previous 
step as shown in Figure 4-59.  Clicking on Open completes this form.  

 
3. WinMACCS expects the map files to be located in the project Data folder.  Choosing the 

Data folder for the gif file destination as shown in Figure 4-60 will enable WinMACCS to 
find the map files. Clicking OK causes the maps to be generated. 
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Figure 4-58  Generate road map files 
 
 

 
 

Figure 4-59  Open map summary.txt 
 
 

 
 

Figure 4-60  Complete creation of road maps 
 

4. Opening a form that shows the polar evacuation grid, for example, Radial Evacuation 
Speed, the user can observe the map updating when changing the Outer Ring Shown 
slider as shown in Figure 4-66. The maps are displayed behind the spatial grid.  When 
the maps do not display, verifying that the Hide Map check box is unchecked, that the 
map .gif files are in the project Data folder, and that the spatial grid values are in 
agreement with the names assigned to the map .gif files should fix the problem. For 
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example, Map_1609.34.gif corresponds to 1609.34 km.  This is the map that is displayed 
when the outer ring in the polar grid is at 1609.34 km.  This corresponds to an entry in 
array SPAEND. 

 
The Outer Ring Shown slider must be clicked to refresh the background the first time the maps 
are created.  
 
The roadmap can be displayed in MapGen by entering the latitude and longitude in decimal 
form and the distance from the center to the left edge as shown in Figure 4-61.  These numbers 
can be read from the file MapSummary.txt as shown in the following example: 
 

/LAT           40.17194  
/LON          -88.83417  
/DAT          Map_1.21.gif   1.289344 

 

 
 

Figure 4-61  MapGen interface 
 
The coordinates of each of the maps centers has a latitude of 40.17194 and a longitude of -
88.83417.  The line labeled /DAT instructs MapGen to create a map file named Map_1.21.gif, 
representing an outer radius of 1.21 km.  This same line specifies that the distance from the 
center to the edge of the map is 1.289344 km. 
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Entering the latitude, longitude and the distance from the center to the edge in MapGen as 
shown in Figure 4-61 and clicking the button labeled Go generates the desired map manually.  
The actual distance from the center to the edge can be verified by clicking the edge of the map 
in MapGen.  This is the shortest distance from the center to the edge as calculated by 
MapPoint, the underlying Microsoft map engine.  
 
The MapPoint interface internally requires that a viewing altitude be specified. It was determined 
that the viewing angle of 30.64353 degrees creates consistent maps with the exception of very 
high altitudes.  However, this does not appear to be a problem at distances less than 2000 km.   
 
MapGen is designed to be consistent with MapPoint 2006. Future versions of MapPoint could 
use a different algorithm or viewing altitude formula, and so could produce unexpected results 
when used with MapGen. 
 

 Assigning Values to Grid Elements 4.4.7.4
 
The Network Evacuation Direction form is used as an example, shown in Figure 4-66.  The 
same techniques used to assign values to grid elements in the Network Evacuation Direction 
form is used for the Populations Assigned and the Radial and Network Evacuation Speed forms.  
The only difference between these forms is the possible values the grid elements can have.  In 
the example of the Network Evacuation Direction form, the values can be set to In, Out, Right or 
Left.  In the case of the Populations Assigned and the Radial and Network Evacuation Speed 
forms, the values are set to user defined populations or user defined speed multipliers 
respectively. 
 
Understanding the Spatial Grid 
 
Spatial grids are used to enter speed multiplier data for radial and network evacuations, and 
evacuation directions in the case of the network evacuation option.  An example of this form is 
shown in Figure 4-66.   
 
Arrows drawn on the grid elements indicate the evacuation direction as shown in Figure 4-62. 
There are four different directions supported by MACCS, outward, inward, counter clockwise 
and clockwise.  Each of these directions is shown in a different color. 
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Figure 4-62  Evacuation grid 
 
On the Radial Evacuation Speed form, all arrows are red and pointed outward as shown in 
Figure 4-55. 
 
To the right of the map the inner and outer ring displayed on the polar grid are indicated as 
shown Figure 4-66. The integer value shown to the left of the sliders labeled Inner Ring Shown 
and Outer Ring Shown correspond to the first column labeled Ring as shown in Figure 4-63.  In 
the example shown in Figure 4-64, the Inner Ring Shown is set to 2, corresponding to 
SPAEND(2) which is equal to 0.52.  The Outer Ring Shown is set to 3, corresponding to 
SPAEND(3) which is equal to 1.21.   
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Figure 4-63  Radius, sector and multiplier 
 
 

 
 

Figure 4-64  Inner ring and outer ring sliders 
 
The symbols shown in column four labeled Rank as shown in Figure 4-63 indicate the speed 
multiplier rank.  These values are different than the actual speed multiplier.  In this example, the 
number 1 corresponds to a multiplier of 0.5, 2 to a multiplier of 1, and 3 to a multiplier of 1.2 as 
shown in column five, Speed Multiplier.  By showing ranks, the speed multipliers can be 
adjusted without requiring the user to adjust the settings on the polar grid. 
 
When the grid is clicked, the radial distance from the center of the grid to the click is shown on 
the bottom left portion of the form, as shown in Figure 4-65. This is useful for diagnostic 
reasons.  Once a map is displayed behind the grid, the scale can be checked when there is a 
reason to believe that the polar scales and the map scales are inconsistent.  The number shown 
in WinMACCS corresponds to the scale of the polar coordinate system.  From the viewpoint of 
WinMACCS, the roadmap is simply a picture file. 
 
Clicking OK preserves changes.  Clicking Cancel discards changes. 
 

 
 

Figure 4-65  Radial click distance 
 
Assigning Values to the Network Evacuation Direction Form 
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Figure 4-66  Network evacuation direction 
 
The evacuation direction can be modified in two ways.   
 
The first method is to click the grid element on the map.  The direction changes for that grid 
element each time the area is clicked.  The direction rotates ninety degrees clockwise each time 
the grid element is clicked.    
 
When a grid element is clicked, the clicked element is selected in the Radius/Sector list.  In the 
example shown in Figure 4-67, the grid element between 3.22 km and 4.02 km in the fourth 
sector is selected.  Sector 4 corresponds to ENE in a grid that has been divided into 16 sectors. 
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Figure 4-67  Radius and sector selected 
 
The second method is to use the Assign button. 
 
Clicking the UnSelect button clears the selection of the radius and sector.  
 
Selecting a radius and a direction from the list and clicking the Assign button changes the 
direction for all grid elements at the selected radius. 
 
Similarly, selecting a sector and a direction but no radius as shown in Figure 4-68 and clicking 
the Assign button changes the direction for all grid elements in the selected sector. 
  
 

 
 

Figure 4-68  Select sector only 
 
Assigning Values to the Radial or Network Speed Multiplier Form 
 
The speed multiplier ranks can be modified in two ways. 
 
The first method is to click the grid element on the map.  The rank is incremented by one each 
time that grid element is clicked. For example, clicking a grid element with an initial rank of four 
results in a rank of five assigned when five or more ranks are defined; otherwise, the rank 
cycles from four back to one.   
 
When a grid element is clicked, the clicked element is selected in the radius and sector lists. 
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The second method is to use Assign button.  This method is the preferred way to change all of 
the speed multipliers for a given radius or a given sector.  This can be done as follows: 
 
1. Clicking the UnSelect button clears the selection of the radius and sector.  
 
2. Selecting a radius and a direction from the list and clicking the Assign button changes 

the speed multiplier for all grid elements at the selected radius. 
 
3. Selecting a sector and a direction but no radius and clicking the Assign button changes 

the speed multiplier for all grid elements in the selected sector. 
 
4. Selecting a radius, a sector, and a speed multiplier rank and clicking Assign only 

changes the rank of the selected grid element. 
 
In the example shown in Figure 4-69, the speed multiplier rank for the grid elements between 
0.52 and 1.21 in sector two is changed to 2 when Assign is clicked. 
 

 
 

Figure 4-69  Select speed multiplier 
 
Assigning Values to the Populations Assigned Form 
A graphical window similar to the Network Evacuation Direction and Network Evacuation Speed 
windows used to assign populations to grid elements is shown in Figure 4-70.  However, instead 
of assigning evacuation directions or evacuation speeds to the grid sectors, population 
distributions are assigned.  
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Figure 4-70  Selecting populations assigned to cohorts 
 
On the right side of this window there is a list titled Population.   In the example shown in  
 
Figure 4-70, three symbols are listed, namely N, S and G.  These symbols correspond to the 
distributions and distribution labels assigned on the forms EARLY/Population by 
Cohort/Populations and EARLY/Population by Cohort /Population Labels.  A bar chart of the 
population distribution selected is shown below the radii, sector and population lists. 
 
A population distribution can be assigned to a sector by clicking the distribution symbol, and 
clicking the sector on the map.  For example, the sector (11.27, 10) is assigned the distribution 
N.  This was accomplished by clicking on the N in the population list and clicking on the grid 
element on the map.   
 
A population can be assigned to all of the grid elements in a radius by clicking the UnSelect 
button to remove the highlighted list elements, clicking the radius of interest in the list labeled 
Radius, clicking the population in the list labeled Population, and clicking the Assign button.  
Similarly, a population can be assigned to all grid elements in a given sector by following this 
same procedure, but instead of clicking on a radius, the user should click on the sector of 
interest in the list labeled Sector. 
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It can be convenient to predefine all grid elements to a population by clicking the UnSelect 
button, clicking a distribution in the Population list, and clicking the Assign button.  This can be 
followed by manually setting less common populations by one of the other methods described.   
Clicking OK when completed will save the changes. 
 
When the MACCS simulation has finished, the site file used in the simulation, Sumpop_site.inp, 
can be viewed.  This file is found in the project Input folder.  This site file, created by 
WinMACCS and used by MACCS, contains a population array for each of the evacuation 
cohorts.   
 
The population for a grid element for a single evacuation cohort is calculated by considering the 
population fraction for that grid element.  For the cohort of interest, the population fraction 
associated with the evacuation cohort is multiplied by the total population for that grid element.  
Recall the total population for each of the sectors can be viewed on the EARLY/Model 
Basis/Population from Site File form. 
 
The population values per cohort can be viewed on the EARLY/Emergency Cohort 
One/Population, EARLY/Additional Emergency Cohorts/Emergency Cohort Two 
(etc)/Population, … forms. Fractional populations are supported. 
 

 Editing the Speed Multiplier List 4.4.7.5
 
The same basic form used to assign speed multipliers to grid elements is also used to specify 
evacuation directions and population assignments as shown in Figure 4-66. The Modify 
Multipliers button is not available on the Network Evacuation Direction forms but is available on 
the Radial Evacuation Speed and Network Evacuation Speed forms. 
 
A speed multiplier for each grid element is used to adjust the speed multipliers assigned for 
each evacuation phase in variable ESPEED found on the Evacuee Travel Speed form for each 
emergency cohort.  A value of one for the multiplier indicates that the speed in that grid element 
is the same as ESPEED. 
 
The default value for the speed rank and the speed multiplier is one.  Additional speed 
multipliers can be added by clicking the Modify Multipliers button in the Radial Evacuation 
Speed or the Network Evacuation Speed form as shown in Figure 4-71.   
 

 
 

Figure 4-71  Modify multipliers 
 
A dialog box similar to the one in Figure 4-72 opens. 
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Figure 4-72  Edit speed multipliers 
 
Speed multipliers can be added to the list by entering a number in the text box followed by 
pressing Enter on the keyboard or clicking the arrow button on the form.   
 
Multipliers can be deleted by selecting a multiplier from the Speed Multiplier list and clicking the 
delete button as shown in Figure 4-73. 
 

 
 

Figure 4-73  Delete speed multiplier button 
 
Multipliers are automatically sorted in ascending order.  Multiple entries of the same number are 
not allowed. 
 
Clicking OK preserves changes.  Clicking Cancel discards changes. 
 
Ranks shown on the spatial grid may be modified by WinMACCS when the multipliers are 
modified. For example the default speed multiplier value is a single rank of one corresponded to 
a speed multiplier set to one.  In this example, a multiplier of 0.5 is added using the Edit Speed 
Multipliers dialog box resulting in two multipliers, namely 0.5 and 1.0 with respective ranks one 
and two. After this dialog box is closed, the rank of one now corresponds to a speed multiplier of 
0.5. The polar grid is updated to show the rank of two to correspond to a speed multiplier of one 
as shown in Figure 4-74. 
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Figure 4-74  Speed multiplier ranks 
  
Uncertain speed multipliers are not supported in WinMACCS. 
 
 

 

Figure 4-75  Selecting a speed multiplier 

 

 Specifying a Site File 4.4.8
 
Files are generally specified in a general parameter modification form.  However, the site file is 
specified in a custom form. 
  
The site file is usually created using an external software source, such as SecPop.  When 
SecPop 4.0 or later is used, it is possible to choose 16, 32, 48 or 64 compass directions (or 
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sectors).  Older versions of SecPop such as SECPOP2000 support only 16 compass directions. 
For compatibility with MACCS models that require more compass directions, WinMACCS can 
create a site file that supports 32, 48 or 64 sectors from a site file that supports 16 sectors.   
 
Double clicking on the GENERAL/File Specifications/Site File will open a form similar to the 
form shown in Figure 4-76. 
 
A label titled Angular Directions shows the actual number of angular directions written to the site 
file shown in the text box labeled Site File. 
 
Click Browse to choose a site file.  After choosing a site file, the field Angular Directions is 
updated to reflect the number of sectors defined on the file.   
 
NUMCOR, the number of sectors in the spatial grid, is shown as a pull down menu.  It can’t be 
modified in this form but can be modified in the ATMOS/Spatial Grid form.  
 

 
 

Figure 4-76  Specify site population file 
 
Click Create New to create a new site file with more angular resolution.  A dialog as shown in 
Figure 4-77 opens. 
 

 
 

Figure 4-77  Create site file from existing site file 
 
A new site file with more angular directions can be created from an existing site file as follows: 
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1. Clicking Browse… as shown in Figure 4-77, the user can choose a site file that has a 
smaller angular resolution than the file needed.  

  
2. The angular resolution can be selected from the pull down menu labeled Possible 

angular resolutions available.   
 
3. Clicking OK preserves changes and causes a new site file to be created.  An external 

software program, PopMod, has been integrated into WinMACCS to create the new file.  
Clicking Cancel discards changes and the new file is not created.  

 
4. The new file created is assigned a file name that contains the number of new angles 

appended to the file name.  In our example, the source file is clinton_Site.inp.  The new 
file created with 48 sectors is clinton_Site_48.inp.  No new population data was added to 
the file.  The existing population data was spread out into the new sectors. 

 
5. Clicking OK preserves changes as shown in Figure 4-76.  Clicking Cancel closes this 

form and discards changes. 
 

 User Specified Dose Conversion Factors (DCF) in WinMACCS 4.4.9
 
Normally, a single DCF file is used to specify the dose coefficients.  These files have been 
created in the past using a process independent from WinMACCS, such as running the program 
DOSFAC2 to create this file, or using a dose conversion factor file supplied with the WinMACCS 
installation such as one based on FGR-13. 
 
Default values for the dose conversion factors are determined by a predefined DCF file chosen 
within the WinMACCS user interface.  After this file is specified, it is possible to replace DCF 
values by constants or probability distributions.  This capability has been integrated into 
WinMACCS. This allows these values to be correlated against any other variables that have 
been assigned uncertain values, including other dose uncertain dose conversion factors. 
 
The COMIDA2 food model is not currently integrated into the user specified dose conversion 
factor option. 
 

 Project Properties Settings 4.4.9.1
 
The Project Properties form can be opened by selecting Edit/Project Properties from the main 
menu. 
 
The user specified DCF model can be defined on the Properties form as follows: 
 
1. By selecting Early Consequences or Late Consequences on the Scope tab the user 

specified DCF model is available. 
 
2. Selecting Create DCF File on the Dose tab chooses this model, as shown in Figure 

4-78. 
 
3. When Late Consequences is selected on the Scope tab, the user must select the Food 

model on the Food tab as shown in Figure 4-79.  Either the No Food or the MACCS 
Food Model must be selected.  The COMIDA2 Food Model is available for selection, but 
will not properly function with the Create DCF File selection. 

 
4. Clicking OK preserves changes. 
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Figure 4-78  Project Properties Dose tab 
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Figure 4-79  Project Properties Food tab 
 

 Specify a Basis DCF File 4.4.9.2
 
WinMACCS requires a preexisting DCF file to use for default values.  This is specified on the 
same form used for specifying a predefined DCF file when not using the user specified option. 
 
The DCF file can be specified by opening the form named Dose Conversion Factor File found 
on the Parameters tab of the main Project window in the GENERAL/File Specifications category 
as shown in Figure 4-80.  Browse for the DCF file by clicking the Browse button. In the example 
shown, a DCF file that is distributed with WinMACCS based on Federal Guidance Report 13 
has been selected. 
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Figure 4-80  Identify location of the DCF file 
 

 ATMOS/Reveal Nuclides to modify DCF Values 4.4.9.3
 
The list of radionuclides to be considered in the MACCS simulation are specified on the 
Radionuclides form found on the Parameters tab in the ATMOS/Radionuclides category as 
shown in Figure 4-81.  Modifying the DCF values of any of these radionuclides impacts 
subsequent actions by MACCS. 
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Figure 4-81  Radionuclides Used by MACCS 
 

 Specify Dose Coefficients to Change 4.4.9.4
 
Dose coefficients can be modified by opening the form DOSE COEFFICIENTS/Reveal Nuclides 
as shown in Figure 4-82.  Notice that the DCF file previously specified, referred to as the base 
DCF file, is read and a list of nuclides is shown in the left hand portion of this form.  These are 
the radionuclides in the DCF file.  This DCF file name previously specified is saved in a variable 
named DCF_REVEALED.   
 
Indicate the nuclides of interest by selecting the nuclides and clicking the arrow pointing to the 
right to move the selected nuclides from the Hidden Nuclides list to the Revealed Nuclides list.  
Double clicking on the radionuclide moves it from one list to the other list.   
 
Nuclides can be moved back from the revealed list to the hidden list by selecting the nuclide on 
the revealed list and clicking the arrow pointing to the left. 
 
Only nuclides whose DCF values need to be modified should be put on the list Revealed 
Nuclides.  The original values in the DCF are used for the nuclides that are not revealed. 
 
Shift click and Control click can be used to select multiple nuclides. 
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Figure 4-82  Choosing nuclides from DCF file 
 
The check mark next to the nuclide name on the Revealed Nuclides list means that the forms 
for those nuclides will be populated with default values read from the basis DCF file. 
 
By revealing nuclides, MACCS creates forms to allow modification of the dose conversion 
factors for those nuclides. 
 
When these forms already exist, checking the nuclide name causes the current DCF values on 
these forms to be replaced with the default DCF values. When the user had replaced DCF 
values on some of these forms with their own distributions or with constant values, that 
information is overwritten with the default values. 
 
Clicking OK preserves changes. This can take a long time the first time a radionuclide is 
exposed.  Clicking Cancel discards changes. 
 

 Modifying the DCF Values 4.4.9.5
 
The first word in the base DCF file identifies the source of the data.  MACCS expects this first 
word to be one of the following:  
 

 FGR13DF 

 FGRDCF 

 DOSFAC2 
 
The type of the base DCF file determines the forms to be built exposing the DCF values.  This 
also determines the list of organs and pathways that are available.   
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In the following example the base file is of type FGR-13.  In this case and in the case of a 
DOSFAC2 file, two forms are created for each exposed radionuclide as shown in  
 
Figure 4-83. The Acute Inhalation pathway is relevant for a subset of organs, hence the related 
DCF values are placed on a separate form. 
  

 
 

Figure 4-83  Dose Coefficient forms for FGR-13 file 
 
In the example shown in Figure 4-84 the base file is of type DOSFAC2.  Notice that the organ 
list is different than the organ list shown for the FGR-13 base file. 
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Figure 4-84  Dose Coefficient forms for DOSFAC2 DCF file 
 
In the case of FGRDCF, there is one form per nuclide because acute health effects are not 
calculated when this DCF file is used as shown in Figure 4-85.  The acute inhalation pathway is 
not relevant in this case. 
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Figure 4-85  Dose Coefficient form for FGR 11-12 DCF file 
 
DCF values can be modified by clicking on the grid cell and typing the new value.  It is also 
possible to set any values to be uncertain by double clicking on the cell or by clicking in the cell 
and clicking the Make Uncertain button on the form.  Clicking OK preserves changes.  Clicking 
Cancel discards changes. 
 

 Running a Simulation 4.4.9.6
 
Select Execute/Run Models from the main menu to open the Run Models form.  Notice that the 
Create DCF File check box is checked. 
 
When a simulation is run in this mode, a DCF file is created for each LHS realization.  The 
values are generated by LHS in the same LHS instance that generates all MACCS uncertain 
values.   
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Figure 4-86  Files tab when creating DCF files 
 
The Files tab in the WinMACCS Project window shown in Figure 4-86 shows a new entry in the 
Data category called DCF_REVEALED.  This is the file that is used to define the DOSE 
COEFFICIENTS forms, the default values on those forms and the list of unexposed 
radionuclides.  In this example, a file created by Fgr-13 was used, Fgr13dcf.inp. 
 
The Input category lists files that are created by WinMACCS when running model simulations.  
The following files were created in an example with two simulations:  

 Template file dcfTemplate.txt containing deterministic DCF values and place holders for 
LHS realizations were first created. 

 Files DCF_userTemp1.inp and DCF_userTemp2.inp were created per realization. 
Uncertain values generated by LHS were inserted into these files.  These files are in a 
MACCS standard input format, not in a DCF format. 

 Files DCF_user1.inp and DCF_user2.inp are files in a standard DCF format.  These files 
are used by MACCS, and contain the user specified dose conversion factors.  There is 
one file per realization. These files were created from the files DCF_userTemp1.inp and 
DCF_userTemp2.inp. 

 
 Food Model available in WinMACCS with User Specified DCF 4.4.9.7

 
When the CHRONC module of WinMACCS is selected, there is an option allowing the use of a 
COMIDA2 food-chain file.  It is required that the dose conversion file used in the EARLY module 
of MACCS be identical to the dose conversion file used to create the COMIDA2 food chain file. 
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The capabilities that create DCF files have not been integrated into the COMIDA2 food model. 
Either the food-chain model must be off or the older MACCS food-chain model used.  
 
It is possible to create the dose conversion factor files and manually run each one through 
COMIDA2 by selecting the Predefined DCF File Option.  
 

 User Specified DCF file when using Annual DCF Files 4.4.9.8
 
When specifying the annual threshold or piecewise-linear dose model options, it is necessary to 
have the Late Consequences module on.  Additionally, it is required that the No Food Model is 
also selected. Though the interface indicates that it is possible to use the COMIDA2 Food 
Model, this option is not functional. 
 
It is also necessary, as in all threshold type calculations, to specify the basis annual threshold 
files as shown in Figure 4-46.  These files are used to create the annual user specified threshold 
files. 
 
In the following example, in the input folder, there are additional files created by WinMACCS. 
 
When there are two realizations, there are two files created, DCF_TH_MULT1.inp and 
DCF_TH_MULT2.inp.  These files are in a MACCS reconized DCF format.  These files do not 
contain DCF values, but contain multipliers used to transform a predefined DCF file into a user 
based DCF file.  These multipliers are applied to each of the predefined DCF threshold files to 
derive the user defined DCF threshold files.  Values that are -1 indicate that the data are not 
used.   
 
For example, the following is an excerpt from one of the multiplier files.  For all DCF values used 
(values not equal to -1) the multiplier used is one.  This means that the data will pass through 
with no changes.  Columns correspond to pathways.  Some values are set to –1 because 
MACCS does not consider these pathways. 
 
Am-241 

BONE SUR           1        -1        -1         1        -1         1         1 

BREAST             1        -1        -1         1        -1         1         1 

STOMACH            1        -1        -1         1         1         1         1 

BLAD WAL           1        -1        -1         1        -1         1         1 

LOWER LI           1        -1        -1         1         1         1         1 

LIVER              1        -1        -1         1        -1         1         1 

RED MARR           1        -1        -1         1         1         1         1 

THYROID            1        -1        -1         1         1         1         1 

LUNGS              1        -1        -1         1         1         1         1 

ICRP60ED           1        -1        -1         1        -1         1         1 

 
There is a multiplier file for every LHS realization.   
 
In the following example, fgr13dcf.inp and its associated annual threshold files, fgr13dcfYY.inp, 
are shown, where YY is the year number (01, 02…50).  Realization number 5 is shown in the 
following illustration.  

 DCF_user5.inp is the DCF file associated with realization number five.  LHS results for 
realization five have been inserted into this file.  

 DCF_TH_MULT5.inp contains the multipliers calculated by calculating the ratio of the 
user defined value in the file DCF_user5.inp to the original value in FGR13dcf.inp.  After 
this step has been completed, the 50 files used by the threshold model can be 
calculated by using this multiplier as a scale factor. 
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 DCF_user5_01.inp through DCF_user5_50.inp are the threshold files used for 
realization 5, derived by multiplying the DCF values in the predefined threshold DCF file, 
fgr13dcfYY.inp where YY is the year (01 through 50), with the multipliers for realization 5 
in DCF_TH_MULT5.inp. 

 
For example, to derive the file for realization number 5 for year 9, the multiplier file, 
DCF_TH_MULT5.inp is used with the data in the file Fgr13dcf09.inp to create a user defined 
input file DCF_user5_09.inp. 
 

 Multi Source Term 4.4.10
 
A group of MelMACCS files, possibly created from a combination of different MELCOR plot files 
and single files with multiple rings, can be run the Multi Source Term option. This is done by 
opening a project in WinMACCS and merging the source term files using the following steps: 
 

1. The multi source term option is activated by clicking on the box labeled Multi Source 

Term on the Plume/Source tab, as shown in Figure 4-87. This setting needs to be saved 

by clicking OK in the Project Properties form. 

2. Source term files are selected from the GENERAL/File Specifications/Multi Source Term 

File Set form.  From this form, the user can navigate to the folder containing the multi 

source term files created by MelMaccs.  Files can be selected by double clicking on the 

file names or by selecting or shift selecting, right clicking, and selecting Add Files from 

the pop-up menu.  The order that the files are processed can by changed by selecting the 

file in the left most window pane, and clicking the up or down arrow below that pane to 

change the order, as shown in Figure 4-88. The order of the files affects some of the 

subsequent steps.  

 
 

Figure 4-87  Selecting Multi Source Term option 
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Figure 4-88  Specifying Multi Source Term input files 
 

3. Forms under the category, Multi Source Term, are required.  Two of the forms are the 

same or similar to the ones required for a single-unit source term, the Chemical Names 

and Radionuclides forms. The Time Offsets form allows the user to specify time offsets 

for each source term file, as illustrated in Figure 4-89.  The Plume Segments form shows 

the plume segments arranged chronologically and identifies which multi source term file 

each plume segment is from.  The plume delay values on this form account for the time 

offset values specified on the Time Offsets form. In the example shown, there are fifteen 

plume segments defined, ten from the file Ring1.inp and five from the file Ring2.inp.  The 

files used by WinMACCS are copies of the original and are located in the Input folder of 

the project. 
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Figure 4-89  Forms for specifying a multi-unit source term  
 

4. A special form named Spatial Intervals for Output can be found under the ATMOS/Output 

Control category.  This form has the same name as another form, as shown in Figure 

4-90.  However, the upper bound for the variable INDREL, indicating the plume segment 

number, is the number of plumes segments in all of the multi source term files.  The row 

number on the Plume Segments form shown in Figure 4-89 identifies value of INDREL 

for a specific plume segment.  
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Figure 4-90  Specifying ATMOS output with the multi-unit source term model 
 

5. Running a multi-unit source term calculation is performed from the Run Models form by 

selecting Execute/Run Models from the main menu, as shown in Figure 4-91. Notice that 

Create Multi Source Term File is checked.  This means that Combine Source is to be run 

to recreate a file called CombineSource.out.  This file is used by MACCS, and the file 

name is specified on an input card in the ATMOS input file.  

6.  

 
 

Figure 4-91  Running multi source term calculation with MACCS 
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4.5 Running Simulations 
 
Model execution can be initiated by opening the Run Models form by selecting Execute→Run 
Models… from the main menu and clicking on Run Simulation. 
 
This section describes the options available when running simulations. 
 

 Run Models Form 4.5.1
 
The following are the main components of the Run Models form as shown in Figure 4-92.  The 
model settings are modified from the Project Properties form.  The MACCS modules to be used, 
namely Atmospheric Dispersion, Early Consequences, and Late Consequences, are selected 
from the Scope tab of the Project Properties form. The MACCS Cyclical File Set is also selected 
from the Scope tab. The Create COMIDA2 File setting can be modified from the Food tab, 
Create DCF File from the Dose tab, Create Site File from the Site/Data tab, and the Create Multi 
Source Term File from the Plume/Source tab.  
 
None of these settings can be modified directly from the Run Models form. 
 

  

 
Figure 4-92  Run a simulation 

 
The Number of Simulations is the number of cyclical and/or LHS samples to be run. However, 
MACCS attempts to prevent redundant simulations. For example, when no cyclical files or 
uncertain parameters are specified within MACCS, only a single simulation is performed. 
Likewise, when a set of cyclical files are specified but there are no uncertain parameters, 
MACCS performs the same number of simulations as cyclical files. 
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The Number of Simulations can be changed by selecting Advanced to open the Advanced 
Execution Parameters form. The seed used by the LHS random number generator can also be 
modified on this form. 
 
Clicking Run Simulation initiates simulations. Progress is reported in the Results window. 
 
The current simulation number (e.g., the MACCS run number) is displayed in the status bar 
found at the bottom of the Run Models form.   
 
Selecting Abort Simulation aborts a MACCS run in progress. 
 

 Advanced Execution Parameters Form 4.5.2
 
Opening the Run Models window by selecting Execute→Run Models from the main menu 
allows the user to set advanced execution options. Clicking the button Advanced opens the 
Advanced Execution Parameters dialog as shown in Figure 4-93. 
 

 
 

Figure 4-93  Advanced execution parameters form 
 
The Number of Simulations text box is the number of times MACCS runs.   
 
When there are uncertain parameters, set number of simulations to the number of LHS 
simulations that are to be used in the analysis. Changing this number changes the sampled 
values of the uncertain parameters used in the simulations. 
 
When MACCS cyclical files are used with or without LHS, enter the number of times you want 
MACCS to run. When LHS is not used, the Number of Simulations should be the same as the 
number of cyclical files; when LHS is used, the Number of Simulations must be an integer 
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multiple of the number of cyclical files. When the value entered by the user is not a multiple of 
the number of cyclical files, WinMACCS resets this value to be the next larger integer that is a 
multiple of the number of cyclical files. Statistical results for the aggregated output assume that 
the conditions represented by the cyclical files are equally likely.  
 
The value in the Seed for Random Generation text box is the random number seed used by 
LHS to create distribution samples of the variables the user has chosen to be represented by 
probability distributions. Changing this number changes the sampled values of the uncertain 
parameters used in the simulations. Powers of two should be avoided. The value of the seed 
must be between 1 and 2,147,483,647. 
 
The section labeled Disposition of MACCS Input and Output Files gives the user the option of 
deleting various files that do not need to be referenced.  These are useful options when there 
are many simulations.  The files deleted are removed after MACCS has executed a single 
sample with the exception of the MACCS binary results files.  The template files are always 
retained in the project Input folder. 
  
When the Delete Atmos, Early, Chronc and COMIDA2 Input Files check box is checked, the 
MACCS input files are deleted after they have been used in a simulation.  The template files 
(e.g., AtmosTemplate.txt) are not deleted.  These files are located in the project /Input folder. 
 
When the Delete MACCS and COMIDA2 Text Output Files check box is checked, the MACCS 
text output files and the COMIDA2 text output files are deleted after the simulations have all 
completed. These files are located in the project /Output folder. 
 
When the Delete MACCS and COMIDA2 Binary Result Files check box is checked, the MACCS 
binary files are deleted after the reports are created.  When no reports are requested and the 
Execute→Auto Create Summary Report checked command is off the MACCS binary results 
files are removed after each MACCS run and data is not available for post processing.  In each 
other case, the binary data is imported into the project database and is available for post 
processing.  Data for plots and additional reports are available through the database, even after 
the binary files are removed. 
 
Clicking OK preserves changes.  Clicking Cancel discards changes.  
 

 Template files 4.5.3
 
Template files are created by MACCS to facilitate the task of creating input files. These are 
named atmosTemplate.txt, earlyTemplate.txt, chroncTemplate.txt and comidaTemplate.txt. The 
positions where the values of uncertain variables are inserted are tagged within these files. The 
tags can be used to identify the uncertain variables. For example, notice the special characters 
around the number 309 in the following input line taken from a sample atmosTemplate.txt file. 
 
WDCWASH1001 §309§  

 
This line indicates that CWASH1 is uncertain. A sampled value from LHS is inserted into the 
space §309§ when the input file is created from the template file. The number 309 is an internal 
key used by MACCS to identify which variable to insert. 
 
The Atmos1.inp, Early1.inp, Chronc1.inp and the three COMIDA2 input files are recreated from 
the template files when the user selects Run Simulation.   
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When the user desires to manually modify one or more input parameters within the MACCS 
template files, the user must first uncheck the main menu option Execute→Refresh Template 
Input Files before Running. Otherwise, the modified file is overwritten before MACCS executes 
and the modification is lost. 
 

4.6 Model Results 
 
Results are output from MACCS in text format, e.g. Model1.out, and in binary format, e.g., 
Model1.bin.   
 
The binary results are available from WinMACCS as custom reports, custom plots or a text view 
of the binary file. 
 

 Text Results from MACCS 4.6.1
 
Text results from MACCS can be viewed in a text editor such as Notepad.  These files can be 
opened directly by double clicking on the file name (e.g. Model1.out) found in the Project/Files 
tab. 
 
Most MACCS results from a single simulation are probability distributions representing uncertain 
weather.  For example, in Figure 4-94, the MACCS results for Center Air Concentration for Cs-
137 for plume number one at 4.8 to 5.6 km is a probability distribution. MACCS reports statistics 
such as Prob Non-Zero, Mean, etc., calculated from this distribution. These statistics are listed 
as column headings in Figure 4-94. 
 
 

 
 

Figure 4-94  MACCS statistical summary results 
 
The Statistical Summary Results form described in section 4.6.3.3 allows the user to display a 
graphical view of the CCDF for each of the entries in Figure 4-94(e.g., the mean value of Center 
Air Concentration for Cs-137 for plume number one at 4.8 to 5.6 km) over all realizations. In 
other words, a plot created with this option displays a probability distribution (CCDF) of one of 
the statistics above calculated over the set of LHS samples.  
 
A binned CCDF of output requests is created by MACCS when the Report Option is set to 
CCDF or CCDF & REPORT on the forms in the ATMOS/Output Control, EARLY/Output Control 
and CHRONC/Output Control categories. 
 
Parameters set under the EARLY and CHRONC Output Control categories of the interface 
determine the consequences calculated by MACCS.  MACCS can calculate a variety of different 
consequence measures to portray the impact of a facility accident on the surrounding region.  
The user has control over the results that are produced.  By choosing appropriate values in 
Output Control, the user can ensure that the code produces only desired results.  This affords a 
great deal of flexibility but it also requires that the user anticipate the results that are needed.  
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When any are omitted, the user needs to correct the parameter choices and rerun the 
calculation. 
 
In this regard, a result can only be produced when the model needed for its calculation has 
been previously defined in the appropriate section.  When any results pertaining to health 
effects are requested, risk factors for that model must have been supplied on forms Early 
Fatality Parameters, Early Injury Parameters, and Latent Cancer Parameters. 
 
EARLY can produce many different types of results.  Some of these types of results are also 
calculated by CHRONC, but some are not.  For instance, both EARLY and CHRONC calculate 
cancer cases and population dose, but only EARLY calculates early fatalities, and only 
CHRONC calculates economic costs. When the user requests EARLY to produce a result that is 
also produced by CHRONC, the code automatically calculates results for both EARLY and 
CHRONC.  
 
Summary statistics with respect to each requested result are reported independently of the 
value of the WinMACCS variable, Report Options.  There are ten columns of numeric data 
which provide a statistical summary, as follows: 
 

 PROB NON-ZERO is the conditional probability of having a nonzero consequence 
estimate, conditional on the occurrence of the release under consideration. 

 MEAN is the average (expected) consequence over all weather trials.  This is calculated 

by taking the sum of all the products [(consequence value)  (conditional probability of 
that value)] for each weather trial. The probability of the weather trials are not 
necessarily the same, so the conditional probabilities can be different for each weather 
trial.  

 50TH QUANTILE is the median of the estimated complimentary cumulative distribution 
function (CCDF). 

 90TH QUANTILE is based on the estimated CCDF. It is the value for which there is a 
10% chance this consequence magnitude is exceeded. 

 95TH QUANTILE is based on the estimated CCDF. It is the value for which there is a 
5% chance this consequence magnitude is exceeded. 

 99TH QUANTILE is based on the estimated CCDF. It is the value for which there is a 
1% chance this consequence magnitude is exceeded. 

 99.5TH QUANTILE is based on the estimated CCDF. It is the value for which there is a 
0.5% chance this consequence magnitude is exceeded. 

 PEAK CONS is the largest consequence magnitude obtained from the set of weather 
trials that were examined. 

 PEAK PROB is the conditional probability associated with the largest consequence 
magnitude. 

 PEAK TRIAL refers to the weather trial for which the largest consequence occurred.  By 
referring to the ATMOS portion of the output file, the user can determine the start time 
(day and time period) of this weather sequence. 

 
A CCDF is an estimate of the distribution of consequence magnitudes.  The variability of 
consequence values in a single MACCS simulation is due solely to the uncertainty of the 
weather conditions existing at the time of the accident.  A MACCS output file is created for each 
simulation when any input variables are chosen to be uncertain.  In this case, the user chooses 
the number of realizations to capture the uncertainty in the input variables. MACCS produces 
one CCDF per realization. WinMACCS can quantify the overall uncertainty in results by 
assembling the set of CCDFs into a single CCDF that accounts for both weather and input 
uncertainty.  
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CCDFs can be viewed as spider plots (one CCDF curve per simulation) from within the 
WinMACCS interface using Post Processing/Graphical Results/Results over all Weather Trials 
under the main menu selection.  Additionally, statistical results (such as the mean result over all 
weather trials) can be viewed using Post Processing/Report Results/Create Summary Report 
under the main menu. 
 
Report Options appears on most of the output request forms.  When set to CCDF or CCDF & 
REPORT, CCDF data are reported in the MACCS output file. When set to REPORT or CCDF & 
REPORT, WinMACCS automatically generates a report over all realizations based on quantiles 
specified on the Reporting Options form. 
 
When the user did not select Report Options to be CCDF or CCDF & REPORT when requesting 
the calculation in the WinMACCS input forms, it is still possible to retrieve those data from 
WinMACCS.  Though the CCDF data are not written to the output file, when the user requests a 
report based on the desired data using the custom report form, Post Processing/Create Custom 
Report, CCDF data are read into WinMACCS from the binary output file and are available in the 
Post Processing/Graphical Results forms. The user should be aware that the method used to 
estimate quantile levels in WinMACCS differs from the one used in MACCS, so quantile values 
for a single realization produced by WinMACCS will differ slightly from those produced by 
MACCS. 
 
When a consequence measure was calculated by both EARLY and CHRONC, the output lists 
results separately for EARLY and CHRONC.  The weighted sum or average of all consequence 
results is presented at the beginning of the output file in a section labeled OVERALL 
RESULTS...  Following the overall results, those from each of the cohorts are presented. The 
total number of cohorts listed is one greater than the number of emergency response cohorts 
created in EARLY. The final cohort in the output represents CHRONC.  
 

 Custom Reporting Options 4.6.2
 
Reports created from the MACCS binary result files are created using different methods as 
follows: 

 Report requests that combine the results over the MACCS simulations can be requested 
on the forms in the ATMOS/Output Control, EARLY/Output Control and 
CHRONC/Output Control categories.  These requests result in a report referred to as a 
Summary Report.   

 Reports that combine the results over the MACCS simulations can also be created using 
the custom report features. Data is available from every calculation request made from  
ATMOS/Output Control, EARLY/Output Control and CHRONC/Output Control 
categories, even when report requests were not made on those forms. These can be 
created using the Combine Realizations option on the Manage Reports form as 
described in section 4.6.2.3. 

 Reports that display results without combining data over the MACCS simulations are 
created using the Realization Based option on the Manage Reports form as described in 
section 4.6.2.54.6.2.3. 

 
Reports are created automatically after the simulations are completed provided the main menu 
item Execute→Auto Create Reports is checked.  The reports created include the Summary 
Report and all of the custom reports defined. These reports are placed in the project \Output 
folder, and are also available within WinMACCS on the Project/Files tab. 
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When the menu item Execute→Auto Create Reports was not checked before the simulations 
began, the reports can still be requested from the Manage Reports form described in section 
4.6.2.3 and section 4.6.2.5.  The summary report can be created by selecting 
PostProcessing→Report Results→Create Summary Report. These post processing features 
only function when the MACCS binary files have not been deleted. 
 
Custom reports are defined using the menu item PostProcessing→Report Results→Manage 
Custom Reports.  New custom reports must be defined after the MACCS simulations have 
completed because the list of variables to place on the reports is not be available before the run 
has been finished. After the custom reports have been set up, it is possible to recreate them for 
each subsequent run.   
 
When the output requests to MACCS (see the forms in Output Control) are modified to exclude 
some output requests that were used to define the custom reports, those custom reports are not 
created. The user should be careful not to confuse reports from previous runs with current runs 
since old created reports are not deleted unless the new file has the same name as the existing 
file.  
 
It is possible to import custom report definitions from other projects using the menu item 
File→Import Custom Report Definitions as description in section 4.2.1. 
 

 Combining Results over Realizations 4.6.2.1
 
The first step in defining the reports that combine data over realizations is to define the 
probabilities, or quantiles, to use.  When the probabilities are not defined, only the grand mean 
(e.g., the mean over all realizations) is reported. These reports that combine realizations contain 
the grand mean and the interpolated values based on the binned CCDF results for a user 
entered quantile. 
 
Opening the form GENERAL/Output Options/Reporting Options allows quantiles to be entered.  
This is shown in Figure 4-95.  When the MACCS simulations have already completed, a 
Summary Report cannot be created, but custom reports can be requested that combine the 
realizations. 
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Figure 4-95  Specifying quantiles 
 

 Creating a Summary Report 4.6.2.2
 
A summary report based on MACCS output variables is created after MACCS simulations have 
completed.  To include a variable in the summary report, the Report Options flag should be set 
to REPORT or to CCDF & REPORT as shown in Figure 4-96. 
 
The summary report is created after MACCS simulations have completed provided the 
Execute→Auto Create Summary Report menu item is checked.  This report can also be created 
by selecting PostProcessing→Report Results→Create Summary Report. 
 
The categories ATMOS/Output Control, EARLY/Output Control and CHRONC/Output Control 
contain calculation requests.  Most of the forms in these categories contain the Report Options 
flag. 
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Figure 4-96  Summary report request 
 
Summary reports can be requested as follows: 
 
1. Quantiles are defined as shown in Figure 4-95. 
 
2. The outputs of interest are selected by first opening an output request form.  This is a 

form that is in one of the Output Control categories.  
 
3. In the Report Options column, by choosing either REPORT or CCDF & REPORT causes 

WinMACCS to include this variable in the report after all MACCS simulations are 
completed.  When the CCDF & REPORT is chosen, the additional binned data for each 
cohort is printed in each of the MACCS output files associated with the simulation. 

 
4. This process can be repeated for all variables to be included in the summary report. 

Clicking OK preserves the summary report requests. 
 
5. After running the MACCS simulations, the binary result files, Model1.bin, Model2.bin, …, 

are imported into the database.  The report, summary.txt, is automatically created based 
on the user input, and placed in the project output folder.  Double clicking on 
Output/Summary.txt found on the Files tab of the Project window will open the report. 

 
 Creating a Report that Combines Realizations 4.6.2.3

 
This section describes how to create new combine realization reports after MACCS simulations 
have completed.   
 
After MACCS has run, the PostProcessing menu is available.  The custom report generator can 
be opened by selecting PostProcessing→Report Results→Manage Custom Reports as shown 
in Figure 4-97 . 
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Figure 4-97  Opening the Manage Reports form 
 
This form lists the custom reports currently defined as shown in the example shown in  
 
Figure 4-98.  In this example there are two reports defined.  The column labeledType identify 
the report format as Combined. This means that these are reports based on combining 
realizations. All reports listed in the Manage Reports form are automatically created after the 
MACCS simulations have completed provided the menu item Execute→Auto Create Reports is 
checked. 
 

 
 

Figure 4-98  Reports based on combining realizations 
 
The Custom Combined Report form as shown in Figure 4-99 lists each of the MACCS output 
requests.  This form is opened when a new Combine Realizations report is created, or when an 
existed Combine Realizations report is edited.   
 
The column labeled Report Description identifies the form description as found in the 
Project/Parameters tab. For example, in Figure 4-99 the entries defining the report Population 
Dose were requested from the WinMACCS form EARLY/Output Control/Population Dose.  The 
column labeled MACCS Input Card is a copy of the line written to the MACCS input file 
EARLY1.inp.  
 
The Combine Realizations report contains results similar to the Summary.txt report.   
WinMACCS combines the CCDF data over all of the MACCS binary result files and displays the 
grand mean and the interpolated quantile values.   
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Figure 4-99  Defining a Combine Realizations report 
 
New combine realization reports can be defined as follows: 
 
1. Quantiles are defined as shown in Figure 4-95. 
 
2. The Manage Reports form is opened by selecting PostProcessing→Report 

Results→Manage Custom Reports as shown in Figure 4-99. 
 
3. A new definition can be defined by first selecting the radio button Combine Realizations 

and clicking on the button New. 
 
4. The user can enter report name in the field labeled Report Name. 
 
5. The MACCS output requests are selected by clicking check boxes in the Include column.   
 
6. Clicking OK to saves the new report definition. 
 
If the report has already been defined, the report can be opened by checking the box in the 
column labeled Select. Selecting the radio button labeled View in the group Selected Reports  
and clicking the Apply button will create and open the report. 
 
A defined report can be edited by checking the box in the column labeled Select and clicking the 
Edit button. 
 
A defined report can be deleted by checking the box in the column labeled Select, selecting the 
radio button labeled Delete in the group Selected Reports and clicking the Apply button.   
 

 Interpretation of Combining Realization Reports 4.6.2.4
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The report format used for summary reports is the same format that is used when creating a 
custom report when the combine realization is option is used as shown in Figure 4-99. 
 
These reports consist of the grand mean and an estimate for the probability of exceedance for 
the probabilities requested on the General/Reporting Options form based on the binned 
cumulative probability distributions calculated by MACCS.   
 
If all of the CCDF values are identical, there is no variance in the parameter values.  In this case 
it is not possible to calculate a meaningful value for the probability of exceedance and the report 
contains the text “Unable to transform CCDF No differences in probability values in CCDF”. 
 
In the following example, the report request was made on the form Early/Output Control/Health-
Effect Cases.  The statistics from each of the LHS trials are combined.  
 
 
************************************************************************ 
Request 1  Health-Effect Cases 
MACCS Image:TYPE1OUT009 'CAN FAT/TOTAL' 1 26 REPORT 
************************************************************************ 
 
Evacuation CHRONC CAN FAT/TOTAL [0.,1609.34](km)  
                                          Probability of Exceedance 
                                           Grand Mean     0.5                  0.9                  0.95            
Health-Effect Cases (none)  2.732E+03      9.231E+02      1.006E+02      5.008E+01       
 
Evacuation Evac #  1 CAN FAT/TOTAL [0.,1609.34](km)  
                                          Probability of Exceedance 
                                           Grand Mean     0.5                  0.9                  0.95            
Health-Effect Cases (none)  4.094E+02      1.017E+02      5.141E+00      1.856E+00       
 
Evacuation Evac #  2 CAN FAT/TOTAL [0.,1609.34](km)  
                                          Probability of Exceedance 
                                           Grand Mean     0.5                  0.9                  0.95            
Health-Effect Cases (none)  3.637E+00      1.83E+00       3.321E-01      2.049E-01       
 
Evacuation Overall CAN FAT/TOTAL [0.,1609.34](km)  
                                          Probability of Exceedance 
                                           Grand Mean     0.5                  0.9                  0.95            
Health-Effect Cases (none)  3.145E+03      1.273E+03      1.35E+02       7.178E+01       
 
The first entry, CHRONC, reports the cancer fatalities due late consequences.  The next two 
entries, Evac # 1 and Evac # 2 report the cancer fatalities due to early consequences for cohort 
1 and cohort 2 respectively.  The early and late consequences are combined in the entry 
labeled Evacuation Overall.  
 
Interpreting the results for the overall health effects, we are 90 percent certain that the number 
of total fatalities exceeds 135.  The mean number of fatalities over all LHS realizations is 3145.  
This is precisely the sum of the mean cancer fatalities due to the late and early consequences. 
 
Cohort results are combined using the weighting factors stored in variable WTFRAC when the 
overall results are calculated for some of the variables that are independent of the population 
such as Average Individual Risk, Peak Dose and Population Weighted Risk calculations.   
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 Creating a Report Based on Individual Realizations 4.6.2.5
 
This section describes how to create reports that show results for individual realizations after 
MACCS simulations have completed. 
 
After MACCS has run, the PostProcessing menu is available.  The custom report generator is 
opened by selecting PostProcessing→Report Results→Manage Custom Reports. 
 
This form lists the custom reports currently defined.  In the example shown in Figure 4-100 the 
column labeled Type indicates the report format.  For reports based on individual realizations, 
the Type is either byVariable or byTrial depending on whether the By Variable or the By 
Realization radio button was selected on the Custom Realization Based Report form as shown 
in Figure 4-101.  See section 4.6.2.3 for creating reports where the Type is Combined. 
 
All reports listed are automatically created after the MACCS simulations have completed 
provided the menu item Execute→Auto Create Reports is checked. 
 

 
 

Figure 4-100  Reports based on each realization 
 
The Custom Realization Based Report form as shown in Figure 4-101 is organized as a list of 
available results read from the MACCS binary results file.  Each available variable for reporting 
is listed.  A list is opened by clicking the plus sign where more specific results can be selected.  
In the example, there are two results available for Total Centerline Ground Concentration.  
Items in the list, called qualifiers, can be individually selected or selected as a group by clicking 
on the box preceding the variable name. 
 
This form is opened when a new Realization Based report is created, or when an existed 
Realization Based report is edited. 
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Figure 4-101  Defining a Realization Based report 
 
New realization based reports can be defined as follows: 
 
1. The Manage Reports form can be opened by selecting PostProcessing→Report 

Results→Manage Custom Reports from the main menu.  
 
2. Selecting the radio button Realization Based and clicking the button New opens the 

Custom Realization Based Report form as shown in Figure 4-101. 
 
3. A report name must be entered in the field labeled Report Name. 
 
4. Variables can be selected by clicking on the empty boxes in front of the variable names.  

Individual items can be selected from the qualifier lists by clicking the + in front of the 
variable name and clicking the empty boxes in front of the qualifiers. 

 
5. Selecting either the radio button By Variable or By Realization will complete the report 

definition.  When By Variable is selected the results for each variable are listed for a 
given trial when the report is created.  When By Realization is selected the results for 
each trial are listed for a given variable as shown in Figure 4-97. 

 
6. Clicking OK saves the report definition. 

 
When the report has already been defined the report can be opened by checking the box in the 
column labeled Select.  Select the radio button labeled View in the group Selected Reports.  
Click the Apply button.  The report is created and opened. 
 
A defined report can be edited by checking the box in the column labeled Select and clicking the 
Edit button. 
 
A defined report can be deleted by checking the box in the column labeled Select, selecting the 
radio button labeled Delete in the group Selected Reports and clicking the Apply button.   
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Figure 4-102  Report of type By Realization opened in Excel  
 

 Custom Plotting Options 4.6.3
 
Graphical output can be displayed after completing a MACCS run by selecting an entry from the 
main menu Post Processing→Graphical Results. The following results are available: 

 Scalar results are displayed by selecting PostProcessing→Graphical Results→Scalar 
Results from the main menu. 

 Statistical summary results are displayed by selecting PostProcessing→Graphical 
Results→Statistical Summary Results from the main menu. 

 Probability distribution results representing weather uncertainty are displayed by 
selecting Post Processing→Graphical Results→Results over all Weather Trials from the 
main menu. 

 
When a plot request is made after a simulation (e.g., one of the menu entries such as 
PostProcessing→Graphics→ Results over all Weather Trials) is selected, the MACCS binary 
result files (e.g., Model1.bin and Model2.bin) are imported into the project database when they 
were not already imported to support automatic or custom reports. This progress can be 
observed in the Results window as shown in Figure 4-103. 
 

 
 

Figure 4-103  Results window after processing binary files 
 
After the binary result files have been processed into the project database, the result information 
is available for quick access without repeating the import process. 
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 Scalar Results 4.6.3.1
 
Graphical results are displayed after completing a MACCS run by selecting an entry from the 
main menu item PostProcessing→Graphical Results→Scalar Results as shown in Figure 4-104.  
This graph was made by selecting the entry under release, Plume 1 Kr-85, clicking Add and 
clicking Select to show the data points.  In this example, the release duration was made 
uncertain. 
 

 
 

Figure 4-104  Scalar Results plot 
 

 Results Displayed as a Complementary Cumulative Distribution Function (CCDF) 4.6.3.2
 
Graphical results are displayed after completing a MACCS run by selecting an entry from the 
main menu PostProcessing→Graphical Results→Results over all Weather Trials from the main 
menu as shown in Figure 4-105.  This graph was made by selecting the entry under Ground 
Level Air Concentration, Plume 1 Cs-137(25.75, 32.19] km, and clicking Add. In this example, 
uniform bin sampling from the weather file was used. 
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Figure 4-105  Results over all Weather Trials plot 
 
Early and Chronc MACCS results from a single execution are often CCDF’s or statistics 
representing uncertainty of the weather during a hypothetical accident. This window displays the 
CCDF distributions for each MACCS calculation. For example, when five MACCS simulations 
were run using LHS, there would be five CCDF curves for each result.  

 
Even when not requested by the user, all CCDF results are written to the binary results files 
(e.g., Model1.bin). In the example shown in Figure 4-106, even though CCDF results for plume 
one (INDREL) at grid element ten (INDRAD) are not reported in the Model1.txt results files, they 
are saved in the binary-result files and are available in the plots and reports. 
 

 
 

Figure 4-106  Requesting CCDF results in WinMACCS 
 

 Statistical Summary Results 4.6.3.3
 
Graphical results can be displayed after completing a MACCS run by selecting an entry from the 
main menu PostProcessing→Graphical Results→Statistical Summary Results from the main 
menu as shown in Figure 4-110.  This graph was made by selecting the entry under Ground-
Level Air Concentration, Plume 1 Cs-137[4.83, 5.63] km, and clicking Add. The mean of the 
means (over all realizations) is shown on the plot as a vertical green line.  The plot is the 
distribution of the means. 
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 Navigation of the Plot window 4.6.3.4
 
Multiple plot windows can be opened after simulations have completed as shown in Figure 
4-107. 
   

 
 

Figure 4-107  Plot windows available 
 

 
The caption of each plot window contains the MACCS version used in the simulation.  The date 
and time correspond to a date/time stamp written on the first binary output files (e.g., 
model1.bin) as shown in Figure 4-108.   
 
 

 
 

Figure 4-108  Plot window caption 
 
 
A series can be added to a Statistical Summary Reports window by selecting the variable to plot 
from the Select Variable list as shown in Figure 4-109, selecting the desired statistic in the 
Statistic list and clicking Add to add it to the existing graph. 

 

 
 

Figure 4-109  Add a Series to a Statistical Summary Reports Window 
 
When the Mean is added, notice that the grand mean (average of all means over all 
simulations) is calculated and displayed on the graph as a vertical line. 
 
A series can be selected by doing any of the following operations: 

 Clicking the Select button. 

 Selecting Select Next Series from the PostProcessing→Graphical Results→Edit Plots  
menu. 

 Clicking on the series on the plot. 

 Pressing the Enter key on the keyboard. 
 
After a series is selected the following is true: 
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 The individual points are marked. 

 The details, including the qualifier, indicating the series selected are shown in blue at the 
bottom of the window. 

 The Select Variable list and the Statistic list are selected to entries consistent with the 
selected series.   

 The series is also selected in the legend.   

 When the bulls-eye button is pushed in, the data values of the selected series are shown 
on the plot. 

 
Series are selected in the order they were added. Only one series can be selected at a time. 
 
When the last series added is the selected series and the Select is clicked, no series is 
selected. This feature allows the user to cycle through all the series, unselect all plots, and start 
the selection again with successive mouse clicks on the Select button. 
 
In Figure 4-110, the Ground-Level Air Concentration for Plume 1, Cs-137 at a spatial distance of 
4.83 to 5.63 km for the mean statistic is choosen. Notice that this information is displayed in 
blue at the bottom of the window. Also notice that the Grand Mean is displayed on the plot as a 
vertical line.  
 

 
 

Figure 4-110  Statistical Summary Results plot 
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A series can be deleted by selecting the plot by clicking Select until the desired plot is selected, 
clicking Delete.  After the series has been selected, it can also be deleted by selecting Delete 
Selected Series from the PostProcessing→Graphical Results→Edit Plots menu. 
 
The axis labels or title of a graph can be modified by selecting the Modify Titles entry from the 
PostProcessing→Graphical Results→Edit Plots menu.  The Modify Titles form opens as shown 
in Figure 4-111.  This allows the user to modify the plot and axis titles. Notice that by default the 
main plot title and the X axis title corresponds to the first plot placed on the graph.  Clicking OK 
saves the settings.  Clicking Cancel discards the changes. 
 
 

 
 

Figure 4-111  Modify plot titles 
 
To zoom in the graphics window hold the left mouse down in the top right corner of the desired 
area. Drag a rectangle by moving the mouse down and to the right. Release the mouse. 
 
To unzoom, or restore the graphics window to its original scale hold the left mouse down 
anywhere in the plot. Drag a rectangle by moving up and to the left. Release the mouse. 
 
To show the values in the series select the bulls-eye toggle. When this toggle is pushed in, as 
shown in Figure 4-112, the associated data points in the selected series are overlayed as 
coordinate pairs. To view some of the values, it may be necessary to use the zoom feature. 
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Figure 4-112  Data values as text displayed in a plot window 
 
To modify the plot axis click Modify Axis to open the Modify Axis Bounds form as shown in 
Figure 4-113. This allows the user to change the axis limits or switch to a log scale. 
 
The X or Y axis can be rescaled by: 

 Selecting the X or Y toggles. By default, the X axis is selected. 

 Selecting the scale of the toggled axis by selecting either Linear or Log.  

 Setting the bounds of the toggled axis to Automatic or Manual.  

 Deciding whether the axis limits are to be determined by WinMACCS by selecting 
Automatic or entered by the user by selecting Manual.   

 Manually entering the axis limits if the selection was Manual in the text boxes labeled 
Minimum and Maximum.  

 Clicking OK preserves changes.  Clicking Cancel discards changes.  
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Figure 4-113  Modify axis bounds 
 
The plots can be exported by selecting Export Plot from the PostProcessing→Graphical 
Results→Edit Plots menu. A SaveAs dialog is opened as shown in Figure 4-114. The following 
file types are supported: 

 Windows bit map (.bmp): A graphical format that integrates into other Microsoft 
documents such as Microsoft Word, Excel, or WordPad. Files can be edited in Microsoft 
Paint. 

 Jpeg (.jpg): Viewable as a graphic in a web browser or photo editing software. Requires 
less memory than a .bmp file. 

 Text files (.txt): ASCII text that is viewable in a text editor such as Notepad, WordPad, or 
Microsoft Word. 

 XML and HTML: Viewable in a web browser such as Internet Explorer.  This file can also 
be edited in Microsoft Word. 

 Excel file (.xls): A document that can be opened with Microsoft Excel. Allows the user to 
do further data analysis in the graphical and functionally rich environment of Excel. 

 
The result file is saved in the Project\Output folder unless the path is modified in the Save As 
form. Saved files are shown in the Files tab of the Project window as shown in Figure 4-115. 
Double-clicking on the exported file in the Project window causes the associated application to 
open that file for viewing.  
  
The file names shown in the Files tab of the Project window are updated by selecting 
File→Refresh File View from the main window. 
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Figure 4-114  Exporting plots 
 
 

 
 

Figure 4-115  Exported plots in Files tab of project window 
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5. TUTORIALS 
 
The following tutorials demonstrate how to modify an existing WinMACCS project and how to 
convert a legacy MACCS project into a WinMACCS project.  Following the tutorials are some 
guidelines for constructing a new project from scratch, i.e., without the benefit of an existing 
project.   
 
Tutorial One should be tried by all new users.  Tutorial Two will be primarily useful if it is 
necessary to convert MACCS input files into a WinMACCS project file. 
 
Tutorial One demonstrates how to:  

 Open the existing sample project, Point Estimates LNT. 

 Save this as a project, sample 1. 

 Modify models. 

 Run a simulation. 

 Modify a deterministic parameter and compare results. 

 Change from two to one evacuation scenarios. 

 Create uncertain parameters. 

 Run an uncertainty calculation. 

 View and export results. 
 
Tutorial Two demonstrates how to: 

 Import MACCS input files to create a sample WinMACCS project.  

 Connect the meteorological file, site data file, dose conversion factor file and COMIDA2 
file with the imported project. 

 Understand how the import process is reported in the WinMACCS Results window. 

 Understand that some modifications to the input are required to run MACCS.  In 
particular, it is necessary to enter chemical group names in ATMOS (variable 
GRPNAM). 
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5.1 Tutorial One  
 
What follows is a description of running six samples using sample problem “Point Estimates 
LNT” as a basis.  
 

Table 5-1  Open WinMACCS project. 

User Action WinMACCS response 

Double-click on the WinMACCS icon 
on the desktop or select WinMACCS 
from the WinMACCS group within the 
Windows Start Menu. 

WinMACCS starts and displays menus on the top of the 
screen. File and Help are accessible. 

Choose File→Open Project. 

Change directory to C:\WinMACCS 
Samples\NRC Sample Problems 

WinMACCS shows available sample project folders. 

Double-click on the Point Estimates 
LNT folder. 

Folder opens and shows the project file Point Estimates 
LNT.mxd. 

Double-click on Point Estimates 
LNT.mxd. 

WinMACCS loads the project.  All projects will have four 
directories, \Input, \Data, \Results_DB and \Output.  
WinMACCS will display a message and will create the 
missing folder(s) if any of these folders are missing. 
WinMACCS displays two tabs on the bottom of the 
Project window: Parameters and Files. Above the tab, 
WinMACCS displays a list containing the following 
headings: GENERAL, ATMOS, EARLY, CHRONC, 
DOSE COEFFICIENTS and COMIDA2. 

Select File→Save As Project from the 
main menu.  

Change to the directory in the root 
drive called WinMACCS Projects. 

Type Sample 1 in the Project Name 
field. 

Click OK. 

A new copy of the sample project, Sample 1, is created 
in the default WinMACCS project directory, WinMACCS 
Projects. 

The path shown in the caption of the main WinMACCS 
window is as follows: 

C:\WinMACCS Projects\Sample 1 

Click on the Files tab in the Project 
window. 

Above the tab, WinMACCS displays a list containing the 
following headings: Data, Input, and Output. 
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Table 5-2  Viewing parameters. 

User action WinMACCS response 

Click on the Parameters tab in the 
Project window. 

Each + button, when clicked, displays sub-lists until 
the lowest level is reached. At the lowest levels, black 
bullets appear next to the names of variables. For 
example, METCOD is one of the variables under 
ATMOS/Property Form Parameters. 

Open the ATMOS or EARLY 
heading by clicking on the + button. 
Peruse the different lists by clicking 
on the + buttons.  

      A solid green octagon indicates that all of the 
variables under that entry are required and 
have been properly defined.  

  A solid orange diamond indicates that all of the 
optional variables under that entry have been 
properly defined. 

      An empty orange diamond indicates that all of 
the optional variables have not been defined. 

 
An X-ed red octagon indicates that must be 

defined or corrected before proceeding with a 
MACCS simulation.

 
  A X-ed orange diamond indicates that there is 

an error on this optional form. 

   A solid gray octagon with a diagonal line 
indicates that the variables are not used in a 
MACCS simulation because they are not 
needed under the current choices. This symbol 
also indicates that all of the variables have 
been defined. 

    An empty gray octagon with a diagonal line 
indicates that the variables are not used in a 
MACCS simulation because they are not 
needed under the current choices. This symbol 
also indicates that not all of the variables have 
been defined. 

Choose ATMOS/Property Form 
Parameters. 

Double-click on the word METCOD. 

The Property Form Parameters form opens. At the 
bottom of the form, the variable type "Integer" and 
range of values "[1,5]" is shown, as well as a 
description of the METCOD variable. Values on this 
form cannot be modified as indicated by the grey 
background; the values indicate choices made on 
GENERAL/Properties/Properties form. 
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User action WinMACCS response 

Click inside the other variable boxes 
in the Property Form Parameters 
window. 

Notice that the variable type, range, and description 
change for each variable. 

Close the property form by clicking 
OK or Cancel. 

Property Form Parameters form closes. 

Open the ATMOS/Deposition 
category by clicking on the + button. 

 

Notice that this entry on the Parameters tab contains a 
list of several forms, namely Wet/Dry Depos Flags, 
Wet Deposition, and Dry Deposition.  The category, 
Deposition, contains many forms.  The icon next to a 
category name summarizes the state of those forms.  

    A solid green octagon means the information 
under that category is required and has been 
properly specified. This also means that there 
are no optional variables in this category.  No 
more user attention is required. 

Click on the ATMOS/Radionuclides 
category 

Notice that the Pseudostable Radionuclides form is 
optional.   

   An orange diamond, empty or solid, indicates 
that there is at least one optional form in this 
category. 

    A crossed red octagon means that there are 
forms in this category containing variables that 
must be defined or corrected before 
proceeding with a MACCS simulation. 

    A crossed orange diamond means that there 
are optional forms in this category that need to 
be corrected before proceeding with a MACCS 
simulation. 

Click on the COMIDA2/Model Basis 
category 

Notice that none of these forms are used in a 
simulation.  This is consistent with the current model 
settings on the GENERAL/Properties/Properties form.   

 All forms in this category have a grey symbol; 
hence the category symbol is grey. No user 
attention is required. 

 
 

  



5-5 

Table 5-3  Changing the main model to early only. 

User action WinMACCS response 

Click on the + sign next to General. 
Click the + sign next to Properties. 
Double-click on the solid green 
octagon next to Properties. 

The Project Properties window opens with tabs 
showing different model options. The model definition 
state is displayed in color at each of the tab headings. 
A solid green octagon indicates that the data have 
been defined; if there were an empty red octagon on 
this form, it would indicate that the data were not 
defined or the data were inconsistent with other 
choices. 

Click on the check box next to the 
heading Early Consequences. 

Both check boxes Early Consequences (EARLY) and 
Late Consequences (CHRONC) are unchecked.  If 
Early Consequences is unchecked, it is not possible 
to run the Late Consequences model.  The choice 
means that only Atmospheric Dispersion (ATMOS) will 
be considered in the simulation. 

Click on the tab labeled Dispersion 

 

Notice that the Properties form is the location where 
modeling choices are made.  When the Dispersion tab 
is clicked the symbols next to the heading prefixes are 
updated to reflect that Atmospheric Dispersion will be 
the only main module considered. 

Only tabs relevant to the ATMOS module, namely 
Scope, Dispersion, Weather, and Plume/Source, have 
a solid green octagon next to them in this example. 

The rest of the headings are prefixed with a solid 
gray octagon containing a diagonal line, indicating 

the model selections are valid but are not needed. 

Click on the Scope tab.  
 

Notice that all of the labels within the Parameters tab 
in the Project window under the EARLY heading 
continue to have green and orange icons associated 
with them, even though the Early Consequences 
check box is unchecked. 

Click the Show Required Forms 
button. 

The EARLY module is temporarily deactivated. 

Notice that the symbols within the Parameters tab in 
the Project window in the EARLY category now have 
grey octagons associated with them.  

Click on the check box next to the 
heading Early Consequences. 

Click the OK button to save the 
model settings. 

By clicking OK, the simulation will have ATMOS and 
EARLY results. 

The Project Properties window closes.   
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Table 5-4  Run a simulation. 

User action WinMACCS response 

Choose Execute→Run Models… on 
the top menu. 

The Run Models window opens. 

Click the button labeled Advanced… The Advanced Execution Parameters window opens. 

Uncheck the check box labeled 
Delete Atmos, Early, Chronc and 
COMIDA2 input files. 

Click OK 

All check boxes should be unchecked.  This will insure 
that all intermediate files will not be deleted. 

Click Run Simulation. 

A message box will be displayed as 
follows: 

“Do you want to save the project 
changes?” 

Click “Yes” or type the Enter key to 
save the project changes. 

Before running a simulation, the user is prompted to 
save the changes made to modeling parameters.   

A minimized command window will 
be created. 

Bring the command window to the 
foreground to see the progress of 
the MACCS simulation.   

WinMACCS executes the run and shows the steps in 
the process in the Results window at the bottom of the 
screen (e.g., “Verifying data are defined”).  

Trials listed in the command window refer to 
calculating results for each weather trial. 

After the simulation has completed, notice one of the 
messages written in the Results window is “Model 
execution SUCCESSFUL,” indicating that the 
simulation was successful. If an error had occurred, 
an error condition would have been reported in the 
Results window. 

Close Run Models box by clicking on 

the . 
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Table 5-5  Viewing simulation results. 

User action WinMACCS response 

Click on the Files tab on the bottom 
of the Project window. 

Above the tab, WinMACCS shows a list containing the 
following headings: Data, Input, and Output. 

Click the + next to Input.  Notice that four files have been created as follows: 

atmosTemplate.txt, earlyTemplate.txt, Atmos1.inp, 
Early1.inp 

Atmos1.inp and Early1.inp contain model input 
parameters to MACCS.  The file atmosTemplate.txt is 
identical to Atmos1.inp because there are no uncertain 
parameters specified in this project.  Similarly, 
earlyTemplate.txt and Early1.inp are identical.  The 
template files contain placeholders for uncertain 
values when these are specified. 

Double-click on the Atmos1.inp file in 
the Input category. 

Atmos1.inp will open up in Notepad. 

Notice that the creation date of the input file and 
version of WinMACCS is reported on the first line. 

Close Atmos1.inp by clicking on the 

 

The text editor closes. 

Click on the + next to the Output 
category. 

Notice that one file is listed as follows: 

When the model was run, MACCS results were written 
to Model1.out. 

File Model1.bin is also present and contains binary 
results.  This is not shown in the WinMACCS 
interface, but is read by WinMACCS.  The information 
read is saved in the /Results_DB folder and will be 
used to create custom reports and plots upon request. 

Double-click on Model1.out.  Notepad starts and Model1.out opens.   

Notice that the creation date of the output file and 
version of MACCS is reported on the first line. 
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User action WinMACCS response 

Search for the second occurrence of 
the label AVERAGE INDIVIDUAL 
RISK.  Select the row titled ERL 
FAT/TOTAL  0.2-0.5 km. (The early 
fatality risk considering all 
radionuclides to the average 
individual at a spatial range of .2 to 
.5 km.) 

The second number in the row (mean risk) should be 
6.20E-06, reflecting a weighted combination of 
evacuating and non-evacuating cohorts.   

Values can also be located reflecting evacuation risk 
for scenario one (0.0) and non-evacuation risk for 
scenario two (1.24E-03). 

Close Model1.out by clicking on the 

. 

The text editor closes. 
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Table 5-6  Sample effect of changing a single input parameter. 

User action WinMACCS response 

Click on the Parameters tab in the 
Project window. 

Find ATMOS/Release 
Description/Inventory Scale Factor. 
Double-click on CORSCA. 

Radionuclide Inventory Scaling Factor window opens. 

Modify the value of CORSCA from 
1.0 to 2.0. 

Click OK. 

Radionuclide Inventory Scaling Factor window closes. 

Choose Execute→Run Models on 
the top menu. 

Click Run Simulation. 

Wait until the simulation has 
completed. 

WinMACCS executes run with the changed input. 

In the Results window the text “Model execution 
SUCCESSFUL,” is displayed indicating that the 
simulations were successful. 

Open the file Model1.out found in the 
Output category. 

Search for the second occurrence of 
the label AVERAGE INDIVIDUAL 
RISK. Select the row titled ERL 
FAT/TOTAL  0.2-0.5 km.  

The mean of AVERAGE INDIVIDUAL RISK ERL 
FAT/TOTAL 0.2-0.5 km from all causes should be 
larger than before (i.e., 6.50E-05 as compared with 
6.20E-06). 

Close Model1.out.  The text editor closes. 
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Table 5-7  Changing parameters from deterministic to uncertain. 

User action WinMACCS response 

Click on the Parameters tab. 

Open the category EARLY/Additional 
Emergency Cohorts by clicking on 
the +. 

Select Edit→Project Properties from 
the main window. 

Click the Evac/Rotation tab 

Change the Number of Cohorts from 
2 to 1. 

Click OK 

EARLY/Additional Emergency Cohorts graphic is now 
grey.  This means that there is only one evacuation 
scenario to be considered. 

Open the parameter modification 
form that contains the variable 
WTFRAC by selecting Edit→Find 
Parameter Window… 

From the main menu. 

Scroll down to WTFRAC using the 
scroll bar.  

Click on WTFRAC.  

Click OK 

Change the value of variable 
WTFRAC to 1. 

Click OK. 

Variable WTNAM has the value PEOPLE.  This means 
that the population fraction, WTFRAC, is considered 
for each cohort (defined on the Edit→Project 
Properties, Site Data tab).  The previous run had two 
evacuation cohorts. The value of WTFRAC associated 
with cohort 1, 0.995, meant that 99.5% of the people 
would evacuate according to the parameters specific to 
cohort one. The value of WTFRAC associated with 
scenario 2, no evacuation, was set to 0.005 (defined 
on the EARLY/Additional Emergency 
Cohorts/Emergency Cohort Two/Basic Parameters 
form).  Because all values of WTFRAC must sum to 
one, WTFRAC needed to be set to 1. 

Using the Edit→Find Parameter 
Window open the form associated 
with variable ESPEED. 

Variable ESPEED is displayed in a grid.  There are 
three rows shown corresponding to the Initial, Middle 
and Late evacuation phases for cohort one. 

Notice that the tree displayed on the Parameters tab is 
expanded and the variables on the form, Phase 
Durations and Evacuee Travel Speeds for Cohort One, 
are listed in the Project window in the category 
EARLY/Emergency Cohort One/Phase Durations and 
Speeds 
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User action WinMACCS response 

Double click the text box associated 
with ESPEED in row number one or 
click that text box and click the Make 
Uncertain button. 

 

A dialog will open with a caption as follows: 
ESPEED(1) . 

A pull-down menu of distribution types next to the label 
Distribution is shown with Constant indicated. 

Note: to change a distribution from uncertain to 
deterministic, open the distribution window and change 
the distribution to Constant. It is not possible to type in 
a constant in a box on a parameter modification form 
that has been set to be uncertain.  

Click on the down arrow and select 
Uniform.  Enter 0.9 in the text box 
labeled Lower Limit.  Enter 3.6 in the 
text box labeled Upper Limit. 

Click OK 

The uncertain value has been associated with variable 
ESPEED(1).  The background of the text box 
associated with ESPEED(1) is shaded and contains 
the text UNCERTAIN. 

Set ESPEED(2) and ESPEED(3) to a 
Uniform distribution using the same 
parameters used for ESPEED(1). 

Click OK in the Phase Durations and 
Evacuee Travel Speeds for Cohort 
One window. 

Only when OK is clicked in the main parameter 
modification form (e.g., Evacuee Travel Speed for 
Scenario One) will the uncertain values be saved. 

Set variable SCLADP to a UNIFORM 
distribution where the Lower Limit is 
0.5 and the Upper Limit is 1.5. 

  The background of the text for variable SCLADP on 
the form Plume Rise Data is shaded and contains the 
text Uncertain. 

Choose File→SaveAs Project.  

Change directory to WinMACCS 
Projects 

Specify “sample 1 uncertain” for the 
Project name. 

WinMACCS creates a new project, sample 1 uncertain. 

Choose Execute→Run Models 

Click on the button Advanced… 

Type 3 in the box labeled Number of 
Simulations 

Click the OK button 

Number of samples (or number of MACCS simulations) 
is now three. 
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User action WinMACCS response 

Click the Run Simulation button 

Click Yes when prompted to save the 
project 

MACCS will run three times, creating three results files, 
model1.out, model2.out and model3.out. 

Click on the Files tab on the bottom 
of the Project window. 

Above the tab, WinMACCS shows a list containing the 
following headings: Data, Input, and Output. 

Click the + next to Input.  WinMACCS created MACCS input files Atmos1.inp, 
Early1.inp, Atmos2.inp, Early2.inp, Atmos3.inp, 
Early3.inp, one set of files for each realization from 
LHS using the data in LHS.out. 

Double-click on the input file for Latin 
Hypercube Sampling, LHS.inp.    
 

LHS.inp, a file created by WinMACCS, contains a 
summary of uncertain variables and their distributions. 
The Latin Hypercube Sampling program, LHS, is run 
with input as reported in this file: 

ESPEED(1) UNIFORM 0.9 3.6 

ESPEED(2) UNIFORM 0.9 3.6 

ESPEED(3) UNIFORM 0.9 3.6 

SCLADP UNIFORM 0.5 1.5 

Open the file in the Input folder 
created by Latin Hypercube 
Sampling, LHS.out. 

A list of mean values for each variable and the 
sampled values are shown. 

 Close LHS.inp and LHS.out  The text editors close. 

Click on the + next to Output. Model1.out, Model2.out and Model3.out are displayed. 
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User action WinMACCS response 

Choose PostProcessing→Report 
Results→Manage Custom Reports 

Click on the radio button labeled 
Combine Realizations. Click on the 
button New. 

Click on the column labeled Include 
for the first two entries labeled Spatial 
Intervals for Output. 

Click on the column labeled Include 
for all of the entries where the Report 
Description column is labeled 
Population Dose.  There are three 
entries. 

Enter report name Atmos Summary 
and Population Dose. 

Click OK to close the Custom 
Combined Report form. 

Define a new custom report. 

A copy of the MACCS output requests created by 
WinMACCS are shown in the grid.  These entries are 
found in the MACCS input files. 

 

Click the Select check box to choose 
the report Atmos Summary and 
Population Dose. 

Select the radio button labeled View. 
Click the Apply button. 

Report defined in the previous step is created and 
opened in the Notepad text editor. 

In the report, scroll down to Request 
3 Population Dose  

Notice that the columns labeled Probability of 
Exceedence are based on quantiles specified on the 
form GENERAL/Output Options/Reporting Options 
found on the Parameters tab.  The reported data is 
based on binned CCDF tables.  Variation of values for 
any given LHS simulation is due to weather sampling.  
These CCDF tables can be viewed in the MACCS 
output when the Report Option variable is set to CCDF 
or CCDF & REPORT for the Output Control form of 
interest (e.g., EARLY/Ouput Control/Population Dose). 

Notice the following message is displayed for request 
3: 

Unable to transform CCDF No differences in probability 
values in CCDF. 

This is because the population dose was zero from 0 to 
16.09 km and did not change for the set of weather 
trials. 
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User action WinMACCS response 

In the report, scroll down to the entry 
labeled Request 4  Population Dose. 

 

The Population Dose corresponding to combining the 
LHS realizations is shown as follows: 

Evacuation Evac #  1 L-ICRP60ED [0.E+00,80.47](km)  

                                      Grand Mean       

Population Dose (Sv)    1.36E+03   

Note: The custom reports can be used to report overall 
statistics when multiple realizations are being 
calculated with sampled variables. However, it can also 
be used to conveniently calculate additional quantile 
information using the binned CCDF results from 
MACCS.  

Close report. The text editor closes. 

The report, Atmos Summary and Population Dose.txt, 
can also be opened by double clicking on this named 
entry Output category found on the Files tab.   

Note: It is possible to summarize the output without 
combining the data from the realizations. When 
creating a new report, select the radio button labeled 
Realization Based on the Manage Reports form 
instead of the Combine Realizations button. 

Double-click on General/Output 
Options/Reporting Options on the 
Parameters tab to open the Reporting 
Options form. 

A form labeled Reporting Options opens. 

Clear all old entries by clicking the 
erasor icon. 

Enter the following quantiles: 

0.01, 0.25, 0.50,  0.75, 0.99 

Click OK. 

Note: Rows can be deleted in a grid by selecting the 
row and pressing the Delete key on the keyboard. 

New rows can be added to the grid by clicking on the 
text in a row and selecting Edit →Grid →Insert Rows 

A new row can be added to the bottom of the grid by 
typing in the text area of the last row.  
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User action WinMACCS response 

Create a new summary report by 
selecting PostProcessing→Report 
Results→Manage Custom Reports. 

Click the Select check box to choose 
the report Atmos Summary and 
Population Dose. 

Select the radio button labeled View. 
Click the Apply button. 

Data corresponding to user chosen quantiles are 
calculated by interpolating values from the binned 
CCDF’s that MACCS calculates. 
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Table 5-8  Viewing results as plots. 

User action WinMACCS response 

Choose PostProcessing→Graphical 
Results→Results over all Weather 
Trials. 

A Results Over All Weather Trials window opens with 
the version of MACCS used in the simulation 
displayed in the Window caption. 

Click the + next to Centerline Ground 
Concentration 

Click on Plume 1 CS-137[5.63, 8.05] 
(km) 

Click on Add. 

Result is placed on chart.  There is a single plot 
corresponding to each of the three simulations. 

Click Modify Axis. The Modify Axis Bounds window opens with options 
for X- and Y-axis and their bounds. In addition, the 
user may choose a linear or a logarithmic scale for X 
and Y. The minimum and maximum values must be 
specified for the logarithmic scale; the linear scale 
can either be automatically set or manually set by the 
user. 

Click Cancel in the Modify Axis 
Bounds window. 

The Modify Axis Bounds window closes. 

Select PostProcessing→Graphical 
Results→Edit Plots→Modify Titles. 

Close the Modify Titles window by 
clicking the Cancel button. 

The plot title and axis labels can be modified. 

Click the Select button on the plot 
window three times. 

The data points representing the complementary 
cumulative distribution function (CCDF) are shown. 
Notice that the sample numbers, LHS1, LHS2 and 
finally LHS3 are shown.   

The bottom of the plot window displays details 
describing the selected plot series in blue lettering. 

Click the Select button again. The plot is now in an unselected state. Notice that the 
bottom of the plot window displays the words 
“Selected Series: NONE.” 

Click the Bulls-eye button. The plotted values are now displayed as text.  Click 
and drag to draw a rectangle from upper left corner to 
lower right to zoom in on the plot.  Click and drag 
from lower right to upper left to un-zoom. 
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User action WinMACCS response 

Click the Bulls-eye button again. The text values are no longer displayed. 

Select PostProcessing→Graphical 
Results→Edit Plots→Export Plot. 

A Save As window appears. Notice the different file 
formats available, including JPEG image, MS Excel, 
and ASCII text. 

Enter "MyData" in the text box 
labeled File Name. 

Select Windows BMP Image (*.bmp) 
in the Save as Type pull-down menu. 

Type the name of the file, MyData.  
Do not type an extension. 

WinMACCS saves the data as a .bmp file called 
MyData.bmp into the \WinMACCS Projects\sample 1 
uncertain\Output directory.  This file can be opened in 
MS Paint. 

Double-click on file MyData.bmp in 
the Output directory found under the 
Files tab in WinMACCS. 

The .bmp file opens in the associated application, 
usually MS Paint. 
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5.2 Tutorial Two 
 
What follows is a description of how to import a MACCS input set into WinMACCS. This is 
necessary when there are MACCS input files that have been used outside of the WinMACCS 
environment. 
 

Table 5-9  Create a new project based on a MACCS input set. 

User action WinMACCS response 

Double-click on the WinMACCS icon 
on the desktop or select WinMACCS 
from the WinMACCS group from the 
Windows Start Menu. 

WinMACCS starts and displays pull-down menus on 
the top of the screen. File and Help are accessible. 

 

Choose File→Open Project 

Open file Point Estimates LNT.mxd 
found in directory C:\WinMACCS 
Samples\NRC Sample 
Problems\Point Estimates LNT 

Sample project Point Estimates LNT is opened. 

Path is displayed in caption of main window 

C:\WinMACCS Samples\NRC Sample Problems\Point 
Estimates LNT 

Choose Execute→Run Models  

From the main menu 

The run models window is open 

Click the button labeled Advanced… The Advanced Execution Parameters window opens. 

Uncheck the check box labeled 
Delete Atmos, Early, Chronc and 
COMIDA2 input files. 

Click OK 

All check boxes should be unchecked.  This will insure 
that all intermediate files will not be deleted.  The 
MACCS input files were created in the previous 
exercise, but were deleted because the box labeled 
Delete Atmos, Early, Chronc and COMIDA2 input files 
was checked. 

Click Run Simulation. 

Click No when asked when you want 
to save the project changes 

WinMACCS creates input files every time the Run 
Simulation button is checked.  A simulation is run.  

Choose File→Close Project 

When prompted  

Do you want to save the project 
changes?   

click No 

Sample problem will be closed.  MACCS input files will 
be used in this exercise. The following MACCS input 
files have been created.  These files are in the project 
directory. 

Maccs.tmp 

\Input\Atmos1.inp 

\Input\Early1.inp 

\Input\Chronc1.inp 
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User action WinMACCS response 

Open an ASCII text editor such as 
Windows Notepad. 

Open the file C:\WinMACCS 
Samples\NRC Sample 
Problems\Point Estimates 
LNT\Maccs.tmp in the editor. 

Some of the files used by the MACCS simulation are 
listed.  This file is read by MACCS.  The full path is 
referenced, but only the file name are indicated below.  
These are as follows: 

Line 1: ATMOS input file 

Atmos1.inp 

Line2: EARLY input file 

Early1.inp 

Line 3: CHRONC input file 

Chronc1.inp 

Line 4: Meteorological data file, metsurMxHt_60min.inp 

Line 5: Site data file 

FicticiousSite.inp 

Line 5: Output data file, specified name of results file 
written by MACCS 

Model1.out 

The file Early1.inp contains the name of the DCF file on 
line labeled DCF_FILE001 as follows: 

Data\Fgr13dcf.inp 

Chronc1.inp contains the name of the COMIDA2 binary 
file on line labeled BIN_FILE001  

Data\fgr13samp_a.bin 

Close the ASCII text editor. The text editor closes. 

Choose File→New Project. 

Navigate to the folder WinMACCS 
Projects.  Enter the name Sample 2 
in the Project Name field.  Click OK. 

A new project is created. The Project Properties form is 
opened.  This form is used to select the appropriate 
models for the simulation. 

Notice that only the ATMOS model is checked.  This is 
the default setting for new projects. 

Click the Cancel button in the form 
titled Project Properties. 

It is not necessary to select models when importing 
MACCS input files such as Atmos1.inp.  WinMACCS 
will define the radio buttons and check boxes in the 
Project Properties form dependent on the values in the 
imported files 
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Table 5-10  Import Atmos1.inp, Early1.inp and Chronc1.inp. 

User action WinMACCS response 

On the Parameters tab of the Project 
window, click the plus sign, +, to the 
left of the headings GENERAL, 
ATMOS, EARLY and CHRONC. 

Notice the crossed red octagons next to categories of 
data in the GENERAL and ATMOS categories 
indicating that data are required but are not yet 
defined.   

Notice the filled in green octagon next to the heading 
Property Form Parameters.  These are variables that 
are defined and can be changed only by using the 
Project Properties form.  These are set to default 
model settings.  

Notice the slashed grey octagons in the EARLY and 
CHRONC categories.  These data are not required 
because Early Consequences and Late 
Consequences have not been checked on the Project 
Properties form. 

Select File→Import MACCS Input 
File from the main menu.  Select the 
ATMOS input file titled Atmos1.inp in 
the directory C:\WinMACCS 
Samples\NRC Sample 
Problems\Point Estimates 
LNT\Input\  

Click Open. 

The file Atmos1.inp is read by WinMACCS.  The data 
in this file is loaded into the interface.  The progress of 
processing this file can be seen in the WinMACCS 
Results window.   

The ATMOS crossed red octagons have turned into 
solid green octagons, indicating that the data on these 
forms are now defined. 

The EARLY model is now on.  This is because a 
variable, ENDAT1, in the file Atmos1.inp, was set to 
.FALSE. indicating that the EARLY model should be 
executed.   

Observe stage one of the import 
process. 

Expand the Results window by 
moving the mouse to the Title bar on 
that window.  When the mouse 
pointer turns to a double sided 
arrow, hold the left mouse button 
down while dragging towards the 
main window caption.  Release the 
mouse button to resize the window. 

Models are normally turned on or off 
in WinMACCS using the Project 
Properties form.  This is done 
automatically when reading in a 
MACCS file. 

The first line shown in the Results window indicates 
the name of the file that is being imported is as 
follows: 

Importing MACCS input file C:\WinMACCS 
Samples\NRC Sample Problems\Point Estimates 
LNT\Input\Atmos1.inp  

The next line shows that the file is being read to 
determine which models are turned on in WinMACCS.  

Processing input lines that define models 

The next set of lines report which lines of Atmos1.inp 
are used to determine the model settings.   
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User action WinMACCS response 

The models that are set in 
WinMACCS can be viewed or 
changed on the Properties form that 
can be opened by selecting 
Edit→Project Properties from the 
main menu. 

Open the form Project Properties 

Click on the Dispersion tab 

 

This tutorial will not go through all the logic used to 
define WinMACCS model settings from the MACCS 
input files.  However, dispersion is offered as a single 
example to increase understanding of this process. 

Some project property settings defined on the Project 
Properties form are translated into variable values.  
These variable values can be observed by opening the 
forms 

ATMOS/Property Form Parameters 

EARLY/Property Form Parameters 

CHRONC/Property Form Parameters 

Notice that the dispersion model is set to Lookup 
Tables in the Project Properties form. When the 
MACCS variable NUM_DIST is equal to zero in the 
imported file, the dispersion model is set to Power Law 
Functions (NUM_DIST=0) 

Often, there is a direct correspondence between a 
model setting and the value of a MACCS imported 
variable (e.g., NUM_DIST).  In these cases, the value 
of the MACCS input variable will be part of the model 
label shown on the Project Properties form. 

Open the file Atmos1.inp in an ASCII 
text editor such as Notepad.   

Search for the character string 
NUM_DIST001 

Notice that the value is set to 50 

Recall, the MACCS input file Atmos1.inp can be found 
in the following folder: C:\WinMACCS Samples\NRC 
Sample Problems\Point Estimates LNT\Input\ 

The input lines that are used to define the models are 
shown in the Results window, e.g., Saving MACCS 
Data for input line: NUM_DIST  

Setting this value to a nonzero quantity indicates that 
the source of the dispersion data is the form 
ATMOS/Dispersion/Dispersion Table.    
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User action WinMACCS response 

Observe stage two of the import 
process. 

The variables relevant to the 
updated model settings are 
extracted from the file.   

Lines are processed until a period in 
column one is encountered.  This is 
considered the end of the data to be 
imported in stage two. 

In the second stage, only the data relevant to the 
current model settings are extracted.  The file is read 
for the second time. 

Example output in the Results window from the 
second pass is: 

Processing input lines for file section 1 

Saving MACCS Data for input line: RIATNAM1 

Observe stage three of the import 
process. 

In the last step in the import 
process, WinMACCS looks for 
multiple cohort data.  When other 
cohorts (I.e., change card sets) are 
present, they will be separated by a 
period in column one. 

EARLY model input sets created by 
WinMACCS may contain up to 
twenty cohorts to support multiple 
evacuation scenarios. 

There was no additional scenario data present.  

Example output from stage three is as follows: 

Processing input lines for file section 2 

No data to import for file section 2 

WARNING - Check the Properties form for model 
settings. 

When importing older MACCS input files, some 
models are not specified. 

This concludes the import of the ATMOS input file.   

Repeat the import process, and 
import the file Early1.inp and 
Chronc1.inp. 

Notice that two evacuation cohorts were defined in the 
Early1.inp file.  WinMACCS properly processes this 
and sets the variables accordingly. 
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Table 5-11  Define additional forms. 

User action WinMACCS response 

Click on the Parameters tab of the 
Project Window.  Click on the plus 
sign, +,  next to the label GENERAL 

Notice that the File Specification category has an 

associated icon as follows:  

This indicates that attention is needed.  

Click the plus sign, +, to the left of 
the heading GENERAL\Properties.  
Double click on the form name 
Problem Description. 

Enter some text in the box 

Click OK. 

Notice that the form Problem Description is an optional 

form, as indicated by the diamond shaped icon:  

After the file is defined, the diamond becomes filled. 

The text entered will become comments in the 
MACCS input files.  

Click the plus sign, +, to the left of 
the heading GENERAL\File 
Specifications.  Double click on the 
form name Meteorological File. 

Notice that all file specifications for the project are 
listed in the category File Specifications.  

The form titled Specify Meteorological File is opened. 

Click on the button labeled Browse. 
Locate file titled 
metsurMxHt_60min.inp 

A copy of this file is in 
C:\WinMACCS Samples\NRC 
Sample Problems\Point Estimates 
LNT\Data\ 

Click OK.  

A copy of this file will be made and placed in the 
current projects \Data directory. 

Recall that the name of this file was referenced in the 
file Maccs.tmp 

Define the site file by double clicking 
on the form name GENERAL/File 
Specifications/Site File. Click on the 
Browse button to find the file 
FicticiousSite.inp in the directory 
C:\WinMACCS Samples\NRC 
Sample Problems\Point Estimates 
LNT\Data\  

Click OK. 

Notice that the number of angular directions shown in 
16.  WinMACCS opens and reads FicticiousSite.inp to 
determine this.  When the user needs to change the 
number of angular directions on the evacuation grid on 
an existing site file, the Create New button can be 
used to create a new site file based on the older site 
file.  It is preferable to create a new site file using the 
program SecPOP. 

A copy of this file will be made and placed in the 
current projects /Data directory. 
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User action WinMACCS response 

Answer Yes to the following 
questions shown in the message 
box:  

Do you want to update the spatial 
grid to be consistent with the site 
file? 

This updates the values of variable SPAEND.  
SPAEND and the site file should be consistent.  
NUMCOR will be updated to be consistent with the 
number of angular directions specified on the site file 
independent of the answer given in the message box. 

Recall that the name of this file was referenced in the 
file Maccs.tmp 

Open the form Dose Conversion 
Factor File.  Specify the file 
Fgr13dcf.inp in the directory  
C:\WinMACCS Samples\NRC 
Sample Problems\Point Estimates 
LNT\Data\ 

Click OK. 

A copy of this file will be made and placed in the 
current projects /Data directory. 

The name of this file can be found in the file Early1.inp 
on the line containing the keyword DCF_FILE001.  

The data files can be opened by clicking on the Files 
tab of the Project window, clicking on the + next to the 
word Data, clicking on the variable of interest (e.g., 
Site File), and double clicking on the file name. 

Open the form COMIDA2 File.  

Specify the file fgr13samp_a.bin in 

the directory  C:\WinMACCS 
Samples\NRC Sample 
Problems\Point Estimates LNT\Data\ 

Click OK. 

 

A copy of this file will be made and placed in the 
current projects /Data directory. 

The name of this file can be found in the file 
Chronc1.inp on the line containing the keyword: 
BIN_FILE001 

MACCS requires that this binary file was created using 
the specified DCF file (in this example Fgr13dcf.inp) 
using the COMIDA2 preprocessor.  

Click the plus sign, +, to the left of 
the heading CHRONC. 

Notice there are no errors. Interface should appear as 
follows: 
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Table 5-12  Execute new project. 

User action MACCS response 

Select Execute→Run Models from 
the main menu.  Click on the Run 
Simulation button on the Run Models 
form. 

Click on the entry on the task bar: 

 

The progress is displayed in the command prompt 
window.   

 

Successful execution can be verified by observing that 
the Results window contains the following: 

Running model as follows: 

"C:\Program Files\WinMaccs\MACCS.exe" -i 
"C:\WinMACCS Projects\Sample 2\Maccs.tmp" -p 
"Model1" 

Model execution SUCCESSFUL 

OK   

Run Completed  

 
The following are a few guidelines for creating a new project from scratch: 
 

 When a new project is created by selecting File→New Project from the main menu, the 
WinMACCS Properties form is opened.  The settings on this form should be reviewed 
and changed as needed.  After this has been reviewed, click OK to save the settings.  
These settings determine which subsequent forms are required, not required, and are 
optional. 

 Starting at the top of the Parameters tab, fill in the required forms in order.  There are six 
main models listed, namely GENERAL, ATMOS, EARLY, CHRONC, DOSE 
COEFFICIENTS and COMIDA2.  Each contains many forms, however only the data in 
the required forms will be used.  A form is not required when the icon to the left of the 
form name is a grey octagon with diagonal line.  Forms with orange diamond shaped 
icons are optional.  The Project Properties form can be modified at will.  It is not required 
that the forms be filled out in order, but it may be helpful because information on some 
forms is required before other forms can be completed. Filling out the forms in order 
avoids any conflicts. 

 When the X-ed red octagons have been converted to solid green octagons, select 
Execute→Run Models from the main menu.  Click on Run Simulation to run.  Look in the 
Results window to verify that the execution was successful.  The output files from the 
execution can be opened by double clicking on the file names on the Files tab. 
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 It may be easier to debug the input when only the ATMOS model is enabled the first time 
MACCS is executed.  After ATMOS is running successfully, change the main model to 
include EARLY on the Properties form.  When needed, continue with CHRONC and 
COMIDA2 as each set of model input is debugged. 

 
The following are a few guidelines for importing a project from MACCS input files: 
 

 When importing MACCS input files, the improved Briggs model will always be used 
unless Original MACCS 1.12 Briggs Model is manually checked on the Plume Rise tab 
of the Project Properties form.  To compare results to MACCS 1.12, it is necessary for 
the plume rise model to be consistent. 

 ATMOS input for MACCS 1.12 supported multiple source terms using change card sets. 
This is not supported in WinMACCS for ATMOS.  Any additional change card sets in an 
imported card set will be considered to be related to additional evacuation cohorts only.  
However, multiple source terms can be modeled by using the MACCS Cyclical File Set 
feature found on the Scope tab of the Project Properties form. Multiple Source terms can 
also be modeled by selecting the Multi Source Term check box on the Plume/Source 
tab.  This process requires input files in a format compatible with MelMACCS version 
1.7.3 (or greater) output files. 

 When importing an ATMOS input deck created using MACCS 1.12, it will be necessary 
to manually define the chemical group names, GRPNAM. 

 Before importing an EARLY input file, when the DCF file used is not based on Federal 
Guidance Report FGR-13, it is necessary to manually specify this on the Dose tab of the 
Project Properties form.  For example, when the DCF file was created by the 
preprocessor DOSFAC2, the form EARLY/Model Basis/Organs of Risk DOSFAC2 is 
required.  Similarly, the form EARLY/Model Basis/Organs of Risk FGR-13 is required 
when the DCF file was created from FGR-13 data.  Neither form is required when the 
DCF file is of type FGRDCF (based on FGR-11 and FGR-12). 

 When importing an EARLY input file, the number of evacuation cohorts are not 
decreased from the number specified on the Project Properties tab.  However, the 
number may be increased when more cohorts are specified than is defined on the 
Project Properties tab. This can be manually changed by using the Evac/Rotation tab of 
the Project Properties form.  This is by design because of considerations with respect to 
the MACCS Cyclical File Set option that uses the same import algorithms. 

 When importing a CHRONC input deck created using MACCS 1.12, the 
CHRONC/Shielding and Exposure form is not defined.  A reasonable value to use is the 
value used for the Shielding and Exposure variables defined for Normal behavior in 
Early as shown in Table 5-13.. 
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Table 5-13  Defining CHRONC shielding and exposure. 

User action WinMACCS response 

Click on the + next to the headings 
GENERAL, EARLY and CHRONC 
when these headings are not already 
open. 

Double click on the form name 
Shielding and Exposure in CHRONC. 

 

Notice that the CHRONC variables LPROTIN, 
LBRRATE and LGSHFAC are not defined.  These 
are new variables that do not have images in the 
imported file. 

Open the form EARLY/Emergency 
Scenario One/ Shielding and 
Exposure 

Enter the related data in the row 
labeled Normal into the 
CHRONC/Shielding and Exposure 
form. 

Adding these CHRONC variables ensures that 
consistent values are independent of the EARLY 
evacuation scenarios.  Before this modification, 
MACCS used the values used during the last EARLY 
evacuation scenario for the CHRONC calculation.  It 
was not clear to the user which values were used, so 
these variables were added to CHRONC. 
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6. SITE FILE FORMAT 
 

6.1 Format Overview 
 
In the site file, the user specifies the population distribution and land use information for the 
region surrounding the site.  Contained in the site file are the geometry data used for the site 
(spatial intervals), population distribution, fraction of the area that is land, watershed data for the 
liquid pathways  model, information on agricultural land use and growing seasons, and regional 
economic information.  An example of a site file is provided in NUREG/CR-4691, Volume 1, 
Appendix D.2. 
 
The user specifies on the Site Data tab on Properties form whether a Site Data file is to be 
used. When a Site Data file is not being used, the population density applied in the EARLY and 
CHRONC modules are specified on the EARLY/Model Basis/Population Data form.   
 
The site file used in MACCS is a fixed formatted file.  The data must appear exactly as 
described below and in exactly the same order.   
 
The use of fixed format requires that the user exercise special attention to line up the data items 
in their proper fields.  Any numeric items specified in exponential format (e.g., 1.E-) must be 
right-justified in the field because trailing blanks are processed as zeros. To prevent errors due 
to right justification of data, it is recommended that a decimal point is used, and the exponential 
portion of the field is indicated using the letter E as in 1.E-6.  When this recommendation is 
followed, the number to the right of the FORTRAN format descriptor (e.g., the 2 in F8.2 or E8.2) 
is ignored and only the field length is considered (e.g., the 8 in F8.2). 
 
The FORTRAN fixed field input rules for an edit descriptor Fw.d or Ew.d are as follows.  The 
input field consists of an optional sign, followed by a string of digits optionally containing a 
decimal point.  When the decimal point is omitted, the rightmost d digits of the string are 
interpreted as the fractional part of the value represented. This is why it is critical not to omit the 
decimal point. The basic form may be followed by an exponent of one of the following forms: 
 
1. Signed integer constant (e.g., 1.-6 means 1.E-6) 

 
2. E followed by zero or more blanks followed by an optionally signed integer constant. 

 
It is recommended that SECPOP be used to construct the site data file.  When it is necessary to 
edit this file, or create a site file from scratch, it is recommended that the user exercise care in 
constructing the file.  It is very important that all items appear in their proper fields and that all 
numeric values lie within the range of acceptable values.  Failure to conform to these 
requirements may lead to the generation of spurious results.  This is because the validation 
performed on the site data is only partially complete in MACCS.   
 
The first two records of the site data file contain identification information.  This header 
information is printed on the output listing. 
 
When using SECPOP to create the site file, quality assurance information is written to the first 
two lines to include the version identification of SECPOP and parameter settings used to create 
the site data file.  For example, the first two lines in the sample site file distributed with 
WinMACCS are as follows: 
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SECPOP Version: 4.3.0 SVN:2242 FileType: MACCS_Site Project: "Fictitious" Census: 
"C:\Program Files (x86)\SecPop\Census\Census2010.bin" County: "C:\Program Files 
(x86)\SecPop\Census\County2012.dat" 
 
Lat: 36d11'35'' Long: 115d58'55'' Latitude: 36.193058 Longitude: 115.98194 
Population_multiplier: 1.0 Economic_multiplier: 1.0 Run_Time: 2016/02/04_12:28:56 
 
Following the descriptive text fields, there are six data records that specify the amount of data 
that is being supplied on the file.  The values defined on these data records must be consistent 
with values defined in WinMACCS.  The data are input as integers in FORTRAN (I4) format.  
The integers must be right justified in the four character long input field. 
 
Some of the variables defined in the site file must agree with variables defined in WinMACCS.  
However, when the variable is not required by WinMACCS, agreement is not required.  For 
example, when the CHRONC model is not selected, variables such as NFICRP, NUMWPI are 
not required to be defined in WinMACCS.  When the MACCS Food Model is not selected, the 
CROP variable will not be defined in WinMACCS.  However, variables listed in Table 6-1 are 
required to be defined in the site file even though they may not be used in calculations. 
 

Table 6-1  Basic site file parameters. 

Line 
in site 

file 
Columns 

FORTRAN 
format 

Variable 
name 

Allowed values Description 
Example line from 
FicticiousSite.inp 

3 1 to 4 I4 NUMRAD 2 to 35  
Must agree with 
WinMACCS 
variable NUMRAD 

Number of radial 
spatial intervals. 

  26 SPATIAL 
INTERVALS 

4 1 to 4 I4 NUMCOR 16, 32, 48 or 64 
Must agree with 
WinMACCS 
variable 
NUMCOR. 

Number of 
sectors in the 
spatial grid. 

  16 WIND 
DIRECTIONS 

5 1 to 4 I4 NFICRP 1 to 10 
Must agree with 
WinMACCS 
variable NFICRP 

Number of crop 
categories that 
will be used by 
the food 
pathway model 

  7 CROP 
CATEGORIES 

6 1 to 4 I4 NUMWPI 1 to 10 
Must agree with 
WinMACCS 
variable NUMWPI 

Number of 
radionuclides in 
drinking water 
pathway 

  4 WATER 
ISOTOPES 

7 1 to 4 I4 NUMWPA 1 to 4 Number of water 
pathways 

  1 WATERSHEDS 

8 1 to 4 I4 NECRGN 1 to 99 Number of 
economic 
regions 

  97 ECONOMIC 
REGIONS 

 
SecPop2000 only supports NUMCOR equal to 16.  SecPop 4.0 and later allow the values of 
NUMCOR to be 16, 32, 48 or 64.  However, once a site file is created, WinMACCS can create a 
new site file based on this site file that supports NUMCOR equal to 32, 48 or 64.  This feature 
can be accessed on the WinMACCS form GENERAL/File Specifications/Site File.  This is 
necessary to allow the WinMACCS user a finer grid resolution.  When not using a site data file, 
WinMACCS assumes one watershed.  Water ingestion data for each radionuclide considered in 
the water pathway is defined in the WinMACCS variable WINGF for one watershed only.  Only 
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by using the site data file can more water pathways be specified.  In this case, MACCS will use 
the ingestion factor read from the site file.  The format for input of the ingestion data is described 
below.  SecPOPenters constants for these values with the intention that this data would be 
edited further. 
 
Eight blocks of site data follow the introductory block described in Table 6-2. Each of these data 
blocks as summarized in Table 6-2 is introduced by a separator line that identifies the block of 
the data to follow. The first line of data block must be the separator for that block. Data block 
separators start in column 2 and are right justified.  
 

Table 6-2  Site file data blocks. 

Data 
block 
in site 

file 

Columns 
FORTRAN 

format 
First line of data block 

Description of data 
block 

1 2 to 23 A22 SPATIAL DISTANCES Defines the distance 
to the outer radii of 
each grid element 

2 2 to 23 A22 POPULATION Defines the population 
of each grid sector 

3 2 to 23 A22 LAND FRACTION Defines the fraction of 
land of each grid 
sector 

4 2 to 23 A22 REGION INDEX Defines the economic 
region for each grid 
sector. 

5 2 to 23 A22 WATERSHED INDEX Defines the 
appropriate watershed 
to use for each grid 
sector 

6 2 to 23 A22 CROP SEASON AND SHARE Defines variables 
associated with crops 

7 2 to 23 A22 WATERSHED DEFINITION Defines water 
ingestion data for each 
watershed 

8 2 to 23 A22 REGIONAL ECONOMIC DATA Economic data for 
each economic region 
defined 

 

6.2 Spatial Distances Data Block 
 
The spatial distance data define the spatial grid for which the population and land use data are 
specified.  The data define the distance in kilometers to the endpoints of the spatial intervals.  
The areas between the spatial interval endpoints within each of the 16, 32, 48 or 64 direction 
sectors are referred to as spatial elements.  This grid definition must agree with the grid defined 
in the ATMOS input variable SPAEND.MACCS reads the spatial intervals distances in the site 
file and compares the values to SPAEND.  If MACCS is run without the WinMACCS interface, 
an error of 10% is allowed, however only the values in the ATMOS variable SPAEND values are 
used in the calculations. For larger discrepancies in the geometry data, the error flag will be set 
and execution will terminate upon completion of the Site Data file input processing.  WinMACCS 
sets the values of SPAEND to be identical with the values in the Site Data file when the Site 
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Data file is specified, so it is not possible to to have any difference between the spatial distances 
data block and SPAEND. 
 
The first line of the spatial distance data block contains the 22-character separator beginning 
with SPATIAL DISTANCES in column 2.  Next, the endpoint distances in kilometers are 
specified, eight values per line, using the format described below.  As many lines as are needed 
to define the spatial distances are used.  The minimum spacing between adjacent spatial 
intervals is 0.1 km. 
 
A maximum of eight interval endpoints may be input per line within ten column intervals. The 
first interval endpoint would be input in columns 1–10, the second interval endpoint would be 
input in columns 11–20, etc.  The data must be right justified in the ten columns allotted to that 
data point.  The data are input as real numbers. 
 

Variable 
Name 

Dimensions 
FORTRAN 

Format 
Allowed 
Values 

Description 

SPAEND NUMRAD 8E10.2 0.05 to 
9999.0 km 

Radial spatial intervals 

 

6.3 Population Data Block 
 
The population data for each element in the spatial grid is defined here.  The first line of the data 
block contains the 22-character separator beginning with POPULATION in column 2.  Next, the 
number of people in each element is given for the first sector.  (The first sector is assumed to be 
centered on north.)  The population data are specified, eight values per line, using the format 
described below.  As many lines as needed to cover all the spatial elements in the sector are 
used.  Proceeding in a clockwise rotation, the population data for the second (NNE when there 
are 16 sectors) and subsequent sectors follow.  Data for all directions (sectors) must be 
provided.  Data for each sector begin on a new line.   
 
The population data are input as a real number.  Fractional values are supported.  The 
population data for up to eight spatial elements may be defined per line and the data are input 
per ten column intervals; i.e., the population in the first element would be input in columns 1–10, 
the population in the second element would be input in columns 11–20, etc. The data must be 
right justified in the ten columns allotted to that data point.  The data are input as real numbers 
supporting whole numbers. 
 

Variable 
Name 

Dimensions 
FORTRAN 

Format 
Allowed 
Values 

Description 

POPDAT NUMRAD 
by 

NUMCOR 

8E10.0 0.0 to 109 Number of people 
living in sector 

 
MACCS combines evacuation scenarios using one of three different algorithms specified by a 
variable WTNAM.  This variable can be set to PEOPLE, TIME or SUMPOP.  This variable is 
defined on the Site Data tab in WinMACCS.   
 
When WTNAM is set to PEOPLE, EARLY variable specified per cohort, WTFRAC, represents 
the fraction of the population that belongs to the cohort.  When WTNAM is set to TIME, the 
EARLY variable WTFRAC represents the fraction of the time or probability that this evacuation 
scenario is applicable. With this option, the entire population follows each evacuation scenario a 
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fraction of the time.  When the variable WTNAM is set to SUMPOP, population data for each 
evacuation scenario are defined in the site data file as follows. 
 
When WTNAM is set to TIME or PEOPLE the population data block is delimited with the header 
record POPULATION beginning at column 2, followed by the population data.   
 
When the SUMPOP option is selected, the header lines for each population data block are 
POPULATION1, POPULATION2, and POPULATION3, corresponding to the respective 
emergency cohorts, all beginning in column 2.  MACCS reports an error when the number of 
population data blocks does not equal the number of emergency response cohorts defined in 
the EARLY input file. 
 

6.4 Land Fraction Data Block 
 
The fraction of each spatial element that is land (as opposed to lakes, oceans, etc.) must be 
defined.  The first line of the data block contains the 22-character separator beginning with 
LAND FRACTION in column 2.  Next, the fraction of area that is land in each radial spatial 
interval of the first sector is given.  All values must be between 0 and 1.  A value of 0 means the 
grid element has no land, a value of 1 means the element is all land.  The land fraction data are 
specified, 16 values per line, with the format described below.  As many lines as needed to 
define all the spatial intervals in the sector are used.  The land fraction data for the second and 
subsequent sectors follow in a clockwise rotation.  Data for all direction sectors must be 
provided.  The data for each sector begin on a new line. 
 
The land fraction data are read as a real number and land fractions are input every five 
columns.  The data must be right justified in the five columns allotted to that data point. 
 

Variable 
Name 

Dimensions 
FORTRAN 

Format 
Allowed 
Values 

Description 

FRCLND NUMRAD 
by 

NUMCOR 

816F5.2 0.0 to 1.0 Fraction of sector 
that is land 

 

6.5 Region Index Data Block 
 
In this data block the user assigns a user-defined economic region to each of the spatial 
intervals. The economic regions are defined in the regional economic data block.  The regional 
economic data block  defines the economic data for each economic region.  Data for each 
sector must be provided.  The data for each sector begins on a new line. 
 
The first line in the Region Index data block contains the 22-character separator beginning with 
REGION INDEX in column 2.  The next line contains two-digit integers associating a region 
index with each of the spatial elements in the first sector limiting the region numbers to 99 
possible regions.  For example, a region index of 09 means that economic data for region 
number nine will be used for the spatial element. Though the FORTRAN format, 40I2, supports 
up to forty values per line, the number of values considered on each line will be NUMRAD.  As 
many lines as needed to cover each sector are used, a new line for each sector in a clockwise 
rotation.  For example, when the spatial grid has been divided into 16 sectors, there are a total 
of 16 lines of data. 
 
 The data must be right justified in the two columns allotted to that data point.  The data are 
input as integer, supporting digits only with no decimal component. 
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Variable 
Name 

Dimensions 
FORTRAN 

Format 
Allowed 
Values 

Description 

INDREG NUMRAD 
by 

NUMCOR 

40I2 1 to NECRGN Economic region 
associated with 
sector 

 

6.6 Watershed Index Data Block 
 
Each of the spatial intervals in the grid must be associated with one of the watershed classes.  
The watershed identification data block begins with the 22-character separator beginning with 
WATERSHED INDEX in column 2.  The next line contains two-digit integers associating a 
watershed type with each of the spatial elements in the first sector. Data for all sectors must be 
provided.  The data for each sector begins on a new line.   
 
The next line contains two-digit integers associating a watershed index with each of the spatial 
elements in the first sector. The next line contains two-digit integers associating a watershed 
index with each of the spatial elements in the first sector.  The watershed index data are 
specified.  For example, a watershed index of 1 means that the water ingestion factor for 
watershed type 1 will be used for all material deposited on that spatial element.  A watershed 
index of 2 means that the water ingestion factor for watershed type 2 will be used for all material 
deposited on that spatial element.  Though the FORTRAN format, 40I2, supports up to forty 
values per line, the number of values considered on each line is NUMRAD.  As many lines as 
needed to cover each sector are used, a new line for each sector in a clockwise rotation.  For 
example, when the spatial grid has been divided into 16 sectors, there is a total of 16 lines of 
data. 
 

Variable 
Name 

Dimensions 
FORTRAN 

Format 
Allowed Values Description 

INDWTR NUMRAD 
by 

NUMCOR 

40I2 1 to NUMWPA Watershed index 
associated with 
sector 

 

6.7 Crop and Season Share Data Block 
 
The length of the growing season and the average fraction of the farmland area at the site 
devoted to each crop type must be specified.  These fractions need not sum to exactly 1, but 
their sum should not exceed a value of 1.  When these values sum to a value less than 1, that 
sum indicates the fraction of farmland in production in an average year (some fraction of 
farmland may be fallow).  Data must be given for each of the crop categories.   
 
This information is used only when MACCS Food Model is specified on the Food tab in 
WinMACCS. This data will not be used when the MACCS Food Model is not used, but it still will 
be required. 
 
When MACCS Food Model is specified on the Food tab in WinMACCS, the crop names must 
agree with the variable NAMCRP.  The data block begins with the separator CROP SEASON 
AND SHARE in column 2.  This is followed by NFICRP lines of data. 
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Variable 
Name 

Columns 
FORTRAN 

Format 
Allowed Values Description 

I 1 to 4 I4 1 to NFICRP Crop Index, line 
number starting at 1 

CROP 6 to 25 A20 When the 
MACCS Food 
Model is selected 
in WinMACCS, 
must match with 
a value in vector 
NAMCRP 

Name of crop group. 

GBEG 26 to 30 F5.0 1 to GEND Day of the year the 
growing season 
begins 

GEND 31 to 35 F5.0 GBEG to 365 Day of the year the 
growing season 
ends 

FRCLCP 36 to 45 F10.0 0.0 to 1.0 Fraction of the site-
averaged farmland 
devoted to this Crop 

 

6.8 Watershed Definition Data Block 
 
The data block begins with the 22-character separator beginning with WATERSHED 
DEFINITION in column 2.  For each of the radionuclides considered in the liquid pathways 
model, a single line is supplied.  Exactly NUMWPA ingestion factors are supplied on each line. 
Values supplied will override values of WinMACCS variable WINGF when defined. MACCS 
supports up to 10 radionuclides in the liquid pathway model. 
 
 

Variable 
Name 

Columns 
FORTRAN 

Format 
Allowed Values Description 

I 1 to 4 I4 1 to NWPISO Radionuclide Index, 
line number starting 
at 1 

NMISO 6 to 13 A8 Should match with 
WinMACCS 
variable NAMIPI 
when defined. 
Otherwise, should 
be match with a 
value in vector 
NUCNAM. 

Radionuclide name 

WTRINF(1) 36 to 45 E10.1 0.0 to 1.0 Ingestion Factor for 
Watershed Class 1 

WTRINF(2) 46 to 55 E10.1 0.0 to 1.0 Ingestion Factor for 
Watershed Class 2 

WTRINF(3) 56 to 65 E10.1 0.0 to 1.0 Ingestion Factor for 
Watershed Class 3 

WTRINF(4) 66 to 75 E10.1 0.0 to 1.0 Ingestion Factor for 
Watershed Class 4 
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6.9 Regional Economic Data Block 
 
Economic data must be specified for each of the economic regions.   The data block begins with 
the separator REGIONAL ECONOMIC DATA in column 2.  An economic region is typically 
identified with an existing county, a state, or country to provide an indication of the source of the 
data or the type of geographical area it is intended to represent.  The economic regions defined 
in this section are identified with spatial elements in the Region Index data block.  There is a line 
for each one of the economic regions. 
 

Variable 
Name 

Columns 
FORTRAN 

Format 
Allowed 
Values 

Description 

I 1 to 4 I4 1 to NECRGN Region index, line 
number starting at 1 

NMRGN 6 to 15 A10  Name of region 

FRMFRC 21 to 25 F5.3  
0.0 to 1.0 

Fraction of land 
devoted to farming 

DPF 26 to 30 F5.3 0.0 to 1.0 
 

fraction of farm sales 
resulting from dairy 

ASFP 31 to 40 F10.1 0.0 to 109 

dollars/hectare 
Total annual farm 
sales for the region 

VFRM 41 to 50 F10.1 0.0 to 109 

dollars/hectare 
Farmland property 
value for the region 

VNFRM 51 to 60 F10.1 0.0 to 109 

dollars/person 
Non-farmland 
property value for 
the region 

 

6.10 Sample Site Data File 
 
SECPOP Version: 4.3.0 SVN:2242 FileType: MACCS_Site Project: "Fictitious" Census: 
"C:\Program Files (x86)\SecPop\Census\Census2010.bin" County: "C:\Program Files 
(x86)\SecPop\Census\County2012.dat" 
Lat: 36d11'35'' Long: 115d58'55'' Latitude: 36.193058 Longitude: 115.98194 
Population_multiplier: 1.0 Economic_multiplier: 1.0 Run_Time: 2016/02/04_12:28:56 
  26 SPATIAL INTERVALS 
  16 WIND DIRECTIONS 
   7 CROP CATEGORIES 
   4 WATER PATHWAY ISOTOPES 
   1 WATERSHEDS 
  98 ECONOMIC REGIONS 
 SPATIAL DISTANCES     KILOMETERS 
    0.1600    0.5200    1.2100    1.6100    2.1300    3.2200    4.0200    4.8300 
    5.6300    8.0500   11.2700   16.0900   20.9200   25.7500   32.1900   40.2300 
   48.2800   64.3700   80.4700  112.6500  160.9300  241.1400  321.8700  563.2700 
  804.6700 1609.3400 
 POPULATION 
        0.        0.       44.        3.        9.      198.        0.       12. 
       29.       43.       96.      536.       25.        0.        0.        1. 
        0.        0.        0.        0.        0.       94.      203.    48711. 
   153798.  2143468. 
        0.       13.      235.       61.        0.        8.       35.        5. 
        0.        5.        0.        0.        0.        0.        5.        0. 
        2.      746.        0.        0.     1193.      136.      678.    18438. 
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   949973.   929596. 
        0.        0.        4.        0.       17.       16.        0.        0. 
        0.        0.        0.        0.        0.        0.       10.       82. 
        0.     5237.        0.        0.        3.     3741.     9992.   129062. 
  1669744.   676429. 
        0.        0.        0.       15.        5.       42.        0.        0. 
      148.        0.        0.        0.        0.        0.      212.      220. 
      292.    18068.     8387.        0.     8549.   109552.    93470.    18927. 
   284016.  5256346. 
        0.        7.        0.       57.       73.      327.        0.        0. 
        0.        0.        0.        0.        0.        0.        3.        0. 
      152.   254610.   848885.   365223.      255.     1224.      500.    68862. 
   358505.  2331523. 
        0.        0.      159.       42.       31.      198.      171.      167. 
        0.       97.        5.       11.        0.        0.        0.        0. 
      107.    22919.   211576.   177910.      465.    58248.     2876.   355158. 
   147099.  2542701. 
        0.        0.       50.       15.       72.      298.      288.      303. 
       16.     1266.     1273.       10.        0.        0.        0.        0. 
      609.     1677.      169.      354.      935.    97790.    54566.  4173727. 
  1169129.    20674. 
        0.       29.       46.       79.       66.      283.      148.      130. 
      154.      605.     1963.      316.        2.       10.       45.        0. 
        0.       48.        5.       42.       46.       65.    29179.   203628. 
      106.        0. 
        0.        0.        7.       33.      333.      266.      329.      627. 
      340.     1449.      218.      311.        0.       16.        4.        0. 
        0.        0.        0.      743.       25.    63475.   412494.   199515. 
        0.        0. 
        0.        0.        0.       24.        5.      215.      284.       66. 
       25.      144.        0.        0.        0.        0.        6.        0. 
      137.        0.        0.        0.    10691.   287689.  3724726.  4275018. 
        0.        0. 
        0.       36.        0.        0.       81.      305.      283.      196. 
       46.        0.        0.        0.        0.        5.        0.       31. 
       13.        0.        0.        0.       11.   147077.  6849804.  5136399. 
        0.        0. 
        0.        0.       83.      175.      123.      425.      193.      304. 
      323.      494.       79.        0.        0.        0.        0.        0. 
        0.        0.        0.        0.     2024.    65914.   648666.   647997. 
        0.        0. 
        0.        0.      155.      131.       42.      352.      392.      307. 
      214.      343.     1846.       74.        0.        0.        0.        3. 
        0.        0.        0.       16.       56.      688.   581198.  1608661. 
      652.        0. 
        0.        0.        0.       71.      114.      436.      616.      240. 
      461.     1494.     1536.       42.        9.        0.        0.        0. 
       89.        0.      344.      101.        3.     4595.    31218.  6807141. 
  4594572.     2463. 
        0.        0.       38.       98.      471.       92.      345.      362. 
      320.     1130.     1871.      957.      126.        0.       13.        0. 
       30.     1058.      270.     1002.       28.      330.     1578.   863619. 
   660171.   795687. 
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        0.        0.        5.       60.       80.       18.       67.       33. 
       37.      500.     1571.     1242.       14.        0.        0.      100. 
        7.        0.        0.        0.        4.     2720.     1712.    37428. 
    15288.  9114675. 
 LAND FRACTION 
 0.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 
 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.99 
 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 0.00 0.00 0.00 1.00 1.00 
 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.92 0.99 
 0.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 
 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.98 0.99 0.99 
 0.00 1.00 1.00 1.00 1.00 1.00 0.00 0.00 1.00 0.98 0.93 1.00 1.00 0.00 1.00 1.00 
 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.98 1.00 0.99 
 0.00 0.99 1.00 1.00 1.00 1.00 0.00 0.00 0.00 1.00 0.00 0.00 0.00 0.00 1.00 1.00 
 1.00 1.00 1.00 0.94 0.85 0.99 1.00 1.00 1.00 1.00 
 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 
 1.00 1.00 1.00 1.00 0.98 0.99 1.00 1.00 1.00 1.00 
 0.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 
 1.00 1.00 1.00 1.00 0.98 0.99 0.99 1.00 1.00 1.00 
 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 
 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 
 0.00 0.00 1.00 1.00 0.99 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 
 1.00 1.00 1.00 1.00 1.00 1.00 0.94 0.96 0.00 0.00 
 0.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 1.00 0.00 0.00 1.00 1.00 
 1.00 1.00 1.00 1.00 1.00 1.00 0.99 0.80 0.00 0.00 
 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 1.00 1.00 0.00 1.00 1.00 1.00 
 1.00 1.00 1.00 1.00 1.00 1.00 0.99 0.62 0.00 0.00 
 0.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 0.00 1.00 1.00 
 1.00 1.00 1.00 1.00 0.98 0.99 1.00 0.87 0.00 0.00 
 0.00 0.00 1.00 1.00 1.00 0.99 1.00 1.00 1.00 1.00 1.00 1.00 0.00 0.00 1.00 0.99 
 1.00 1.00 0.99 1.00 1.00 0.99 1.00 0.94 0.40 0.00 
 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 
 1.00 0.99 1.00 0.99 1.00 1.00 0.98 0.98 0.88 0.69 
 0.00 0.00 1.00 1.00 0.99 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 
 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.96 0.98 0.94 
 0.00 0.00 1.00 0.98 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.98 1.00 1.00 
 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.99 0.98 0.95 
 REGION INDEX 
 1 3 4 4 4 4 4 4 4 4 4 4 4 4 4 4 5 4 6 7 8 910828298 
 1 4 4 4 4 4 4 4 4 4 3 3 3 3111213131415161718838398 
 1 3 4 4 4 4 4 4 3 4 4191313131313131320212223848498 
 1 4 4 4 4 4 3 3 4 4241313 3131313131313252627858598 
 1 4 4 4 4 4 3 3 3 4 3 3 3 3131313131313282930868698 
 1 4 4 4 4 4 4 4 3 4 4 41313131313131313313233878798 
 1 3 4 4 4 4 4 4 4 4 4 43413131313353637383940888898 
 1 4 4 4 4 4 4 4 4 4 4 441424344454647474747488989 3 
 1 3 4 4 4 4 4 4 4 4 449505050505147474747525390 3 3 
 1 3 4 4 4 4 4 4 4 4 350 3 350505455474747475691 3 3 
 1 4 4 4 4 4 4 4 4 35750 35050505058474747596092 3 3 
 1 3 4 4 4 4 4 4 4 46162 3 350505050506364656693 3 3 
 1 3 4 4 4 4 4 4 4 4 467 3 35050505050505068699494 3 
 1 4 4 4 4 4 4 4 4 4 4 4 4 4 47071725050507374959598 
 1 3 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 47576777879969698 
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 1 3 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 48081979798 
 WATERSHED INDEX 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
 CROP SEASON AND SHARE 
   1 PASTURE               90. 270.  0.4100 
   2 STORED FORAGE        150. 240.  0.1300 
   3 GRAINS               150. 240.  0.2100 
   4 GRN LEAFY VEGETABLES 150. 240.  0.0020 
   5 OTHER FOOD CROPS     150. 240.  0.0040 
   6 LEGUMES AND SEEDS    150. 240.  0.1500 
   7 ROOTS AND TUBERS     150. 240.  0.0030 
 WATERSHED DEFINITION  -- INITIAL AND ANNUAL WASHOFF AND INGESTION 
FACTORS 
   1 Sr-89                           5.00E-06       0.0 
   2 Sr-90                           5.00E-06       0.0 
   3 Cs-134                          5.00E-06       0.0 
   4 Cs-137                          5.00E-06       0.0 
 REGIONAL ECONOMIC DATA 
   1 EXCLUSION       .000 .000        .0        .0        .0 
   2 EMPTY02         .000 .000        .0        .0        .0 
   3 EMPTY03         .000 .000        .0        .0        .0 
   4 Nye04           .006 .000    2675.0    5531.0  325945.0 
   5 MIX_CNTY05      .006 .000    2635.1    5745.5        .0 
   6 MIX_CNTY06      .005 .000    2589.3    5791.5        .0 
   7 MIX_CNTY07      .004 .000    2075.2    4290.7        .0 
   8 MIX_CNTY08      .003 .000    1497.8    3096.9        .0 
   9 MIX_CNTY09      .004 .000    2099.9    4341.8  278872.3 
  10 MIX_CNTY10      .005 .000    2511.3    5331.2  325945.0 
  11 MIX_CNTY11      .003 .000    1080.0   14111.0  359500.0 
  12 MIX_CNTY12      .005 .000    2150.7    8351.3        .0 
  13 Clark13         .003 .000    1080.0   14111.0  359500.0 
  14 MIX_CNTY14      .003 .000    1079.9   14110.3        .0 
  15 MIX_CNTY15      .000 .000       2.7      35.0        .0 
  16 Lincoln16       .000 .000        .0        .0  261817.0 
  17 MIX_CNTY17      .001 .000     617.0    1275.7  261817.0 
  18 MIX_CNTY18      .002 .001     486.8    1620.2  368899.1 
  19 MIX_CNTY19      .004 .000    1681.0   10878.0        .0 
  20 MIX_CNTY20      .003 .000    1017.4   13293.0        .0 
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  21 MIX_CNTY21      .000 .000      34.2     447.5  261817.0 
  22 MIX_CNTY22      .014 .005      32.5    1235.3  262068.2 
  23 MIX_CNTY23      .172 .133    1195.1    4544.1  254878.7 
  24 MIX_CNTY24      .003 .000    1080.0   14111.0        .0 
  25 MIX_CNTY25      .002 .000     831.6   10865.9  359500.0 
  26 MIX_CNTY26      .094 .006     217.8   40749.5  291911.2 
  27 MIX_CNTY27      .131 .037     192.5   37899.7  270410.3 
  28 MIX_CNTY28      .059 .000     679.8   39357.5  330392.3 
  29 MIX_CNTY29      .128 .000     190.1   70249.3  261836.0 
  30 MIX_CNTY30      .376 .000      27.0  309321.1  334469.2 
  31 MIX_CNTY31      .104 .000     356.6   59747.0  272337.5 
  32 Mohave32        .146 .000      60.0   78456.0  261836.0 
  33 MIX_CNTY33      .241 .000      79.6  155479.9  287032.1 
  34 MIX_CNTY34      .004 .000    1448.4   12129.4        .0 
  35 MIX_CNTY35      .004 .051    2397.4   15520.1  359002.3 
  36 MIX_CNTY36      .004 .108    3908.4   17345.3  359500.0 
  37 MIX_CNTY37      .004 .179    5776.0   19480.8  354342.9 
  38 MIX_CNTY38      .014 .249    7537.0   26199.0  358495.8 
  39 MIX_CNTY39      .095 .214    6035.3   61683.1  271843.2 
  40 MIX_CNTY40      .093 .054    1542.5   51014.8  269887.5 
  41 MIX_CNTY41      .007 .000    2615.5    5468.3  325945.0 
  42 MIX_CNTY42      .025 .000    1504.1    4919.9  374168.5 
  43 MIX_CNTY43      .038 .000     445.0    5605.8  418105.5 
  44 MIX_CNTY44      .048 .000     201.4    3532.4        .0 
  45 MIX_CNTY45      .039 .180    5128.1   11304.4        .0 
  46 MIX_CNTY46      .007 .659   18361.4   33720.8  307340.0 
  47 San_Bern47      .006 .669   18636.0   34186.0  307340.0 
  48 MIX_CNTY48      .054 .174    7152.4   21712.8  310148.9 
  49 MIX_CNTY49      .023 .000    1673.8    4475.6  325945.0 
  50 Inyo50          .051 .000     146.0    2865.0  422392.0 
  51 MIX_CNTY51      .046 .075    2224.9    6386.5        .0 
  52 MIX_CNTY52      .006 .666   18571.0   34139.4  307340.3 
  53 MIX_CNTY53      .085 .133    7674.7   27115.0  311830.5 
  54 MIX_CNTY54      .042 .135    3873.5    9179.2  422392.0 
  55 MIX_CNTY55      .036 .222    6286.0   13265.8        .0 
  56 MIX_CNTY56      .061 .274   10340.4   31195.3  342463.5 
  57 MIX_CNTY57      .018 .000    2004.4    4824.1        .0 
  58 MIX_CNTY58      .048 .036    1148.5    4563.2        .0 
  59 MIX_CNTY59      .121 .468   13731.4   28287.7  310216.5 
  60 MIX_CNTY60      .057 .045    6120.4   31832.6  443771.9 
  61 MIX_CNTY61      .006 .000    2647.9    5502.4  325945.0 
  62 MIX_CNTY62      .050 .000     199.0    2920.9        .0 
  63 MIX_CNTY63      .035 .240    6793.3   14125.2        .0 
  64 MIX_CNTY64      .029 .453   12671.0   24123.4  312914.7 
  65 MIX_CNTY65      .413 .157    5060.7   13126.1  336839.9 
  66 MIX_CNTY66      .424 .115    4527.7   13533.2  337157.7 
  67 MIX_CNTY67      .024 .000    1637.8    4437.6  365045.1 
  68 MIX_CNTY68      .269 .277    5042.5   13256.6  376652.8 
  69 MIX_CNTY69      .417 .392    7587.6   18887.0  311376.9 
  70 MIX_CNTY70      .009 .000    2478.8    5324.2        .0 
  71 MIX_CNTY71      .049 .000     229.4    2952.9  327028.7 
  72 MIX_CNTY72      .049 .000     228.0    2951.4        .0 
  73 MIX_CNTY73      .094 .044    1067.0    4921.6  422392.0 
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  74 MIX_CNTY74      .343 .070    5391.2   17111.6  394223.3 
  75 MIX_CNTY75      .006 .000    2674.4    5530.4  325945.0 
  76 MIX_CNTY76      .007 .000    2602.8    5454.9  325945.0 
  77 MIX_CNTY77      .018 .000    1903.3    4775.2  332834.1 
  78 MIX_CNTY78      .024 .000     802.5    4269.0  447628.5 
  79 MIX_CNTY79      .015 .000     584.1    4300.2  408604.4 
  80 MIX_CNTY80      .007 .000    2469.8    5429.5  339779.0 
  81 MIX_CNTY81      .006 .000    2338.6    5144.8  325945.0 
  82 MIX_CNTY82      .183 .126     916.5    3266.3  358653.5 
  83 MIX_CNTY83      .240 .114     794.5    4224.6  333545.4 
  84 MIX_CNTY84      .207 .091     571.4    4251.9  358974.7 
  85 MIX_CNTY85      .162 .008     260.7   13629.7  341927.2 
  86 MIX_CNTY86      .500 .010      34.1  183740.1  303938.2 
  87 MIX_CNTY87      .334 .012     167.6  145198.8  299802.0 
  88 MIX_CNTY88      .152 .149    1830.4   35440.3  364356.0 
  89 MIX_CNTY89      .070 .006    7822.9   10749.2  259639.5 
  90 MIX_CNTY90      .140 .019    8597.2   31095.0  330385.6 
  91 MIX_CNTY91      .086 .038    7810.2   45764.2  494904.5 
  92 MIX_CNTY92      .159 .000    8860.2   35902.6  453981.2 
  93 MIX_CNTY93      .458 .022    4370.8   18134.3  456231.0 
  94 MIX_CNTY94      .576 .076    5302.3   15582.4  400578.5 
  95 MIX_CNTY95      .472 .094    3086.1   18982.9  528965.4 
  96 MIX_CNTY96      .175 .023     676.9    8584.3  405306.7 
  97 MIX_CNTY97      .125 .046     533.9    3165.3  400316.2 
  98 MIX_CNTY98      .601 .039     626.9    4428.2  412895.8 
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7. METEOROLOGICAL FILE FORMAT 
 

7.1 Format Overview 
 
When running WinMACCS, a weather model is selected using the Weather tab.  When one of 
the file sampling method models is picked, a meteorological file needs to be supplied. 
 
WinMACCS supports data in this file.  Data may be recorded for one year.  The file consists of 
up to ten years of either fifteen-minute, thirty-minute or hourly averages of the wind direction, 
wind speed, atmospheric stability, and precipitation rate.  Each line of the file will have a wind 
direction, wind speed, atmospheric stability, and accumulated precipitation.  Generally, the data 
are taken from either the facility site or from a nearby weather station. 
 
The meteorological data file used is a formatted text file.   
 
The first two records contain identification information.  Up to 80 characters may be used on 
each line.  This header information is printed on the output listing.   
 

Line in Met 
file 

FORTRAN 
Format 

Allowed 
Values 

Description 

1 A80  File identifying information.  Should 
contain quality assurance 
information. 

2 A80  Continuation of file identifying 
information. 

 
The default recording interval for the weather data are every hour. When 30 minutes or 15 
minutes information is used, the next line is required.  When this line is omitted in the 
meteorological file, a value of 60 minutes is assumed. 
 

Columns 
FORTRAN 

Format 
Allowed 
Values 

Description 

1 to 7 A7 /PERIOD Keyword that identifies line 

9-10 I2 60, 30 or 15 Number of minutes between each 
recorded value on the file 

 

This is followed by a line for each time recorded.  There will be 8760 lines of information when 
the time period is set to 60 minutes. When the time period is 30, there are 17520 lines of 
weather data in the file; when the time period is 15, there are 35040 lines of weather data in the 
file.   
 
The possible values for the variable WINDIR will depend on the WinMACCS variable NUMCOR.  
WinMACCS and MACCS allow NUMCOR to be 16, 32, 48 or 64. This needs to be consistent 
with NUMCOR written on the site data file when used in the calculation.  In other words, when 
the site data file value for NUMCOR is 16, the possible values for variable WINDIR is 1 to 16, 
and the value of NUMCOR used in WinMACCS should be set to 16.   It is up to the user to 
select or create a meteorological file that is consistent with the value of NUMCOR used in 
MACCS.  When this is not done, there will be no error messages, but the results reported from 
MACCS will be wrong. 
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Columns 
FORTRAN 

Format 
Variable 

Allowed 
Values 

Description 

2 to 4 I3 ISTRDY 1 to 365 Julian day of the year 

6 to 7 I2 ISTRHR 1 to 24 Hour of the day 

9 to 10 I2 WINDIR 1 to 
NUMCOR 

Direction of wind, where 1 is 
north, proceed clockwise to 
NNW 

11 to 13 I3 WINDSPD 1 to 300* 10ths of a meter per second 

14 I1 ISTAB 1 to 7** Stability Category, 
corresponds to Pasquill 
stability class A through G 

15 to 17 I3 RNMM -1 to 999*** Rain rate in hundredths of an 
inch per hour 

  
*  Values between 1 and 4 are automatically changed to 5 (0.5 m/s). 
**  A value of 7 is automatically changed to 6 by the code. 
*** Some meteorological data files use –1 to indicate a trace of precipitation during the hour.  
 MACCS assumes these values to be 0. 
 
Following this is a table of eight values of mixing layer height.  Two values of mixing height are 
supplied for each of the four seasons of the year.  The first of these two values corresponds to 
the morning mixing height and the second to the afternoon height.  
 
The FORTRAN edit descriptor for this data is F10.0. This means that the input field is ten 
characters long and right justified. To prevent errors due to right justification of data, it is 
recommended that a decimal point is used. When desired, an exponential portion of the field is 
indicated using the letter E as in 1.4E4.  Any real number within the allowed values (including 
fractional values for meters) is allowed.  
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Columns 
FORTRAN 

Format 
Variable 

Allowed 
Values 

Description 

1 to 10 F10.0 HEIGHT(1,1) 1 to 100 
hundreds 
of meters  

Morning-winter mixing height 

11 to 20 F10.0 HEIGHT(2,1) 1 to 100 
hundreds 
of meters 

Morning-spring mixing height 

21 to 30 F10.0 HEIGHT(3,1) 1 to 100 
hundreds 
of meters 

Morning-summer mixing height 

31 to 40 F10.0 HEIGHT(4,1) 1 to 100 
hundreds 
of meters 

Morning-autumn mixing height 

41 to 50 F10.0 HEIGHT(1,2) 1 to 100 
hundreds 
of meters 

Afternoon-winter mixing height 

51 to 60 F10.0 HEIGHT(2,2) 1 to 100 
hundreds 
of meters 

Afternoon-spring mixing height 

61 to 70 F10.0 HEIGHT(3,2) 1 to 100 
hundreds 
of meters 

Afternoon-summer mixing height 

71 to 80 F10.0 HEIGHT(4,2) 1 to 100 
hundreds 
of meters 

Afternoon-autumn mixing height 

 

7.2 Sample Meteorological Data File 
 
A sample set of records from the meteorological data file is provided, which shows the first and 
last ten records of the file.  NUMCOR is assumed to be 16. In this example, the weather 
conditions for day one, hour one (record number three) are: wind direction—blowing toward the 
SE, wind speed of 2.6 m/s, stability 4 (category D), and accumulated precipitation of 0.07 inches 
(1.8 mm) in the hour.  The winter, spring, summer, and autumn mixing heights for neutral and 
unstable conditions (record 8763) are all 1200 m. 
 
U.S. NATIONAL WEATHER SERVICE METEOROLOGICAL DATA FILE 
Sample Input for the MACCS Documentation 
 1    1  70264  7 
 1    2  60624  7 
 1    3  80414  2 
 1    4  80364 -1 
 1    5  90314  0 
 1    6 110464  0 
 1    7 110264 -1 
 1    8 110414 -1 
 . 
 . 
 . 
 365 16 120154  4 
 365 17 110154  4 
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 365 18 130214  4 
 365 19 130154  3 
 365 20 130104  2 
 365 21 130154  2 
 365 22 140104  2 
 365 23 130104  2 
 365 24 140104  2 
       12.       12.       12.       12.        12        12        12        12 
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8. DOSE CONVERSION FACTOR FILE 
 

8.1 Introduction 
 
WinMACCS is supplied with a set of 51 “adult” dose factor files which are based on the CD 
supplement to Federal Guidance Report 13 (EPA 2002).  Data for 825 isotopes are provided.  
This dose factor file set supports WinMACCS calculations using the linear no threshold, annual 
threshold, and piecewise linear dose-response models for latent cancer health effects and the 
acute health effects model.   
 
These dose factors use ICRP publication 60 (ICRP 1991) tissue weighting and the respiratory 
tract model defined in ICRP-publication 66 (ICRP 1994).  Federal Guidance Report 13 dose 
factors are generally similar to those published in ICRP publication 72 (1996), but they 
incorporate modifications to ICRP publication 72 assumptions that were agreed to by the U. S. 
Environmental Protection Agency and the ORNL Center for Biokinetic and Dosimetric Research.  
Minor differences between Federal Guidance Report 13 and ICRP publication 72 dose 
coefficients are largely attributable to differences in:   
 
1. Assumptions of shared kinetics in some decay chains 
2. Systemic biokinetic models for some elements, and  
3. Gastrointestinal tract absorption-to-blood fractions, f1.   

8.2 Lung Clearance Behavior 
 
With few exceptions, the absorption types are consistent with those used in the current dose 
factor files. The dose factor files do not show an absorption type for certain isotopes when either 
there was no choice of clearance type in Federal Guidance Report 13, or the choice was 
superfluous because the inhalation dose coefficients were zero. 
 

8.3 Gastrointestinal Tract Uptake Fraction, f1 
 
Federal Guidance Report 13 assigned f1 values for uptake of elements from the digestive tract 
via the ingestion pathway based on the chemical form expected to be encountered in the 
environment, and these values were not necessarily consistent with the f1 values used in the 
computation of inhalation dose coefficients.  There were choices of f1 to be made for only four 
elements: hydrogen, sulfur, mercury, and polonium.  The ingestion dose coefficient for tritium 
was based on tritiated water (HTO).  Sulfur, mercury, and polonium isotopes were assigned 
ingestion dose coefficient based on the form and f1 that gave the highest dose.   
 

8.4 Particle Size Distribution 
 
Inhalation dose coefficients for micron sized particles depend on the activity median 
aerodynamic diameter (AMAD).  The Federal Guidance Report 13 inhalation dose factors are 
based on an AMAD of 1 μm.  
 

8.5 Organs Included in Data Set 
 
The following organs and tissues are included in the Federal Guidance Report 13 dose factor 
files.   
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Organs with annual and 50-year 
equivalent dose commitment 

coefficients 

Organs with acute dose 
commitment coefficients 

Adrenals  

Urinary Bladder Wall  

Bone Surface  

Brain  

Breasts  

Stomach Wall Stomach Wall 

Small Intestine Wall Small Intestine Wall 

Upper Large Intestine Wall (ULI)  

Lower Large Intestine Wall (LLI) Lower Large Intestine Wall 

Kidneys  

Liver  

Esophagus  

Muscle  

Ovaries  

Pancreas  

Red Marrow Red Marrow 

Skin  

Spleen  

Testes  

Thymus  

Thyroid Thyroid 

Uterus  

Lungs Lungs 

Colon  

Gonads  

Remainder  

Effective  

 

8.6 Annual and 50-year Equivalent Dose Commitment Factors 
 
The annual and 50-year dose commitment factors are intended for stochastic health effect 
(cancer and heritable effect) estimation, so they include a radiation weighting factor of 20 for the 
high linear energy transfer (LET) contributions to these dose coefficients.  
 

8.7 Calculating Annual and 50-Year Dose Commitment Factors for 
“Composite Organs” 

 
Dose factors for composite organs were calculated from dose factors for the underlying tissues 
or organs as follows: 
 
1. The esophagus was assigned the corresponding inhalation dose coefficients and 

ingestion dose coefficients of the thymus.  
2. Inhalation and ingestion dose coefficients for the colon were calculated as a weighted 

sum of the dose coefficients for upper large intestine (57%) and lower large intestine 
(43%)  

3. The inhalation and ingestion dose coefficients for the lung (thoracic portion of respiratory 
tract) and ETReg (the extra-thoracic region of the respiratory tract) were calculated using 
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equations on page 35 of ICRP publication 66. The lung coefficient is the weighted sum 
of the coefficients for the several respiratory tract tissues.  

4. The dose coefficients for remainder were calculated using equations on ICRP 
publication 71 (ICRP 1995) page 27.  

5. The dose coefficients for gonads were the larger of the dose coefficients for testes and 
ovaries. 

6. The dose coefficients for effective were computed from the individual organ dose 
coefficients using the ICRP 60 tissue weighting method. 

 

8.8 Acute Inhalation Dose Factors 
 
Reliable data on relative biological effectiveness, RBE, of high LET radiation at causing acute 
health effects were not available; so the acute inhalation dose factors were based on an RBE of 
10 for consistency with DOSFAC2 dose factor files.   
 
Next, the resulting acute dose coefficients DCF[i, at, org, cp] were weighted by acute dose 
protraction factors, WTFRAC[cp,org], and summed to obtain adjusted acute dose coefficients, 
DCF[i, at, org].  Here, i represents an isotope, at represents absorption type (equivalent to lung 
clearance class), org represents an organ, and cp represents a commitment period. The values 
of WTFRAC[cp, org] that were used are given in the DOSFAC2 Users Manual (Young and 
Chanin, 1997).  
 

8.9 Designating Pseudo-Stable Isotopes When Using Federal 
Guidance Report 13 Dose Factor Files 

 
In contrast to DOSFAC2 and FGRDCF dose factor files, Federal Guidance Report 13 dose 
factors make no assumptions about the degree of equilibrium within decay chains for 
radioactive materials in the environment or for intakes of radioactive materials from the 
environment. Consequently, one must be mindful about specifying both parent and the 
corresponding progeny that are released or form as decay products in the environment via the 
WinMACCS “Radionuclide Core Inventory and Chemical Group” window.  For long decay 
chains, such as uranium-238, the sixth member of the chain (thorium-230 for example) must be 
identified as pseudo-stable. When the pseudo-stable isotope conventions commonly observed 
for DOSFAC2 or FGRDCF dose factor files are used with Federal Guidance Report 13 dose 
factor files, doses and health effects may be significantly underestimated. For example, Ba-
137m must be listed as a pseudostable isotope when using a DOSFAC2 dose factor file 
because it’s dose is included implicitly with Cs-137. With the FGR-13 dose factor file, including 
Ba-137m as a pseudostable isotope could lead to a significant under-prediction of overall dose. 
 

8.10 Known Issues 
 
The FGR-13 dose factor files have inherited the following issues from the CD Supplement to 
FGR-13: 
 
1. The ingestion and inhalation dose coefficients for four alpha-emitting rare-earth isotopes 

(Sm-146, Sm-147, Gd-148, and Gd-152) are incorrect.  
2. The ingestion and inhalation dose coefficients for four isotopes having significant 

spontaneous fission decay modes (Cm-248, Cm-250, Cf-252, and Cf-254) are listed as 
zero. 
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9. CYCLICAL FILE FORMAT 
 
It is possible to run successive MACCS simulations without using LHS. Model values can be 
varied using successive MACCS input files.  This feature is enabled in WinMACCS through the 
Project Properties form setting on the Scope tab.  The files are selected and copied into the 
WinMACCS project after the user completes the form GENERAL/File Specifications/Cyclical 
File Set.   
 
When the user clicks the Run button to begin a simulation, WinMACCS reads a cyclical file, and 
imports the values temporarily into the project using the algorithm identical to the File→Import 
MACCS Input File option on the main menu.  WinMACCS creates the MACCS template input 
files.  The template input files are identical to the MACCS input files when LHS is not 
incorporated into the simulation.  
 
The format required for the cyclical input files is identical to the input format required for MACCS 
with the following exceptions: 
 

1. ATMOS, EARLY, CHRONC and COMIDA2 model input are grouped together in a single 

cyclical input file.  When MACCS was run directly, input for these models is placed in 

separate files. 

2. The period in column one is used to separate EARLY evacuation scenarios. The first 

evacuation scenario occurs before the first period in column one. On the other hand, 

MACCS supports a period in column one in the ATMOS input to separate different source 

terms, a period in column one in the EARLY input to separate different evacuation 

scenarios, and a period at the end of each input file to indicate the end of the file.  

3. It is not necessary to end the file with a period in column one. 

4. MACCS has evolved since 1.13.1, and though cyclical file input is backward compatible, 

new model options and hence new input has been added. 

The MACCS file format is not documented in detail here.  However, note the following rules: 
 

1. An asterisk (*) in column one signifies a comment 

2. Multiple values on an input line can be separated by any amount of white space, 

including TAB characters 

3. An input line begins with a prefix.  Depending on the input line, this is followed by a two or 

three digit sequence number, or no sequence number. The value(s) of the variable(s) 

follow separated by white space.  The situation will be obvious when viewing a MACCS 

input file.  For example, the following line is a valid MACCS input file line with a three digit 

sequence number and the prefix “RDPDELAY” 

   RDPDELAY001 3700. 
 
Cyclical input files can be created in a number of ways as follows: 
 
1. Modify a MACCS file to reflect the changes desired.  As a starting point, use a file 

created by WinMACCS such as Atmos1.inp, Early1.inp, etc. 
2. Include only relevant changes between the simulations in a cyclical input file.  As a 

starting point, edit a file created by WinMACCS, removing data that will not be changed 
between cyclical runs. 

3. Use a file created by MelMACCS when the basis of the cyclical input file is a varying 
source term created by the MELCOR modeling code. 
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The easiest way to determine the proper format of a cyclical input card is to run a simulation 
with the MACCS Cyclical File Set option in the Project Properties form, Scope tab, set to OFF.  
Open the MACCS input file (Atmos1.inp, Early1.inp, Chronc1.inp or Comida1.inp) in the project 
Input folder , and copy the relevant lines into the cyclical input file.   
 
For example, to find the variable PDELAY in the MACCS input file, as referenced in the 
WinMACCS interface, search for the string PDELAY in the Atmos1.txt file.  This will be found in 
a comment immediately preceding the MACCS input lines responsible for setting the value of 
PDELAY in MACCS to as shown in the following excerpt from atmosTemplate.txt: 
 

* PDELAY, time of release for each plume from xxxx (sec) 
RDPDELAY001 3700. 
RDPDELAY002 10000. 
 

These lines can be copied into a new cyclical input file created in Notepad.  Do not create the 
cyclical input file in a word processor such as Word. 
 

1. The order of the lines is not important, however include all lines relevant to a variable.  In 

the above example, when the second line is omitted, PDELAY is set to be a vector of 

length one. 

2. Blank lines are allowed.   

3. Sections are separated by a line containing a period in column one. 

4. Each emergency evacuation scenario is in a separate section. 

The following is a sample cyclical file.  Notice that there are ATMOS, EARLY and CHRONC 
variables in the first section.  The second section, separated from the first section with a period 
in column one, contains EARLY emergency scenario two input.  

 
* CWASH1, Washout Coefficient Number One, Linear Factor 
WDCWASH1001 9.7x10-5 

 
* WTFRAC - weighting fraction applied to EARLYemergency response scenario one 
EZWTFRAC001 .90 
 
* EXPTIM - long term exposure period, CHRONC variable 
CHEXPTIM001 9.7x108 

. 
* WTFRAC - weighting fraction applied to EARLY emergency response scenario two 
EZWTFRAC001 .1 
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10. MACCS BINARY FILE FORMAT 
 

10.1 Binary File Overview 
 
With the WinMACCS development, it became necessary to create a file for easy communication 
of results between the MACCS modeling engine and the WinMACCS interface. All that existed 
at the point of MACCS 1.12 was an ASCII formatted output file. The information on this file did 
not have sufficient structure to serve as a generic output file. It was believed to be an 
unreasonable constraint to require the MACCS ASCII output file to always comply with a format 
that WinMACCS could automatically process. In a development environment, output files often 
change formats. It was decided that there would be a separate file created by MACCS that 
would provide a better interface between MACCS and WinMACCS with the design criteria 
discussed below. 
 
The binary file created by MACCS is a separate file that serves as the interface between 
MACCS and WinMACCS.  The real and integer representations of the results are consistent 
with the values used by MACCS reflecting the accuracy of the calculated results without the 
round off caused by formatted write statements used to create the readable MACCS output 
files.  
 
If the MACCS developer adds new variables to the file in a later version of MACCS, WinMACCS 
does not have to be modified to display the new data.  
 
The binary file supports multivariate data. For example, Centerline Ground Concentration is 
associated with the plume number, a radionuclide and a position on the spatial grid. 
 

10.2 Mulitvariate Support 
 
MACCS data are multivariate data. Each variable written to the binary file is associated a set of 
qualifiers.  Qualifier can have one of three data types, character, 4-byte integer and 4-byte real. 
The qualifier “MACCS2_Input” is not an additional dimension to the variable, but is used 
internally by WinMACCS to identify the source of the variable request. The qualifier units are 
determined by the MACCS input.   
 
New qualifiers can be defined without impacting the file processing in WinMACCS.  A list of 
possible qualifiers and the possible units supported is shown in Table 10-1. 
 

Table 10-1  Qualifiers associated with variables. 

Qualifier Units Data type Example value 

Nuclide none character Co-60 

Ldistance km, mi real 5.3 

Rdistance km, mi  real 6.5 

Distance km, mi  real 6.6 

Plume none integer 3 

Evacuation none integer 1 

Health Effect none character ERL INJ/PRODROMAL 
VOMIT 

Exceeds Risk none real 5.6 

Organ none character A-LUNGS 
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Qualifier Units Data type Example value 

Exceeds Dose Sv, 
rem 

real 5.2 

Source Term none integer 1 

Angle none character ENE 

Pathway none character GRD 

Elevation Dose Sv, 
rem 

real 10. 

Elevation Concentrat Bq/m2, 
Ci/m2 

real 4.2 

MACCS2_Input none not 
applicable 

TYPE1OUT001 ‘ERL 
FAT/TOTAL' 1 26 NONE 

Time S real 60 

 
 

10.3 Data available on the binary file 
 
The available variables are determined by the input to MACCS.  Output requests to MACCS are 
organized by an output type and details regarding the output request.  For example, the 
following EARLY input card results in a type1 output request of the total early fatalities between 
spatial intervals 1 to 26. 
 

TYPE1OUT001 'ERL FAT/TOTAL' 1 26 NONE  
 
The number of variables associated with this particular calculation request is one, namely 
Health Effects. 
 
What follows in is a description of the results written to the binary file.  Results written depend 
on the output requests made in WinMACCS, however the output requests determine the results 
that MACCS calculate. Some results are available in different units depending on the ATMOS 
input, however the results are available in only of the units listed for any run. 
 
The data available for each of the variables are statistics as shown in Table 10-2 and the CCDF 
of the data stored in a binned form consistent with the MACCS output file. 
 

Table 10-2  Statistics written to the binary file. 

StatID StatLab 

1 Probability Non-zero  

2 Mean  

3 50th Quantile  

4 90th Quantile  

5 95th Quantile  

6 99th Quantile  

7 99.5th Quantile  

8 Peak Concentration  

9 Peak Probability  

10 Peak Trial  

 
The possible variables are shown in Table 10-3. 
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Table 10-3  Binary file results records. 

VarLab Comments Qualifiers Units 

Release 
 
 

This output is always 
included. There are 
entries for each 
isotope (1 to 
NUMISO), for each 
plume release, and 
for each ATMOS 
change set (or source 
term) 

Source Term 
Plume 
Nuclide 

Bq,  
Ci 

Centerline Air 
Concentration 
 
 

Type 0 output Source Term 
Plume 
Nuclide 
Ldistance 
Rdistance 
MACCS_Input 

Bq-s/m3,  
Ci-s/m3 

Ground-Level Air 
Concentration 
 

Type 0 output Source Term 
Plume 
Nuclide 
Ldistance 
Rdistance 
MACCS_Input 

Bq-s/m3, 
Ci-s/m3 

Centerline Ground 
Concentration 
 

Type 0 output Source Term 
Plume 
Nuclide 
Ldistance 
Rdistance 
MACCS_Input 

Bq/m2, 
Ci/m2 

Total Centerline Ground 
Concentration 
 

Type 0 output Source Term 
Plume 
Nuclide 
Ldistance 
Rdistance 
MACCS_Input 

Bq/m2, 
Ci/m2 

Ground-Level Chi/Q Type 0 output Source Term 
Plume 
Nuclide 
Ldistance 
Rdistance 
MACCS_Input 

s/m3 

Adjusted Source Strength Type 0 output Source Term 
Plume 
Nuclide 
Ldistance 
Rdistance 
MACCS_Input 

Bq, 
Ci 
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VarLab Comments Qualifiers Units 

Plume Crosswind 
Dispersion 
 

Type 0 output Source Term 
Plume 
Nuclide 
Ldistance 
Rdistance 
MACCS_Input 

m 

Plume Vertical 
Dispersion 
 

Type 0 output Source Term 
Plume 
Nuclide 
Ldistance 
Rdistance 
MACCS_Input 

m 

Plume Centerline Height 
 

Type 0 output Source Term 
Plume 
Nuclide 
Ldistance 
Rdistance 
MACCS_Input 

m 

Plume Arrival Time Type 0 output Source Term 
Plume 
Nuclide 
Ldistance 
Rdistance 
MACCS_Input 

s 
 

Health-Effect Cases Type 1 output Source Term 
Evacuation 
Health Effect 
Ldistance 
Rdistance 
MACCS_Input 

none 

Health Effects LNT 
Adjusted Population 
Dose 

Type 1 output 
Note: This output is 
only printed when the 
Threshold or 
Piecewise model is 
used 

Source Term 
Evacuation 
Health Effect 
Ldistance 
Rdistance 
Organ 
MACCS_Input 

Sv, 
rem 

Health Effects Used 
Adjusted Population 
Dose 

Type1 output 
Note: This output is 
only printed when the 
Threshold or 
Piecewise model is 
used 

Source Term 
Evacuation 
Health Effect 
Ldistance 
Rdistance 
Organ 
MACCS_Input 

Sv, 
rem 

Early Fatality Radius Type 2 output Source Term 
Evacuation 
Exceeds Risk 
MACCS_Input 

km, 
mi 
 



10-5 

VarLab Comments Qualifiers Units 

Population Exceeding 
Threshold 

Type 3 output Source Term 
Evacuation 
Organ 
Exceeds Dose 
MACCS_Input 

none 

Average Individual Risk Type 4 output Source Term 
Evacuation 
Health Effect 
Ldistance 
Rdistance 
MACCS_Input 

none 

Population Dose Type 5 output Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

Sv, 
rem 

Centerline Dose Type 6 output Source Term 
Evacuation 
Organ 
Pathway 
Ldistance 
Rdistance 
MACCS_Input 

Sv, 
rem 

Centerline Risk 
 

Type 7 output Source Term 
Evacuation 
Health Effect 
Ldistance 
Rdistance 
MACCS_Input 

none 

Population-Weighted 
Risk 

Type 8 output Source Term 
Evacuation 
Health Effect 
Ldistance 
Rdistance 
MACCS_Input 

none 

Peak dose 
 

Type A output Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

Sv, 
rem 

Peak dose Polar 
 

Type B results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
Angle 
MACCS_Input 

Sv, 
rem 
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VarLab Comments Qualifiers Units 

Dose by Grid Element Type C results Source Term 
Evacuation 
Organ 
Angle 
Ldistance 
Rdistance 
MACCS_Input 

Sv, 
rem 

Area that Exceeds Dose 
Threshold 

Type C results Source Term 
Evacuation 
Elevation Dose 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

Ha, 
km2, 
mi2 

Ground Concentration by 
Grid Element 
****here*** 

Type D output Source Term 
Evacuation 
Nuclide 
Angle 
Ldistance 
Rdistance 
MACCS_Input 

Bq/m2 

Early Ground Conc Area 
That Exceeds Threshold 
 

Type D output Source Term 
Evacuation 
Elevation 
Concentration 
Nuclide 
Ldistance 
Rdistance 
MACCS_Input 

Ha 

Early Air Concentration 
 

Type D output Source Term 
Evacuation 
Nuclide 
Angle 
Ldistance 
Rdistance 
MACCS_Input 

Bq-s/m3 

Tot Long-Term Pathways 
Dose 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Tot Long-Term Direct 
Exposure Pathways 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 
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VarLab Comments Qualifiers Units 

Tot Ingestion Pathways 
Dose 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Long-Term Groundshine 
Dose 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Long-Term 
Resuspension Dose 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Population Dependent 
Decontamination Dose 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Farm Dependent 
Decontamination Dose 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Water Ingestion Dose 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Milk Growing Season 
Dose 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Crop Growing Season 
Dose 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 
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VarLab Comments Qualifiers Units 

Milk Long-Term Dose 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Crop Long-Term Dose 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Ingestion of Grains 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Ingestion of Leafy 
Vegetables 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Ingestion of Root Crops 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 
 

Ingestion of Fruits 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Ingestion of Legumes 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Ingestion of Beef 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 



10-9 

VarLab Comments Qualifiers Units 

Ingestion of Milk 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Ingestion of Poultry 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 
 

Ingestion of Other Meat 
Crops 
 

Type 9 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

person-Sv 

Total Economic Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 

Pop Dependent Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 

Farm Dependent Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 

Pop Dependent 
Decontamination Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 

Farm Dependent 
Decontamination Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 

Pop Dependent 
Interdiction Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 
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VarLab Comments Qualifiers Units 

Farm Dependent 
Interdiction Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 

Pop Dependent 
Condemnation Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 

Farm Dependent 
Condemnation Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 

Emergency Phase Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 

Intermediate Phase 
Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 

Milk Disposal Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 

Crop Disposal Costs 
 

Type 10 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

$ 

Farm Dependent 
Decontamination 
Distance 
 

Type 11 results Source Term 
Evacuation 
MACCS_Input 

km 

Pop Dependent 
Decontamination 
Distance 
 

Type 11 results Source Term 
Evacuation 
MACCS_Input 

km 

Farm Dependent 
Interdiction Distance 
 

Type 11 results Source Term 
Evacuation 
MACCS_Input 

km 

Pop Dependent 
Interdiction Distance 
 

Type 11 results Source Term 
Evacuation 
MACCS_Input 

km 
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VarLab Comments Qualifiers Units 

Farm Dependent 
Condemnation Distance 
 

Type 11 results Source Term 
Evacuation 
MACCS_Input 

km 

Pop Dependent 
Condemnation Distance 
 

Type 11 results Source Term 
Evacuation 
MACCS_Input 

km 

Milk Disposal Distance 
 

Type 11 results Source Term 
Evacuation 
MACCS_Input 

km 

Crop Disposal Distance 
 

Type 11 results Source Term 
Evacuation 
MACCS_Input 

km 

Farm Decontamination 
 

Type 12 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

ha 

Pop Decontamination 
 

Type 12 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

individuals 

Pop Decontamination 
Area 
 

Type 12 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

ha 

Farm Interdiction 
 

Type 12 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

ha 

Pop Interdiction 
 

Type 12 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

individuals 

Pop Interdiction Area 
 

Type 12 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

ha 

Farm Condemnation 
 

Type 12 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

ha 
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VarLab Comments Qualifiers Units 

Pop Condemnation 
 

Type 12 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

individuals 

Pop Condemnation Area 
 

Type 12 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

ha 

Milk Disposal Area 
 

Type 12 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

ha 

Crop Disposal Area 
 

Type 12 results Source Term 
Evacuation 
Ldistance 
Rdistance 
MACCS_Input 

ha 

Maximum Annual Food 
Dose 

Type 13 results Source Term 
Evacuation 
Organ 
Ldistance 
Rdistance 
MACCS_Input 

Sv 
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11. MAPGEN 
 
This section provides directions on how to use MapGen to create road maps in a .gif format at 
specific latitudes, longitudes and distances.  These maps can be generated in two different 
ways.   
 
1. Directing MapGen to read a file created in WinMACCS.  This file, MapSummary.txt. can be 

generated by clicking the Create Map File button in any of the WinMACCS map forms 
such as the Network Evacucation Direction form. 

2. Manually entering information  into MapGen consisting of latitude, longitude and distance 
information. 

This application was developed for Sandia National Laboratories by Sigma Software LLC to be 
used starting with WinMACCS version 3.2. The maps generated are used in the WinMACCS 
network evacuation path forms. 
 
This software uses the Microsoft Map Point 2006 libraries.  It is required that Microsoft Map 
Point 2006 be purchased and installed for this software to be functional.  Export restrictions do 
not allow the Map Point North America maps to be used in India, Morocco, Pakistan, China, 
Hong Kong SAR, Maucau SAR, Turkey or Taiwan.  
 
We recommend that all maps be checked against another reliable source for quality assurance 
purposes.  The Microsoft Map Point 2006 license states the following: "Do not expect the 
software to provide or depict exact distances, directions or geographic features."  Though we 
have not experienced any problems with the maps, and we interpret this to be stated for the 
protection of Microsoft, it does remind us that roads are dynamic by nature and computer maps 
can be subject to map database and software errors. 
 

11.1 Installation of MapGen 
 
Install Microsoft Map Point 2006.  When a trial version of available, it will work with MapGen, but 
only for a limited time.  Our trial version worked for 60 days. 
 
Run Setup.exe from the folder of the MapGen 1.0 found on the WinMACCS installation CD. 
 
After you install MapGen the following is added to the MapGen group.  These can be accessed 
from the Start menu.  The entries are as follows: 
 
1. readme.txt contains installation instructions, current issues and contact information. 
2. Users Guide contains instructions and tutorials. 
3. MapGen is the custom windows software used to create maps for use in WinMACCS. 
 

11.2 Uninstallation of MapGen 
 
1. Open the Windows Control Panel found in the Settings category on the Windows Start 

menu.   
2. Double click on the Add/Remove programs entry. 
3. Select the entry MapGen.  
4. Click on Remove. 
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11.3 Tutorial One: How to Create a Map as a GIF file 
 

 Step One: Start the MapGen program. 11.3.1
 
Navigation to a location is by latitude and longitude as expressed as a decimal. 
 
Enter -22.906 for the latitude, -43.195 for the longitude and 100 km for the distance in the text 
boxes on the form. 
 
Click the Go button.   
 
The map generated should look like the map shown in Figure 11-1. 
 
When the Go button was clicked, a radioactive symbol was placed on the map showing the 
latitude and longitude requested. 
 

 
 

Figure 11-1  MapGen interface 
 
 

 Step Two: Load a sample site and save a gif file 11.3.2
 
From the main menu, select Sample Sites/Duane Arnold.  
The parameters of the Duane Arnold site are loaded into the map form. 
 
From the main menu, select File/SaveAs Gif 
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A window is opened allowing you to select a preexisting folder for the gif file.   
 
Select a folder and click OK 
A file named image_map.gif is created.  
 

11.4 Tutorial Two: Exploring Mouse Clicks on the Map 
 

 Step One: Load Rio de Janeiro 11.4.1
 
Type the latitude, longitude and distance as shown in Figure 11-1, namely ---22.906, -43.195 
and 100.   
 
Click the Go button. 
The distance from the center point (latitude/longitude point) to the far right or left edge of the 
map in this example is 100 km.  This is not exact because the width of the map is an even 500 
pixels.  Because of this these distances are close, but differ by a single pixel.   
 

 Step Two: Measure the distance from the center to the edge of the map 11.4.2
 
Click on the right edge of the map until the line drawn from the center of the map to the edge is 
perfectly straight.   
Notice that the distance shown is 99.565 km 
 
Click on the left edge of the map until the line drawn is perfectly straight 
Notice that this distance shown is 100.377.  Observe that the right edge is slightly different than 
the left edge.  Notice that neither is exactly 100 km.  This is because the number of pixels used 
to display the map is a counting number.  However, when used in WinMACCS, we will be 
assuming that the maps are square and of the measurement requested (100 km in this 
example).  This error is less than one percent of the expected (maximum percent error in this 
example is .435%), and was deemed acceptable.   
 

 Step Three: Measure a long distance from the center to the edge 11.4.3
 
Enter 3500 for distance.  Click on Go.  Click on right edge of map. 
Distance shown is the shortest flight distance (straight line distance).  Notice that it is curved 
because of the distortion of the map.  The error between the expected and the actual distance 
has now increased to around 80%. 
 
The distance entered by the user was translated to an altitude by MapGen before the map was 
requested from Map Point.  A viewing angle is shown in the interface (30.64353 km).  This value 
was empirically determined to minimize the distance error. However, for large distances, Map 
Point changes the map view from a flat view to a distorted view in order to view the globe 
(because the curvature of the earth). The correlation between the actual distance to the edge 
and the distance requested is not valid for large distances.  However, for shorter distances (say 
2000 km), the map view is consistent with our calculations of the viewing angle. 
 
You can trust the distance displayed in the box labeled ‘Distance from Center to Click’.  The 
lesson learned is that before exporting maps created manually; check the distances you request 
against the true distance measured by clicking the mouse on the edge.  When distance lines 
shown are curved lines, the MapGen method of determining map dimensions has failed.   
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 Step Four: Clear distance marks from the map 11.4.4
 
Enter 50 for distance.   
Click Go.   
Click on right edge of map.  
Click ‘Clear Marks’.   
Click Go. 
 
Notice that the line drawn from center to edge has been erased.  
 

11.5 Tutorial Three: Creating a set of maps to be used by WinMACCS 
 

 Step One: Create a file, MapSummary.txt 11.5.1
 
Open a WinMACCS sample problem such as Sampled Values LNT. 
Sample problem is opened. 
 
Open form Network Evacuation Direction for Scenario One. 
A form containing a polar grid is opened. 
 
Click on the button titled Create Map File as shown in Figure 11-2. 
An information box is displayed.   
 
Read and click OK. 
A file called MapSummary.txt was created and placed in the WinMACCS project Input folder. 
 
 

 
 

Figure 11-2  Create map interface file 
 

 Step Two: Generate maps using MapGen and map interface file, 11.5.2
MapSummary.txt 

 
Select File/Generate Gif from File from the main menu as shown in Figure 11-3. 
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Figure 11-3  Generate maps from map interface file 
 
Locate and select the MapSummary.txt file created in the previous step.   
 
Click the Open button. 
 
Choose your project Data folder for the gif file destination as demonstrated Figure 11-4. 
 

 
 

Figure 11-4  Select folder for map files 
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Appendix A: MelMACCS Version 2.0 User’s Guide 
 

A.1 Introduction 
 
This document provides directions on how to use MelMACCS in both interactive and batch 
modes to create a MACCS source-term file from a MELCOR plot file.   The standard method of 
processing a MelMACCS output in MACCS is to use the WinMACCS interface (Bixler et al., 
2015) either using the import file option or the cyclical file set option, which can be used to 
process multiple MelMACCS output files.  Section A.6 describes the requirements for creating 
the MACCS input files directly without using the WinMACCS interface. 
 
Not all MELCOR plot files have the information that MelMACCS needs.  The release paths must 
be defined in the MELCOR input cards to create MACCS-specific data in the plot file.  A 
description of the cards needed for MELCOR is included in this document.  
 
MelMACCS comes with a set of default core inventories that can be used without modification. 
However, it is preferable that the user define his/her inventories specific to the reactor that is 
being evaluated. Information on how create an inventory file is provided in the MelMACCS 
Models Document that is provided with MelMACCS.  
 
Section A.2 of this document describes how to use MelMACCS in interactive mode. Section A.3 
describes the MelMACCS data files. Section A.4 defines the format of a project file. Section A.5 
describes how to run MelMACCS in batch mode. Section A.6 describes how to use a 
MelMACCS source term file without using the WinMACCS interface. Finally, Section A.7 
describes the inputs required to run MELCOR so that the plot file is compatible with 
MelMACCS.  
 

A.2 MELMACCS in Interactive Mode 
 
MelMACCS is started by selecting the MelMACCS symbol from the Windows Start Menu, as 
shown in Figure A-1.  This application leads the user one window at a time through the process 
of creating a MELCOR/MACCS interface file, also referred to as a MelMACCS output file or a 
MACCS source-term file.  
 

 
 

Figure A-1  MelMACCS Symbol  
 

A.2.1 Selecting the MELCOR Plot File 
 
The first form that opens when the user starts MelMACCS contains the text “Welcome to the 
MELCOR to MACCS wizard.”  The Select File button is clicked to choose a MELCOR plot file, 
see Figure A-2. The user chooses the MELCOR plot file and clicks Open.  The MELCOR plot 
file commonly has a .ptf extension. The user clicks Next > to continue. 
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Figure A-2  MelMACCS “Welcome” Window 
 

A.2.2 Reading the MELCOR plot file 
 

The next form contains the text “Reading data from plot file…” After this form is opened, 
MelMACCS starts to read the plot file. When this step has completed, the last time read from 
the MELCOR plot file is displayed next to the text labeled Problem Time, Figure A-3. The user 
clicks the Next > button to proceed to the next form. Optionally, the Create Text File button can 
be clicked to create an ASCII file containing a summary of the MELCOR data that are relevant 
to MACCS. 
 

 
 

Figure A-3  MelMACCS Window 3: Problem Time 
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A.2.3 Entering the Reference Time and Height  
 
The default value of the MelMACCS variable labeled Reference time, Figure A-4, corresponds 
to a MELCOR input variable indicating the reactor scram time. Typically, MELCOR input is set 
up so that reactor scram occurs at time zero, but this need not be the case. When either this 
value is missing from the plot file or when the value on the plot file is less than the time of the 
first data block written to the plot file, the value is set to zero. The primary significance of this 
parameter is to control the start of radionuclide decay in the MACCS calculation.  

 
This time is also used to adjust the time of plume releases saved in the MelMACCS output file. 
For example, when the value of the time of accident initiation is input to be 100 s and the user 
selects a plume segment that starts at MELCOR time 300 s in a Release Path form, the starting 
time for the plume written to the MACCS Input file is 300 -100 = 200 s. 

 
The text box labeled MELCOR height associated with ground level (m) (Figure A-4) is the 
ground height in the MELCOR reference frame. This value is used to adjust the height of plume 
segments saved in the MelMACCS output file. For example, when MELCOR records a release 
path height of -10 m and this corresponds to a height of 30 m above ground, this variable should 
be set to –40. This value is used to calculate the MACCS variable PLHITE by subtracting it from 
the height for the release path in the MELCOR reference frame. 

 

 
 

Figure A-4   Setting up MelMACCS run: Reference Time and GRD Level height 
 
The user clicks Next > to continue. 
 

A.2.4 Entering the Release Path Geometry 
 
The grid shown on Figure A-5 contains the release path identification number, the release path 
height, and the adjusted release height based on subtracting the user entered value labeled 
“MELCOR height associated with ground level” from the release path height read from the 
MELCOR plot file. All of this information comes directly from the MELCOR plot file except the 
value used to adjust the release height.  
 

 
 

Figure A-5  Release path geometry 
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The value of the adjusted release height is user editable. For each plume segment, MACCS 
requires a value of building height to evaluate whether a buoyant plume is entrained in the 
building wake. Initial plume dimensions, SigmaY and SigmaZ, are also needed by MACCS.  
These values represent the standard deviation of the Gaussian plume in the cross-wind and 
vertical dimensions, respectively. The MACCS User’s Guide recommends values as follows:  

 
SigmaY = W/4.3 = 0.23 x W 
SigmaZ = H/2.15 = 0.47 x H 
 
Here, W is the building width and H is the building height. These values are not always trivial to 
select since most buildings are rectangular or have even more complex footprints and have 
multiple roof heights. In reality, the best choice for the building dimensions often depends on 
wind direction, but single, representative values are required by MACCS. Fortunately, these 
values only influence the plume concentrations at relatively short distances and generally have 
modest influence at distances of several kilometers downwind.  
 
Clicking the button labeled Reset removes all the values entered by the user and replaces the 
Adjusted Release Height with the default values. 
 
When a row in the grid is defined, clicking the button labeled Auto Fill copies the row to vacant 
entries in subsequent rows until a completed row is encountered. The row is copied is the last 
defined row. 
 
The user clicks Next > to continue. 
 

A.2.5 Specifying the Deposition Velocity Algorithm 
 
Figure A-6 allows the user to select the method of calculating MACCS variable VDEPOS. There 
are two model choices. The first is based on gravitational settling. The default model is based 
on a correlation of expert elicitation data (Bixler et al., 2013). 
 

 
 

Figure A-6  Selecting deposition velocity algorithm 
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When the expert elicitation option is chosen, additional inputs are required as follows: 
 

 Cutoff Aerodynamic Diameter: This is the point at which the deposition velocity 
calculation is switched from the expert elicitation correlation to gravitational settling.  The 

default and recommended value is 20 m. An exception to this rule is made when the 
gravitational settling result for a particle diameter is less than the value calculated using 
the expert elicitation correlation for the cutoff diameter, in which case the velocity 
calculated for the cutoff diameter using the expert correlation is used. 

 Surface Roughness: This is a measure of the terrain roughness. By default this is set to 
0.1 m. This value is allowed to range from 0.01 m to 1.0 m. A value of 0.03 m represents 
grasslands; a value of 0.1 m to 0.8 m represents suburban terrain; a value of 0.2 m to 
1.0 m represents forested land.  

 Wind Speed: The default wind speed is 5 m/s. The range of values are 0.5 to 10 m/s. 

 Quantile: This is a measure of degree of belief in deposition velocity, as expressed by a 
group of experts. A value of 0 represents the smallest value that the experts thought to 
be possible; a value of 0.5 represents the best guess; a value of 1 represents the 
highest value that the experts thought to be possible. This value is 0.5 by default. 

Two of these parameters, wind speed and surface roughness, must be specified as 
representative values over the grid and for all weather trials. Surface roughness often varies 
over the grid and wind speed varies from hour to hour and weather trial to weather trial. As a 
result, the user needs to choose a reasonable, representative value in light of the expected 
variability at a site.  
 
The MELCOR Aerosol Density is read from the MELCOR plot file. When this value is not 
included on the plot file, the number 1000 kg/m3 is used as a default.  
 
When the check box titled "Disable deposition velocity results in MACCS file" is checked, the 
deposition velocity is calculated, but when the MACCS input images are written to the 
MelMACCS output file as comments. Thus, both WinMACCS and MACCS ignore these cards 
and deposition velocities must be specified separately. This option is useful for uncertainty 
analyses for which deposition velocity is treated as an uncertain input.  
 
For example, the input image containing the deposition velocity is disabled in the following line 
because it starts with the * character: 
*DDVDEPOS001 8.7563E-04 

 
When the check box is not selected, the input image containing the deposition velocity is 
enabled, as shown in the line below: 
DDVDEPOS001 8.7563E-04 

 
The user clicks Next > to continue. 
 

A.2.6 Entering the Mass Threshold Fractions 
 
Figure A-7 allows the user to filter out release paths and plume segments that are insignificant. 
There are two threshold values that can be entered to allow this filtering as follows: 
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Figure A-7  Mass threshold fraction 
 
When zero is entered for Mass threshold fraction for path to be used, every Release Path form 
is active. Otherwise, only forms with a release fraction exceeding or equal to the threshold are 
active. Inactive forms do not appear on the screen.  

 
When zero is entered for Mass threshold fraction for plume segment to be used and the Apply 
button is clicked in the Release Path form, every plume segment has an entry in the form 
showing the plume segment parameters.  When a positive value is entered, each release 
fraction for each chemical group of a plume segment is tested against the threshold value.  
When a plume segment has at least one release fraction for a chemical group that is greater 
than or equal to the threshold, it is applied to the form showing the plume segment parameters.   
The user clicks Next > to continue. 
 

A.2.7 Entering the Options That Affect the Core Inventory 
 
Figure A-8 allows the user to specify the set of chemical groups to be included, the core 
inventory, and the ring (when the MELCOR plot file contains release data for more than one 
ring). 
 
All available chemical groups found on the MELCOR plot file that are not specifically excluded 
are shown on this form, see Figure A-9. The user can eliminate chemical groups from this form 
by editing the MelMACCS.usr file in the section labeled /EXCLUDE-GROUPS. Groups listed in 
this section do not appear in the MelMACCS user interface. 
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Figure A-8  Core inventory 
 
Example from the MelMACCS.usr file.  In this example, chemical group B is excluded from the 
MelMACCS interface. 
 
/EXCLUDE-GROUPS 
B 
/END 

 
Select the chemical groups that are to be included in the MACCS analysis using the check 
boxes. By default, all chemical groups are included and the user must deselect groups to be 
excluded.  

 

 
 

Figure A-9  Specifying core inventory 
 
Next, select the inventory that is closest to the inventory modeled by MELCOR.  A description 
field is shown in the user interface to describe each inventory. Ideally, the same ORIGEN 
calculation is used to define the MELCOR inputs and to create an inventory for MelMACCS. 
This is done by creating one of more inventory files, as discussed in Section 6 and also in the 
MelMACCS Models Manual.  

 
The inventory list in Figure A-10 shows the core inventories read from the MelMACCS.inv file 
found in the installation folder and additional inventory files created by the user. User-defined 
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inventory files must be located in the MelMACCS_Docs\Inventories folder in the Windows user 
area.  Under Windows 7, the inventory folder is 
C:\Users\username\MelMACCS_Docs\Inventories. All inventory types defined in these files are 
displayed in the user interface and can be selected, as shown below: 
 

 
 

Figure A-10  Core inventory lists 
 
New inventory files can be added by clicking the button labeled New Inventories. When a new 
inventory file is added, a copy of that file is placed in the MelMACCS_Docs\Inventories folder.  
The next time MelMACCS starts, the new inventory file is automatically loaded. 
 
Inventories can be prevented from loading into MelMACCS by removing the inventory file from 
the MelMACCS_Docs\Inventories folder. 
 
All inventories can be removed from the current MelMACCS run by selecting the button labeled 
C.  This does not change the files that will be loaded the next time MelMACCS is run. 

 
MELCOR is commonly run with multiple rings, but in most cases a single release fraction is 
recorded in the plot file for all of the rings. However, MELCOR can be run in a mode that 
records release fractions on the plot file for each ring. This is especially useful for spent fuel 
pools, where different rings can represent fuel of different ages. MelMACCS processes multi-
ring release fractions when they are present on the MELCOR plot file. When this is done, each 
ring has a set of initial masses and released masses on the plot file. The same set of chemical 
groups is common for all rings. Because the rings may represent fuel of different ages, each 
ring may be associated with a different inventory. When the MELCOR plot file only contains a 
single ring, the selection has already been made and the user does not need to do anything 
further. 
 
The user may select the ring in Figure A-11 to consider in any order. 

 

 
 

Figure A-11  Selection of ring(s) 
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After the plots associated with a ring have been displayed in the Release Path windows, the 
Ring Processed check box is checked the next time this window is displayed. The ring can be 
reevaluated. This check box is only a visual guide to help the user keep track of which rings 
have already been evaluated.   
 
The default value of the inventory scaling factor is 1.0, which is usually the desired value, but 
this value can be changed and defines the value of the MACCS parameter, CORSCA. This 
parameter is useful when the MELCOR calculation has been done for a reactor that is similar, 
but different in size and power rating, than the reactor that is to be evaluated with MACCS.  
 

 
 

Figure A-12  Inventory scaling factor 
 
The user clicks Next > to continue. 
 

A.2.8 Creating the MelMACCS output File 
 
A form with the text Select plume segments and click "Apply…”, referred to as the master form, 
Figure A-13, is opened along with supporting Release Path forms, Figure A-15, where each 
window corresponds to a MELCOR release path written to the plot file.  Each release path is 
displayed provided that the mass release threshold requirements are met, Figure A-14. After 
defining plume segments from the release path windows, as described in this section, the 
MelMACCS output file is created.  
 

 
 

Figure A-13  Master form (empty) 
 
Plume segments can be selected from the Release Path windows, and applied to the master 
form in the manner described below. When these segments are applied in the master form from 
the Release Path windows, the data are summarized in the table titled Plume Segment 
Parameters. 
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Figure A-14  Master form (filled) 
 
For the user to create a MelMACCS output file: 
 

 The user records times in the Recorded Times window of the MELCOR Release Path 
forms, Figure A-15. These times define the beginning and end of the plume segments 
associated with this release path.  

 The user clicks the Apply button in a Release Path form to apply the times record in the 
plot to the master form. 

 The user indicates in the pull down menu with the title “Indicate which plume segment is 
risk dominant…” the risk dominant plume segment.  This can also be chosen by 
selecting the row containing that segment. Typically, the plume segment with the highest 
heat release and/or fastest flow rate is chosen as the risk dominant segment.   

 After all release paths have been considered, the user clicks the Create MACCS File 
button to create the MELMACCS output file. 

 To start over again, the user can click the Reset button in the master form to clear all 
plume segments from the grid. 

 Clicking the Next Ring button returns to the form containing options that define the core 
inventory.   

 
When the header area on any given column heading of the table is clicked on the master form, 
the data in the table are reordered.  The order is toggled between ascending and descending 
order each time the heading is clicked. However, the values in the MelMACCS output file is 
always created in ascending order of plume release time (the column labeled Start (s) in the 
table). 
  
Clicking the Exit button closes MelMACCS. 
 

A.2.9 Navigating a release path form 
 
The following options are available on a release path form: 
 

 A dashed, vertical line tracks the mouse movement as the mouse moves across a plot. 
The time corresponding to the location of the mouse is displayed adjacent to the label 
Current Time. Clicking on the plot records a time in the Recorded Times window. A 
series of n recorded times, t1, t2…tn corresponds to plume segments [t1,t2], [t2,t3], …, 
[tn-1,tn]. 
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 A time can also be recorded by typing a value in the text box labeled Current Time and 
pressing the Enter key on the keyboard. Clipboard functionality is also supported in this 
text box. 

 To select an entry in the Recorded Times list, the user can click on the entry in the list. 
This value is copied to the clipboard using Ctrl-C. This function allows easy duplication 
of recorded of times between Release Path forms.  

 

 
 

Figure A-15  Release path form  
 

In Figure A-15, times 3677.367 and 14954.56 seconds are recorded. The mouse pointer 
is positioned over 5526.476, but the user has not recorded this time by clicking the left 
mouse button. 

 

 A single selected time can be deleted by clicking the time in the list labeled Recorded 
Times and pressing the Delete key on the keyboard, see . 

 All user recorded times are deleted when the user clicks the button Clear. The time of 
the first and last mass released is retained. 
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Figure A-16  Deleting plume segment time 
 
 Time 7678.686 is selected. Remove by pressing the Delete key. 
  

 A sequence of times is inserted by typing in a time interval in the Interval box and 
clicking the Auto Insert button. To use this feature, at least two times must be recorded. 
Insertion is between the first and last recorded times at the interval indicated. The last 
interval is usually shorter than the selected time interval.  

 
 

Figure A-17  Release path form automatic time intervals 
 
 In the illustration, auto Insert is used to insert lines at intervals of 2000 s. 

 

 Toggle the zoom mode by clicking on the zoom button. This prevents recorded times 
from being selected. 
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 When zoom mode is on, the graph can be magnified by drawing a box from top left to 
bottom right by a drag and release motion using the left mouse button. To return to the 
original graph magnification, repeat this process, but move the mouse from bottom right 
to top left. 

 
 Times can be recorded while the graph is magnified provided the zoom mode is off. 

 

     
 

     Zoom Off      Zoom On 
 

Figure A-18  Zoom on/off 
 

 Y-axis scale can be changed from linear to log by choosing the appropriate radio button 
in the group labeled Y Axis Scale. 

 
 

Figure A-19  Changing scale on release form 
 

 The plot can be exported in various formats by clicking Export Plot button. The formats 
include graphics formats, such as Windows bmp (bitmap) and jpeg, and text formats 
such as ASCII, HTML, and XML. All MELCOR data used in MELMACCS calculations 
can also be exported as text by clicking the Create Text File button on the form that 
contains the text “Reading data from plot file…”.. The Export Plot option only exports the 
data shown in the plot window. 

 The Apply button on the Release Form can be clicked to apply the recorded times to the 
master form.  When this button is clicked, previously applied plume segments associated 
with the current release path are replaced. 

The time preceding the first nonzero flow greater than or equal to the reference time and the 
time corresponding to the last nonzero flow are automatically recorded for the user, although 
these can be manually deleted. These times mark the logical beginning and end of a set of 
plume segments for this release path. 
 
The time corresponding to the first nonzero flow is recorded on the bottom left of the graphics 
window adjacent to the label Initial release time (sec) and similarly for the Final release time 
(sec). 
 
The plot legend in Figure A-15 shows the chemical groups chosen in the form “Choose options 
that affect the core inventory”.  The legend entries can be unchecked in the legend, which 
causes the corresponding release fraction curve to become invisible in the plot. This option is 
used to help identify the data series in the plot. This option does not modify the chemical group 
information saved in the MelMACCS output file. When one or more chemical groups are to be 
removed from consideration in the MelMACCS output file, the user must navigate back to form 
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titled “Choose options that affect the core inventory” by clicking the <Previous button on the 
master form. 
 

A.3 MelMACCS Data File Format 
 
A project file is defined in an easily editable format.  A general format is used for all data files 
read by MelMaccs. This includes the user defined inventory files (.inv), the user project files 
(.mel), the user settings file, MelMACCS.usr, and the MelMACCS data files, MelMACCS.ini and 
MelMACCS.inv.  
 
With the exception of the MELCOR plot file, the format of data files read by MelMACCS all 
follow the same language rules.  This format supports editing in an ASCII text editor, such as 
Microsoft Notepad.  Microsoft Word and Microsoft Word Pad can add extra invisible formatting 
characters that are not compatible with MelMACCS, so these editors should not be used to 
modify these files.  Additionally, new lines in the MelMACCS data files are indicated by the 
Windows standard carriage return (ASCII 13) and line feed (ASCII 10) characters.  Because 
UNIX files have only the line feed character, files created on a UNIX box are not compatible with 
MelMACCS.   
 
The following components are found in a MelMACCS data file: 

 A comment is indicated by an asterisk, “*”, in column one.  Comments can occur 
anywhere in the file.   

 Comments following data in a data line are not supported.  Place all comments on their 
own line beginning with an asterisk in column one. 

 A keyword starts with a slash, “/”, in column one, followed by a keyword followed by 
value(s) associated with that keyword.  The number of values required depends on the 
keyword. 

 Values are separated on data or keyword lines using spaces or tabs. 

 A data block begins with a keyword line. This is followed by a series of data lines.  The 
end of the data block is indicated by the following character sequence starting in column 
one, "/END". 

 Some keyword lines are not associated with a data block. 

 Blank lines are permitted in the file.  Blank lines can occur anywhere. 

 When a value is a string containing spaces, it must be enclosed by the double quote 
characters (“ ”). 

 White space can be any number of spaces, tabs or otherwise unreadable characters.  
More precisely, characters with an ASCII code less than or equal to 32 are considered 
white space. 

 
The following is an example of a keyword taken from a MelMACCS.usr file. The keyword is 
“DEFAULT-DIR”.  The value is enclosed in double quotes because it contains a space. 
 
/DEFAULT-DIR "C:\MelMACCS Results" 
 
The following is an example of a data block from the file MelMACCS.ini. The keyword is 
“COMPOUND-GROUPS”.  The data block contains four lines of data.   
 
/COMPOUND-GROUPS 
CSI    I    0.488444  
CSI    Cs   0.511556 
CSM    Cs   0.73478922 
CSM    Mo   0.26521078 
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/END 
 

A.4 Format of a Project File 
 
A project file is used to define settings of a MelMACCS project.  When a keyword or data block 
is not defined in a project file, a default value is used when the keyword or data block is 
optional.  However, some keywords and data blocks are required. 
 
The keywords in a MelMACCS project file are not case sensitive. 
 

A.4.1 Chemical groups 
 
List of chemical groups to be considered, matching the entries in the MELCOR plot file. 
 
This is an optional data block. 
 

Keyword Default Example 

Chemical_Groups 
 

All available chemical 
groups are selected 

/Chemical_Groups 
Xe 
Cs  
Ba 
/End 

 

A.4.2 Ring number 
  
Ring number associated with the MELCOR plot file.  When there is only one ring or the ring 
referenced is out of range, the value is set to 1. 
 
The value following the keyword is as follows: 

 Ring number, integer 
 
This is an optional variable. 
 

Keyword Default Example 

Ring 1 /Ring 2 

 

A.4.3 Inventory scale factor 
 
The inventory scale factor defines the value to write to output file for MACCS variable CORSCA.   
 
The value following the keyword is as follows: 

 Scale factor, positive real 
 
This is an optional variable. 
 

Keyword Default Example 

Inventory_Scale 1.0 /Inventory_Scale 1.2 

 

A.4.4 Reactor type 
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Value indicates which inventory to use when calculating the core inventory.  The value of the 
Reactor_Type must be an inventory defined in the file MelMACCS.inv or in an inventory file 
found in the MelMACCS_Docs\Inventories folder in the user area are loaded into the user 
interface when MelMACCS starts.  Under Windows 7, the inventory folder is 
C:\Users\username\MelMACCS_Docs\Inventories.   
 
The value following the keyword is as follows: 

 Inventory identifier, inventories provided in the MelMACCS.inv file or another user 
loaded inventory file.  LOW, HIGH_PWR, HIGH_BWR and MEDIUM_BWR are provided 
in MelMACCS.inv.   
 

This is a required variable. 
 

Keyword Default Example 

Reactor_Type None.   /Reactor_Type HIGH_PWR 

 

A.4.5 Reference time 
 
This is used to adjust the plume release time, PDELAY.  The reference time is subtracted from 
the start time of each plume segment to calculate the time written to the MelMACCS output file. 
 
The value following the keyword is as follows: 

 Time (sec), real, not to exceed the last time on the plot file 
 
This is an optional variable. 
 

Keyword Default Example 

ATime 0   /ATime 100.0 

 

A.4.6 Ground height relative to MELCOR 
 
This is used to adjust the MELCOR height associated with each release path considered.  The 
value is used to define the MELCOR height associated with ground level, i.e., the height of the 
ground (grade) in the MELCOR reference frame. See section A.2.3 for more information about 
how this variable is used. 
 
The value following the keyword is as follows: 

 Height (meters), real, range [-1000.,1000.] 
 
This is an optional variable. 
 

Keyword Default Example 

Ground_Height 0.   /Ground_Height 5.0 

 

A.4.7 Building Height, Sigma Y and Sigma Z 
 
This data block has an associated data line for every path defined on the MELCOR plot file.  
See section A.2.4 for more information about how these variables are used. 
 
The lines in the data block contain the following: 

 MELCOR release path, integer 
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 Building Height (meters), real, range [1.,1000.]  

 Initial SigmaY (meters), real, range [0.1,1000]  

 Initial SigmaZ (meters), real, range [0.1,1000]  
 
This is a required data block.  There must be an entry for every path on the MELCOR plot file. 
 

Keyword Default Example 

Path None / Path 
51 10.0 0.2 0.3 
99 4.0 0.5 0.6 
101 7.0 0.8 0.9 
/End 

 

A.4.8 Adjusted Release Height 
 
This keyword allows the adjusted release height to be set for each release path.  The automatic 
adjustment for all paths using the value entered for /Ground_Height is ignored for paths listed in 
this data block.  
 
The lines in the data block contain the following: 

 MELCOR release path, integer 

 Release height (meters), real, suggested range [0.,1000.] 
 
Not all paths are required to be listed. 
 
This is an optional data block. 
 

Keyword Default Example 

Adjusted_Release_Height Height of Release 
Path minus  
Ground _Height 

/Adjusted_Release_Height 
51 0.0 
99 10.0 
/End 

 

A.4.9 Deposition Velocity 
 
This indicates the method used to estimate deposition velocity.  See section A.2.5 for more 
information about how this variable is used. 
 
Possible values are EXPERT and GRAVITY. 
 
This is an optional variable. 
 

Keyword Default Example 

Deposition_Velocity EXPERT /Deposition_Velocity EXPERT 
/Deposition_Velocity GRAVITY 

 

A.4.10 Aerodynamic Cutoff Diameter 
 
The aerodynamic particle size above which the gravitational settling method is used to calculate 
the deposition velocity is defined on this line.  This variable is used only when the deposition 
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velocity method is set to EXPERT. See section A.2.5 for more information about how this 
variable is used. 
 
The value following the keyword is as follows: 

 Cutoff diameter ( meters), real, positive number, range (0,25] 
 

This is an optional variable. 
 

Keyword Default Example 

Cutoff_Diameter 20  meters /Cutoff_Diameter 25.0 

 

A.4.11 Surface Roughness 
 
A representative value of surface roughness is entered on this line.  This variable is used only 
when the deposition velocity method is set to EXPERT.  See section A.2.5 for more information 
about how this variable is used. 
 
The value following the keyword is as follows: 

 Surface roughness (meters), real, range [0.01,1.] 
 
This is an optional variable. 
 

Keyword Default Example 

Surface 0.1 (m) /Surface 0.2 

 

A.4.12 Wind speed 
 
The wind speed is entered on this line.  This variable is used only when the deposition velocity 
method is set to EXPERT. See section A.2.5 for more information about how this variable is 
used. 
 
The value following the keyword is as follows: 

 Windspeed (meters/second), real, range [0.5,10.] 
 
This is an optional variable. 
 

Keyword Default Example 

Wind_Speed 5.0 (m/s) / Wind_Speed 4.0 

 

A.4.13 Quantile  
 
The quantile level determines the expert coefficients to use.  This variable is used only when the 
deposition velocity method is set to EXPERT.  See section A.2.5 for more information about 
how this variable is used. 
 
The value following the keyword is as follows: 

 Quantile, real, range [0.,1.] 
 
This is an optional variable. 
 

Keyword Default Example 
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Quantile .5 /Quantile 0.76 

 

A.4.14 Output Format of Deposition Velocity 
 
This value determines whether the deposition velocity values are written to the MelMACCS 
output file as comments.  The value is set to True when the WinMACCS user wants to override 
the deposition velocities with other values entered in WinMACCS. 
 
This is an optional variable. 
 

Keyword Default Example 

Disable_Deposition_Velocity False /Disable_Deposition_Velocity True 

 

A.4.15 Release Path Threshold 
 
This variable is used to eliminate paths that have an insignificant release.  See section A.2.6 for 
more information about how this variable is used. 
 
The value following the keyword is as follows: 

 Release path threshold, real, range [0.,1.] 
 
This is an optional variable. 
 

Keyword Default Example 

ReleasePathThreshold 0 / ReleasePathThreshold 0.001 

 

A.4.16 Plume Release Threshold 
 
This variable is used to eliminate plume segments that have an insignificant release.  See 
section A.2.6 for more information about how this variable is used. 
 
The value following the keyword is as follows: 

 Plume release threshold, real, range [0.,1.] 
 
This is an optional variable. 
 

Keyword Default Example 

ReleaseThreshold 0 / ReleaseThreshold 0.0001 

 

A.4.17 Default Path Boundary  
 
The time boundaries for each path can be determined based on the first and last mass 
released, or can be based on specific user entered times.  When running MelMACCS in 
interface mode, the boundaries are initially determined by the first and last mass released.   
 
This keyword allows the user to override the boundary values with constants.  These 
boundaries are used for every path.  See section A.4.18 to override the boundary determination 
for specific paths. 
 
Possible values associated with the boundary assignment are as follows: 
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 AutoBoth: MelMACCS determines the upper and lower bound based on the first and last 
mass released.  No further parameters are needed. 

 AutoBeginOnly: MelMACCS determines the lower bound.  The upper bound needs to be 
supplied. 

 AutoEndOnly: MelMACCS determines the upper bound.  The lower bound needs to be 
supplied. 

 AutoNone: Both the lower and the upper bounds need to be supplied. 
 
This is an optional variable. 
 

Keyword Default Examples 

Default_Plume_Boundaries AutoBoth Default_Plume_Boundaries 
      AutoBoth 
/Default_Plume_Boundaries 
      AutoBeginOnly 12000.  
/Default_Plume_Boundaries 
      AutoEndOnly 4000. 
/Default_Plume_Boundaries  
      AutoNone  4000. 12000. 

 

A.4.18 Path Boundaries 
 
The determination of the plume boundaries may be specified per path.  This takes precedence 
over the default method for determining the boundaries.  See section A.4.17 for a description of 
the possible default methods.  
 
The first value on a line is the MELCOR release path.  The values following the release path are 
identical to the values following the Default_Plume_Boundary keyword described in section 
A.4.17. 
 
This is an optional data block.   When path boundaries are not defined for a path the default 
boundaries are used. 
 
 

Keyword Default Examples 

Plume_Boundaries Value of  
Default_Plume_Boundaries 

/Plume_Boundaries 
51 AutoNone  4000. 13000. 
99 AutoBeginOnly 13000. 
/End 
 
/Plume_Boundaries 
99 AutoEndOnly 4000. 
/End 

 

A.4.19 Default Plume Segment Interval 
 
A time interval can be specified to define plume segments for all release paths.   The insertion 
of this time interval occurs between the path boundaries for every release path that has not 
been eliminated because of mass threshold limits as defined in section A.4.15.  This operation 
is similar to the Auto Insert function in the user interface; however, it is applied to all release 
paths.   
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See section A.4.20 to specify the release interval by path. 
 
This line causes plume segments to be defined for each path at the interval specified.  When 
the user wants to define plume segments for a limited number of paths, this line should not be 
used. However, the time interval for a specific release path overrides this time interval, as 
described in the following subsection.  
 
The value following the keyword is as follows: 

 Time interval for insertion in seconds, real 
 
When this line is not present, there is no default interval insertion.  In this case, all insertions are 
specified by path as described in section A.4.20 or by specifying each release point manually in 
section A.4.21. 
 
This is an optional variable.  
 

Keyword Default Example 

DefaultAutoInsert none /DefaultAutoInsert 1500.0 

 

A.4.20 Plume Segment Interval 
 
A time interval can be specified to determine plume segments. The insertion of this time interval 
occurs between the path boundaries for the path specified. This operation is similar to the Auto 
Insert function in the user interface.  
 
This line causes the default insertion interval for the specified path defined using the 
/DefaultAutoInsert line to be replaced.   
 
The values following the keyword are as follows: 

 MELCOR release path, integer 

 Time interval for insertion in seconds, real 
 

Not all paths are required to be listed. 
 
This is an optional variable.  There can be multiple entries of this line. 
 

Keyword Default Examples 

AutoInsert Time interval 
defined on the 
DefaultAutoInsert 
line is applied to all 
paths 

/AutoInsert 51  1000.0 
/AutoInsert 99   2000.0 

 

A.4.21 Manual Plume Segment Definition 
 
Time points can also be specified for individual release paths.  This can be used in place of the 
/AutoInsert or /DefaultAutoInsert lines, but when auto insertion is defined for a path and specific 
release times using the /ManualInsert data block are defined for that same path, all times are 
applied. 
 
This data block can be repeated for multiple release paths.   
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The value following the keyword is as follows: 

 MELCOR release path, integer 
 
The lines in the data block contain the following: 

 Time (seconds), real 
 
This is an optional variable. 
 

Keyword Default Examples 

ManualInsert none /ManualInsert 99 
1515. 
4000. 
10000. 
25000. 
/End 

 

A.4.22 Plume Segment of Maximum Risk 
 
This line identifies which plume segment is considered to have the maximum risk in the MACCS 
calculation. This value defines the MACCS parameter MAXRIS.  For the MACCS calculation the 
plume segments are ordered by start time of release, independent of the release path.  MaxRisk 
identifies the plume segment ordered by start of the release. 
 
The values following the keyword are as follows: 

 Plume release number identifying interval, integer 
 

This is an optional variable. 
 

Keyword Default Examples 

MaxRisk 1 /MaxRisk 14 

 
 

A.5 Running MELMACCS in Batch Mode 
 
MelMACCS can be run from a command prompt window (cmd.exe) or from a batch file (.bat 
file).  The parameter values are read from a MelMACCS project file (.mel extension).  A sample 
project file, sampleProject.mel, based on the sample plot file demo.ptf, is provided with 
MelMACCS.  The format of this file is described in section A.4. 

 
The format of a command is as follows: 
 
MelMACCS.exe projectfile [-i melcorplotfile] [-o maccsfile][-r] 
 
The order of the optional parameters as indicated by the brackets is not important. 
 
The following is an example of a line to run MelMACCS in batch mode: 
 
 MelMACCS.exe sampleProject.mel -i "D:\Demo.ptf" -o MACCSInterface.inp -r 
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There are three files specified. When full paths are not specified, it is assumed that the files are 
in the users default folder. File paths and names should be delimited by quotes when there are 
embedded spaces in the file names. 
 
When any of the optional arguments are specified, the project file, in this example 
sampleProject.mel, must be specified. 
 
The meanings of the arguments are as follows: 
 

 MelMACCS project file:  This must be the first argument.  This file has a special format 
containing all information that would normally be entered in the user interface via mouse 
clicks and keyboarding. All values specified in the project file are loaded into the 
interface.  

The interface opens with the preloaded values when the -r option is not used.  In this 
case, the values specified in the project file are viewed in the user interface.    

 
When the –r option is used and an error occurs, the message is appended to the log file, 
AutoRun.log, located in the same folder as the MelMACCS project file.  
 
A MelMACCS project file can be debugged by omitting the -r option, which allows the 
user to review the settings. 

 

 MELCOR plot file: The plot file is specified with the optional entry, “-i melcorplotfile”.  The 
plot file normally ends with a .ptf extension. This must be defined when the -r option is 
used. When missing, a visual dialog box displays an error message as follows in Figure 
A-20: 

 

 
 

Figure A-20  Error message 
 

 MelMACCS output file: The output file is specified in the optional entry, “-o maccsname”.  
This entry defines the MACCS interface file that MelMACCS creates. When not 
specified, the file is called MACCS.inp and is placed in the users default folder.  

 Run in background: Using the “-r” option indicates that MelMACCS is to be run without 
any user input.   

When the –r option is not used, a dialog box pops up explaining any errors, such as data 
validation errors. This allows the user to adjust values in the interface. When the –r 
option is used, any error other than an informative message in MelMACCS causes the 
batch mode to abort. Messages are appended to the AutoRun.log file found in the same 
folder as the MelMACCS project file. In this case, the user should open this file to view 
the error message. 
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When using the -r option, any plume segment deemed illegal is not applied. This does 
not cause an error, but a message is written to the log file. Illegal plume segments are 
those with time durations greater than 86400 s, segments or paths not meeting the 
threshold criteria, and segments with zero flow or zero gas density. The user can force 
these segments to be written to the MelMACCS output file only when running in user 
interface mode.  Additionally, plume segments are not created when there is no mass 
released. 

 

A.6 Creating a Complete MACCS Input File 
 
The MelMACCS output file created contains MACCS input cards that define the source term. 
This is not a complete MACCS ATMOS input file. To create a complete input file, the source-
term file created by MelMACCS must be merged with another MACCS ATMOS input file. 
 
One technique that can be used to incorporate the source-term information into an existing 
MACCS input file is to copy the contents of the MelMACCS output file and paste it at the end of 
an existing ATMOS input file, provided the file does not include multiple source terms. This 
works because MACCS uses the last data values encountered in the input file. The user needs 
to be cautious when there are fewer values for a given MACCS variable in the MELMACCS 
interface file than are in the exiting MACCS input deck. For example, when the number of plume 
segments, chemical groups, radionuclides, pseudostable radionuclides, or particle size groups 
is less than the original set in the MACCS ATMOS file, errors may be generated or the 
calculation may not produce correct results. 
 
To merge a MelMACCS output file with an existing MACCS ATMOS input file 
 

 Open the MelMACCS output file in Notepad or another ASCII text editor. Select the 
contents of this file and copy to the windows clipboard (using the Copy function from the 
Edit menu). 

 

 Open an existing MACCS ATMOS input file in a text editor. Paste the contents of the 
clipboard into an ATMOS file immediately preceding the first line consisting of a “.” in 
column one. The amended file is a valid ATMOS file that can be run using MACCS. 

 
A new input variable, GRPNAM, is included in the MACCS cards, one vector entry for each 
chemical group. This is required by WinMaccs, but at this time MACCS does not recognize this 
card and ignores it. When the output from MELMACCS is imported into WinMaccs, these cards 
should not be removed. 
 

A.7 Creating a MELCOR Plot File with MACCS Information 
 
There are two major versions of MELCOR available, 1.8.6 and 2.1. Input for 2.1 differs from 
1.8.6. Directions are included in the MELCOR user’s guide. The following excerpts have been 
copied and edited for this document. 
 

A.7.1 Directions for MELCOR version 1.8.6: 
 
When using 1.8.6 RG, created on November 20, 2002, or later, the following input cards should 
be included in the MELGEN input. 
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MACCSnn - MACCS Release Path Definition 
1 <= nn <= 99 is the release path assigned by the MELCOR user. 

This input card contains one parameter as follows: 
(1) MCCSFP - MCCSFP is the number of the flow path; the sign is the sign of flow 
corresponding to "release". 
(type = integer, default = none, units = none)   

 
This record allows identification of flow paths that serve as “release” paths for the 
consequences code, MACCS. For these paths, and these paths only, fluid and radionuclide 
transport data are written to the plot file. 
 
Example: This example is consistent with DEMO(rhonom=2500, the sample MELCOR input file 
released with MelMACCS. 
 MACCS51 399 
 MACCS99 398 
 

A.8 Directions for MELCOR Version 2.1: 
 
The MELCOR version must be 2.1.1461 or later. Previous versions of 2.1 MELCOR create plot 
files that are not compatible with MelMACCS. 
  
FL_MACCS – MACCS Release Paths Definition 
 
This record allows identification of flow paths that serve as release paths for the consequences 
code MACCS. For these paths, and these paths only, data about fluid and radionuclide 
transport through the path are written to the plot file. The record can also be used simply to 
force such data to be written to the plot file for other applications. However, all MACCS flow 
paths in a MELCOR plot file are evaluated by MelMACCS, so only the ones relevant to MACCS 
calculations should be defined when the plot file is to be processed with MelMACCS.  
 
MACCSN - The number of MACCS release paths. 
(type = integer, default = 0, units = dimensionless) 
 
The following data are input as a table with length MACCSN. Variables are input in the order 
listed below. 
 

Variable Description 

NFL Table row index. 

 (type = integer, default = none, units = none) 

MACCSNAME MACCS release path name 
(type = character*16, default = none, units = 
none) 

MACCSNUMBER MACCS release path  
(type = integer, default = none, units = none) 

FPNAME Flow path name 
(type = character*16, default = none, units = 
none) 

DIRFL Direction of flow corresponding to release. 
FROM 
TO 
(type = character*4, default = none, units = 
none) 
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MELCOR allows the flow path name to be any character string. However, MelMACCS requires 
this to be converted to an integer. This means that it is necessary to use an integer in the field 
FPNAME. 
 
The field MACCSNAME is not currently used by MelMACCS. 
 
When comparing the input format, a positive flow release path in 1.8.6 input corresponds to the 
keyword FROM, a negative number corresponds to the keyword TO.  
 
Example corresponding to the same problem as referenced above in describing the sample 
input for 1.8.6: 
 
FL_MACCS 2  
1   ‘Release 51’ 51     ‘399’ FROM  
2   ‘Release 99’ 99     ‘398’ FROM    
  

A.8.1 Adding New Chemical Groups: 
 
All chemical groups written to the MELCOR plot file are considered for processing. However, for 
a new chemical group to be accepted by MelMACCS, the MelMACCS.ini file needs to be edited. 
Each chemical group is associated with a set of elements. The association corresponding to the 
MelMACCS.ini file is in a section labeled /CHEM-TO-ISO. This is necessary to calculate the 
core inventory by isotope.  
 
Chemical groups are removed from consideration by MelMACCS by modifying the section titled 
/EXCLUDE-GROUPS in the MelMACCS.usr file found in the Windows user’s folder. Under 
Windows 7, this folder is C:\Users\username\MelMACCS_Docs, where username is the user’s 
login name. 
 
New compound groups such as CsI can be added by editing the MelMACCS.ini file.  See the 
MelMACCS Models Document for more information. 
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